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Getting Started with VERICUT 
Introduction 
Introduction to VERICUT 
VERICUT simulates or replaces costly steps of the NC data verification process, plus 
optimizes the efficiency of material removal. By simulating NC programs, VERICUT 
can reduce or eliminate the time-consuming and expensive steps of the traditional data 
prove-outs. The program also optimizes program feed and speeds to increase the 
efficiency of the machining process. This all adds up to lower costs and higher profits for 
your business. 

Need training? Visit the CGTech web site at www.cgtech.com and click "TRAINING" 
for training course descriptions, schedules, and online registration. 

 

NC program verification process with VERICUT: 

 
 

VERICUT interactively simulates the material removal process of NC program data. 
Instead of messy wax or foam models, or costly prove-outs that waste valuable 
production time, a simulated VERICUT part is graphically produced on your computer 
screen. VERICUT then verifies the accuracy of the NC program and makes certain the 
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finished part matches the design model. Before any machine time is spent, VERICUT 
catches discrepancies that could corrupt the cutting process and identifies the responsible 
NC program records for fast and easy adjustment. 

The input into VERICUT is NC program data from almost any source. G and M code 
data as well as APT type CL-files are directly processed by VERICUT. Similar to the 
requirements of machining a real part, VERICUT needs the NC program data, a 
description of the raw stock material to be machined, and descriptions of the cutting tools 
used to machine the part. The result of the verification process is a solid model of the 
machined part and an error Log file reporting any machining errors detected during the 
simulation. The VERICUT model can be inspected, saved, or used as the stock material 
for another NC program. 

In addition to streamlining the verification process, VERICUT dramatically boosts 
productivity on the shop floor. Automated and user-selectable optimization settings in 
VERICUT let you maximize the material removal process. The feed rate and cutting 
speed of each NC program automatically adjust based on the depth, width, and angle of 
each cut. In fact, you can even set VERICUT to compensate for dull or custom cutters or 
other elements unique to your operation. 

VERICUT simulates up to 5-axis milling, drilling and wire EDM operations, as well as 
turning and combination mill/turn machining. With a complete line of specialization 
modules for added features and functionality, VERICUT is truly the total simulation, 
verification, and optimization solution for unleashing NC productivity. 

 

Installing VERICUT 
In most cases installing VERICUT is a straight-forward and easy task, requiring only a 
few minutes of time. Prior to installing any software, review the system requirements and 
the installation procedure for the computer type on which you intend to operate 
VERICUT. 

Detailed step-by-step instructions are provided in the online VERICUT Installation 
Guide found in the V6.1 Help Library. Follow all applicable steps to ensure smooth 
VERICUT installation and successful operation.  

 

Accessing VERICUT 
The method of accessing VERICUT is different, depending on the environment in which 
it is operated. All methods described below are for accessing VERICUT as installed 
using instructions provided by CGTech. Your VERICUT installation may be different. 

 

Access VERICUT on a Windows computer: 
From the Taskbar, click Start > All Programs > CGTech VERICUT 6.x > VERICUT 
6.x where "6.x" is the desired VERICUT version number. 
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For example, to run VERICUT 6.0 you would click: Start > All Programs > CGTech 
VERICUT 6.0 > VERICUT 6.0 

 

Access VERICUT on a UNIX computer: 
Type "vericut". If the command is not found, include the full path, e.g. 
"/<cgtech6x>/<computertype>/commands/vericut" where <cgtech6x> represents the 
directory path to where CGTech products were installed, and <computertype> is the type 
of computer on which VERICUT is being operated, for example: hp, rs, sgi, or solaris. 

For example, to run VERICUT installed in "/server/apps/cgtech60" on an HP700 
computer, you would type: /server/apps/cgtech60/hp/commands/vericut 

Hint: Copy the "vericut" command file to the /usr/bin directory and the next time you log 
in, you should be able to just type "vericut". 

 

Access VERICUT from CATIA: 
Assuming you have CGTech's CATIA-to-VERICUT Interface installed, choose the 
"CATV" function. Use CATV functions to select the CATIA data to use in the 
verification session (geometry models, NC programs, etc.) and transfer the data to 
VERICUT. Then access VERICUT via choosing PROCESS menu > VERICUT. 

 

Access VERICUT from UG: 
Assuming you have CGTech's Unigraphics-to-VERICUT Interface installed, access 
VERICUT from UG as follows: 

UG V17 and V16 — Click on the Verification icon in the UG CAM icon bar. 

UG V15 — Click Tools Manufacturing menu > VERICUT. 

 

Access VERICUT from WorkNC: 
Assuming you have CGTech's WorkNC-to-VERICUT Interface installed, access 
VERICUT via choices in the WorkNC Utilities menu. VERICUT can be run 
interactively or in batch, to perform NC program verification or optimization. 

 

Access VERICUT from Pro/Engineer: 

Access VERICUT from ProE as follows: 

Click NC Sequence Play Path menu > NC Check => simulates the current selected NC 
sequence. 
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Click CL Data menu > NC Verification => enables users to select a single NC 
sequence, multiple sequences, or an entire NC operation for simulation.  

NOTE:  The NC data must be selected prior to selecting starting the verification 
process. 

 

Access VERICUT from Mastercam-to-VERICUT Interface: 
Access VERICUT from Mastercam as follows: 

Hold down the Alt key and click the C key (referred to as Alt-C). You will see a file 
selection dialog offering all the installed C-Hooks. Pick "VERICUT.dll" and click on the 
Open button.   
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VERICUT Licenses and Options 
VERICUT licenses and capabilities differ, depending on the environment in which 
VERICUT is being operated. A modular approach provides the flexibility to purchase 
only the capabilities you need. As your needs change, you can add the appropriate 
licenses to increase VERICUT's functionality. It is not necessary to install any additional 
software to add a license CGTech provides a license that allows immediate access. 
CGTech software licenses allow you to share VERICUT over a network. One user may 
access a given license at a time. CGTech's license system supports Windows 2000, XP 
and UNIX. See VERICUT System Requirements for more detailed information. The 
server and networked workstations can be different computer types. 

 
Licensing for VERICUT 
VERICUT 6.0 licensing is required. Pre-5.4 licensing is incompatible with the 6.0 
CGTech Network License Server. If you do not have a 6.0 license, obtain licensing from 
CGTech as described below. 

6.0 licenses are issued via email only. Your6.0 license will be emailed to the primary 
VERICUT user at your company. If you do not have licensing, submit an application via 
our website at www.cgtech.com. 

NOTE TO NEW CUSTOMERS — You will need to know the machine ID 
(ethernet address) of the machine on which the CGTech Network License Server is to 
operate. To determine the machine ID, see the steps described in the VERICUT 
Installation Guide, located in the CGTech Help Library. (ref. pre-installation procedure 
for your computer type: Windows or UNIX). 
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Licenses and Options available for VERICUT by CGTech 
The sections that follow describe the software products obtained from and licensed by 
CGTech. The terms "licenses" and "options" are synonymous, since each option for 
VERICUT is licensed by CGTech.  

 
  
Mold & Die Machining 
The Mold & Die Machining module is a new base module designed for the mold and die 
machinist or NC programmer. It is a packaging of existing Verification and OptiPath 
features, controlled by a default custom interface. The interface can be tailored by 
CGTech for specific end-users, or by anyone with a license for the new Customizer 
module. 

Mold & Die Machining is targeted at new customers. It is intended to be attractive to the 
Mold and Die tooling manufacturer who would not consider standard VERICUT for a 
variety of reasons, such as: too difficult to setup and use, no perceived value in 
verification, not enough advantages for the mold or die making process. It is not intended 
for existing customers, but some existing customers may want to add Mold & Die 
Machining licenses rather than Verification licenses. 

The goal of Mold & Die Machining is to provide enough useful features for mold or die 
makers to justify the cost, while not affecting the value of standard VERICUT and 
modules. 

The Mold & Die Machining base module license contains some features found in 
OptiPath. However, do not confuse these OptiPath features with an OptiPath license. 
The OptiPath features are included with the Mold & Die Machining license, and cannot 
be accessed with a standard Verification base license. 
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The Mold & Die Machining base module restricts some access to Verification and 
OptiPath features due to the interface customization, but the feature restriction is mainly 
controlled by licensing. 

The following Verification features ARE NOT available in the Mold & Die Machining 
base module: 

Multiple stock components 
Fixture collision checking 
X-caliper measuring (feature info is available) 
Machine and Machine/Cut Stock views 
NC Program Review 
Comparator 
Save a control file 
Save a machine file 
Turning 
Wire EDM 

  

The following OptiPath features ARE NOT available in the Mold & Die Machining 
base module: 

Optimize Circles & NURBS 

  

The following add-on modules MAY NOT be added to the Mold & Die Machining base 
module: 

OptiPath 
Machine Simulation 
Machine Developer's Kit 
Cutter Grinder Machine Simulation 

  

Add-on modules available with Mold & Die Machining are: 

Multi-Axis 
AUTO-DIFF 
EDM Die Sinking Simulation 
Model Export 
Inspection Sequence 

  

There are no pre-requisites for this base module. 
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Verification 
The Verification license is the foundation of VERICUT. It includes everything necessary 
to simulate and verify 3-axis milling and multi-axis positioning operations to detect errors 
such as: 

Inaccurate programming 
Rapid motion contact 
Incorrect tool path motions 
Collisions with fixtures & clamps 
Incorrect or misread blueprints 
Tool shank and holder collisions 
CAD/CAM and post-processor errors 

VERICUT has two viewing options: Workpiece, and Machine. The Workpiece view 
interactively displays material removal and the tool assembly, stock and fixtures. The 
Machine view displays the CNC machine tool and the complete machining environment, 
including the cut model as material is removed. On its own, the Verification license 
supports the Workpiece view. The Machine view requires a Machine Simulation 
license. 

Model analysis — You can move, zoom, reverse, and rotate the model at any point in the 
cutting process. You can also cross-section it multiple times at any orientation, and view 
it in translucent mode enabling you to check areas that would be impossible to see in a 
solid model (such as the intersection of drilled holes). X-Caliper, a comprehensive 
measurement tool is included to check thickness, volume, depth, gaps, distances, angles, 
hole diameters, corner radii, scallop height, and edges. Delta X, Y, Z component distance 
measurements are included. 

Cutter simulation — You can accurately simulate the material removal process using 
the exact cutter used to machine the part. VERICUT includes a library of standard cutters 
provided by Ingersoll Cutting Tool Company. You can also define your own cutters. 
Holders can be specified as a "non-cutting" portion of the tool in order to check for any 
potential collisions. VERICUT supports concave bottom, or non-center cutting end mills, 
such as carbide insert end mills. Although designed to remove large volumes of material 
at high speeds during planar or XY cutting, carbide insert roughing end mills are often 
used to ramp into material. If the angle of the cut is too steep, the "non-cutting" portion of 
the tool collides with the material and can break the tool and ruin the part. VERICUT 
enables you to define inserts as cutting edges and the body as a non-cutting portion of the 
tool, helping you take full advantage of your equipment without fear of destroying the 
workpiece or cutting tool because of an incorrect ramp motion. 

FastMill — The FastMill cutting mode is designed to quickly process large NC 
programs and is especially useful for mold and die manufacturers. A single mouse click 
switches cutting operations to FastMill mode. FastMill provides complete control of the 
speed, accuracy, and quality of the model. Accuracy is calculated independently of the 
display, enabling you to create highly accurate models and display them at lower 
resolutions for quick manipulation and high resolution for detailed analysis. FastMill 
uses the same trajectory logic for calculating material removal as the standard cutting 
mode (e.g. it's built with the same robust simulation technology developed and refined for 
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a decade in VERICUT). FastMill IS NOT a replacement for VERICUT's standard 
machining mode; it is designed to work with large tool paths at a single setup orientation. 

Convert NC data — VERICUT is a powerful reverse post-processor. By translating NC 
programs to APT or other NC data formats, the program saves valuable machine tool and 
programmer time. Because obsolete or incompatible NC programs can be recycled or 
made to run on different machines, you can take advantage of all your programming 
resources – present and past. 

There are no pre-requisites for this base module. 

 

Model Export 
With a few mouse clicks, the Model Export license enables you to export a cut model at 
any stage in the machining process, as an in-process CAD model complete with 
machined features! 

 

 
 

CGTech's unique algorithm minimizes file size, while preserving manufacturing features 
such as holes, fillets, corner radii, pocket floors and walls. The result is a highly accurate 
IGES or STL model. 

Why Model Export? — Since the invention of the first NC machine tools, NC 
programming languages, and CAD/CAM systems, manufacturing engineers have needed 
an accurate electronic model of the initial and in-process state of material. It's difficult to 
confidently create tool paths for each subsequent operation without an accurate 
representation of the initial material. The accuracy, efficiency, and "correctness" depend 
on the material's initial geometric shape. 

Access to the correct geometric workpiece shape in the CAD/CAM environment, at each 
manufacturing stage, helps avoid problems when creating subsequent cuts. Until now the 
only way to get an in-process CAD model is with expensive, labor-intensive, error-prone, 
and inaccurate methods. These include manually modeling the material state for each 
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operation, or using scanning equipment and surfacing software on the physical workpiece 
produced by the previous operation. 

Some CAD/CAM systems attempt to provide this by using their CAD solid modeling 
tools. This approach is typically limited to 2½ axis operations, and does not simulate 
motion. Instead it estimates the region to be removed, creates a solid feature for that 
region, and subtracts it from the initial stock model. Often details produced by cutter 
radius, step-over, or step-down are not included. And the size of the model can grow such 
that it becomes unmanageable. 

Another CAD/CAM technique produces a rough faceted approximation of the in-process 
material. Typically limited to 3-axis motions and from a single setup position, the 
accuracy is only as good as the facet tolerance. Manufactured features such as holes, and 
radii are often lost. The models can be gigantic, requiring millions of facets to represent 
even relatively simple shapes. 

Both of these techniques seek to avoid the difficulty of using an "as-machined" 
verification model to generate a usable CAD model. After simulating an NC tool path, 
the verification model contains much more data than a traditional CAD solid model 
algorithm can process. Because it is designed to create verification models, VERICUT 
has the unique advantage of being able to manage the data without failing and export an 
accurate CAD model in a manageable size. 

Model Export requires a Verification, or Mold & Die Machining, base module license 
as a pre-requisite. 

 
AUTO-DIFF 
AUTO-DIFF enables you to compare a design model to the "as-machined" VERICUT 
solid model to automatically detect differences and protect against gouges. Using this 
license, anyone involved in the production process can identify incorrectly machined 
areas. AUTO-DIFF is also used to detect a possible weakness or mistake in the design. 

Why use AUTO-DIFF? — Often, from the time a part is designed to when it is ready to 
be machined, the design has passed through several people, departments, companies, and 
CAD/CAM systems. In the end, it is difficult to tell if the tool path accurately reflects the 
original design model. Without AUTO-DIFF, the only way to be sure is to cut the part 
and do a first article inspection. By using AUTO-DIFF to compare the simulated model 
to the design model, you are assured the tool path accurately represents the original 
design concept. This reduces the time it takes to cut the first production-worthy part. 
AUTO-DIFF also reduces the time it takes to prepare an NC program. You can check for 
gouges or excess material during the programming stage – not at the machine. 

 

Solid, Surface, & Point comparisons 

SOLID — Solid models from most popular CAD/CAM systems can be used. AUTO-
DIFF embeds the solid model in the simulated part. You can identify gouges and excess 
material by setting a user-defined tolerance level. You can also compare the cut model 
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with another VERICUT model – ideal for comparing different operations such as 
roughing and semi-finishing cuts. 

SURFACE — A surface, a set of surfaces, or the skin of a solid model can be compared 
with the simulated part. The surface is overlaid on top of the simulated part, and gouges 
and excess material are displayed. Large amounts of data from very complex tool paths 
can be quickly compared. The design model does not need to be watertight, nor does the 
entire part need to be included. 

POINT — When solid or surface model data does is not available, you can lay 3-D 
points from CMM or manual methods over the top of the simulated part. The points are 
compared to the NC tool path to accurately detect errors or out-of-tolerance conditions. 

Gouge checking — With AUTO-DIFF, you can perform constant gouge-checking 
interactively during simulation with virtually no degradation in speed or performance. It's 
not necessary to simulate the entire NC program first – you can identify and correct 
problems as they occur. To identify gouges, AUTO-DIFF embeds the design model 
inside the rough material. When the tool path cuts into the embedded model, the gouge is 
highlighted and the error is reported. 

AUTO-DIFF also detects collisions between a tool and components nested inside the 
stock model, such as tooling pins, hardened inserts, or bearings. Previous cutting 
operations can be "protected" from any further machining. Any material removed from a 
protected area is highlighted and reported as an error. To make identifying gouges, 
collisions, or excess material easy, you can assign different colors to the design models, 
rough stock, and errors. Excess material boundaries can be exported as IGES or point 
data. 

AUTO-DIFF reports — You can view automatically generates error reports which 
include information such as type of error, tolerance value, all tool path records out of 
tolerance, error location, and summary of results. AUTO-DIFF error reports are 
interactively linked to the graphics. Picking on an item in the report screen highlights the 
error on the screen. A report can be printed or saved as .TXT files. Both reports and 
graphical results can be generated in batch mode. 

AUTO DIFF requires a either a Verification, or a Mold & Die Machining, base module 
license as a pre-requisite. 

 

EDM Die Sinking Simulation 
EDM Die Sinking Simulation provides the ability to simulate the EDM die sinking 
process in VERICUT by using VERICUT models (polygon, STL, block/cylinder/cone) to 
represent EDM electrodes, and subtracting those "electrode" models from the VERICUT 
stock model. In addition to using the usual VERICUT models to represent electrodes, the 
new VERICUT Solid model can be used. 

The EDM Die Sinking Simulation module provides a new tool to the mold tooling 
designer and fabricator. No other technology exists today to allow the mold builder to 
simulate the EDM burn process and produce the final mold cavity directly from solid 
models created by NC program. VERICUT's simulation of the EDM burn process gets as 
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close as possible to the physical process by using VERICUT "as machined" solid models 
of the rough machined mold components and machined electrodes used to produce the 
completed mold tooling. 

The EDM Die Sinking Simulation module allows several different views of the burn 
process, including display of the rough machined stock, the electrodes, and the burn 
material (material removed by the electrodes). All can be displayed, blanked, or 
displayed translucent. The burn process also displays the volume removed by each 
electrode, and allows specification of an "overburn" offset on each electrode. 

The resulting burned mold component can then be compared to a design model of the 
final desired mold component using AUTO-DIFF. AUTO-DIFF is NOT included with 
the EDM Die Sinking Simulation module. 

EDM Die Sinking Simulation requires either a Verification, or a Mold & Die 
Machining, base module license as a pre-requisite. 

  

OptiPath 
The OptiPath license automatically modifies feed rates based on cutting conditions and 
amount of material removed. Using OptiPath can dramatically reduce the time it takes 
you to machine parts and increase the productivity (and profitability) of the NC machine 
tools at your shop. 

The feed rate problem — With the current advances in cutting tools, materials, and 
automatic tool path generation software, it is increasingly critical to use the right feed rate 
for each and every cut in the NC program. However, determining and setting the 
optimum feed rate has traditionally presented NC programmers and machinists with a 
number of problems. Because an incorrect estimate can break the cutting tool, damage 
the fixture, and scrap the part, usually only one or two conservative feed rates are used. 
Typically, the 'safe' feed rates chosen are a compromise between tool life, cycle time and 
the worst-case cutting condition encountered. 

These 'worst-case' feed rates are fine for the cuts that remove the largest amount of 
material or encounter the worst cutting conditions. Unfortunately, these slow, poorly 
controlled speeds waste time, increase manufacturing costs, and create poor cutting 
conditions elsewhere on the part. 

CAM software does not provide the material removal information necessary to determine 
optimum feed rates. And many CAM systems have limited cut patterns that do not fit the 
workpiece geometry. Their machining strategies and cut patterns are not very efficient for 
common operations such as open boundaries, roughing cuts on complex shapes, complex 
pocketing, or planar roughing on mold cavities or cores. Cutters therefore waste a lot of 
time while "cutting air" and feeding slowly across the surface of the part, in contact with 
it, but not removing any material. Additionally, an automatically generated tool path may 
plunge the cutter into material at an incorrect or inefficient angle. The end results can 
include excessive machining time, bad workpiece finishes, increased cutter wear, and 
broken tools. 
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Even if you somehow know the optimal feed rates to use for each individual cut, inserting 
them into the NC program is time consuming and error prone. 

Optimizing the operation — OptiPath works by reading the NC program file and 
dividing motion into a number of smaller segments. Where necessary, based on the 
amount of material removed in each segment, the software assigns the best feed rate for 
each cutting condition encountered. It then outputs a new tool path, identical to the 
original one but with improved feed rate settings. It does not alter the tool path trajectory. 

This solution offers the best of both worlds. On one hand, it is automatic and determines 
the best feed rates before the NC program is even loaded on the machine. On the other, it 
uses the expertise of the NC programmer and machinist to determine the best feed rates 
for specific cutting conditions. You input ideal feed rates for a number of pre-determined 
machining conditions. Factors such as machine tool capacity (horse-power, spindle type, 
rapid traverse speed, coolant, etc.); fixture and clamp rigidity; and cutting tool type 
(material, design, number of teeth, length, etc.) all affect the process. These factors 
determine settings (chip thickness, volume removal rate, entry feed rate, spindle speeds, 
etc.) used to calculate the optimum feed rate for each segment of each cut. 

Typically, different optimization techniques are best suited for certain materials or 
machining processes: 

Roughing — During planar roughing of aluminum structural components, material is 
removed at a constant axial depth, but the radial width of cut varies greatly from cut 
to cut. The goal is to remove as much material as quickly as possible. Maintaining a 
constant volume removal rate keeps the cutter at its maximum rate of advance into 
material for the varying cutting conditions. Using the information provided while 
verifying the tool path, the software is able to determine the amount of material 
removed in each segment of the tool path. The software then assigns the best feed rate 
using the information supplied by the NC programmer and/or machine tool operator. 

Finishing — Another example would be semi-finishing or finishing operations in a 
tool steel mold cavity. Cutting is typically characterized by widely varying chip loads 
as the tool profiles through the roughing cuts and over the contours of the workpiece 
to near net shape. In order to achieve a constant chip load, feed rates are optimized 
based on the maximum chip thickness for each cut segment. The software takes into 
account where the material is in contact with the cutter and adjusts the feed rate to 
maintain a constant chip thickness. This is especially critical when tip cutting with a 
ball end mill, or when touring a surface with a small step-over. The feed rates 
continually change over the course of the cut in order to maintain a constant 
maximum chip thickness. The result is an improvement in tool life and a higher-
quality surface finish. 

 

Benefits of OptiPath 
Faster time-to-market... Optimized tool paths reduce the over-all cycle time required 
to produce parts so they can be brought to market more quickly. 

Save money... Reducing the time it takes to machine each part adds up to huge 
savings over the course of a year. 
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Increase productivity... Existing machine tools produce more parts in the same 
amount of time. It's almost like getting another NC machine for free! 

Reduced fatigue... Machinists are not forced to keep a close eye on the machining 
process. They can set up other jobs or attend to other duties while the optimized 
program is running. 

Reduced cutter wear... Less time required to cut each part means less cutter wear. 
Cutting at optimum conditions also prolongs tool life, so they are used longer before 
needing to be re-ground or replaced. Machinists are less frequently required to change 
tools or inserts. 

Reduced machine wear... Machines are subject to less wear because optimized feed 
rates maintain a more constant cutting pressure between the machine tool and the 
workpiece. This reduces variable forces on the axis motors which leads to smoother 
NC machine tool operation. 

Better quality... Optimized tool paths produce a better finish because constant cutting 
pressure causes little or no variation in cutter deflection. Finishes on corners, edges, 
and blend areas are significantly better. This reduces the amount of time required to 
bench finish the completed part. 

High-speed machining — During high speed machining, the way the cutter contacts 
material is critical. Too low a feed rate produces chatter, vibration and work hardening, 
leading to poor surface finishes and premature cutter failure. Too high a chip load causes 
excessive cutting pressure and unsafe conditions that can lead to catastrophic failure of 
the tool, spindle, fixture and machine. Adjusting feed rates to maintain a constant chip 
load or volume removal rate help reduce these problems typically found in high speed 
machining – and are recommended by cutting tool manufacturers to solve the "chip 
thinning" problem. Constant chip thickness works especially well with high speed 
finishing with ball end mills where very small volumes of material are removed at high 
feed rates and spindle speeds. Spindle speed can also be optimized to maintain a constant 
surface speed at the maximum contact diameter on the cutter. Depending on the 
capabilities of the machine, constant surface speed optimization can help improve the 
surface finish. 

Optimization settings — Feed rates are adjusted based on a number of user-defined 
settings. Feed rates are affected by machining conditions such as: machine tool capacities 
(horse-power, spindle type, rapid traverse speed, coolant, etc.); fixture and clamp rigidity; 
and cutting tool type (material, number of teeth, length, etc.). 

Other settings are dependent on the nature of the tool path and determine the optimum 
feed rate for each cut: 

Cut depth 
Cut width 
Cut angle 
Entry feed rate 
Cutter wear 
Volume removal rate 
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The OptiPath Library — A library of feeds rates and surface speeds for different 
cutting tools, materials, and cutting conditions is included. Provided by Ingersoll Cutting 
Tool Company, this library serves as a useful starting point for determining the ideal 
feeds and speeds for particular machining conditions. 

All optimization settings are stored in this central library, organized by type (different 
cutting tools, NC machines, etc.). Because everyone can access the same cutting 
information from the library, OptiPath is an excellent tool for achieving more consistent 
machining results between different operators, machines, shifts, etc. – even if your 
'resident expert' is unavailable. 

Acceleration / deceleration & NURBS support — OptiPath accounts for changes in 
velocity as each axis accelerates and decelerates during changes in direction. With this 
information, feed rates settings are based on the physical capabilities and limitations of 
the machine tool. OptiPath supports NURBS interpolation. It examines the machining 
conditions and amount of material removed by each segment of the curve – then 
calculates an ideal feed rate for each NURBS span, while maintaining the original 
geometric shape of the curve. 

OptiPath requires a Verification base module license as a pre-requisite. 

  
Machine Simulation 
In complex multi-axis machine work where tool orientation changes frequently, the 
possibility of costly collisions is a frightening reality. A machine crash can cost 
thousands of dollars, ruin the NC machine, and delay the entire production schedule. 
Machine Simulation supports 3-D modeling machines and detects collisions and near-
misses between all machine tool components such as axis slides, heads, turrets, rotary 
tables, spindles, tool changers, fixtures, work pieces, cutting tools, and other user-defined 
objects. 

VERICUT's Machine Simulation module enables you to perform realistic 3-D 
simulation of entire NC machines, just like they behave in the shop, with extremely 
accurate collision-detection. 

A complete library of pre-assembled machine tools is included. All models can be easily 
customized to match your machine. A partial list includes machines from: Bostomatic, 
Maho, Cincinnati Milacron, Makino, Mazak, Fadal, Mitsui Seikii, Okuma, SNK (Shin 
Nippon Kok), Kearney & Trecker, Sundstrand, Giddings & Lewis, Toyoda, Ingersoll 
Milling, and many more. 

You can also build machine components and job-specific components (such as work 
pieces, cutting tools, rotary tables, spindles, fixtures, and clamps) in your CAD system 
and import them into VERICUT. By mixing imported CAD data with VERICUT solid 
primitives you can easily modify an existing machine or to create a new one. Any 
machines you modify or build from scratch can be saved to the machine tool library. 
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Simulating controls — VERICUT is developed by industry professionals who 
understand the complexities of NC code and control functions. This technical expertise 
makes VERICUT an excellent tool for verifying complex code using advanced 
programming functions such as: 

Look-ahead or 3-D cutter compensation 
Tool tip programming & tool length compensation 
Gage length reference point programming 
Canned cycles & fixture offsets 
Rotary axis pivot points 
Variables, subprograms & macros 
Subroutines, looping & branching logic 

With this license, you can accurately simulate every control in your shop and account for 
different machines, programs, parts, and functions. No programming language is required 
to simulate most NC controls. Machine Simulation includes an extensive library of 
flexible, easily modified controls, including: Fanuc, Allen-Bradley, Mazak, NUM, 
Cincinnati Acramatic, Okuma, Fadal, Maho Phillips,General Electric, Siemens 
Sinumerik, Giddings & Lewis, Heidenhain, Yasnac, and many more. 

Collision checking — VERICUT is the fastest, most accurate NC machine collision 
checking program available. 

Rather than checking only start and end points, or checking a number of points along a 
path, VERICUT uses a set of unique algorithms to check for potential collisions along the 
entire machine path. 

The program also detects axis travel limit errors (user-defined limits for machine 
component movement). The program checks for and highlights collisions between all 
machine tool components such as axis slides, heads, turrets, rotary tables, spindles, tool 
changers, fixtures, work pieces, cutting tools, and other user-defined objects. The 
program also allows near-miss zones to be defined around the components. 

Machine Simulation requires a Verification base module license as a pre-requisite. 

  

Multi-Axis 
As complexity increases, so does the chance for error. Tool positioning is critical in four 
and five-axis milling operations, further increasing the importance of verification. While 
it is nearly impossible to predict how these machines will respond to complex motion 
commands, Multi-Axis enables VERICUT to graphically display the results and take the 
guesswork out of multi-axis tool path prove-outs. 

The Multi-Axis module enables VERICUT to simulate multi-axis milling, drilling, 
turning, and combination mill/turn operations. VERICUT will attempt to checkout a 
Multi-Axis license whenever the tool axis orientation changes. If a Multi-Axis license is 
not available, only the final position will be calculated and simulated. Any rotary motions 
involved will NOT be simulated. Error checking and/or collision detection between the 
start point and end point will NOT be detected. 
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Milling — The Multi-Axis license accurately displays material removal during multi-
axis milling of complex profiles and surfaces. The Multi-Axis license simulates and 
verifies four and five axis milling/drilling machining operations. 

Turning — The Multi-Axis license also simulates and verifies up to 2-4-axis turning 
operations. VERICUT supports 4-axis synchronized (merged) turning operations with 
multiple tools. 

When combined with Machine Simulation, CGTech's comprehensive 3-D collision-
checking can be applied to the in-process workpiece as it is machined. This is useful for 
detecting interference between the machined part and tool holders, boring bars, tool 
blocks, turrets, head assemblies, and other machine components, in addition to standard 
collision checking between machine components. 

Multi-Axis requires a Verification base module license as a pre-requisite. 

 

  
Advanced Machine Features 
The Advanced Machine Features option accesses advanced NC machine and control 
features during the simulation. These features simulate complex or special machine or 
control functions. Some advanced features are developed to meet specific user's custom 
requirements and may need additional development work to expand them to other 
applications. 

Examples of advanced features that have already been implemented include: 

Facing Heads (or "programmable boring bar") 

Simulation of the Index mill/turn multi-channel control programming and 
synchronization technology 

The use of certain macros requires an Advanced Machine Features license. The 
macros in this category are:  

ClampOnOff 

Ijk2AbcType (with a non-zero value) 

ModeAssymTurningOnOff (with a non-zero value) 

As new advanced NC machine and control features are added to VERICUT in the future, 
having this option provides access to them as well as those listed above. If you have 
advanced or custom requirements to be simulated by VERICUT, contact your CGTech 
representative to learn how we can help. 

Advanced Machine Features requires a Verification base module license as a pre-
requisite. 
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Machine Developer's Kit 
While VERICUT's capabilities are ideal for most, some users with special simulation or 
unusual processing requirements may require the Machine Developer's Kit – a high-
level programming tool designed to increase VERICUT's ability to interpret and translate 
complex or unusual NC machine code data. 

Do you need the Machine Developer's Kit? — VERICUT strives to support all the 
codes that are typically executed when running a job. However, it does not support all 
codes for every available control. (A special milling cycle, for example, may not be 
supported.) Under special circumstances some customization may be necessary. Based on 
a programming language similar to C, the Machine Developer's Kit provides a great 
deal of flexibility for interpreting and translating NC file formats. There are a number of 
additional benefits. For example, new functions can be written for new or enhanced 
control capabilities. Hardware and NC controls can be retrofitted or replaced without 
retiring NC code. VERICUT can be set to output NC code compatible with new 
equipment. Some programming experience is recommended. 

Machine Developer's Kit requires a Verification base module license as a pre-requisite. 

  
Cutter Grinder Verification 
The Cutter Grinder Verification module is a new base module designed to make the 
use of VERICUT more accessible to Cutter Grinder machine users. Cutter Grinder 
Verification is a packaging of the current Verification and Multi-Axis modules, 
controlled by a default custom interface (see "Customizer" below). The interface can be 
tailored by CGTech for specific end-users, or by anyone with a license for the new 
Customizer module. 

Cutter Grinder Verification is expected to be launched from a grinder programming 
system. Currently the only known functioning systems are NUMROTO by Schnieder 
Electric (NUM) from Switzerland, and the software produced by Alfred Schuette in 
Germany. 

The following Verification and Multi-Axis features ARE NOT available in the Cutter 
Grinder Verification base module: 

APT CL formats other than VERICUT APT 
Multiple NC program files 
Multiple stock components 
NC Program Review 
Save a control file 
Save a machine file 
Wire EDM 
4-axis merged turning 
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The following add-on modules MAY NOT be added to the Cutter Grinder Verification 
base module: 

AUTO-DIFF 
Multi-Axis 
OptiPath 
EDM Die Sinking Simulation 
Model Export 
Machine Simulation 
Machine Developer's Kit 

  

There are no pre-requisites for this base module. 

  

Cutter Grinder Machine Simulation 
The Cutter Grinder Machine Simulation module is an add-on module available only 
with Cutter Grinder Verification. It allows you to simulate and detect collisions using a 
grinding machine file and appropriate control file. 

Cutter Grinder Machine Simulation requires a Cutter Grinder Verification license as 
a pre-requisite. 

  
CNC Machine Probing 
CNC Machine Probing enables you to simulate the use of probing devices on a CNC 
machining center and detect errors that could break the probe... before your program even 
leaves for the shop! 

If you use your CNC for probing operations, CNC Machine Probing will help ensure that 
you will not destroy the probe or crash the machine during tasks such as: 

Locating the stock and/or fixture and adjusting offsets  
Measuring and adjusting for stock variations  
Identifying stock and/or fixture configuration or part number on the machine  
Measuring and adjusting tool or fixture offsets  
Detecting tool failure  
Inspecting critical machined features  
 

Why Simulate Probing Operations? — When using a CNC machine to perform 
probing operations a number of errors can occur. The probe tip/stem could contact 
another object while not in probe mode, likely breaking it. The probe body or other 
machine component could hit something when moving and destroy an expensive 
inspection probe. Or, an error in the probe cycle logic could cause unexpected machine 
motion — which could crash the machine, destroy the probe body, or break the probe tip! 

With VERICUT simulation, there is no reason your probing operations should ever cause 
a headache! It notifies you when the probe tip contacts an object while not in 'probe 
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mode,' and detects any collisions. It even verifies that the probe cycle’s logic (which 
alters machine motion based on information gathered during probing) will not cause an 
error! 

How it works — It's easy to create a probe tool. Simply specify the spherical "tip" 
diameter and shank diameter and length. Adding a holder completes the assembly and 
protects the entire inspection probe! VERICUT detects collisions when anything other 
than the probe tip contacts another object. 

VERICUT then moves the simulated probe device along the specified path. Motion stops 
when the probe tip contacts an object, or when it reaches the end of the programmed 
motion. The probe motion results (such as machine axis locations) are applied in the 
probe sub-program with VERICUT's standard control emulation, just like on your CNC. 

VERICUT simulates all aspects of probe cycle subroutines/programs, including complex 
logic and Type II formats used to set offsets and make decisions based on probe results. 
Contact CGTech to learn how VERICUT can simulate your custom probe cycles!  

CNC Machine Probing requires a Verification base module license as a pre-requisite. 

  
Inspection Sequence 
The Inspection Sequence module is an add-on module that enables you to save time and 
improve accuracy by generating in-process inspection instructions and documentation 
from VERICUT's simulated in-process machined features. 

Inspection Sequence requires a Verification, or Mold & Die Machining, base module 
license as a pre-requisite. 

  
Pro/E-to-VERICUT Interface (PROEV) 
The Pro/E-to-VERICUT Interface gives Pro/Engineer users a better way to work with 
VERICUT from within their CAD/CAM environment.  

VERICUT is launched from within Pro/Engineer's NC menus and can be run 
interactively or in batch mode. Tool path motions for the selected Operation or NC 
Sequence; tool descriptions; and reference, workpiece and fixture models from the 
current manufacturing session are automatically transferred to VERICUT.   

The VERICUT session runs as an external process, allowing you to work in Pro/Engineer 
while VERICUT verifies the tool path.  

  
Unigraphics-to-VERICUT Interface (UGV) 
The Unigraphics-to-VERICUT Interface, or "UGV" license provides a fully integrated 
Unigraphics-to-VERICUT interface that streamlines the verification and optimization of 
UG-generated tool paths. 

Verify individual paths, a series of selected paths, or a complete sequence of operations. 
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Stock, fixture, and design models are automatically transferred to VERICUT, along with 
tool path and tooling information. 

VERICUT runs independently from UG, so you can work in UG while verifying a tool 
path. 

NOTE:  The following Unigraphics products, ufunc_execute (P2_ufunc_execute for 
NX2) (product name "UG/Open API Execute") and the grip_execute (product name 
"UG/Open Grip Execute") are required prerequisites to running the Unigraphics-to-
VERICUT Interface. 

 

CATIA V5-to-VERICUT Interface  
The CATIA V5-to-VERICUT Interface integrates VERICUT into the CATIA V5 NC 
programming process, making set up, simulation, and optimization of NC programs 
easier and more efficient! You can simulate and verify individual operations, a series of 
operations, or a set of NC programs. All stock, fixture, and design geometry is 
automatically transferred to VERICUT in the correct orientation, along with tool path, 
tooling, machine and control data and other simulation parameters. VERICUT runs 
independently, so you can continue working in CATIA while simulating and optimizing 
your NC programs. 

  

CATIA V4-to-VERICUT Interface (CATV) 
The CATIA V4-to-VERICUT Interface, or "CATV" license provides a fully integrated 
CATIA-to-VERICUT interface that provides an improved way to work with the two 
programs. Using CATV, you can run VERICUT directly from CATIA. The VERICUT 
process runs independently, so you can work in CATIA while verifying a tool path. 
CATV transfers CATIA geometry to VERICUT for stock, fixture, and design models. It 
converts CATIA line and arc elements (2D tool profiles) into VERICUT cutter and 
holder tool definitions. Based on CATIA coordinate systems, CATV automatically 
calculates translations and rotations. CATV exports STL data so there is no need for 
expensive STL converters. Unlike converters which only output STL from solids, CATV 
outputs faces, skins, surfaces, and volumes. 

  
WorkNC-to-VERICUT Interface (WNCV) 
The WorkNC-to-VERICUT Interface, or "WNCV" license provides WorkNC users 
with an easy and convenient way to verify and optimize tool paths. VERICUT can be run 
directly from WorkNC, either interactively or in batch mode. Tool descriptions from 
WorkNC are automatically transferred to VERICUT. For quick setup, VERICUT creates 
a stock workpiece for you based on WorkNC settings. 
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Mastercam-to-VERICUT Interface (MCAMV) 
The Mastercam-to-VERICUT Interface, or "MCAMV" is a base module allowing 
users to launch VERICUT from within Mastercam. Setup information, including tools, 
tool paths, and models are automatically sent to VERICUT in their proper orientation and 
location. You can work in Mastercam while VERICUT verifies the tool path.  

There are no pre-requisites for this base module. 

 
EdgeCAM-to-VERICUT Interface  
The EdgeCAM-to-VERICUT Interface enables you to easily send model, tool 
assembly, and NC program information to VERICUT from EdgeCAM. Developed using 
Pathtrace's PDI development tools, it simplifies VERICUT setup for seamless simulation 
of EdgeCAM NC programs. VERICUT is launched from within EdgeCAM, but runs 
externally so you can work in EdgeCAM while verifying and optimizing NC programs in 
VERICUT. 

  

TDM Interface 
The TDM Interface provides direct access to the TDM Systems', Tool Data 
Management (TDM) system. Lists of tools can be extracted from TDM and used in 
VERICUT. No intermediate files are produced, so the tool data used is the latest available 
from the TDM database. 

  

Model Interfaces 
The following Model Interface modules enable VERICUT to both read and, when 
combined with Model Export, write the designated model file formats. These modules do 
not require a CAD/CAM system be available for VERICUT to read or write any of the 
formats. These modules are available on Windows platform only. Each module is 
licensed separately. 

 

CATIA V5 Model Interface — 
The CATIA V5 Model Interface reads CATIA V5 part files (.CATPart), up to R16. 
CATIA topological entities (such as CATBody, CATNurbsSurface, CATplane, etc.) are 
converted to triangular facets and written out as STL or VERICUT polygon files. 
Optionally a CATIA part file can be referenced directly in VERICUT's modeling 
interface, no intermediate file is written.  

When used in conjunction with a new output option in the existing CATIA V5 to 
VERICUT Interface (CATV5), the CATIA V5 Model Interface is used to read 
.CATPart files directly referenced in the VERICUT project file written by CATV5.  

When used in conjunction with Model Export, the CATIA V5 Model Interface writes a 
CATIA V5 model file. Depending on the features detected by Model Export, the CATIA 
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file contains trimmed topological features (such as CATBody, CATNurbsSurface, 
CATplane, etc.). 

  

CATIA V4 Model Interface — 
The CATIA V4 Model Interface reads CATIA V4 model files (.model), version 4.1.9 
and 4.2.4. CATIA topological entities (such as SOLIDE, SKIN, VOLUME, FACE, 
surface, plane, etc.) are converted to triangular facets and written out as STL or 
VERICUT polygon files. Optionally a CATIA model file can be referenced directly in 
VERICUT's modeling interface. No intermediate file is written. 

When used in conjunction with Model Export, the CATIA V4 Model Interface writes a 
CATIA V4 model file. Depending on the features detected by Model Export, the CATIA 
file contains trimmed topological features (such as VOLUME, polynomial surface, plane, 
etc.). 

 

Step Model Interface — 
The STEP Model Interface reads STEP files (.stp or .step) containing AP203 and 
AP214 (geometry only) protocols. STEP topological entities (such as surface, solid, 
sheet, shell, face, etc.) are converted to triangular facets and written out as STL or 
VERICUT polygon files. The interface does not separate STEP assembly files into 
individual parts. Optionally a STEP file can be referenced directly in VERICUT's 
modeling interface. No intermediate file is written. 

When used in conjunction with Model Export, the STEP Model Interface writes a STEP 
file. Depending on the features detected by Model Export, the STEP file contains 
trimmed topological features (such as bspline surface, plane, conical surface, cylindrical 
surface, etc.). 

  
ACIS Model Interface — 
The ACIS Model Interface reads ACIS files (.sat), up to version R16. ACIS topological 
entities (such as bspline surface, solid body, sheet body, shell, face, etc.) are converted to 
triangular facets and written out as STL or VERICUT polygon files. Optionally an ACIS 
file can be referenced directly in VERICUT's modeling interface. No intermediate file is 
written. 

When used in conjunction with Model Export, the ACIS Model Interface writes an 
ACIS file. Depending on the features detected by Model Export, the ACIS file contains 
trimmed topological features (such as bspline surface, plane, cone, etc.). 

  

840D Virtual NC Kernel and Interface — 
The 840D Virtual NC Kernel (VNCK) and Interface is a VERICUT optional module 
that provides an alternate control emulation method using the VNCK program developed 
by Siemens Automation and Drives Motion Control Systems Division, the developers of 
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the 840D CNC control. When VERICUT uses the VNCK for simulation, VERICUT is 
not reading the NC program and is not calculating the machine's axes positions. Rather, 
the VNCK (an external process running on the Windows computer that is also running 
VERICUT) reads the NC program, calculates the axes positions, and sends those 
positions to VERICUT. The VNCK is only able to read and simulate NC programs 
written for the Siemens 840D control. 

The VNCK and Interface consists of two components: The 840D VNCK software 
program developed by Siemens, and the VERICUT Interface to the VNCK program. 
Using this optional module, the VERICUT simulation is controlled by the VNCK 
program. The VERICUT Interface starts the VNCK and instructs it to load the control 
configuration data and NC program. During simulation, the VNCK then reads the NC 
program, calculates the NC motion axes positions, and sends this motion information to 
VERICUT. The VNCK program contains the actual 840D control's NC kernel, providing 
NC program processing and motion emulation consistent with the physical control. The 
VERICUT interface handles communication between the VNCK and VERICUT, using 
Microsoft's COM protocol. 

 

Limitations: 
OptiPath and CNC Machine Probing ARE NOT compatible with the VNCK. Also, 
since the VNCK is directing the simulation, other standard VERICUT simulation features 
may not be available or may behave differently. Additionally, the VNCK only notifies 
VERICUT when motion commands, those NC lines containing axes motions, are 
processed. Other NC program lines, such as variable definitions, calculations, and 
miscellaneous functions, are not considered NC events and are not displayed in the 
sequential processing of the NC program. 

 

Licensing: 
The VNCK program requires a separate node-locked license from Siemens. It is not 
available as a network license (i.e. does not "float"), but is locked to the specific machine 
where the VNCK is used. Thus a separate VNCK licensed module is needed for each 
computer that will run it. The license is locked to the MAC (physical ethernet hardware) 
address of ALL network devices detected on the computer. Thus all MAC addresses on 
the target computer are required. 

 

VERICUT Machine/Control Configuration: 

A VERICUT machine and a control file are still required for a VNCK configuration. 
When used with VERICUT, the VNCK program reads the NC program and passes axes 
positions to VERICUT. However, only axes controlled by the NC kernel (typically the 
machine's primary motion axes) are recognized. Any other commands, such as tool 
change, feed rate, pallet change, coolant, and other miscellaneous NC program codes are 
not recognized by the VNCK. These are typically known as "PLC" (Programmable Logic 
Controller) functions, outside the realm of the NC kernel. It is VERICUT's responsibility 
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to emulate these PLC actions. A mechanism is available to register PLC commands with 
the VNCK, so that it can notify VERICUT when one of these commands is encountered. 
However, VERICUT must be configured to register each command and provide a 
simulation action for the event. 

Currently, only VERICUT NC macros configured in the Word Address dialogue may be 
executed. It is not possible to execute a sub-program from within VERICUT when using 
the VNCK control emulation. 

 

NC "ARC" Data: 
In addition to the usual VERICUT configuration requirements, CGTech must also copy 
the NC "ARC" (ARChive) data file from the physical 840D control to the simulation 
computer. This file must then be expanded using Siemens' ARC utility, and configured 
for VNCK simulation. The ARC file is then saved in a proprietary binary format for use 
with the VNCK. 

 

Hardware: 
The VNCK only works on computers running Windows 2000 and Windows XP 
Professional operating systems. 

840D Virtual NC Kernel and Interface requires either a Verification, a Mold & Die 
Machining, or a Cutter Grinder Verification base module license as a pre-requisite. 
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VERICUT System Requirements 
Version 6.1 
Review the latest system requirements on VERICUT 6.1's Requirements webpage. 

NOTE:  Requirements have changed – review carefully. 

 
General Requirements 
1. CD-ROM drive 

2. Two or three button mouse 

3. Network interface card 

NOTE:  The VERICUT license server may not work correctly with more than one 
network card on some UNIX computers. 

4. Graphics device capable of displaying at least 16K colors 

5. Hardware graphics accelerators are optionally used in a machine simulation view. 
Due to the large amount of graphics memory required to display the cut stock, 
graphics memory of 128mb minimum is recommended, and 256mb is preferred.  

 
 
Disk space: 1. 240 Mb for Windows (includes Library, Samples and help 

files and Java Run-Time) 
2. 200 Mb for the first UNIX platform (includes Library, 

Samples and help files) 
3. 20 Mb for each additional UNIX platform type 

Physical Memory: 512 Mb (1 Gb preferred, 2Gb if you want to run 
VERICUT concurrent with another large program) 

UNIX Swap partition 
or Windows page file 
size: 

2X Physical Memory 

Temporary disk 
space: 

1. 120 Mb required during installation, in addition to the disk 
space required for the installed files, as described in "Disk 
Space" above. 

2. By default the installation program temporarily uses disk 
space on: C:\TEMP on Windows or /tmp on UNIX. 

3. The temporary disk space used during installation can 
optionally be redirected by defining the IATEMPDIR 
environment variable prior to running the installation 
program. 
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Windows Requirements  
  
Windows 
  
  

1. Windows 2000 Professional SP2 
2. Windows XP Professional 
3. Java Run Time Environment 1.4.2 (included with 

VERICUT for Windows) 
4. Microsoft recommends Windows be allowed to 

dynamically manage the page file size. 
5. Windows Script 5.3 or later is required for the CATIA V5 

Interface 
Processor  1. Intel Pentium or 100% Pentium-compatible Processor. 

2. 1 ghz or faster recommended. 
3. Dual processors improve performance, especially when 

running other large programs concurrently with VERICUT.
  

   
UNIX Requirements  
  
HP  1. HP-UX 11.0 plus required patches 

2. Java RTE v1.3.1.07 dated October 14, 2002 or later 
(installation files included on the VERICUT CD) 

  
IBM   1. AIX 4.3.3 plus fixes 

2. Java Run-Time 1.3.1 build ca1311-20011123a or later 
(included in the installed VERICUT files and used locally 
by VERICUT) 

  
SGI   1. IRIX 6.5.x plus required patches 

2. Java eoe 1.3.1 20020611 or later (installation files included 
on the VERICUT CD) 
MIPS4 processors (R10000, R12000 series processors). 
Not recommended with R5000 processors. 

Sun/Solaris 1. Solaris 2.6 plus required patches 
2. Java Run-Time 1.3.1_06-b01 or later (installation files 

included on the VERICUT CD) 
  

   
Java Run-Time Environment (JRE) for UNIX Systems  

Java Run-Time Environment (JRE) files required by VERICUT are included on the 
VERICUT CD for all UNIX platforms. 

For IBM RS6000 only, the Java Run-Time files are automatically copied into the 
VERICUT directory tree during VERICUT installation, but are not installed by the 
operating system's installation utility, and will not disturb any existing Java installation. 
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These files are used exclusively by VERICUT. The Java Run-Time version documented 
above in the "UNIX Requirements" section is the version included on the VERICUT CD, 
and is the minimum recommended version. 

For proper behavior of VERICUT the minimum JRE described above must be used. Later 
versions should work, but for practical reasons not all JRE versions can be tested with 
VERICUT on all platforms.  VERICUT has been tested and is shipped with JRE V1.4.2 
on Windows. At the time of release, JRE 1.4.2 was not available for all supported UNIX 
platforms. Earlier versions of JRE 1.4 (for example 1.4.0 and 1.4.1) do not work with 
VERICUT. 

It may be necessary to apply operating system patches for the Java Run-Time version 
supplied. Some sites may want to use their currently installed Java Run-Time or install 
and use another Java Run-Time. Please ensure that the JRE is equal or later that the 
versions described above. 

Following are links to each UNIX vendor's java information and download site. UNIX 
system administrators should check these sites for the latest operating system patch 
information, and ensure that the computer used for VERICUT is at the minimum patch 
level for the Java Run-Time version being used. 

 

HP www.hp.com/products1/unix/java/java2/sdkrte1_3/downloads/index_pa-risc.html.
SGI www.sgi.com/products/evaluation/6.x_java2_1.3/ 
Sun java.sun.com/j2se/1.3/download.html 
IBM http://www-106.ibm.com/developerworks/java/jdk/aix/service.html 
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VERICUT with SpaceBall/SpaceMouse 
 

VERICUT now supports 3Dconnexion 6 axis input devices (SpaceBall and SpaceMouse) 
on Windows. Use of these devices require a driver known as 3DxWare. 

 
These devices have at least 8 buttons, some of which we have designated as follows: 

1. Toggles translations on and off.  
2. Toggles rotations on and off (you can't have both of these off together, so turning 

one off will turn the other on if necessary).  
3. Toggles the dominant axis filter on and off (when on, only one axis moves at 

once).  
4. Fit. 
5. Decreases sensitivity.  
6. Increase sensitivity.  
7. Reverse 
8. Refine 

With the exception of buttons 4, 7 and 8, these functions are a de-facto standard for 
software that supports the devices. PTC uses button 4 as "Fit" in Pro/E. A configuration 
file (VERICUT.scg) is required and is accessed by the 3DxWare driver on startup. This 
file is distributed by 3Dconnexion with the most recent version of their driver. 

While beta testing has shown that VERICUT generally works correctly with various 
older models and older versions of the device drivers, CGTech recommends using the 
latest driver version. It can be downloaded from www.3dconnexion.com. The VERICUT 
configuration file was added to 3DxWare version 2.3 build 5, September 4, 2002. 

  

NOTE: 3Dconnexion motion control devices currently work with VERICUT on 
Windows platforms only. 
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Performance Considerations 
This section describes ways to help increase VERICUT productivity. 

 

System considerations 
Computer speed — VERICUT runs faster on faster computers. When comparing 
computers made by different manufacturers, you can get a general idea how VERICUT 
will perform by comparing the processor speed for floating point computations. 

Multiple processors — VERICUT runs 10-20% faster on computers with dual 
processors over a comparable computer with a single processor. 

Memory — The amount of memory available to VERICUT can make a difference. See 
"VERICUT System Requirements" for memory recommendations. If you intend to 
process large tool paths, complex cutting operations, or use AUTO-DIFF, you may need 
more memory. VERICUT uses virtual memory (hard disk) when physical memory 
(RAM) is exhausted. Best performance is obtained when sufficient physical memory is 
available to VERICUT. Excessive memory does not make VERICUT run faster, 
however, insufficient memory will slow it down. 

Running concurrently with other applications — Even though your system may run 
VERICUT or other large applications (e.g. CAD/CAM packages) comfortably, running 
them concurrently may cause competition for resources: memory, disk space, etc. Under 
these conditions the computer begins "paging" or "swapping" memory (a.k.a. "disk 
thrashing"), which adversely affects performance. Symptoms of disk thrashing are: 
constant hard drive activity or noise, active applications are slow, "Out of memory" error 
messages or warnings appear. In the worst case you can run out of all available memory 
which can cause your computer to crash or hang. When determining the amount of 
memory the system needs to run your applications, be sure to consider the memory 
requirements of ALL applications that will be run concurrently. 

Graphics cards — VERICUT uses 2-D raster (pixmap) graphics. It does not use triangle 
shading (such as with a 3-D API like OpenGL or Direct3D), texture mapping, or much (if 
any) vector drawing. All graphics cards (even the cheapest) do pixmap graphics. The card 
needs enough display or video memory to drive the display resolution at the desired 
number of colors. For example, 8mb of display memory may be enough to do a 1024 x 
768 display at True Color, but may only be able to do 64k colors at 1600 x 1024 
resolution. VERICUT 5.0 or higher performs best in a True Color display environment. 
More expensive does not necessarily mean "better for VERICUT". Lower cost cards 
frequently outperform expensive cards when running VERICUT. 
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Tolerances  
Cutting Tolerance — The "Cutting Tolerance" value (ref. File menu > Properties, 
Tolerance tab) controls the accuracy of cuts applied to the workpiece. This value 
directly affects the speed and quality of the results from comparing or exporting models, 
optimizing tool paths, checking for holder collisions, "Fast Feed" errors, dynamic rotation 
speed, and zoom speed. A larger cutting tolerance value makes VERICUT go faster, but 
the resulting cut model and collision checking will be less accurate. A smaller cutting 
tolerance value may slow the simulation, but provides the high level of accuracy needed 
to perform detailed model analysis or export, optimization, etc. 

• A larger cutting tolerance value is probably okay for quick visual checks, or when 
only X-Caliper will be used to analyze the model (no AUTO-DIFF). 

• Use a smaller cutting tolerance value if you expect to use AUTO-DIFF, Model 
Export, OptiPath, or examine very small model details. 

 
How VERICUT uses Cutting Tolerance to determine model accuracy — The "Base 
Cut Tolerance on" option on the File menu > Properties: Tolerance tab controls how 
VERICUT applies the Cutting Tolerance value to set cut model accuracy. 

• Choose "Stock Size" to achieve consistent performance on similar sized parts, 
regardless of the variety of cutting tools used. However, cuts made by very small 
cutters or cutters with complicated shapes should be evaluated closely to determine if 
sufficient accuracy has been maintained. 

• Choose "Tool Size" to consider sizes of cutting tools in addition to the stock model 
size, or when optimal results must be achieved for all cutting tools. Be aware that 
with this option, very small cutters such as tiny drills, scribe end mills, etc. can 
severely impact overall performance. 

 
Model file tolerances — Model files, such as Stereolithography (STL) or VERICUT 
model files, exported from CAD systems should be created using tolerances appropriate 
for how they will be used in VERICUT. For example, models that will be used as stock 
workpieces, holding fixtures, or NC machine components probably do not need to be as 
accurate as models that will be used by AUTO-DIFF to check for gouges or excess 
material. Outputting CAD models with excessively small tolerance values can result in 
very large model file sizes that cause VERICUT to use large amounts of memory. Similar 
considerations apply to tolerances for converting IGES model files that will be used in 
VERICUT. Assuming you have enough memory, model file size/complexity does not 
affect cutting speed in VERICUT. 

 

Other tips and tricks 
Axes display — Axes displayed in the graphics area (e.g. via View menu > View Axes 
or right-click shortcut menu) slow cutting speed. For best performance clear all axes 
before cutting. 
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Fixture display — Fixtures displayed in the "Workpiece" view slow cutting speed. For 
best performance, set Visibility to Machine View on the Component Attributes tab of the 
Modeling window. (e.g. via Project menu > Setup Models > Define: Component 
Attributes tab or double-click on the fixture component in the Component Tree) 

Skip Cut and Animation Speed control — These features on the Project menu > 
Processing Options > Motion window directly affect cutting speed. Skipping cuts can 
make VERICUT run faster by updating the display less frequently, especially when 
multi-axis cuts, large cutters, or tools with holders are involved. Also, for best 
performance ensure the Animation Speed slider, located at the bottom of the VERICUT 
main window, is positioned as far right as it will go ("Fast"). 

No Animation — This feature on the Project menu > Processing Options  > Motion 
window enables you to reduce processing time. When No Animation is toggled "on", the 
graphics display is not updated until either processing is complete or you Stop the 
processing. At that time the cut model is displayed in it "final" state or the state that it 
was in when processing was stopped. 

Tool holders — Using tool holders enables VERICUT to detect when non-cutting 
portions of the tool assembly remove material or crash into clamps/fixtures holding the 
workpiece. You can minimize this effect by modeling only portions of the tool assembly 
that can be involved in a collision. For example, don't bother modeling the taper of a 
milling tool holder (portion that seats inside the spindle). If you don't have concerns 
about tool holder collisions, VERICUT will run faster if tool holders are not displayed, 
e.g.: Project menu > NC Programs: clear "Use Holders" checkbox. 

Status and NC Program windows — Opening these windows via the Info menu 
provides valuable information about the machining process. However, since VERICUT 
updates them with each tool path record processed, having them open while cutting slows 
performance. For best performance, close them before cutting. You can reopen them 
later, as needed for reference. 

Address unsupported codes in G-code tool paths — When processing G-code tool 
paths, "unsupported" codes cause messages to be written to the VERICUT Log file and 
the VERICUT main window message area. Reporting numerous unsupported codes can 
slow performance dramatically. Avoid writing "false" errors and the corresponding time 
loss by addressing unsupported codes via the NC control configuration. To ignore codes 
that are unimportant to the simulation, use Configuration menu > Word/Address to add 
groups that will have unsupported codes call the macro, IgnoreMacro. 

Faster zooming — Following is a technique to improve the zoom and display speed, and 
eliminate the post zoom delay between pressing Play and resuming cutting. Create a 
second, smaller view window (View menu > Layout > Add View) and position it to the 
side. Cut the part. When you want to see an area in more detail, use the smaller window 
for zooming. This protects the refined display in the larger window. Because VERICUT 
needs only to update the smaller image, you get zoom images much faster than 
performing the operation in the larger window. Also, when you restart the simulation 
there is virtually no delay before VERICUT starts cutting again. 
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Disable Report — This feature on the Analysis menu > AUTO-DIFF window: 
Settings tab enables you to turn off the AUTO-DIFF Report feature to reduce AUTO-
DIFF processing time. For large NC program files, generating the report can take a 
significant amount of time. When toggled "off", you will still see the AUTO-DIFF results 
in the graphics area. 

 

Want more VERICUT tips and tricks from the experts? Visit the CGTech web site at 
www.cgtech.com and click "SUPPORT PAGE", then look for "Tips and Tricks".        
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VERICUT Files 
Summary of VERICUT File Types 

The sections that follow provide information about the files VERICUT uses and typical 
file extensions. 

 

Types of VERICUT files 
Files provided by CGTech to assist with simulating NC program and machine tool 
motions can be divided into two categories: 

Library files — General purpose files for configuring VERICUT to simulate NC 
program and machine motions. Library files are included in every installation, and 
include: 

VERICUT default files — Default files opened by VERICUT. The files are configured 
to perform a short simulation when Play is pressed. Two sets of files provide 
demonstrations for inch (vericut.VCProject) and metric (vericutm.VCProject) 
environments. 

VERICUT initialization files — Initialization files opened by VERICUT via File menu 
> New Project. Two sets of files provide initialization for inch (init.VCProject) and 
metric (initm.VCProject) environments. 

Machine and Control files — NC machines and controls intended to help you configure 
VERICUT for simulating G-Code NC programs that run on popular NC machining 
centers. See "Library Machine files" and "Library Control files" for details. 

For information about these files, see "Library Files". 

Sample files — Files used to demonstrate VERICUT capabilities and options. Sample 
files are included with CGTech software on the CD, and are available to all users who 
choose to load them. For information about these files, see Sample-Demo Files in the 
CGTECH Help Library. 

 

VERICUT File Descriptions 
The types of files used by VERICUT to load and save various types of data are listed 
below in alphabetical order. See the appropriate section for a description of file contents 
and formats, and how to open and save them.
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APT Output File 
Typical file extension: .apt 

 An ASCII text file containing APT NC program records resulting from reverse post-
processing by VERICUT. By default when sequenced G-Code data is converted, columns 
73-80 in the output file indicate the block numbers of the G-Code data block where the 
converted records came from. Sequence number output is controlled via the Output Block 
Sequence Numbers feature on the Project menu > Processing Options > G-Code > 
Process Options: Messages tab. 

An APT Output file is created when a G-Code NC program is processed with Create 
APT Output File feature on the Project menu > Processing Options > G-Code > 
Process Options: G-Code Output Files tab is active. You can view this file using the 
View APT Output File feature on the Project menu > Processing Options > G-Code > 
Process Options: G-Code Output Files tab or the View feature, under APT Output 
File, on the Project menu > Output: G-Code Files tab. 

  

Sample G-Code NC Program file: 
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Sample of resulting APT Output file: 
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APT Table File 
Typical file extension: .tbl 

 An ASCII text file used by the Binary CL Converter that contains information necessary 
to convert binary APT data into ASCII APT NC program records. Such information 
includes: blocking factor, major and minor word classes, sub-classes, etc. 

APT Table files are loaded into VERICUT via the File menu > Convert > Binary CL 
function. APT Table files can also be specified on the command line when the Binary CL 
Converter is executed, such as during batch processing to simulate NC programs without 
user interaction. 

Sample APT Table file "aptwords.tbl" (located in the \vericut\ directory of your 
VERICUT installation):  

 

3838



VERICUT HELP - Getting Started with VERICUT 
 

Tips: 
1. The default blocking factor for interpreting binary CL data is 3228. If this does 

not produce favorable results, use any text editor to change the blocking factor. 
Other typical blocking factors you can try are: 512, 4628, 15476. 

2. If the ASCII NC program file output by the converter has major or minor words 
other than what you expected, try editing the APT Table file to change the 
"Word" output for a specific APT class/subclass. 
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AUTO-DIFF Report File 
Typical file extension: .rpt 

 

 An ASCII text file that contains information about an AUTO-DIFF model comparison 
operation, such as identification of all detected errors, and the NC program history related 
to each error. This information is valuable when determining the correctness of the 
VERICUT simulated cut model, and NC program records responsible for discrepancies 
detected by AUTO-DIFF. 

An AUTO-DIFF Report file is created when an AUTO-DIFF comparison is performed, 
and can be viewed via the "Report" feature. (Ref. Analysis menu > AUTO-DIFF) 

The exact format of the report varies, but generally includes a summary of the results, 
information about tolerances and models used in the comparison, error types 
(gouge/excess) and amounts, NC program history associated with errors, etc. 

Sample AUTO-DIFF Report file: 
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AVI File 
Typical file extension: .avi 

  

Also known as an Audio-Video Interleaved file, this file contains recorded images of 
VERICUT. AVI files are saved (recorded) via the File menu > Images > Record Movie 
function, and replayed via File menu > Images > Playback AVI Movie. 
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Batch Script Files 
Multiple VERICUT batch sessions can be run via a single executable command by 
including VERICUT batch commands in an executable script file. The script file is then 
submitted to the operating system for processing. After each batch execution terminates, 
the operating system then executes the next command in the script file. 

Batch files for different operating systems differ slightly in format. Details will follow 
later in this document. In general, each batch command in the script file appears as it 
would when entered by itself on the command line. Other operating system commands, 
such as those that delete or rename files can also be included in the script file. 

Tip: VERICUT batch files can be easily created using VERICUT's Batch Wizard. 

Windows batch script files 
A batch file to be run on Windows is named with a ".bat" extension, for example 
"batchfile.bat". Windows NT batch execution lines in the script file are "called" via the 
"call" command to return control to the script file after each VERICUT execution. The 
examples that follow show two sample script files. 
 
Windows XP batch script file examples: 

 
Example 1 executes two batch sessions, each processing a part unrelated to the other. 
 

call vericut batch "vcp=part1.VcProject" 
call vericut batch "vcp=part2.VcProject" 

 
Example 2 represents a part machined in two setups: the first is configured to 
automatically save an In-process file named "setup1.ai" via the AutoSave function. 
The second uses the ip=<ipfile> option to load the "setup1.ai" In-process file so 
cutting can be continued with the session configuration saved in the 
"setup2.VcProject" project file. 
 

call vericut batch "vcp=setup1.VcProject" 
call vericut batch "vcp=setup2.VcProject" "ip=setup1.ai" 

 
UNIX batch script files 
A batch script file to be executed in UNIX must have "executable" permissions. Use the 
"chmod" command to give the file executable permissions, for example the following 
command makes a file named "batchfile" executable by all users: chmod 777 batchfile 
The "batchfile" file is executed via typing the file name on the command line, for 
example type: batchfile. The examples that follow show two sample script files.  
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UNIX batch script file examples: 
 
Example 1 executes two batch sessions, each processing a part unrelated to the other. 
 

vericut batch vcp=part1.VcProject 
vericut batch vcp=part2.VcProject 

 
Example 2 represents a part machined in two setups: the first is configured to 
automatically save an In-process file named "setup1.ai" via the AutoSave function. 
The second uses the ip=<ipfile> option to load the "setup1.ai" In-process file so 
cutting can be continued with the session configuration saved in the 
"setup2VcProject" project file. 
 

vericut batch vcp=setup1.VcProject 
vericut batch vcp=setup2.VcProject ip=setup1.ai 
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CGTECH Macro Executable File 
Typical file extension: .cme 

  

A platform-independent binary file also known as a "CME file", that is compiled using 
the Machine Developer's Kit and contains custom macros that control processing G-
Code data. In addition to macros, this file can also establish modals which allow users to 
further customize how machine code data is interpreted, and provide access to custom 
tables containing job and machine related data. The CME file used to perform these tasks 
is specified via the Control file- ref. "Dev Kit CME" under the Configuration menu > 
Adv. Options function. 
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Control File 
Typical file extension: .ctl 

 

An ASCII text file that contains data describing how the NC control processes G-Codes. 
Data in this file includes: a list of interpretable machine codes, machine code format 
information, rules for grouping machine codes, and rules for calling macros. This file is 
required to interpret G-Code data via the G-Code Data NC program type. When the 
Machine Developer's Kit is used to create a custom CME file, the Control file can also 
specify a custom CME file to assist with the simulation. 

By default, VERICUT is configured with a "Fanuc" control. Many control configurations 
are available in the library that is installed with VERICUT software- see "Library 
Control Files" for more information. 

A different Control file can be loaded into VERICUT via the Configuration  menu > 
Control > Open function. NC control configurations are changed via other "Control" 
functions in the Configuration menu. Save the new file via Configuration menu > 
Control > Save As. 
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Control Report File 
Typical file extension: .rpt 

  

An ASCII text file that contains information about how the current NC control 
configuration will interpret various codes. Reported information includes: 

G-Codes present in the NC program and macros (actions) the control will perform, 
variables used (if any), cutting tools used, subroutines defined and referenced, and more. 
Control Report files are created via the Info menu > Control Report function. 

  

Sample Control Report file: 
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CSYS File 
   
An ASCII text file containing information necessary to create a VERICUT Coordinate 
System using the CSYS from File feature in the Coordinate System window. The file 
contains a collection of APT CL matrices, possibly with different syntaxes in a single 
file. The CSYS File is also used by the csys_file command line argument. 
 
  
The CSYS file may contain one or all combinations of: 
  
CATIA syntax: 
   

$$*CATIA0 
$$*AXS1 
$$     1.00000 ... 
 
Use "$$*AXS xx" to name the coordinate system, for example "AXS1" in the above 
snippet. 

  
 
UG syntax: 
  

TOOL PATH/P1 
. 
. 
MSYS/ ... 
 
Use "TOOL PATH/ xx" to name the coordinate system, for example "P1" in the 
above snippet. 

  
PTC syntax: 
  

$$-> FEATNO / 102 
. 
. 
TRANS / ... 
$$-> CSYS / ... 
 
Use "FEATNO / xxx" to name the coordinate system, for example "102" in the above 
snippet. 
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VERICUT-MATRIX syntax: 
 
Modify the syntax to allow an optional name. The code needs to support both with a 
quoted name string and without. 
 

PPRINT/VERICUT-MATRIX "name" 1,0,0 ... 
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Design Points File 
Typical file extension: .pts 

  

An ASCII text file also known as an "inspection point file", that contains point locations 
used to inspect the VERICUT model when performing an AUTO-DIFF Point comparison 
operation. 

Design Point files are loaded into VERICUT via the Project menu > Setup Models > 
Define function. Point record formats support specifying surface normals, tolerances, and 
check distances with any or all inspection points. Example point record formats follow. 

 

Design Points file record formats: 

GOTO/X,Y,Z — where "X,Y,Z" represents the design point location, for example: 
"GOTO/1,2,3". 

 

GOTO/X,Y,Z,I,J,K — as above plus "I,J,K" represents the surface normal vector, for 
example: "GOTO/1,2,3,1,0,0". 

 

GOTO/X,Y,Z,I,J,K,intol,outtol — as above plus "intol"and "outtol" override the 
Gouge Tolerance and Excess Tolerance values, for example: 
"GOTO/1,2,3,1,0,0,.0005,.015". The overrides are only applied to the point where they 
are listed. 

 

GOTO/X,Y,Z,I,J,K,intol,outtol,incheck,outcheck — as above plus "incheck" and 
"outcheck" override the Gouge Check Distance and Excess Check Distance values, for 
example: "GOTO/1,2,3,.1,0,0,.015,.015,.300,.300". The overrides are only applied to the 
point where they are listed. 

 

Any combination of the above formats can be included in the Design Points file. There is 
no limit to number of records that the file can contain. "$$" comment records and spaces 
are permitted. 
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Sample Design Points file: 
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Die Sinking Simulation Report File 
Typical file extension: .htm 

  

An HTML file that contains data describing a particular die sinking process. 
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G-Code Log File 
Typical file extension: .log 

  

An ASCII text file that contains error, warning and informational messages about G-
Code processing. One of the most valuable pieces of information this file provides is a 
copy of each input G-Code data block followed by the converted ASCII APT NC 
program record indented by 4 spaces. This allows you to see a direct translation of G-
Code versus equivalent ASCII APT output for all NC program records processed. 

G-Code Log files are created when a name is entered in the Project menu > Processing 
Options > G-Code > Process Options: G-Code Output File tab, Log File field, and 
are viewed via Project menu > Processing Options > G-Code > Process Options: G-
Code Output Files tab, View G-Code Log File. For help with interpreting error and 
warning messages in this file, consult ERRORS and Problem Solving at 
http://www.cgtech.com/support/errors_problems/errors.htm. 

  

Sample G-Code Log file: 
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G-Code Report File 
Typical file extension: .rpt 

  

An ASCII text file that contains information about how the current NC control 
configuration will interpret a G-Code NC program file. Reported information includes: 
G-Codes present in the NC program and macros (actions) the control will perform, 
variables used (if any), cutting tools used, subroutines defined and referenced, and more. 
G-Code Report files are created via the Info menu > G-Code Report function. 

  

Sample G-Code Report file: 

 

5353



VERICUT HELP - Getting Started with VERICUT 
 

IGES Model File 
Typical file extension: .igs 

  

An IGES (Initial Graphics Exchange Specification) model file, also known as an "IGES 
file", is an ASCII text file which describes virtually anything that can be modeled in a 
CAD system. IGES data is widely accepted as an industry standard for transferring model 
data. While IGES model files containing only 2-D data (lines and arcs) are not useful in 
VERICUT, files containing 3-D surfaces and solids can be used to describe stock, fixture, 
or design models, as well as machine component shapes. 

IGES model files are imported into VERICUT via the Project menu > Setup Models > 
Define function, or can be converted into STL or VERICUT Polygon model files using 
the IGES converter. 
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Image File 
Typical file extension: .img 

  

A platform-independent binary file that contains recorded images of a NC program 
simulation. Image files can contain any combination of snapshot (single still image) and 
animation images (similar to a movie). These files can be recorded and replayed on any 
supported computer platform. 

Two types of VERICUT images can be recorded. Both types can be recorded into the 
same file. Machining status is automatically recorded with either image type. 

Snapshot — single-frame image. These images are also used to mark stop points in an 
animation. 

Animation — multiple images that when replayed, appear like a simulation (like a 
movie). 

Image files are saved (recorded) via the File menu > Images > Record Movie function, 
and replayed via File menu > Images > Playback VERICUT Movie. 

  

NOTE:  Image files are not intended for printing. Use File menu > Print View or File 
menu > Images > View Capture to print VERICUT images. 
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In Process File 
Typical file extension: .ip 

  

A part ASCII text-part binary file also known as an "IP file" that contains the data 
necessary to re-establish a VERICUT session, including the current VERICUT model 
(with cuts), user interface settings, and a copy of the Log file. IP files are also used to 
"backup" the verification session, safeguarding against lost work if the session is 
interrupted by computer or power failure. 

Save an In-process file interactively via File menu > In Process > Save As, or 
automatically via the Auto Save function. Due to differences in math processing on 
various computer types, IP files are usable on computers of the same type on which they 
were saved. 

Load IP files via File menu > In Process > Open to re-establish a VERICUT session or 
provide a VERICUT model for additional machining and analysis. IP files can also be 
specified on the command line when VERICUT is executed, such as during batch 
processing to simulate NC programs without user interaction. 

  

NOTE:  Environment variables can be used to affect VERICUT's use of IP files. For 
more information, see "Environment variables". 
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Inspection Sequence Custom Tolerance File 
Typical file extension: .txt 

  

A custom inspection tolerance file is an ASCII text file that contains default tolerances 
that are automatically used when creating inspection record in an Inspection Sequence 
data table.  
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Inspection Sequence File 
Typical file extension: .VcInspect 

  

An inspection sequence file is an XML (Extensible Markup Language) text file used to 
retain all the information needed to reproduce the Inspection Sequence data table and the 
corresponding inspection markers on the workpiece for a single inspection report. 
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Log File 
Typical file extension: .log 

  

An ASCII text file that contains information about a VERICUT session, such as: names 
of NC programs processed, errors, warnings, simulated machining times, and other 
informational messages. 

When VERICUT is run, it must always be able to open a Log file. When an existing Log 
file of the same name is found VERICUT responds differently, depending on the run 
mode: 

VERICUT run in interactive mode — Log file is automatically reset, unless the 
"append log" command line option is used. 

VERICUT run in batch mode — Log file is automatically reset, unless the "reset log" 
command line option is used. 

For more information on command line options used with VERICUT, see "Command 
line options for VERICUT". 

Using the Info menu > VERICUT Log function, Log file contents can be viewed, 
edited, or the file name changed. For help with interpreting error and warning messages 
in this file, consult ERRORS and Problem Solving at 
http://www.cgtech.com/support/errors_problems/errors.htm. 
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Sample VERICUT Log file: 
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Machine File 
Typical file extension: .mch 

  

An ASCII text file that contains data describing the construction, kinematics, and other 
properties of an NC machine tool. By default, VERICUT is configured with a 3-axis 
vertical mill machine. Many machine configurations are available in the library that is 
installed with VERICUT software- see Library Machine Files in the VERICUT Files 
section for more information. 

A different Machine file can be loaded into VERICUT via the Configuration menu > 
Machine > Open function. NC machine configurations are changed via other "Machine" 
functions in the Configuration menu. Save the new file via Configuration menu > 
Machine > Save As. 
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NC Program File 
Typical file extension: .mcd (G-Code), .tp (APT), many other extensions depending on 
CAM system 

  

NC program, or "NC program" files are ASCII text files that contain data describing 
cutting tool positions, machine information, and other information required to operate NC 
machine tools. 

NC program files to be simulated or optimized are referenced in VERICUT via the 
Project menu > NC Programs function. VERICUT does not actually keep a copy of the 
NC program files, but instead stores NC program file names and keep tracks of which 
record in the file is being processed. 

NC programs files can be divided into two general types: APT-CLS NC and G-Code. A 
general discussion of each type follows. 
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APT-CLS NC program files 
APT and CLS NC program files are generic file formats output by CAM systems that are 
intended to be easily read by the NC programmer. They are intermediate file formats that 
typically are not used directly by the NC machine. Before the data can be used by an NC 
machine these files must be post-processed to a G-Code NC program file format 
containing codes specific to that machine tool (see "G-Code NC program files" below). 

VERICUT processes "Simple ASCII APT" NC programs-meaning all macros, motion 
commands, and motion copy routines are pre-processed into an ASCII centerline file 
containing GOTO, CIRCLE, CYCLE, and miscellaneous machine commands. No 
geometry definitions, symbolic substitutions, macros, or complex motions (such as 
GORGT, GOLFT, etc.) are present. 

Common APT-CLS NC program variations that VERICUT can process are listed below. 

ACL 
CADRA CL data 
CATIA workstation APT 
CV APT 
ProManufacturing APT 
UG CLS 

To process one of the APT-CLS NC program variations listed above, be sure to specify 
the appropriate NC Program Type under Project menu > NC programs. 
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G-Code NC program files 
G-Code NC program files are formatted for use directly by the NC machine. These files 
typically originated as APT-CLS NC program files (see "APT-CLS NC program files" 
above), and have been post-processed to contain specific codes for a given machine tool. 

To process G-Code NC program file, be sure to specify NC program Type=G-Code Data 
under Project menu > NC programs. While VERICUT easily processes G-Code data 
that conforms to the EIA Standard RS-274 format, other variations can also be simulated 
with a little configuration effort. Configuration menu functions provide most of the 
configurability needed to support various NC machine and control combinations. 
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Operations File 
Typical file extension: .VcTmp 

  

Introduction 
An Operations File, or Ops File, can be used to assemble a project with multiple setups 
from several VERICUT project files, which typically have the extension ".VcProject". 
This assembly process can only be triggered from the command line that invokes 
VERICUT. The necessary command line syntax is;  

  

For Windows ... "ops=D:\My\Path\MyOperationsFile.VcTmp"   ... 

For UNIX ... "ops=/My/Path/MyOperationsFile.VcTmp"   ...   

  

Any extension can be used in the file name, but by convention ".VcTmp" denotes a 
temporary file.  

 An Operations File is a man-readable text file. Each line of the file is independent and 
references a VERICUT project file. A line requests that information from its project file 
should be transferred to the project being assembled. A line can request that the entire 
project and all its setups be transferred, or that information from one setup be transferred, 
or that all the setup-independent information, which we will refer to as project 
information, be transferred. It is suggested that the first line of the file should always 
request at least the project information from a ".VcProject" file that was saved by 
VERICUT, so that the new project will have a good foundation.  

  

Syntax 
In the following explanation the Windows path delimiter, "\", is used. For a UNIX 
platform you should substitute the "/" character. Names should be enclosed in double 
quotation characters ("). Fields are separated by one or more spaces.  

 To request that the entire project, with all its setups, be transferred to the new project 
being assembled, the syntax of the required line is;  

 

ALL   FILE="My\Path\MyProjectTemplate.VcProject" 
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To request that the project information from a file be transferred to the new project being 
assembled, the syntax of the required line is;  

  

PROJECT   FILE="My\Path\MyProjectTemplate.VcProject"  
  

Setup independent information in a project file pertains to the following VERICUT menu 
items;  

  

Model Export  
Colors  
Image Recording and Playback  
View Capture  
AutoSave  
View Select/Store  
Status  
Graphs  
Cycle Definitions  
AUTO-DIFF  

  

To request that setup information from a file be transferred to the new project, the syntax 
of the required line is;  

  
SETUP   NAME="Setup A"   INDEX=1   FILE="My\Path\MySetupTemplate.VcProject"  

  

The NAME field specifies the name that the setup will have in the new project. The 
INDEX field selects which of the setups in the referenced file will be transferred. An 
index value of "1" selects the first setup in the file, "2" would use the second setup, 
etcetera. The FILE field references the VERICUT project file that contains the required 
setup.  

 Note that more than one SETUP line in the Operations File can have the same NAME 
field. The first such line would cause a new setup to be appended to the project being 
assembled, and subsequent lines could adjust the parameters of that same setup. Setup 
specific information in a project file pertains to the following VERICUT menu items;  

  

Properties  
Views  
Sections  
Components and Models  
NC Programs and Filters  
Tools and Tool Changes  
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APT and G-Code Settings  
Coordinate Systems  
Control  
Machine  
Inspection  
Die Sinking  
OptiPath  

  

Project Naming 
The name and location of the assembled project file will be derived from the name and 
location of the Operations File. The extension ".VcProject" will replace any extension 
that the Operations File's name has, and the assembled project will be placed in the same 
folder. This assumes that the user saves the project before explicitly renaming it and 
before exiting VERICUT. To remind the user that he needs to save the project before 
exiting, you can include another keyword on the command line. Thus you may have;  

  

...   "ops=D:\My\Path\MyOperationsFile.VcTmp"   usr_changed   ...  
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Optimized File 
Typical file extension: .opti, .mco (G-Code NC program file) or .tpo (APT NC program 
file) 

  

The Optimized NC program file is created from optimizing NC program feed rates via 
OptiPath. 

For details about using OptiPath and sample optimized NC program files, see the 
OptiPath menu functions. 
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OptiPath Library File 
Typical file extension: .olb 

  

An ASCII text file that contains optimization data for use by VERICUT's OptiPath feed 
rate optimization module. Specific optimization data values are defined per tool intended 
to be used in specific machining conditions, e.g. workpiece material, NC machine, etc. 

  

NC program optimization can performed in a variety of ways, including: configuring 
cutting tools-to-optimization library records, storing optimization information with tools 
in a VERICUT Tool Library, or interactive prompting. 
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Post-Processor File 
Typical file extension: .VcPost 

  

A Post-Processor file is an ASCII text file, created using the CGTech Post Processor, that 
contains all the information required to read machine independent NC Program data and 
convert it to G-Code files for a specific machine/control combination. 
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Preferences File 
Typical file extension: .prefs 

  

Also known as a "Prefs file", this ASCII text file is automatically saved when you exit 
VERICUT and stores such user preferences as: 

 

• VERICUT user interface Look & Feel 
• size and locations of VERICUT windows 
• state of menu toggles in any window that has them, for example: View menu > 

Toolbar, View Axes, etc. 
• filters for VERICUT file selection windows 
• recent User/Project files opened in VERICUT 

 

The Preferences file is unique for each VERICUT version and each user, based on your 
login. The file is named "cgtech_user.prefs" for VERICUT 5.0, and follows the naming 
convention "cgtech_<ver#>_user.prefs" for subsequent versions. For example, a Prefs file 
for VERICUT 5.1 has the name "cgtech_51_user.prefs". The Prefs file is automatically 
stored in your home directory and are updated each time you exit VERICUT. When you 
run a new VERICUT version for the first time (no Prefs file exists for that version), it 
will attempt to use the Prefs file from the previous version. 

When users share a machine (or an account), CGTech recommends that each user set a 
unique CGTECH_USERNAME environment variable to prevent overwriting the 
Preferences file. See "Environment Variables" for more information. 

 

To reset Preferences file settings: 
Windows — Choose Reset VERICUT Preferences file from the CGTech programs 
group. 

UNIX — Delete the "cgtech_user.prefs" from your home directory, or run the 
"delprefs" command file located in the ...<computertype>/commands directory of 
your VERICUT installation. 
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Sample Preferences file "cgtech_user.prefs": 
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Project File 
Typical file extension: .VcProject 

  

A VERICUT Project file is an XML (Extensible Markup Language) text file containing 
VERICUT session settings, also known as "user configuration values" or "user values", 
including: measurement units, colors, choices, data field values, directory paths and file 
names, etc. These files are relatively small in size, yet can control the entire cutting 
process and minimize the effort required to configure the system for processing NC 
program files. 

 Project files are saved via the File menu > Save Project function, and loaded via File 
menu > Open. User files can also be specified on the command line when VERICUT is 
executed, such as during batch processing to simulate NC programs without user 
interaction. 
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Report Template File 
Typical file extension: .VcTemplate 

  

A Report Template file is an XML (Extensible Markup Language) text file containing all 
of the formatting information required to generate VERICUT reports. 

7474



VERICUT HELP - Getting Started with VERICUT 
 

Status File 
Typical file extension: .txt 

  

An ASCII text file that contains whatever data is sent to the Status window during the 
simulation (ref. Info menu > Status). A Status file is created when the 
CGTECH_STATUS environment variable is set to a file name before VERICUT is 
executed. The file is overwritten when the VERICUT model is reset. 

For each NC program record processed, the following status data is written: 

REC — Indicates a NC program record processed. 

REC fields — NC program Record Line Number, NC program Record 

DATA — Specifies most of the status values separated by commas. Fields not 
displayed in the Status window are represented by commas. 

DATA fields — Mch Axis Loc- X, Y, Z, A, B, C, U, V, W, Tool Tip Loc- X, Y, Z, I, 
J, K, Errors, Warnings, Time, Time%, Dist, - Dist%, Coolant, Feedrate, OP Feedrate, 
Spindle, OP Spindle 

TOOLCHANGEREC — The record which caused the last tool change (present only 
if the Status window is configured to show this field). 

TOOLDESC — The current tool description (present only if the Status window is 
configured to show this field). 

TOOLGEOMETRY — The current tool geometry (present only if the Status 
window is configured to show this field). 

  

APT example: 

REC,12,GOTO/3,2,1 
DATA,,,,,,,,,,,,,,,,3,,,,0,0,0.5355,,,,ON ,10 IPM,,500,CLW , 
TOOLCHANGEREC,CUTTER/1.125,.25,0,0,0,0,2.1 

  

G-Code example: 
REC,20,N0130G0X-.2Y-.3Z2.S1200M3 
DATA,,,,,,,,,,,,,,,,19,,,4,0,0,1.6979,,,,OFF,2 IPM,,1200, 
TOOLCHANGEREC,N0120T4M6 
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Stereolithography (STL) Model File 
Typical file extension: .stl 

  

A Stereolithography model file, also known as an "STL" or "SLA" file, is an ASCII text 
or binary file which describes virtually any surfaced or solid model shape. The STL data 
representing the model shape is composed of three-sided facets with associated surface 
normals. STL files typically originate from a CAD system and represent an enclosed 
model used by an SLA machine, such as developed by 3D Systems. 

Load Stereolithography model files into VERICUT via the Project menu > Setup 
Models > Define function. For an STL file to be used in VERICUT as a solid model, the 
STL data must represent a fully enclosed (watertight) model and have normals that point 
consistently outward. (STL files used as surface models do not have to be watertight.) If 
normals are inconsistent, gaps exist between facets, or facets overlap, solid model display 
results are unpredictable. When cutting is started or the model is analyzed, these 
symptoms indicate problems exist in the model file data: 

• model is not displayed at all 

• model is displayed with holes, gaps, or seams 

• portions of the model are missing 

  

Tip:  If any of the above symptoms are experienced, use the PolyFix Converter and/or 
the Stock Consistency Check feature (ref. File menu > Properties: General tab) to 
repair the model before cutting. Similar advice applies for models added to Design 
components for use with AUTO-DIFF, except the Design Consistency Check feature is 
used (ref. Analysis menu > AUTO-DIFF: Options tab). 
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Sample STL file: 
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Tool Library File 
Typical file extension: .tls 

  

An ASCII text file that contains descriptions of cutting tools, shanks and holders, as well 
as other tool data used by VERICUT. Specific tool data is stored and retrieved via a tool 
"ID". 

This file is created and maintained via the Project menu > Tools function. The Tool 
Library file used by VERICUT when the Project menu > NC programs function is 
configured to do so. 

 NOTE:  If errors occur when attempting to load the file, consult ERRORS and 
Problem Solving at http://www.cgtech.com/support/errors_problems/errors.htm, for 
assistance. 

  

Sample VERICUT Tool Library file: 
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Tool Manager Report File 
Typical file extensions: .htm (HTML version), .txt (test version) 

  

An HTML or text file that contains information about tools in a VERICUT Tool Library 
file, such as: the Tool Library name, listing of tools, tool images (HTML version only), 
and optimization properties, if defined. Tool Manager Report files are created and viewed 
from the Tool Manager window via clicking File menu > Create Report features. 

  

Sample HTML version Tool Manager Report file: 
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Sample text version Tool Manager Report file: 
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User File 
Typical file extension: .usr 

  

An ASCII text file that contains VERICUT session settings, also known as "user 
configuration values" or "user values", including: measurement units, colors, choices, 
data field values, directory paths and file names, etc. These files are relatively small in 
size, yet can control the entire cutting process and minimize the effort required to 
configure the system for processing a NC program file. 

User files are loaded via File menu > Open. User files can also be specified on the 
command line when VERICUT is executed, such as during batch processing to simulate 
NC programs without user interaction. 

  

Sample User file: 

 
  

Within the User file, the left column contains descriptive information about user 
variables, the center column lists the user variable names, and the right column lists saved 
values for corresponding user variables. 
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Use the user variable names listed in the center column when referencing via command 
line options. For more information, see "Command Line Options". 

 

NOTE:  Environment variables can be used to affect VERICUT's use of User files. For 
more information, see "Environment Variables". 
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VERICUT Linear Sweep File 
Typical file extension: .swp 

  

A VERICUT Linear-sweep file, or "Linear-sweep file" for short, is an ASCII text file that 
describes an extruded shape. A 2-D profile is defined in the XY plane, then swept 
(extruded) along the model's Z axis. 

Linear-sweep files are loaded into VERICUT via the Project menu > Setup Models > 
Define function, and contain the following data: 

File type record — Specifies the type of VERICUT file, for example "VERICUT-
model". 

Version number record — Software version in which the file is to be used, for 
example "version-3.0". 

Model file identifier record — Model file type: "2" identifies a Linear-sweep file. 

Sweep start value — Z value of the linear sweep start. 

Sweep end value — Z value of the linear sweep end. 

Polyline data — The remaining records in the file are the XY point pairs which 
define the polyline to extrude. Each X and Y value must be on a separate line with a 
space between values. There is no limit on the number of point pairs allowed, but 
there must be at least 3 pairs. The polyline can be completely enclosed or open ended, 
but can not cross over itself. Open ended polylines are automatically closed to the 
start point. 
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Sample Linear-sweep files: 
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VERICUT Polygon File 
Typical file extensions: design- .dsn, fixture- .fix, stock- .stk, any- .ply 

  

A VERICUT Polygon file, or "Polygon file" for short, is an ASCII text file that describes 
virtually any shape open surface or enclosed shape. The polygon (faceted) data is 
composed of three or four sided polygons with associated surface normals that represent 
the true geometric model shape. 

Load Polygon model files into VERICUT via the Project menu > Setup Models > 
Define function. For a Polygon file to be used in VERICUT as a solid model, the polygon 
data must represent a fully enclosed (watertight) model and have normals that point 
consistently outward. (Polygon model files used as surface models do not have to be 
watertight.) If normals are inconsistent, gaps exist between facets, or facets overlap, solid 
model display results are unpredictable. When cutting is started or the model is analyzed, 
these symptoms indicate problems exist in the model file data: 

 
• model is not displayed at all 
• model is displayed with holes, gaps, or seams 
• portions of the model are missing 

 

 Tip:  If any of the above symptoms are experienced, use the PolyFix Converter and/or 
the Stock Consistency Check feature (ref. File menu > Properties, General tab) to 
repair the model before cutting. Similar advice applies for models added to Design 
components for use with AUTO-DIFF, except the Design Consistency Check feature is 
used (ref. Analysis menu > AUTO-DIFF, Options tab). 

  

Polygon file format: 

File type record — Specifies the type of VERICUT file, for example "VERICUT-
model". 

Version number record — Software version in which the file is to be used, for example 
"version-3.0". 

Model file identifier record — Model file type: "1" specifies a Polygon file. 

Sweep start value — Z value of the linear sweep start. 

Sweep end value — Z value of the linear sweep end. 
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Polygon format record — Describes the surface normal data and vertex data formats. 
This record contains three integer numbers separated by blanks: n1 n2 n3 (e.g. "0 0 1") 
where: 

n1 (normal vector type) — Specifies the type of surface normal vector information 
present in the polygon file. 

 
0 - each polygon has one normal vector 
1 - each vertex has a normal vector 
 

n2 (normal vector direction) — Specifies the surface normal vector direction 
relative to the model surface. 
 

0 - normal vectors point inward 
1 - normal vectors point outward 
2 - normal vector directions are inconsistent (should ONLY be used after both the 

"0" and "1" values have been attempted with unfavorable results; requires 
significantly more processing time and computer resources) 

 
n3 (Polygon format type) — Specifies the polygon data format. 
 

0 - binary data format (recommended- requires less storage space and is processed 
faster, however, binary formatted files are computer-specific) 

1 - ASCII data format 
 

Polygon data — The remaining records in the file are the polygon data records which 
define the model shape. Each model facet (or polygon) is represented by a series of 
records describing its number and location of vertices, as well as surface normal vector 
direction(s). There is no limit on the amount of data allowed. 

Two polygon data formats are supported. The polygon data type must be consistent for 
the entire file. 

Format 1 - 1 normal per polygon: 

vertex count (3 or 4) 
X Y Z (vertex 1) 
X Y Z (vertex 2) 
X Y Z (vertex 3) 
I J K (normal) 
 

Format 2 - 1 normal per vertex: 

vertex count (3 or 4) 
X Y Z (vertex 1) 
X Y Z (vertex 2) 
X Y Z (vertex 3) 
I J K (normal 1) 
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I J K (normal 2) 
I J K (normal 3) 

  

Sample Polygon file: 
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VERICUT Solid File 
Typical file extension: .vct 

  

A VERICUT Solid file is a binary file containing data representing a cut stock model. 
The VERICUT Solid enables you to use a previously created cut stock model in a new 
VERICUT session as a stock, fixture or design model. You can also use a VERICUT 
Solid as a design model for Constant Gouge Check. 

A cut stock model can be saved as a VERICUT Solid using either File menu > Save Cut 
Stock > VERICUT Solid in the VERICUT Menu Bar, or using the File > Save Cut 
Stock option in the Configuration menu  > Component Tree window.  (See How) 

A cut stock model can be saved as a VERICUT Solid file "with features" or "without 
features". When the cut stock model is saved "with features", the cut database and the full 
history database are stored in the VERICUT Solid file in addition to the geometry data. 
When the cut stock model is saved "without features", only the geometry data is saved in 
the VERICUT Solid file. Toggle the Save with Features option, on the Save Cut Stock 
window, On (the default) or Off. 

VERICUT Solid files are loaded into VERICUT using the Project menu  > Setup 
Models > Define function. (See How) 

When a VERICUT Solid file, saved with features, is loaded into a new VERICUT 
session: 

Before cutting: 
Modeling window > Position tab >Assemble tab features, Mate and Align, recognize 
the original features saved in the VERICUT Solid. 

X-Caliper treats the VERICUT Solid in an approximated (triangulated) way, the same 
as any other primitive (Swept Solid, Solid of Revolution (SOR), etc.). 

 

When cutting begins: 
If the VERICUT Solid model was saved "with features", then the history database is 
used to create the new cut stock from VERICUT Solid model with the new settings. 
This is usually is much faster and more accurate than using a VERICUT Solid saved 
"without features", and restores all features of the original cut stock saved into the 
VERICUT Solid file. 

 

X-Caliper: 

Once the new cut stock is created, all X-Caliper measurements on a VERICUT Solid 
model, saved "with features", are exact. 
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NOTES: 
1. VERICUT Solid models are not recognized in FastMill Cut Mode or when using 

AUTO-DIFF Surface. 

2. AUTO-DIFF and Die Sinking models are always saved without features (features 
are destroyed by the tolerance offsets). 
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VERICUT Solid-of-Revolution File 
Typical file extension: .sor 

  

A VERICUT Solid-of-revolution file, or "Solid-of-revolution file" for short, is an ASCII 
text file that describes a revolved shape. A 2-D profile is defined in the ZX plane, then 
revolved around the model's Z axis. 

Solid-of-revolution files are loaded into VERICUT via the Project menu > Setup 
Models > Define function, and contain the following data: 

File type record — Specifies the type of VERICUT file, for example "VERICUT-
model". 

Version number record — Software version in which the file is to be used, for 
example "version-5.0". 

Model file identifier record — Model file type: "0" identifies a Solid-of-revolution 
file. 

Tolerance of revolution — Chordal tolerance (intol) of the revolved surface, 
controls the S.O.R.'s degree of roundness for the model database. 

Polyline data — The remaining records in the file are the XZ point pairs which 
define the polyline to revolve. Each X and Z value must be on a separate line with a 
space between values. There is no limit on the number of point pairs allowed, but 
there must be at least 3 pairs. X values must be greater than or equal to zero. The 
polyline can be completely enclosed or open ended, but can not cross over itself. 
Open ended polylines are automatically closed to the start point. 
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Sample Solid-of-revolution files:  
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Library Files 

Library File Overview 
This section provides information about the library files installed with VERICUT 
("library" directory in your VERICUT installation). Library files are included in every 
installation, and include: 
 
General Purpose Library Files 
The following types of General Purpose Library Files are included: 

VERICUT default files — Default files opened by VERICUT. The files are 
configured to perform a short simulation when Play is pressed. Two sets of files 
provide demonstrations for inch (vericut.*) and metric (vericutm.*) environments. 

VERICUT initialization files — Initialization files opened by VERICUT via File 
menu > New Project. Two sets of files provide initialization for inch (init.*) and 
metric (initm.*) environments. 

 

Library Control Files 
Library Control Files are example NC machine controls intended to help you configure 
VERICUT for simulating G-Code NC Programs that run on popular NC machining 
centers.  

 

Library Machine Files 
Library Machine Files are example NC machines intended to help you configure 
VERICUT for simulating G-Code NC Programs that run on popular NC machining 
centers. 
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General Purpose Library Files  
 
The general purpose library files are listed below in alphabetical order. 
 
Library file name: Usage: Notes: 
init.VcProject (in), 
initm.VcProject (mm) 

Initialization files for 
VERICUT- clears settings 
from the prior simulation, 
then configures VERICUT 
with default settings for inch 
(init.*) or metric (initm.*) 
environments. 

Automatically loaded by 
VERICUT via selecting File 
menu > New Project > Inch 
(Millimeter ). 

vericut.VcProject (in), 
vericutm.VcProject (mm) 

Default files- files 
configured to perform a 
short simulation of a three 
setup project, using three 
different machines, when 
Play is pressed. 

Demonstrates how 
VERICUT identifies many 
common NC tool path 
problems. 
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Library Control Files 
This section describes Control files available in the CGTech library ("library" directory in 
your VERICUT installation). These files enable you to quickly configure VERICUT to 
simulate how features of various NC controls affect the machining process. A Control file 
is loaded into VERICUT via the Configuration menu > Control > Open function, or by 
opening a Project file configured to use the control. 

Available NC controls are listed below in alphabetical order, by control manufacturer and 
model. See also the accompanying notes file for details (same base file name with .txt 
extension-located in the "library" directory).  

NOTE:   Customized machines and controls can be found in the "samples" directory in 
your VERICUT installation. See "Sample-Demo Files" in the CGTech Help Library for 
more information. 

 

Control 
Manufacturer Control Model Control File Name 

Acramatic (by 
Cincinnati) 

    

  850MC acr850mc.ctl 

  950MC acr950mc.ctl 

  2100 acr2100.ctl 

  CNC PC acrcncpc.ctl 

Allen-Bradley     

  7320 ab_7320.ctl 

  8200 ab_8200.ctl 

  8600 ab_8600.ctl 

  9260 ab_9260m.ctl 

Bosch     

  CC300 bshcc300.ctl 

Boston Digital     

  BDC 3200 (inch) bdc3200_in.ctl 
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  BDC 3200 (mm) bdc3200_mm.ctl 

Charmilles     

  200 Wire EDM chr200.ctl 

Cincinnati - see 
"Acramatic" 

 

    

Fadal     

  
CNC 88, Format 1 
("Fadal" mode) 

fad88a.ctl 

  
CNC 88, Format 2 
("Fanuc" mode) 

fad88.ctl 

Fanuc     

  
Series 0 fan0m.ctl (mill) 

fan0t.ctl (turn) 

  
Series 3 fan3t.ctl (turn) 

fan3tt.ctl 

  Series 5 fan5m.ctl (mill) 

  
Series 6 fan6m.ctl (mill) 

fan6t.ctl (turn) 

  Series 9 fan9t.ctl (turn) 

  
Series 10 fan10m.ctl (mill) 

fan10t.ctl (turn) 

  
Series 11 fan11m.ctl (mill) 

fan11t.ctl (turn) 

  
Series 12 fan12m.ctl (mill) 

fan12t.ctl (turn) 
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Series 15 
fan15im.ctl (model "I" mill) 
fan15it.ctl (model "I" turn) 
fan15m.ctl (mill) 
fan_15m_custom_optimizable.ctl 
fan15t.ctl, (turn) 
fan15t_t.ctl (turn-turret) 
fan15t_t_ws.ctl 

  

Series 16 
fan16im.ctl (model "I" mill) 
fan16it.ctl (model "I" turn) 
fan16m.ctl (mill) 
fan16t.ctl, (turn) 
fan16w.ctl (wireEDM) 

  

Series 18 
fan18im.ctl (model "I" mill) 
fan18it.ctl (model "I" turn) 
fan18m.ctl (mill) 
fan18t.ctl (turn) 

  

Series 21 
fan21im.ctl (model "I" mill) 
fan21it.ctl (model "I" turn) 
fan21m.ctl (mill) 
fan21t.ctl (turn) 

  Series 30 fan30im.ctl (model "I" mill) 

  Series 31 fan31im.ctl (model "I" mill) 

  Series 32 fan32im.ctl (model "I" mill) 

  

Series 150 
fan150im.ctl (model "I" mill) 
fan150it.ctl (model "I" turn) 
fan150m.ctl (mill) 
fan150t.ctl (turn) 
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Series 160 
fan160im.ctl (model "I" mill) 
fan160it.ctl (model "I" turn) 
fan160m.ctl (mill) 
fan160t.ctl (turn) 

  

Series 180 
fan180im.ctl (model "I" mill) 
fan180it.ctl (model "I" turn) 
fan180m.ctl (mill 
fan180t.ctl (turn) 

  

Series 210 
fan210im.ctl (model "I" mill) 
fan210it.ctl (model "I" turn) 
fan210m.ctl (mill) 
fan210t.ctl (turn) 

  Series 300 fan300im.ctl (model "I" mill) 

  Series 310 fan310im.ctl (model "I" mill) 

  Series 320 fan320im.ctl (model "I" mill) 

  Series 3000 fan3000c.ctl 

Fidia     

  M30 fidm30.ctl 

GEMINI 
(by Kearney & 
Trecker) 

    

  GEMINI-C kt_c.ctl 

  GEMINI-D gemini_d.ctl 

  GEMINI-E gemini_e.ctl 

General Electric 
(GE) 

    

  1050MC CNC ge_1050mc.ctl 

  2000MC CNC ge_2000mc.ctl 

Generic (Fanuc-like) 
controls 

+   
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decimal generic.ctl (in) 

genericm.ctl (mm) 

  
leading zeros genlead.ctl (in) 

genleadm.ctl (mm) 

  
trailing zeros gentrail.ctl (in) 

gentrailm.ctl (mm) 

Giddings & Lewis 
(G&L) 
      see 
"NumeriPath" 

    

HAAS     

  CNC hascnc.ctl 

  MiniMill haas_minimill.ctl 

Heidenhain     

  Mill Plus heimplus.ctl 

  
TNC 407 hei407.ctl (conversational) 

hei407g.ctl (ISO) 

  
TNC 415b hei415b.ctl (conversational) 

hei415bg.ctl (ISO) 

  
TNC 415c hei415c.ctl (conversational) 

hei415cg.ctl (ISO) 

  
TNC 425 hei425.ctl (conversational) 

hei425g.ctl (ISO) 

  
TNC 426 hei426.ctl (conversational) 

hei426g.ctl (ISO) 

  
TNC 430 hei430.ctl (conversational) 

hei430g.ctl (ISO) 

  TNC530 hei530.ctl 
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Kearney & Trecker - 
see "GEMINI" 

    

Lumonics     

  Laserdyne System 
94 

laserdyne_94.ctl 

Maho - see 
"Phillips" 

    

Makino     

  Professional Series 
3 

makpro3.ctl 

  Professional Series 
5 

makpro5.ctl 

Mazak     

  

Mazatrol Fusion 
640 

maz640m.ctl (mill) 
maz640mpro.ctl (mill) 
maz640t.ctl (turn) 
maz640t_t.ctl 
maz640mpro_mazak_e650h_2000u.ctl 
maz640m_mazak_nexus410a.ctl 
maz640m_variaxis.ctl 
mazak_e650h_2000u_640mpro.ctl 
mazak_nexus410a_maz640m.ctl 

  Mazatrol M-2 mazm2.ctl 

  Mazatrol M-3 mazm3.ctl 

   Mazatrol M-32 mazm32.ctl 

  Mazatrol T-2 mazt2.ctl 

  Mazatrol T-3 mazt3.ctl 

  Mazatrol T-32 mazt32.ctl 

Mori Seiki     

    mori_seiki_mt2000sz_fan16it.ctl 

NUM     

  1020T num1020t.ctl 
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  1040T num1040t.ctl 

  1060M num1060m.ctl 

  1060T num1060t.ctl 

NumeriPath (by 
G&L) 

    

  800M nph800m.ctl 

  8000L nph8000l.ctl 

  8000M nph8000m.ctl 

Okuma - see "OSP"     

Olivetti     

  MC8600 oli8600.ctl 

OSAI     

    osai_10.ctl 

OSP (by Okuma)     

  OSP700L osp700l.ctl 

  OSP5000L osp5000l.ctl 

  OSP5000M osp5000m.ctl 

  
OSP7000L osp7000l.ctl 

osp7000l_t.ctl (turret) 

  OSP7000M osp7000m.ctl 

PaR Systems     

  Cimroc 5000 cimroc_5000.ctl 

Phillips     

  CNC 432 phi432.ctl 

  CNC 532 phi532.ctl 
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Sinumerik (by 
Siemens) 

    

  3T, 3TT sin3t.ctl, sin3tt.ctl 

  810 sin810d.ctl (810D) 

  
840 sin840c.ctl (840C) 

sin840d.ctl (840D) 

  880M sin880m.ctl (880M) 

  FM-NC sinfmnc.ctl 

Sundstrand     

  MicroSWINC LM swilm.ctl 

  MicroSWINC 
M200 

swim200.ctl 

Thermwood     

  91000 Super 
Control 

thermwood_91000.ctl 

Tosnuc (by Toshiba)     

  888 tos888.ctl 

Yasnac     

  i80m yasi80m.ctl 

  MX-3 yasmx3.ctl 
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Library Machine Files 
This section describes Machine files available in the CGTech library ("library" directory 
in your VERICUT installation) and CGTech sample files ("samples" directory). These 
files enable you to quickly configure VERICUT to simulate motions on various NC 
machines. Note that while library machines are generally considered ready to use, many 
of the sample machines have job-related data that may interfere when configuring for use 
with new NC tool paths. A Machine file is loaded into VERICUT via the Configuration 
menu > Machine > Open function, or by opening a Project/User file configured to use 
the machine. 

Available NC machines are listed below in alphabetical order, by manufacturer and 
model. All machines reside in the "library" directory of your VERICUT installation 
unless otherwise noted to be in "samples" or "showroom". See also the accompanying 
notes file for details (same base file name with .txt extension-located in the "library" 
directory). See "Sample-Demo Files" in the CGTech Help Library for more information. 

 

Machine 
Manufacturer 

Machine 
Model 

Thumbnail 
(click to see larger 

image): 

Machine File Name 

Aerostar      

  

H2200  
5ax horiz. 
mill 

aerh2200.mch 

Bohle      

  

BW120S  
5ax horiz. 
mill 

bohbw120.mch 

Bostomatic      

  

405  
5ax vert. 
mill 

bos405.mch 
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5ax vert. 
mill 

samples - bos5vm01.mch 

Charmilles      

  

Robofil 
200 4ax 
wire 
EDM 

chr200.mch 

Cincinnati      

  

3-spindle 
5ax 
gantry 
mill 

samples - cinci_3spindle_5ax.mch 

  

5ax dual-
tilting 
head vert. 
mill 

samples- cin5vm01.mch 

  

T30  
5ax horiz. 
mill 

cint30m.mch (mm), 
cint30_2.mch, 
cint30_3.mch (tool change arm) 

Deckel Maho 
- see "Maho" 

  
 

  

Dixi      

  

100  
4ax horiz. 
mill 

dix100m4.mch 
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100  
5ax horiz. 
mill 

dix100m5.mch 

  

150  
4ax horiz. 
mill 

dix150m4.mch 

  

150  
5ax horiz. 
mill 

dix150m5.mch 

  

350 
TCA50S 
5ax horiz. 
mill 

dix350m.mch 

  

DPH-80 
4ax horiz. 
mill 

 

dixi_dph80.mch 

Droop and 
Rein 

  
 

  

  

DR969 
vert. 3 
spindle 
mill 

dr_dr969.mch 

Fadal      

  

VMC 15 
3ax vert. 
mill 

fadvmc15.mch 
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VMC 
4020 4ax 
vert. mill 

fad4020.mch 

  

VMC 
6030 3ax 
vert. mill 

fad6030.mch 

Fidia      

  

218  
5ax vert. 
mill 

fid218.mch (in), 
fid218m.mch (mm) 

Forest      

  

Flexiax 
510 5ax 
horiz. 
mill 

forfx510.mch 

Generic 
machines 

  
 

  

  

2ax horiz. 
lathe 

generic_2ax_turn.mch 

  

2ax horiz. 
turret 
lathe 

samples-  
2hl02.mch (shown), 
2hl03.mch 

  

3ax vert. 
mill 

g3vm.mch 
generic_vmill_3ax.mch 
generic_vmill_3ax_3d.mch 
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4ax vert. 
mill-table 
A 

Not 3-D 
g4vmta.mch 

  

3ax vert. 
mill with 
robot 
gripper 
arm 

samples -  
bars_robot.mch 

  

3ax horiz. 
mill/turn-
table C 

samples - 
3ht.mch 

  

4ax horiz. 
dual 
turret 
lathe 

samples - 
4hl02.mch (steadyrest), 
4hl03.mch (no steadyrest), 
4hl04.mch (steadyrest) 

  

4ax horiz. 
dual 
turret 
lathe with 
pick-off 
spindle 

samples - mcdturn6.mch (robot arm 
part-grabber) 

  

4ax horiz. 
mill-table 
B 

library - 
generic_vmill_4ax_table_b.mch 
  
samples -  
4hmtb.mch (shown) 

  

4ax horiz. 
mill/turn-
table C 

samples -  
4ht.mch (in), 
4htm.mch (mm) 

  
4ax vert. 
mill-table 
A 

Not 3-D 
generic_vmill_4ax_table_a.mch 

  
5ax horiz. 
mill-head 
A, table B 

Not 3-D 
generic_5ax_hmill_heada_tableb.mch
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5ax horiz. 
mill-table 
A on 
table B 

Not 3-D 

generic_5ax_hmill_tablea_tableb.mch

  

5ax horiz. 
mill-table 
B on 
table A 

Not 3-D 

generic_5ax_hmill_tableb_tablea.mch

  

5ax vert. 
mill-head 
A on 
head B 

Not 3-D 

generic_5ax_vmill_heada_headb.mch

  
5ax vert. 
mill-table 
A, head B 

Not 3-D 
generic_5ax_vmill_tablea_headb.mch

  

9ax cutter 
grinder 

samples - 
9v_grind.mch 

Giddings & 
Lewis (G&L) 

  
 

  

    Not 3-D gl_2ax_turn.mch 

  

5ax vert. 
mill/turn-
table C 

samples- gl_5vt01.mch 

  

G60 4ax 
horiz. 
boring 
mill 

gl_g60.mch 

  

G60 4ax 
horiz. 
boring 
mill 

gl_g60_sav.mch 
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HAAS      

  

MiniMill  
3ax vert. mill 

 

haas_minimill.mch 

  

VB-1  
5ax vert. mill 

 

hasvb1.mch 

Hermle      

  

C30 
5ax mill 

 

hermle_c30.mch 

  

C800U 
5ax mill 

 

hermle_c800u.mch 

Ingersoll      

  

Mastercenter 4ax 
Multi-head gantry 
mill-detailed 

 

ingmast1.mch 

Kearney & 
Trecker 
(K&T) 

  
 

  

  

HB4  
4ax horiz. mill 

 

kt_hb4.mch 
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Model 180 4ax 
horiz. mill 

 

kt_180.mch 

Kuraki      

  

KBM11  
5ax horiz. boring 
mill 

 

kurkbm11.mch 

Maho      

  

DMU 80 P 5ax 
horiz. mill 

 

mahdmu80.mch 

  

MH700  
3ax vert. mill 

 

mah700m.mch 
(mm), 
mahmh700.mch (in)

    Not 3-D mahvrt.mch 

  

DMU 50V 5ax 
vert. mill 

 

dmg_dmu50v.mch 

  

DMU 60 t 5ax vert. 
mill 

 

dmg_dmu60t.mch 

  

DMU 125 P 5ax 
vert. mill 

 

dmg_dmu125p.mch
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DMU 200 P 5ax vert. mill 

 

dmg_dmu200p.mch

Makino      

  

MC1010 
5ax horiz. mill 

mak1010.mch 

  

A55  
4ax horiz. mill 
  

makino_a55.mch 

  

A66  
5ax horiz. mill 

makino_a66.mch 

  

A77  
4ax horiz. mill 

makino_a77.mch 

Marwin      

  

Advanced 
Manufacturing 
Cell  
5ax horiz. mill 

mrwamc.mch 

Matsuura      

  
FX-5  
4ax vert. mill Not 3-D 

matfx5.mch 

  
MAM 600HF vert. 
mill Not 3-D 

mat600hf.mch 
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Mazak      

  

H500  
4ax horiz. mill 

mazh500.mch 

  

Super 400H 4ax horiz. 
mill 

maz400h.mch 

  

E650H  
horiz. mill/turn 

mazak_e650h_2000u_3_jaw.mch

  

HTC 4000 5ax horiz. 
mill 

mazak_htc_4000.mch 

  

Nexus 410a vert. mill mazak_nexus410a.mch 

  

QTN250MY Mazak_qtn250my.mch 

  

Variaxis 500 5ax vert. 
mill 

mazak_variaxis500.mch 

  

  mazak_variaxis730.mch 
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Mori 
Seiki 

     

  

Partner M-400C1  
5ax vert. mill 

ms_m400.mch 

  

MT 2000 SZ multi-
axis turning center 

mori_seiki_mt2000sz_alpha1.mch

Motch      

  

135 VNC vert. 
turning center 

motch_135vnc.mch 

Okuma      

  

LB400 2ax horiz. 
lathe 

Okuma_LB400.mch 

  

LB25 2ax horiz. 
lathe 

samples - 
okulb25.mch 

SNK      

  

FSP-100V 5ax 
horiz. mill 

snkfsp01.mch 

  

SH-200  
5ax gantry mill 

snksh200.mch 
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STC      

  

STC1000 
5ax horiz. mill 

 

stc1000.mch 

Sundstrand      

  

Omnimil OM3  
5ax vert. mill 

 

sunom3.mch 

  

Omnimil OM80  
5ax horiz. mill 

 

sunom80.mch

Toyoda      

  

FH80  
5ax horiz. mill 

 

tydfh80.mch 

Tsugami      

  
MA3  
4ax horiz. mill Not full 3-D 

tsuma3.mch 

Warner & Swasey 
  

 
  

  

Titan  
4ax horiz. dual turret lathe

 

ws_titan.mch
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Sample–Demo Files 
 
See the Sample-Demo Files section, in the CGTech Help Library. 
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Environment Variables  

 

You can set environment variables to help customize the VERICUT user interface, alter 
VERICUT performance, and perform other various actions. This section describes 
environment variable formats and the available environment variables that can affect the 
VERICUT simulation. 

Environment variables are typically set via CGTech command files located in the 
CGTech "commands" directory, under the directory representing your computer type. For 
example, the command files or VERICUT 6.1 installed on the "C:" drive of a Windows 
NT computer are located in the C:\CGTech61\winnt\commands directory. Environment 
variables can also be set in any other system file used to execute VERICUT. 

Formats 
Formats used to set environment variables differ, based on the computer's operating 
system. Consult the operating system documentation, or refer to the CGTech-installed 
command files on your computer for specific examples. 

 

Operating 
System 

Environment Variable  
Format 

Examples of Use 

Windows set 
ENV_VAR_NAME=value

set CGTECH_DEFAULT_UNITS=inch 

set 
CGTECH_LIBRARY=C:\CGTech50\library

UNIX ENV_VAR_NAME=value

export 
ENV_VAR_NAME 

(2 records required to set 
each variable) 

CGTECH_DEFAULT_UNITS=inch 

export CGTECH_DEFAULT_UNITS 

CGTECH_LIBRARY=C:\CGTech50\library

export CGTECH_LIBRARY 

 
"CGTECH" Environment Variables 
Available environment variables that can affect the VERICUT simulation are listed 
below in alphabetical order. For simplicity, all examples of use below are in Windows 
format. See above for UNIX format examples. 

 

CGTECH_CEILING_IMAGE — Specifies the JPEG file to use as texture for the 
ceiling in OpenGL machine views. 
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Example of use:  
set CGTECH_CEILING_IMAGE=C:\path\ceiling.jpg 

  

CGTECH_DEFAULT_UNITS — Sets the default units for VERICUT. Specify either 
INCH or MILLIMETER 

Example of use:  
set CGTECH_DEFAULT_UNITS =MILLIMETER 

  

CGTECH_DISPLAY — Sets the animation display method for tool motion in the 
Workpiece view. The display is updated for animation when you start cutting or the 

refine the display ( e.g. press Refine Display  ). Changing the animation display 
method can affect simulation speed and display quality, but does not affect model 
accuracy. Results are different, based on the types of parts you cut and specified Cutting 
Tolerance.  

Options: 
 

REFINE1 — This display method creates the best quality animation image for all-
around use, but may take slightly longer to simulate with than REFINE2 (see below). 
REFINE2 — Alternate display method-fastest when a large amount of model detail 
is visible. This method is more sensitive to Cutting Tolerance than REFINE1, and is 
typically very good when the cut tolerance is small enough. 
ULTRA — Another alternate display method-this method can be faster than the 
others, but has lower display quality when compared to the default method. 
 

Example of use:  
set CGTECH_DISPLAY=REFINE2 

  

CGTECH_FLOOR_IMAGE — Specifies the JPEG file to use as texture for the floor in 
OpenGL machine views. 

Example of use:  
set CGTECH_FLOOR_IMAGE=C:\path\floor.jpg 

  

CGTECH_FONT_SIZE — Sets the font size for text appearing in the VERICUT user 
interface. Size can be given an absolute point size, or incremental value from the default 
value of "12". 

Examples of use: 
set CGTECH_FONT_SIZE=14 (sets 14 pt. font) 
set CGTECH_FONT_SIZE=+2 (also sets 14 pt. font: default 12 +2= 14) 
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CGTECH_INSPECTION_TOLERANCES — Specify a fully qualified /path/filename 
of a "custom" inspection tolerance file" containing default tolerances to be used for 
Inspection Sequence. 

Example of use:  
set CGTECH_INSPECTION_TOLERANCES=C:\mydir\inspect_tolfile.txt 

  

CGTECH_LIBRARY — Specifies the directory location of the CGTech Library of 
machines and controls accessed via choosing the "CGTECH_LIBRARY" shortcut option 
on file selection windows. Setting this environment variable can be useful for sites that 
use their own library VERICUT machines and controls instead of that supplied on CD 
with VERICUT. The full directory path can be included.  

Example of use:  
set CGTECH_LIBRARY =C:\mylibrarydir 

 

See also:  "Where VERICUT looks for files" in the Introduction section 

  

CGTECH_MATRIX_FORMAT — Enables you to view the Matrix Tables in the 
Coordinate System Window, Matrix tab and the Modeling Window, Position tab, 
Matrix tab with the I, J, K along the vertical axis and the X, Y, Z along the horizontal 
axis rather than the "default" horizontal orientation. 

Horizontal Orientation (default): 

 
  

Example of use:  
set CGTECH_MATRIX_FORMAT=VERTICAL 

  

Vertical Orientation: 

 
 

CGTECH_OLD_FSB — Enables you to use the more common Windows File Selection 
Box (FSB) rather than the "standard" VERICUT FSB. 
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Example of use:  
set CGTECH_OLD_FSB=YES 

  

CGTECH_STATUS — Creates a Status file, an ASCII text file that contains whatever 
data is sent to the Status window  during the simulation. The full directory path can be 
included with the file name. 

Example of use:  
set CGTECH_STATUS=C:\mydir\statusfile.txt 

  

CGTECH_TPEDITOR — Causes Edit Toolpath to issue a system command using the 
string content of the variable, with the current tool path file as an argument. Thus you can 
choose to run an alternate tool path editor, such as any one of the clever NC code editors 
available today. 

When you press Edit > NC Program > 'c:\path\filename.mcd', or  Project menu > NC 

Program >(list item) > right mouse click > Edit, or the Edit NC Program icon   , 
then VERICUT issues the system command: 

c:\program files\cooltoolpatheditor\editor.exe c:\path\filename.mcd 

This will only work with tool path editors that can take the tool path file name as an 
argument on the command line that runs the editor. Depending on the editor's command 
syntax, it may be necessary to point CGTECH_TPEDITOR at a batch or script file that 
intercepts the tool path file name and re-formats the command as necessary. 

Example of use:  
set CGTECH_TPEDITOR=c:\program files\cooltoolpatheditor\editor.exe 

  

CGTECH_USERNAME — Specifies the user name to include in the name of the 
Preferences file that is automatically saved when you exit VERICUT. This environment 
variable is recommended to prevent users that share a machine (or an account) from 
overwriting the Preferences file. 

Example of use:  
set CGTECH_USERNAME=bob (Preferences file saved => "cgtech_bob.prefs") 

  

CGTECH_VCPROJECT — Specifies the default Project file for VERICUT. The full 
directory path can be included. 

Example of use:  
set CGTECH_VCPROJECT=C:\mydir\myprojectfile.VcProject 

  

CGTECH_VCUSR — Specifies the default User file for VERICUT. The full directory 
path can be included. 
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Example of use:  
set CGTECH_VCUSR=C:\mydir\myuserfile.usr 

  

CGTECH_X_WALL_IMAGE — Specifies the JPEG file to use as texture for the two 
walls having normals along plus or minus X in OpenGL machine views. 

Example of use:  
set CGTECH_X_WALL_IMAGE=C:\path\x_wall.jpg 
 

CGTECH_Y_WALL_IMAGE — Specifies the JPEG file to use as texture for the two 
walls having normals along plus or minus Y in OpenGL machine views. 

Example of use:  
set CGTECH_Y_WALL_IMAGE=C:\path\y_wall.jpg 

  
Adding custom environment variables for shortcuts 
You can add your own environment variables to the beginning section of the VERICUT 
command file and have them appear in the shortcut list of file selection windows. 
VERICUT lists all custom environment variables that begin with "CGTECH_" in the 
shortcut list, and have at least one file in the directory that is recognized as a CGTech file 
type, for example a file with any of the following extensions: *.ctl, *.ip, *.job, *.mcd, 
*.mch, *.olb, *.stl, *.tls, *.tp, *.usr, or  *.VcProject 

Note that the contents of the file are not verified unless loaded by VERICUT. Just the 
existence of a file with an extension that qualifies as one of the valid CGTech file types 
(see above) is enough to make the shortcut appear in the list. 

Example 1 — The following environment variable creates a shortcut to a directory 
containing VERICUT 6.1 sample files. 

set CGTECH_61SAMPLES=C:\CGTech61\samples\vericut 
 

Example 2 — The following environment variable creates a shortcut to a directory 
containing a user's custom VERICUT files. The directory contains a file named 
"dummy.usr". 

set CGTECH_MYVERICUTFILES=E:\myvericutfiles 
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Interacting with VERICUT 
VERICUT main window 
 

The VERICUT main window is composed of distinct areas, each with different user 
interaction. The window header displays the last Project file loaded and the current 
session units (inch or millimeter). This window can be resized like most other window, 
via dragging the window header, sides or corners. 

 

 
 
 
Hint: Press "F1" in any VERICUT window to receive help on that window. 
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Menu Bar 
 

The menu bar, located across the top of the VERICUT window, provides easy access to 
VERICUT functions. Each menu in the menu bar contains groups of related functions. 
Left-click on any menu name to expose the list of functions available in that menu. If an 
arrow appears to the right of a function in a menu, move the mouse over the arrow to 
expose a sub-menu of additional functions. Click on the function in the menu you want to 
use. 
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VERICUT menu descriptions 
 

The menus which provide access to all VERICUT functions are listed below, followed by 
a brief description of what the menu functions do. In VERICUT Help, click VERICUT 
Menus & Functions, then open the desired menu and select the function for more 
information about each function. 

File menu — Functions in this menu open and save the most common files used in 
VERICUT, access converter products, control properties, export cut model data, and 
generate VERICUT reports. 

Edit menu — Functions in this menu enable you to edit text files, NC programs and 
control display colors. 

View menu — Functions in this menu set up the number of views, orientation (angle 
and distance) for each view, and store or select commonly used views, and set up 
other VERICUT display characteristics. 

Info menu — Functions in this menu access session information, such as the files 
currently being used, machining status, machine offsets, log files. 

Project menu — Functions in this menu provide the functions required for "job" 
setup including the display of the Project Tree. Functions include selection of 
machines, controls, NC programs, tools, and processing options. Its features also 
enable the selection and setup of output files created by VERICUT during processing 
and customized reports. 

Configuration menu — Functions in this menu are used to build  or configure NC 
machines and controls. 

Analysis menu — Functions in this menu are used to analyze and inspect the 
VERICUT model. It provides access to the following features: X-Caliper, AUTO-
DIFF, Comparator, NC Program Review, Inspection and Die Sinking Simulation. 

OptiPath menu — Functions in this menu access OptiPath-the feed rate and spindle 
speed optimization software that creates "optimized" tool paths that cut parts in the 
least amount of time. 
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Tool Bar 
 

VERICUT's Toolbar provides quick and easy access to the most commonly-used 
functions/features. 

 
To see what is associated with a Toolbar icon, simply position the cursor over the icon 
and a tip appears, as shown with the Close Toolbar icon in the illustration above. You can 
close/open the Toolbar at any time. Using View menu > Toolbar you can also customize 
the Toolbar to suit your needs. The Toolbar window is also one of the dockable windows 
enabling you to be able to re-position it if you choose. 

To close the Toolbar: 

From the Toolbar select Close Toolbar . 

 

To open the Toolbar: 
Select View menu > Toolbar. 

Select Display Toolbar. 

 

To add/remove groups in the Toolbar: 
Select View menu > Toolbar. 

Clear the check, by clicking on it, to remove groups you do not want displayed. Add a 
check, by clicking in the box, for groups that you want to display. 

Tip: You can affect all Toolbar groups at once using the Set All / Clear All buttons. 
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Graphics area 
 

The graphics area is where solid models of the workpiece, fixtures, etc. are displayed, and 
where the simulation takes place. By default, two views are seen: a Workpiece view and 
a Machine Cut/Stock view. Using View menu > Layout you can add more views 
displaying the workpiece or NC machine (if a machine is defined). All views are 
contained within the VERICUT main window. 

 

 
 

Right-click in a view to display Shortcuts menu, as shown in the illustration below, 
enabling you to modify its attributes, such as: view type, standard modeling views, 
background, etc. Use dynamic and static view options on the Tool Bar to rotate, zoom, or 
fit the model. 
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Many other VERICUT functions enable user interactions in this area, including: picking 
models or surfaces to be measured, determining tool path records responsible for specific 
cuts, and more. 
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Message Area 
The message area, also known as the "message logger", is located below the graphics 
area, and by default displays the most recent message VERICUT has provided. 
VERICUT provides error, warning, and informational messages to assist you during a 
simulation session. 

To review previous messages, click on the message line-the most recent message is listed 
last. Click again to close the message logger. 

 

 
 

NOTES:   
1. All messages can be seen along with other valuable information in the Log file. 

2. See problem descriptions and solutions for VERICUT error/warning messages in 
ERRORS and Problem Solving at 
http://www.cgtech.com/support/errors_problems/errors.htm. 
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Animation Speed Slider 
 

The Animation Speed Slider, located at the bottom of the VERICUT main window 
between the Message Area and the Busy/OptiPath Lights, controls the speed at which 
VERICUT animates material removal in workpiece views. Moving the slide bar left 
slows animation by adding intermediate tool display positions between motion start and 
end points. Moving the slide bar right reduces the number of intermediate tool display 
positions to speed animation display. 

 

 The animation slider will be displayed in one of two ways: 

 Animation Speed Slider in full 
right position 

 Animation Speed Slider moved off of full 
right position 

      

 

  

 
  

  

Use Min. Motion Dist. and Max. Motion Dist., in the Project > Processing Options > 
Motion window, to define the range for the Animation Speed Slider. 

   

Tip:  To group cuts together for even faster animation display, use the Skip Cut feature 
located on the Motion window. 
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BUSY-OptiPath lights 
 

The "BUSY" and "OptiPath" lights located at the bottom-right of the VERICUT window 
provide constant visibility over when VERICUT is busy performing a task, or optimizing 
a tool path file. A bright red color indicates an "on" condition, as seen in the example 
below with the "BUSY" light. 
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Progress bar 
The progress bar located at the bottom-right corner of the VERICUT window provides 
visibility over progress of a CPU-intensive task, such as: comparing models using 
AUTO-DIFF, exporting model data, and checking the consistency of the stock model(s). 
The progress bar moves towards the right as the task nears completion. To interrupt the 

task, press the Stop icon, . 

 

Sample progress bar nearing completion of a task: 
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Simulation (VCR) controls 
 

The simulation controls, also known as VCR buttons, located at the bottom-right corner 
of the VERICUT window control interactive tool path simulation. Once VERICUT is 
configured, you will use these control to start and stop the simulation, as well as begin 
with a new, uncut workpiece. To see what is associated with a Simulation control icon, 
simply position the cursor over the icon and a tip appears.  

 

Simulation control: 

Icon Name Function 

  
Play to End Start or re-start tool path 

processing 

  
Single Step Process one tool path record 

("single block") 

  (or press Escape key <Esc>) 
Stop Stop processing (after the 

current record is processed) 

  
Rewind NC Program Rewind the NC program file 

to the beginning (leave the 
model as is) 

  
Reset Model Display a new VERICUT 

model and rewind the tool 
path file 

 

130130



VERICUT HELP - Getting Started with VERICUT 
 

Look & Feel 
Location: View menu > Look & Feel 

 

The Look & Feel features change the appearance of VERICUT's user interface. All 
windows are affected. The look and feel of VERICUT can be changed any time. (Not all 
options are available on all systems.) 

Options: 
Metal —  

 
 

131131



VERICUT HELP - Getting Started with VERICUT 
 

Motif — 
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Windows — 
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Windows Classic — 
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Text Larger — Use to make the text in VERICUT menus, message logger, windows, 
etc. larger. Each time you click on "Text Larger", the text gets incrementally larger to 
a maximum font size of "14 point". 
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Text Smaller — Use to make the text in VERICUT menus, message logger, 
windows, etc. smaller. Each time you click on "Text Smaller", the text gets 

incrementally smaller to a minimum font size of "6 point ". 

 

 
  

 

 

To change the user interface look and feel: 

 

1. In the View menu, select Look and Feel. 
2. Choose the option that provides the desired appearance. 
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Right Mouse Button Shortcut Menus 
 
VERICUT Graphics Area: 
Right-click in the VERICUT Graphics Area to display the following menu: 

  
View Type   Workpiece, Machine, Machine/Cut Stock, Profile 

View To Back   
View Always In Front   
Reverse   
Fit   
Set Spin Center   
Select View  List of standard and available custom views 
Draw Mode (Machine 
View Only)  

Shade, Lines, Hidden, Mixed 

Background Style  Flat, Shaded, Walls (Machine View Only) 
Attach Component  List of available components 
Accelerated (Open GL)   
Set Active Coord. Sys.  List of available coordinate systems 
Display Axes   List of available Axes: Component, Model, Machine 

Origin, Workpiece Origin, Tool Tip Zero, Driven Point 
Zero, Spindle Direction, Active Coordinate System, Set 
Axes, Clear Axes, Set CSYS, Clear CSYS, View Axes 

Model Definition   
Project Tree   
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Tool Manager Window: 
Right-click in the Tool Manager Tool Table to display the following menu: 

  
Modify     
Rename     
Delete      
Cut     
Copy     
Paste     
Add Tool   New  Mill 
Add Tool Component Select Existing ... Turn 
Add OptiPath  New Probe 
Add Driven Point Select existing ...   
Add Cutter Compensation     
Search Tool     
Search OptiPath     
Spin Around     Tool Axis   
   Machine Spindle   

 
  
 

Right-click in the Tool Manager Tool Display area  to display the following menu: 

  
    Fit    
    Reverse   
    Select View   XY 

  Driven Point YX 
 Gage Point YZ 
  Axes ZY 

  ZX 
  XZ 
  V-ISO 
  H-ISO 
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Project Tree: 

NOTE:  Any item shown in bold a Project Tree pop-up menu can also be reached 
directly by double clicking on the item (branch, component, model, etc.) in the Project 
Tree that you right -clicked on to display the pop-up menu. For example, double-clicking 
on the Project branch in the Project Tree displays the Open Project window, just like 
clicking on Open in the pop-up menu shown in 1 below. 

  

Right-click on the Project branch in the Project Tree window to display the following 
menu: 

 New   Inch, Millimeter 

 Open   

 Save 
  

 Save As 
  

Units  Inch, Millimeter 
Import Setup   

 Motion 
  

APT Cycles   
Expand All Children   
Recent  List of recently used project files 

 Close 
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Right-click on a Setup branch in the Project Tree window to display the following 
menu: 
  

   Active     

 Cut     

 Copy     
 Paste     

 Delete     
Rename     

 Properties     

Report   Report Template  Edit 

 Motion User-Defined Tag Values   

 G-Code   Settings, Variables, Process Options   

 APT Settings     

 Coordinate Systems  Define, Active   

 Section     

 Inspection     

  Die Sinking     
Expand All Children     

 
 
Right-click on a CNC Machine branch in the Project Tree window to display the 
following menu: 
  

     CNC Machine... 
 MDI ... 
 G-Code Settings ... 

      Variables... 
      Process Options... 

 Machine Settings ... 
 Expand All Children 
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Right-click on a Control branch in the Project Tree window to display the following 
menu: 
  

 Open 
 Cut 
 Copy 
 Paste 
 Delete 
 MDI ... 
 G-Code Settings ... 

 Variables... 
 Process Options... 

  
 
Right-click on a Machine branch in the Project Tree window to display the following 
menu: 
  

 Open 
 Cut 
 Copy 
 Paste 
 Delete 

 Machine Settings ... 
Expand All Children 

  
 
Right-click on an Attach Component in the Project Tree window to display the 
following menu: 
  

 Component Attributes     
 Paste     

Append  Fixture   
Expand All Children Stock   
  Design   
  Design Point   
  More  List of Components 
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Right-click on a Component Branch (Fixture, Stock, Design) in the Project Tree 
window to display the following menu: 
  

 Component Attributes     

  Cut     

 Copy Fixture   
 Paste Stock   

 Delete Design   
Rename Design Point   
Append   More   List of Components 
Visibility  
                              

Blank, Workpiece View, Machine View, Both 
Views 

Expand All Children   
 
  
NOTE:   When Visibility is set to "Blank" for a component, the icon representing the 
component in the Project Tree will be displayed in gray  instead if a color. 
  
  
Right-click on a Model in the Project Tree window to display the following menu: 
  

 Modify... 
 Cut 
 Copy 
 Paste 
 Delete 
 Visible 

  
 
NOTE:  The Visible icon will indicate the visibility status of the model.  indicates 
"visible",  indicates "not visible". Click on Visible to toggle between the two modes. In 
the Project Tree, any model in the "not visible" state will be displayed in gray instead if a 
color. 
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Right-click on Tooling in the Project Tree window to display the following menu: 
  

 Open 
 Tool Manager... 
 Cut 
 Copy 
  Paste 

  Delete 
  
  
Right-click on an NC Program branch in the Project Tree window to display the 
following menu: 
  

 Add/Modify NC Programs... 
 Paste 
  Delete All 

Expand All Children 
  
  
Right-click on an NC Program file in the Project Tree window to display the following 
menu: 
  

   Active 

 Add/Modify NC Programs... 

 Edit... 
 Cut 
 Copy 
  Paste 
 Delete 
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Right-click on an NC Subroutines branch in the Project Tree window to display the 
following menu: 
  

Add/Modify NC Subroutines... 
 Paste 
 Delete All 

Expand All Children 
  
  
Right-click on an NC Subroutine file in the Project Tree window to display the 
following menu: 
  

 Edit... 
 Cut 
 Copy 
 Paste 
 Delete 

  
 
Component Tree: 
 
NOTE:  Any item shown in bold a Component Tree pop-up menu can also be reached 
directly by double clicking on the item (component, model) in the Component Tree, that 
you right-clicked on to display the pop-up menu. For example, double-clicking on the 
Component branch in the Component Tree displays the Modeling window: Component 
Attributes tab, just like clicking on Component Attributes in the pop-up menu shown in 
1 below. 
  
Right-click on a component in the Component Tree window to display the following 
menu: 
  

 Component Attributes   

 Cut   

 Copy   
 Paste   

 Delete   
Rename   
Insert  List of Components 
Append   List of Components 
Visibility  Blank, Workpiece View, Machine View, Both Views 
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NOTE:   When Visibility is set to "Blank" for a component, the icon representing the 
component in the Component Tree will be displayed in gray instead if a color. 
  
 
Right-click on a model in the Component Tree window to display the following menu: 
  

 Modify... 
 Cut 
 Copy 
 Paste 
 Delete 
 Visible 

  
NOTE:  The Visible icon will indicate the visibility status of the model.  indicates 
"visible",  indicates "not visible". Click on Visible to toggle between the two modes. In 
the Project Tree, any model in the "not visible" state will be displayed in gray instead if a 
color. 
  
  
NC Program Review window: 
Right-click in the NC Program Review window to display the following menu: 
  

Set Start 
Set Current 
Set End 
Display to Box 

 Cut Line 

 Non-Cut Line 

 Current Line 
Goto Start 
Goto Current 
Goto End 
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Inspection Sequence window: 
Right-click in the Inspection Sequence window to display the following menu: 
  

 Insert Wall Thickness Row 

 Insert Floor Thickness Row 

 Insert Hole Diameter Row 

 Insert Datum Plane Row 

 Insert Distance Row 

 Insert Angle Row 

 Insert Position Rows 

 Insert Hole Depth Row 

 Insert Radius Row 

 Insert Surface Finish Row 

 Insert Note Row 

 Use probe for selected feature 

 Use probe for all features 

 Program probe cycles 

 Modify Marker Location 
Restore Default Tolerance 
Edit Geometric Tolerance 

 Delete Row 

 Refresh 
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NC Program window: 
Right-click in the NC Program window to display the following menu: 
  

Add   
Replace   
Copy   
Paste   
Origin  None, List of Available Coordinate Systems 
Delete   
Edit   

  
  
Word/Address window: 
Right-click in the Word/Address window to display the following menu: 
  

Add/Modify 
Cut 
Copy 
Paste 
Find 
Contract All Children 
Expand All Children 

  
  
G-Code Settings window, Subroutines tab: 
Right-click in the G-Code Settings window, Subroutines tab to display the following 
menu: 
  

Add 
Replace 
Delete 
Edit 

  
Edit — Displays the of the highlighted subroutine file in a Text Editing window. 
Standard text editing features are provided, such as: copy/cut, paste, search, etc. 
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Personalizing the VERICUT Main Window 
 

VERICUT enables you to personalize your workspace to match the process by which you 
use VERICUT's many features, as well as incorporating your own personal preferences. 
Through the use of "dockable" dialog windows, you can set up your VERICUT 
workspace as simply or as complex as you choose. Each of these windows can be docked 
inside the VERICUT main window, or un-docked to be displayed as a stand alone 
window like previous versions of VERICUT. By docking or undocking windows, you 
can taylor the VERICUT workspace to meet your specific needs. The "Simple VERICUT 
Workspace" illustrates the most basic workspace.  

  

Simple VERICUT Workspace: 

 
  
 The "Complex VERICUT Workspace" is shown with nearly all of the available 
"dockable" windows docked to the VERICUT main window. While it appears cluttered, 
and is not likely an efficient workspace, the intent is to show the flexibility that you have 
for setting up your workspace. Your optimum workspace layout will likely fall 
somewhere between these two extremes. The main point is that you decide the most 
effective workspace layout based on how you use VERICUT and how you prefer to 
interact with its many features. 
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Complex VERICUT Workspace: 
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Dockable Windows 
 

The following summarizes the dialogue windows that can be docked inside VERICUT's 
main desktop: 

  

Dockable 
Window Location Docking Positions 

      
Toolbar VERICUT main window Left, Right , Top, Bottom, Standalone 
Progress bar VERICUT main window Top, Bottom, Standalone 
NC Program Info menu > NC Program Left, Right , Top, Bottom, Standalone 
Status Info menu > Status Left, Right, Standalone 
Project Tree Project menu > Project Tree Left, Right, Standalone 
X-Caliper Analysis menu > X-Caliper Left, Right, Standalone 
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Docking and Un-docking windows 
 

The procedure for docking/undocking any of the dockable windows is the same. All 
dockable windows have a dotted line on the left side of the window as indicated by the 
arrow in the Toolbar in the picture below. This dotted line is used for both docking and 
undocking these windows. To undock a currently docked window, left click on the dotted 
line on the left side of the window, then while keeping the button depressed, drag the 
rectangle representing the window (see Figure 1) to the desired location outside the 
VERICUT main window. When you release the mouse button, the window moves and is 
displayed as a stand alone window.  

  

Figure 1 
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Figure 2 shows the result of dragging the Toolbar window to a position below the 
VERICUT main window. 
  
Figure 2 

 
  
 The procedure for docking a stand alone window or moving a currently docked window 
to a different docking location is the same. Starting with the stand alone Toolbar window 
shown in Figure 2, left click on the dotted line in the Toolbar window, then drag the 
rectangle representing the window to one of the docking positions available for the 
particular window. 
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In this case we are docking the Toolbar window on the right side of the VERICUT main 
window. When the rectangle representing the window is dragged to a dockable position, 
the shape of the rectangle will change and the border will be displayed red as shown in 
Figure 3.  

 

Figure 3 
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Releasing the left mouse button moves the window to the docked position as shown in 
Figure 4. 

 

Figure 4 
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VERICUT Menus and Features 
File Menu 
New Project 
Location: File menu > New Project > Inch / Millimeter 

Toolbar short cut for creating a New Project file:  (Inch) or  (Millimeter). Right-
click on the icon to switch between the two modes. 

Sets VERICUT to a "new" condition, as if no files have been loaded. Afterwards, 
configure VERICUT by adding models, tool paths, descriptions of cutting tools, etc. 

To establish the new condition, VERICUT purges all data from memory, then opens the 
init.VcProject (inch project) or initm.VcProject (millimeter project) Project file from the 
CGTech library. The Project Tree and Component Tree shown below are automatically 
defined, ready for you to configure VERICUT by adding models, tool paths, descriptions 
of cutting tools, etc. 

 

  

Project Tree after a new condition: Component Tree after a new condition: 
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Tips: 
 
1. You can customize how VERICUT establishes the new condition by making changes 

to the init.VcProject or initm.VcProject files. Store the changed files in your working 
directory, or the CGTech library directory. 

2. If needed, change the units for the new session as follows: 
A. Right-click in the graphics area and select Project Tree in the menu that 

displays. 
B. In the project tree, right click on the "project" branch, and select Unit > Inch 

or Millimeter in the menu that displays. 
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Open (Project) 
Location: File menu > Open 

  

Toolbar short cut for opening Project files:  
  
Use to open an existing Project file with the current VERICUT session settings. Use the 
Open Project file selection window that displays to select the desired project file.  
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Save Project  
Location: File menu > Save Project 

Toolbar short cut for saving Project files:  

 

Saves (updates) an existing Project file with the current VERICUT session settings. 
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Save As 
VERICUT Users: 
VERICUT Location: File menu > Save As 

Toolbar short cut for saving Project files:  

  

Mold and Die Users: 
Mold and Die Location:   Setup page > Save the Setup or Preview and Optimize page 
> Save the Setup 

Notebook Feature:        

  

Cutter Grinder Users: 
Cutter Grinder Location:   Setup page > Save the Setup or View Simulation page > 
Save the Setup 

Notebook Feature:       

  

Opens a file selection window enabling you to save Project files, In-Process files, Control 
files, Machine files, Tool files, or any other VERICUT file. Most features on this window 
are standard file selection window features that enable you to navigate through 
directories, filter files, and type or select file names. Use the "Filter" to specify the type of 
file to be saved.  Depending on the filter setting, VERICUT will save the current file of 
that type. If "Filter" is set to anything other than .usr, .ip, .ctl, or.mch, the user file will 
always be saved. 
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Save All 
Location: File menu > Save All 

  
Saves (updates) Project files, Machine Files and Control Files associated with the current 
VERICUT session. It provides the combined functionality of File menu > Save Project, 
Configuration menu > Control > Save and Configuration menu > Machine > Save. 
In the event that a file cannot be saved, a window will open enabling you to Save As. 

160160



VERICUT HELP – File menu 
 

In Process 

Open (In Process file) 
  
VERICUT Users: 
VERICUT Location: File menu > In Process > Open 

Toolbar short cut for opening IP files:  
  
Mold and Die Users: 
Mold and Die Location:   Setup page > Open In-Process Session 

Notebook Feature:       

  
Cutter Grinder Users: 
Cutter Grinder Location:   Setup page > Open In-Process Session 

Notebook Feature:       

  
Opens a window enabling you to open (load) an In Process file, or "IP file". IP files 
contain all the data necessary to re-establish a VERICUT session, including the current 
VERICUT model (with cuts), user interface settings, and a copy of the Log file.  
Features on this window are standard file selection window features that enable you to 
navigate through directories, filter files, and type or select file names. 
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Save (In Process file) 
Location: File menu > In Process > Save 

Toolbar short cut for saving IP files:  

Saves (updates) an existing In Process file, or "IP file", with the current VERICUT 
model, including all machine cut. 
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Save As (In Process file) 
  
VERICUT Users: 
VERICUT Location: File menu > In Process > Save As 

Toolbar short cut for saving IP files:  

  

Mold and Die Users: 
Mold and Die Location:   Preview and Optimize page > Save In-Process Session 

Notebook Feature:       

  
Cutter Grinder Users: 
Cutter Grinder Location:   View Simulation page > Save the In-Process Session 

Notebook Feature:       

  

Opens a window enabling you to save an In Process file, or "IP file". IP files contain all 
the data necessary to re-establish a VERICUT session, including the current VERICUT 
model (with cuts), user interface settings, and a copy of the Log file.  

Most features on this window are standard file selection window features that enable you 
to navigate through directories, filter files, and type or select file names. 
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Save Cut Stock 

VERICUT Solid 
VERICUT Location: File menu > Save Cut Stock > VERICUT Solid 

  
Save Cut Stock enables you to save the selected Cut Stock model as a VERICUT Solid 
file (.vct). (See How) This option is only active after a Cut Stock model has been created 
by VERICUT. The default file extension is .vct.   
  
This feature provides access to the same functionality as File > Save Cut Stock in the in 
the Component Tree window. 
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STL 
 

VERICUT Location: File menu > Save Cut Stock > STL 
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CAD Model 

Export Cut Stock window 
Location: File menu > Save Cut Stock > CAD Model  

 

Opens a window enabling you to export the VERICUT model. Export formats include: 
Stereolithography (STL) or VERICUT Polygon model files, or IGES data. (See how) A 
cut VERICUT model is exported with machine cuts intact. During the export operation a 
Model Export Boundaries window may open enabling you to manually close ambiguous 
open boundaries that VERICUT was unable to resolve, prior to completing the export. 
When the model has been exported, a message informs you how many IGES surfaces (or 
model file triangles) were created. 

 

 
 

Tips on exporting models: 
1. Make sure that Model Export Cut Mode in the File menu > Properties > 

General tab is toggled "On". 

2. Make sure that Display Holders in Workpiece View in the Project menu > 
Processing Options > Motion window is toggled "Off". 
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3. Make sure that Visibility is set such that models of fixture components are not 
visible in the Workpiece View. See Model menu > Model Definition > 
Component Attributes tab for more information. 

4. When you cut the model a message similar to "For best AUTO-DIFF, OptiPath 
and Model Results, set Cut Tolerance to 0.XXXX, due to small tool features" will 
appear in the logger. Use this information as a starting point for setting Cutting 
Tolerance and  Base Cut Tolerance on values on the File menu > Properties > 
Tolerance tab. 

5. To export a higher quality model, reduce the Cutting Tolerance. 

6. You can section cut models, then export what remains in the sectioned view. This 
can be helpful to export portions of complex models on computers with limited 
resources. 

 

Settings tab — Features on this tab establish general properties for the model export. 

Options tab — Features on this tab are used specify properties related to specific 
methods of processing VERICUT model geometry. 

 

Apply — Saves the Export Model window settings. 

Output — Processes and exports the VERICUT model according to the Export Model 
window settings. During the export operation a Model Export Boundaries window 
opens providing control over small surfaces that may cause problems in your CAD 
system. When the model has been exported, a message informs you how many IGES 
surfaces (or model file triangles) were created. 

Close — Closes the Export Model window. 

167167



VERICUT HELP – File menu 
 

Export Cut Stock window, Settings tab 
Location: File menu > Export Cut Stock 

  

Features on this tab establish general properties for the model export. 

  

 
  

Output File — Enter the \path\file name in the text field of the file to receive exported 
model data or click on Browse and use the Export Model File selection window to 
specify the file. 

File Type — Type of file to export. Options are: VERICUT, STL, IGES, CATIA V5, 
ACIS, CATIA V4 and STEP. 

File Format — Format in which STL or VERICUT model data is exported. Options are: 
ASCII or Binary. 

Output Color — Use to specify the color that is stored in the IGES file for the exported 
model. (Only active when File Type = IGES) 

Output Solid — Use to export a solid model. (Only active when File Type = CATIA V5, 
ACIS, CATIA V4,or STEP) 

Stock — When multiple Stock components are defined, this option enables you to select 
which one to export. 

Coordinates — Coordinate system in which model data is exported. Options are: Stock 
(stock component origin) or Active System (See Project menu > Coord. System). 

Units — Unit measurement system in which model data is exported. Options are: Inch or 
Millimeter. 
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Method — Controls the method of processing VERICUT model geometry into the 
specified data format. Features and Patches, Features Only and Turned Features Only are 
only active when File Type = IGES, CATIA V5, ACIS, CATIA V4, or STEP.  Slices is 
only active when File Type = IGES 

Options: 
Features and Patches — Builds synthetic features from several small adjacent 
features that are difficult to resolve in 'Features Only' mode. Analyzes the cut model 
using UV grid logic and group machined features by grid region. Grid Count specifies 
the number of grid squares in U and V space, spread over the cut model surface. 
VERICUT attempts to create one surface within in each grid, or as few surfaces as 
possible.  This option is recommended for cut models with smooth or transitioning 
surfaces, for example: mold and die cavities and patterns, blended or sculptured 
surfaces, etc.  

Features Only — Groups similar machined features into like IGES data entities. This 
option is recommended for cut models with distinct differences between machined 
features, for example: aerospace structural components, pocketed parts, parts with 
strengthening ribs/walls and stepped floors, etc. 

Turned Features Only — Exports the turned, or "revolved" representation of the cut 
model. Turned models are exported as an IGES file and contain the 2-D turned profile 
and surface of revolution. 

Slices — Exports the cut model such that resulting IGES output is a set of composite 
curves representing slice profiles of the cut stock. 
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Export Model window, Options tab 
Location: File menu > Export Cut Stock 

  

Features on this tab are used specify properties related to specific methods of processing 
VERICUT model geometry. The options displayed will vary depending on the method of 
processing (either Features and Patches or Slices) selected on the Settings tab.  

 

 
 

Process = Features and Patches 
Grid Count — Use to specify the number of grid squares in U and V space to be spread 
over the cut model surface during the IGES export process. Increasing this number 
increases the size of the output file, and increases IGES data accuracy. Valid values are 0 
(the same as off) - 100. 

 

Global Angle — Angle which, if exceeded, divides the machined surface into multiple 
IGES surfaces. Enter the angle in degrees. Increasing the angle decreases output file size 
and decreases IGES data accuracy.  On "Grid" processed models Global Angle affects the 
output of all machined surfaces. 

NOTE:  When you increase the Grid Count (more grid sections), the Global angle can 
also typically be increased since fewer features are considered for each grid. 
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Tolerance — Use to specify the amount that the exported model surface can deviate 
from the cut model surface. The smaller the value, the closer the output model will 
approximate the cut stock. 

 NOTE:  This tolerance value should be equal to, or greater than, the cut tolerance. 

 Group by Color — When toggled "On" (checkmark visible), patches will  be created to 
only contain data related to a single color. 

Detect Scallop Planes — Toggle "On" to activate "scallop plane logic" to process. 
Processing is faster when toggled "Off". 

Preview and Combine Patches — Toggle "On" to activate The Model Export "Preview 
and Combine Patches" feature. After VERICUT completes a preliminary analysis of the 
model, the model display changes to show multi-colored patches (see below), and the 
Preview and Combine window displays enabling you to: 

• Preview the model before going through the entire model export process. This 
enables you to cancel the current export and update settings before proceeding. 

• Merge adjacent patches for smoother output, faster model export, and smaller 
model sizes. 

   

VERICUT display for Preview and Combine Patches 

 
  

Filter Features — Use to specify the size of the area to be taken into account when 
differentiating between a "feature" and a "surface". Select the appropriate "feature" tab, 
(Plane, Cone, Cylinder, Sphere, Torus, Torus Sweep, or Ellipse Sweep) then use the 
slider to specify the size of the area.  More end if the scale is approximately equal to 
.0001 of the part size. Less end of the scale is approximately equal to .1 of the part size. 
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Process = Slices 
Slice Direction — Use to specify the direction of the slices. Select X, Y, or Z based on 
the axes of the cut stock model. 

Number of Slices — Use to specify the total number of slices to create. 

NOTE:   If the specified number is greater than the number of grid planes internally 
stored in the cut stock database, the number of slices output will automatically be reduced 
to this smaller value. 

 Local Angle — determines the max angle between 2 adjacent pieces of one slice when 
they still can be combined in one segment. 

Tolerance — Use to specify the amount that the exported curves can deviate from the cut 
model surface. The smaller the value, the closer the output curves will approximate the 
cut stock surface. 

NOTE:  This tolerance value should be equal to, or greater than, the cut tolerance. 
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Model Export Boundaries window 
The features in the Model Export Boundaries window enable you to close difficult or 
poorly defined feature trimming edges before exporting the model. 

  

 
  

Feature/Boundary Table — Contains a list of features. Each "feature" contains one or 
more open edges that VERICUT was not able to close automatically. Click on the "+" 
sign to the left of the feature to display a list of edges associated with it.  

Construct Mode — These options enable you to manually close open feature edges prior 
to exporting the model. To activate Construct Mode, select any option in the list other 
than "Off". A red and white "cross-hairs" cursor indicates when Construct Mode is active. 
(See how) 

Options: 
Off — Turns off Construct Mode. (You can also use the "escape" key on the 
keyboard) 

Project Edge — Use to extend an edge along a feature/feature intersection, one 
point at a time by projecting  the "Begin / End" point of the highlighted edge to 
the selected point on the intersection.  

Trim Edge — Use to eliminate overlapping boundary curves by trimming the 
"Begin / End" point of the highlighted boundary to the selected location.  

NOTE:  It is better to trim the boundary short, leaving a small gap that can then 
be closed than to have an "overlap" condition in the boundary. 
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Add Edge — Use to connect two edges within the same feature. The "begin/end" 
point of the highlighted edge is connected to the "end" or "begin" point on the 
selected edge.  

NOTE:  Highlight the edge by selecting it in the Feature/Edge table or by 
clicking on the edge in the graphics area with the center mouse button. 

Construct Patch — Use to construct a patch to fill an open area between 
features. 

Delete Edge — Use to delete the highlighted edge. 

 

Reverse Edge — Use to reverse the direction of the highlighted edge. 

Fit Edge — Use to resize and center the graphics window display around the highlighted 
edge. Select the edge in the Feature/Edge table or by clicking on the edge with the center 
mouse button in the graphics area. 

Fit Feature — Use to resize and center the graphics window display around the selected 
feature. Select the feature in the Feature/Edge table or by clicking on the feature in the 
graphics area. 

Clear — Use to clear the graphics display of "persistent boundaries". 

Do Not Output Open Boundaries — Toggle "on" to prevent the export of open 
boundaries. 

Persistent Boundaries — When toggled "on", enables you to display multiple feature 
boundaries. Use to display the feature boundaries adjacent to the edge that you are trying 
to close. Use Clear, described above, to remove "persistent boundaries" from the graphics 
display.  

Color Pallet — Select an object from the list then click on the color pallet icon to display 
the color pallet. Select the color for the selected object. You can specify colors for the 
following objects: 

Begin Point Color — Use to specify the color to display the "begin" point of an open 
feature boundary. 

End Point Color — Use to specify the color to display the "end" point of an open feature 
boundary. 

Boundary Color — Use to specify the color to display "open" feature boundaries. 

Projection Color — Use to specify the color to display the projected feature curve that 
displays when using Construct Mode options Project, Trim or Extend are used. 

Selected Color — Use to specify the color to display "selected" open boundary color (the 
highlight color of the active boundary).  

Closed Color — Use to specify the color to display "closed" feature boundaries. 

Node Color — Use to specify the color to display "node" points (the point where two 
adjacent edge segments connect on a feature boundary). 
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OK — Creates the export file and closes the Model Export Boundaries window. 

Output — Creates the export file and leaves the Model Export Boundaries window open. 

Cancel — Cancels the export of the model. 

175175



VERICUT HELP – File menu 
 

Export Cut Stock, Preview and Combine window 
Use the features on the Preview and Combine window to: 

• Preview the model before going through the entire model export process. This 
enables you to cancel the current export and update settings before proceeding. 

• Merge adjacent patches for smoother output, faster model export, and smaller 
model sizes.  

The features available, and how to use them, are described right in the window. 
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Export Cut Stock, "Combine" Example 
The following example shows the process of combining a number of smaller patches into 
a single patch. 

When Preview and Combine Patches is toggled "On", VERICUT completes a 
preliminary analysis of the model, then displays the model as multi-colored patches as 
shown below. 

 
To combine patches, start by selecting the "initial" patch (in this case patch # 1) using the 
left mouse button. The initial patch will display as shown below. 

NOTE:  Patch boundaries and numbers have been added for illustration purposes and 
will not be seen in the VERICUT display. 
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Select the first patch to be merged (in this case patch #2) with the middle mouse button. 
Any patch adjacent to the "initial" patch could have been selected for merging. The 
display updates as shown. 

 

 
 

Continue selecting adjacent patches to merge using the middle mouse button. The picture 
below shows the display after all 12 of the numbered patches have been selected for 
merging. 
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When finished selecting patches to be merged, click on the part with the left mouse 
button to combine the selected patches into a single patch as shown in the picture below. 
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Export Cut Stock, Preview and Combine Techniques 
The following techniques are provided to assist you in maximizing the quality of the 
models you create using the Export Cut Stock features. 
 
  
1. Avoid long narrow strips. 
  

The first image shows original patches. 

 

The second image shows a resultant long 
narrow patch which should be avoided. 

 

The third image shows an ideal resultant 
patch. 
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2. Consider neighboring node propagation. 
  

The first image shows original patches.  

 

The second image shows a resultant 
patch which will be split do to 
neighboring nodes. 

 

The third image shows what should be 
done to minimize unnecessary splits. 
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3. Merge small patches.  
  

Use the table to identify small patches by 
sorting by the Size column. Once small 
patches have been identified combine 
small patch with larger patch or combine 
a group of small patches to create one 
large patch. The image at the right shows 
a small patch (in red) that should be 
merged with one of the two larger 
patches.  

 
  
 
 
4. Merge all small plane anomalies. 
 

All small anomalies within a plane 
should be combined with the plane. The 
first image shows a plane (in red) with 
several small anomalies within the plane.  

 

The second image shows the plane with 
the small anomalies combined with the 
plane. 
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5. Consider initial design intent. 

When combining patches take into 
consideration intended design feature. 
The initial design intent of the images 
below is a cylinder. 
The first image shows the original 
patches. 

 

The second image shows the combined 
patches considering the initial design 
intent. 

 
 
  
6. Tabulated cylinder representation. 
  

Patches should be combined to represent 
a tabulated cylinder. The first image 
shows the original patches. 
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The second image shows what should not 
be done. 

 

The third image shows the ideal patch 
combination abiding by the tabulated 
cylinder rule. 

 
  
  
7. Use Split and Merge to improve fillets. 
  

The first image shows the patches from 
the original collection. 

 

184184



VERICUT HELP – File menu 
 

The second image shows the patches 
after using split and merge to improve 
fillet areas. 

 
  
  
8. Use Split and Merge to improve jagged boundaries. 
  

The first image shows the original patch 
boundary. 

 

The second image shows the patch, after 
using split and merge to improve 
boundary. 
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Working Directory 
  
VERICUT Users: 
VERICUT Location: File menu > Working Directory 

Toolbar short cut for setting a working directory:    
  
Mold and Die Users: 
Mold and Die Location:   Setup page > Work Directory 

Notebook Feature:       

  
Cutter Grinder Users: 
Cutter Grinder Location:   Setup page > Work Directory 

Notebook Feature:       

  

Opens a window enabling you to set the working directory where you can open and save 
VERICUT files. After setting the working directory (see how), VERICUT will look here 
by default whenever files are saved or opened. You can also quickly access files in this 
directory via the Working Directory entry in the file selection window Shortcut list.  

Most features on this window are standard file selection window features that enable you 
to navigate through directories, filter files, and type or select file names. In this case, all 
that is required is to select a directory. 
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Properties window 
  
VERICUT Users: 
VERICUT Location: File menu > Properties 

  

Mold and Die Users: 
Mold and Die Location:   Other Settings page > Session Properties 

Notebook Feature:        

  

Cutter Grinder Users: 
Cutter Grinder Location:   Other Settings page > Session Properties 

Notebook Feature:       

  

Opens a window to set properties for the verification session, such as: cut mode, 
resolution and tolerance values that affect cut model display, accuracy, and motion 
simulation. 

 

 
 

General tab — Features on this tab establish general properties for the VERICUT 
simulation session. 

Tolerance tab — Features on this tab set tolerances for the overall simulation session. 
These values are used by VERICUT to construct the solid database for machining, 
simulate circle motions, identify errors related to material removal, and work with conic 
solid models. 
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OK — Saves the window settings and closes the Properties window. 

Apply — Saves the current window settings and leaves the Properties window open. 

Cancel — Closes the Properties window without saving changes. 
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Properties window, General tab 
Location: File menu > Properties 

 

Features on this tab establish general properties for the VERICUT simulation session. 

 

 
 

Default Machining Type — Sets the machining mode for VERICUT.  

Options: 

Mill — A spinning tool removes material when in contact with Stock/Fixture. 

Turn — A Spindle spins the Stock/Fixture assembly and a stationary tool (not 
spinning) removes material when in contact with Stock/Fixture. 

Wire EDM — An electrically charged wire removes material when in contact with 
Stock/Fixture. 

The machining type can be changed during the simulation using a VERICUT-
MODAL record (APT or G-code tool paths) or via the 
VC_ModeMilling/VC_ModeTurning NC control macros (G-code tool paths only). 

 

Stock Consistency Check — When selected, VERICUT checks the consistency of stock 
models, including: check for "watertight" solid- repair improperly trimmed surfaces 
(overlaps and gaps), and reconstruct insignificant missing surfaces. This option is highly 
recommended for stock models creating from importing IGES data, and other model files 
where portions of the stock model disappear, or gaps/seams appear in the model when 
cutting is started. 

Model Export Cut Mode — When toggled "On", causes VERICUT to cut with a more 
accurate internal cutter representation for better results when using modules like Model 
Export or OptiPath. Only toggle "On" when the additional accuracy is required as it can 
have an impact on processing speed. 
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Properties window, Tolerance tab 
Location: File menu > Properties 

 

Features on this tab set tolerances for the simulation. The tolerance values control the 
accuracy of the cut stock model, simulated circular motion and other interpolated 
motions, whether or not certain errors get written to the error log, and the accuracy of 
cylinders, cones and other revolved models and tool assemblies for collision checking. 

 

 
 

Interpolation Tolerance — This value is used to interpolate intermediate positions 
during NURBS, circular, and helical motions. This tolerance is also used by the Detect 4-
Axis Rotary Motion APT setting to determine if sequential GOTO locations can be 
performed as a single 4-axis motion- ref. Project menu > Processing Options > APT 
Settings: Rotary tab. 

Minimum Error Volume — This value sets a threshold for the minimum volume of 
material that must be removed by a fast feed motion or holder collision in order for an 
error to be reported. If the volume removed by an error motion is less than this value then 
no error is reported in the log file or logger for the motion, and the error count is not 
incremented.  

However, any volume of material removed by a fast feed motion or holder is always 
shaded in the error color (typically red), regardless of the volume. Thus small volume 
errors may be shaded red but will not be reported in the log file or logger if the volume is 
less than Minimum Error Volume.  

The Minimum Error Volume value is in cubic units (inch or millimeter). Use this setting 
to filter very small fast feed and holder collisions from VERICUT's error reports. The 
default value "0" causes VERICUT to calculate a small internal value based on stock size 
and cut tolerance. 

Model Tolerance — This value is used when displaying revolved models such as 
cylinders, cones, and revolved profiles. It is also used when displaying the revolved 
image of a turning stock model created from an IGES profile. Accuracy of cylindrical 
tool assemblies displayed in a machine view are also affected by this value. 
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This value has a small effect on collision checking accuracy for revolved models used to 
represent machine components or fixtures. 

Cutting Tolerance — This value sets the accuracy of VERICUT's cut stock model. The 
Base Cut Tolerance on choices below determine how the value is used to establish the cut 
stock accuracy. Increasing the Cutting Tolerance value increases the speed of the 
simulation and various other operations, and uses less memory, but reduces the accuracy 
of the cut stock model. Decreasing the value improves accuracy of the cut stock model, 
but reduces speed and increases the memory required by the cut stock model. 

The cutting tolerance affects the accuracy and speed of  AUTO-DIFF, Model Export, and 
OptiPath. A smaller Cutting Tolerance produces more accurate results but takes longer to 
process. VERICUT's ability to detect small holder collisions and fast feed errors are also 
affected. The speed of dynamic rotate/pan/zoom operations and the time required to 
create the refined image in the workpiece view are also affected. 

NOTE:  This feature is only available when the first setup in a project is active. For 
subsequent setups, this feature is grayed out. 

Base Cut Tolerance on — Controls how VERICUT applies the Cutting Tolerance to set 
the accuracy of the cut stock model. 

Tool Size — When selected, VERICUT scans the current tool path files and analyzes the 
geometry of all cutters used by the NC programs. The Cutting Tolerance value is applied 
as a chordal deviation on curved tool shapes (diameter, corner radius, etc). The smallest 
calculated chord length or cutter profile segment is then used to set the accuracy of 
VERICUT's cut stock model in order to reliably create cut features with the tools used by 
the current NC programs. This option is recommended when faster simulation speed is 
important. This is the default setting. 

Stock Size — When selected, VERICUT applies the Cutting Tolerance value directly, 
creating the cut stock model at the specified accuracy. The tool path files are not scanned 
to detect the cutters used. The value represents the size of the smallest cut feature 
VERICUT can detect.  

NOTE:  It is very important to understand that the value represents the size of a cut's 
volume measured in any direction. Thus, cuts that are larger than the Cutting Tolerance in 
at least one direction will be detected by VERICUT.   

For example, a .001" axial depth cut by a .25" ball end mill produces a volume with the 
following shape: 
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As a general practice, setting Cut Tolerance Based on Stock Size to one-fourth (1/4) the 
size of a cut volume's span will detect the cut. Thus in this case, to detect a .001" deep cut 
by a .25" ball end-mill, set Cut Tolerance to .007" or smaller. However, results can vary 
depending on the shape of the cut volume. 
The Stock Size option is recommended when an exact value is desired for VERICUT's 
cut stock model accuracy, independent of the tools used. 
NOTE:  This feature is only available when the first setup in a project is active. For 
subsequent setups, this feature is grayed out. 
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Preferences window 
Location: File menu > Preferences 

  

Opens a window enabling you to specify the VERICUT project file (.VcProject) that you 
want displayed when you start a the next VERICUT session. 

  

 
  

Open standard VERICUT project — When toggled "On", the standard VERICUT 
project is displayed upon startup. The standard VERICUT project is either 
vericut.VcProject, or vericutm.VcProject,  in the "library'" directory of your VERICUT 
installation depending on the way environment variable, 
CGTECH_DEFAULT_UNITS, is set.  

Start a new project — When toggled "On", the VERICUT session opens ready to start a 
new project. 

Open last project — When toggled "On", the new VERICUT session opens with the 
same project file that was open when you closed the previous VERICUT session. 

Choose project file on startup — When Toggled "On", VERICUT displays the Open 
Project window at startup enabling you to select a project file. 

  

OK — Saves the window settings and closes the Preferences window. 

Cancel — Closes the Preferences window without saving the window settings. 
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Convert 
 
See Converters and CAD/Cam Interfaces in the VERICUT Help Library.
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Custom Interface 
Location: File menu > Custom Interface 

Toolbar short cut for accessing Custom Interface:    

 

Opens a file selection window that enables you to select an existing custom VERICUT 
User Interface for use; or for editing an existing, or creating a new custom interface with 
VERICUT Customizer. 

  

 
  

Folder "tree"— Enables you to specify the location for new custom interface folder or 
select an existing custom interface folder. All files related to the notebook and custom 
interface are stored in this folder. 

Shortcut — Displays the Shortcut option list providing quick access to files in your 
Working Directory, or CGTech library and sample files. Use the "Folder Up" icon to 
move to the next higher level in the Folder "tree". 

Folder — Use this text field to enter a /path/folder name to open an existing custom 
interface notebook, or to create a new custom interface folder and open a new "empty" 
custom interface notebook. You can also  use the Folder "tree" to specify the path then 
append the name for the new custom interface folder in the text field,. 

OK — Opens an existing custom interface notebook or creates the new custom interface 
folder and displays new "empty" custom interface notebook. 

Cancel — Ends book selection and returns to VERICUT. 
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Introduction to VERICUT Customizer 
The VERICUT Customizer, or "Customizer", is a standard VERICUT feature that 
provides the tools to create a custom simplified VERICUT User Interface. VERICUT 
Customizer is designed to simplify VERICUT usage for specific jobs or classes of jobs. 

Include only the VERICUT functionality that you need in a custom interface and 
eliminate the need to search through the wide range of features that are presented in 
VERICUT's "full function" standard user interface to find the ones they need to use.  

VERICUT Customizer:  

• Enables you to graphically arrange and label buttons, choice lists, check boxes, 
etc. in a way that is most meaningful in your particular work environment. 

• Enables you to include instructions and pictures within the interface to prompt or 
explain to the user how to use VERICUT to accomplish their job. 

• Enables you to produce a simplified user interface that will make "new" or 
"occasional" VERICUT users productive with minimal training. 

  

What does a custom VERICUT interface look like? 

 
 

A custom VERICUT interface consists of two main parts, the "notebook" and the 
VERICUT main window. 
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Notebook 
This is a simplified VERICUT user interface. It has been designed for a particular type or 
class jobs. It contains only the functionality essential to the particular job type without the 
complexity of the standard "full functionality" VERICUT user interface. A notebook can 
be created with both "feature" and "help" pages.  

Feature Pages -  
Contain features (buttons, text fields, choice lists, etc.) that enable you to pass 
necessary information to VERICUT for processing. Each of the features selected 
for use on the feature pages can be labeled in the language and/or terminology 
that is most appropriate for the intended end user. Feature pages use XML files to 
store feature information. 

Help Pages -  
Used to include instructions, explanations and pictures within the custom 
interface to assist the user in providing the necessary information to VERICUT. 
Help pages are HTML files and GIF or JPEG images to illustrate the instructions. 

 

VERICUT Main Window 
The VERICUT main window in a custom user interface is similar to the standard 
VERICUT main window without the main menu bar and a lot less icons. This makes 
using VERICUT much easier to use for those who do not need the full range of 
functionality provided by the standard VERICUT user interface.  

  

What is involved with creating a custom VERICUT interface? 
Creating and deploying a custom interface for use by VERICUT users involves the 
following seven steps. Each of the steps listed below is described in the following 
section. 

1. Set up a default user file. 

2. Creating the notebook. 

3. Determining the size of the notebook. 

4. Adding custom interface features. 

5. Adding custom interface help. 

6. Test the custom interface. 

7. Make the custom interface available for use. 
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Setting up the Custom Interface Default Project File 
  

Each customized interface notepad references a default project file. This project file is 
retrieved by VERICUT each time the notebook is opened. It is advisable to preset as 
many parameters as possible in the default project file. Doing this will minimize the 
number of features that will be required in the customized interface notebook and make it 
much simpler to use. 

It cannot be stressed too much that the key to creating a concise, easy to use custom 
interface is attention to detail in the design of the default project file. While there are 
seven steps involved in creating a custom interface, it is estimated that as much time will 
be spent on this first step as the other six put together. If you get the default user file 
right, the remaining steps to create the custom interface will be much easier and the 
resulting notebook will be much simpler to use. 

The following topics should be considered when setting up a default user file for use with 
a specific notebook: 

• Use of colors  

• Cut mode (Standard or FastMill)  

• Units  

• Tolerances  

• Conditions for AutoSave  

• Layout, orientation and attributes of Views  

• Configuration of status window  

• Report, log and result file names  

• Machine and fixture models  

• Toolpath type  

• Tool change technique  

• Motion, G-Code and APT settings  

• Location of stock model within stock component  

• Tool and OptiPath library  

• Control parameters  

• Machine parameters  

Many of the parameters associated with the above topics can be set using features 
displayed on the feature pages of the notebook, but if they are not going to change, there 
is no reason to include them in the notebook. Just set them in the default project file. 
After all, the purpose of the custom interface is to simplify the use of VERICUT.  
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In many instances, creating multiple notebooks that reference different default user files 
can simplify the use of a custom interface. For example, if you are creating a notebook to 
lead a machine operator through processing a toolpath in VERICUT before running it on 
the machine, it could be beneficial to create a notebook and corresponding default user 
file for each machine/controller combination on the shop floor. That way the operator 
does not have to enter machine/controller information every time. Just call up the 
appropriate notebook enter the toolpath information, then process.  
   
Notebooks should be created in such a way that the user is can only save the user file 
with their input under a different name. Default project files should also have permissions 
set as "read only" and stored in "write protected" directories and folders so they do not 
accidentally get modified.  
   
   
Now that you have tailored a project file for the notebook you intend to create, it's time to 
create the notebook.  
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Creating the Custom Interface Notebook 
  
Creating a custom interface notebook: 
Select File > Custom Interface in the VERICUT main menu to display the Select book's 
folder window shown below. 
  

 
 

 Folder "tree"— Enables you to specify the location for the custom interface folder. All 
files related to the notebook and custom interface are stored in this folder. 

Shortcut — Displays the Shortcut option list providing quick access to files in your 
Working Directory, or CGTech library and sample files. Use the "Folder Up" icon to 
move to the next higher level in the Folder "tree". 

Folder — Use this text field to enter a /path/folder name, or use the Folder "tree" to 
specify the path and append the name in the text field, for the new custom interface 
folder. 

OK — Creates the folder and displays the new custom interface notebook. 

Cancel— Ends book selection and returns to VERICUT. 
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The notebook: 
  

 
  

Notice that when the notebook is created it contains no pages. Adding pages will be 
discussed later. The custom interface notebook header shows the folder that the notebook 
is associated with. The main menu bar contains the following options: 

  

File: 
Open — Displays the Select book's folder window allowing you to open another custom 
interface notebook for editing or create a new notebook. 

Recent — Displays a list of recently opened files. To open a file in the list, select the 
desired file. 
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Close Book — Closes the VERICUT custom interface and displays the standard 
VERICUT interface. 

Exit VERICUT — Ends the VERICUT session. 

  

Layout: 

 — Positions the notebook on the left side of the VERICUT main window. 

 — Positions the notebook on the right side of the VERICUT main window. 

 — Overlays the notebook on top of the VERICUT main window. Left click on 
the notebook's header and drag to any position.  

Minimize — Reduces the notebook size to only display the custom Interface header 
and main menu bar. 

One Page — Use to display the custom interface notebook as a single page. 

Two Pages — Use to display the custom interface notebook as two pages. 

  

Help: 
On VERICUT — Starts VERICUT Help. 

About VERICUT — Opens a window that displays information about the current 
VERICUT session. 

  

Notebook modes: 
User mode:  
When a notebook is in "user" mode it can only be used to interact with VERICUT. It 
cannot be modified or edited in any way. When a notebook is opened, it is always in 
"user"mode, even when it is new and empty. If password protection for "author" mode is 
in effect, the following window will be displayed when the F7 key is used to enter 
"author"mode: 

 

Password — Enter the correct password in the text 
field and select Unlock to allow entry to "author" 
mode. 

Unlock — Use with password above, to allow 
entry to "author" mode. 

Cancel — Use to dismiss the access window. 
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Author mode: 
When a custom interface notebook is in "author" mode, pages and features can be added 
or removed, text and labels can be edited and the size of the notebook can be changed. 
Use the F7 key on the keyboard to switch between "user" and "author" modes. When you 
are in "author" mode, the notebook changes as seen in the illustration below. 

 
Notice that "(284x554)" has been added to the end of the menu bar. This number 
represents the current size of the notebook in pixels. While you are in "author" mode you 
can change the size of the notebook. Click on one of the corners or edges and drag to 
change the notebook size like any other window. The size of the notebook that is set in 
"author" mode is what the user will have to work with. The size of the notebook is fixed 
for the user. The position of the notebook can be changed by the user but not the size. See 
Sizing the Custom Interface Notebook below, for more information on determining the 
appropriate size for the notebook. 
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Notice also that a row of icons has been added to the sides of the notebook. The icons on 
the right are used to add or remove pages and save the notebook. The icons on the left are 
used to edit the text on notebook help pages. They remain grayed out and inactive until 
help pages are added to the notebook. 

Finally, the following options have been added to the File menu: 

User File — Enables you to specify the default .usr file that is associated with the 
custom interface notebook. 

Protect — This item enables the author to prevent the user from entering "author" 
mode without entering a password. Selecting Protect displays the Protection window 
which enables you to specify whether or not to use password protection for the 
notebook while in "user" mode and to specify a password. 

 

 

Password — Enter a password in the 
text field that will allow entry to 
"author" mode. 

Lock — Use to turn on password 
protection for "author" mode. 

Unlock — Use to turn off password 
protection for "author" mode. 

Cancel — Use to exit the Protection 
window without making changes. 

 

To add password protection for entering "author" mode: 

1. Type a password in the text field. 

2. Select the Lock button. 

3. Save the notebook using the Save all changes icon. 

The next time that the notebook is opened, if the user uses the F7 key to enter "author" 
mode, they will be prompted to enter the password before being allowed into "author" 
mode. 

Use the Unlock button while in "author" mode to remove an existing password 
protection. 

  

Allow Close — This item enables the author to prevent the user from exiting the custom 
VERICUT interface and returning to the standard VERICUT interface. This item toggles 
"on" and "off". 

If Allow Close is toggled "on" (indicated by a checkmark), the Close Book option will 
appear in the File menu when in "user" mode allowing the user to exit the custom 
VERICUT user interface and return to the standard VERICUT user interface. 

204204



VERICUT HELP – File menu 
 

 If Allow Close is toggled "off" (indicated by no checkmark), the Close Book option will 
not appear in the File menu when in "user" mode preventing the user from exiting the 
custom VERICUT user interface and returning to the standard VERICUT user interface. 

  

Adding pages to the notebook: 
Before you can add features or help text to the notebook you need to add pages. Add any 
combination of feature pages and help pages. Keep in mind that two pages are displayed 
at once. It makes a lot of sense to have alternate feature pages and help pages. One 
advantage of this user interface style is that it can lead the user through a specific 
sequence of steps. 

Use the icons illustrated below to add pages to or remove pages from the notebook. 

NOTE:  If you do not see the icons below on the right side of the notepad, you are not in 
"author" mode. Use the F7 key on the keyboard to switch to "author" mode. 

  

  

  

 

  

Help Page   

Feature Page 

  

 

  

Remove Upper Page 

 Insert Upper Page 

 Insert Lower Page 

 Append Page 

 Remove Lower Page 

 Save all changes 
  

  

Remove upper page — Use to remove the displayed upper page from the notebook. 

Insert upper page — Use to insert a page into the displayed upper position of the 
notebook. Select HTML or Form from the pop-up menu to specify the type of page to 
create. 

HTML — Use to create a help page.  

Hint: You can tell a help page by its white background. 

Form — Use to create a feature page. 

Hint: You can tell a feature page by its gray background. 

Insert lower page — Use to insert a page into the displayed lower position of the 
notebook. Select HTML or Form (described above) from the pop-up menu to specify the 
type of page to create. 
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Append page — Use to add a page to the end of the notebook. Select HTML or Form 
(described above) from the pop-up menu to specify the type of page to create. 

Remove lower page — Use to remove the displayed lower page from the notebook. 

Save all changes — Use to save all changes made to the notebook. This includes 
notebook size changes, pages added or removed, and page content added or edited.  

NOTE:  There is no "undo" capability in "author" mode so saving often is highly 
recommended. 

  

Once you have added some pages, use the following to move around in the notebook. 

Click on one of the "dog-eared" corners in the upper page (or use the Page Up key on 
the keyboard) to turn back one page in the notebook. 

Click on the one of the "dog-eared" corners in the lower page (or use the Page Down 
key on the keyboard) to turn forward one page in the notebook. 

Use the Ctrl and Home keys on the keyboard at the same time to move directly to the 
first page of the book.  

Use the Ctrl and End keys on the keyboard at the same time to move directly to the 
last page of the book. 

  

Now that you have created the notebook, it's time to decide on the size of the notebook. 
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Sizing the Custom Interface Notebook 
A customized interface notebook retains the size set while in "author" mode and cannot 
be changed by user. This is because information on one page does not reposition to the 
next page if the size of the notebook is reduced, nor are scroll bars used if a page contains 
more information than will fit. To do so would be contrary to the idea of a simplified user 
interface.  

You need to decide on the size of the notebook, which in turn determines the size of its 
pages, before you start adding content. The size of the notebook can be changed later, but 
if you make it smaller you may be spending a lot of time cutting and pasting between 
pages.  

To help determine the appropriate size for the notebook, try to answer the following 
questions: 

1. What is the resolution of my target user's screen?  

2. How large does the VERICUT main window need to be?  

3. How much space to the left or right of the VERICUT main window remains for 
the notebook? Positioning the notebook on either of the main window is clearly 
preferable. 

If the answer to this last one is "Not enough!", is it reasonable to overlay the 
notebook on top of the VERICUT main window?  

As a starting point, you might try allocating 3/8ths of the screen's width for the notebook. 
You can adjust the notebook size by dragging its edges or corners as you would any other 
window. The numbers on the right side of the notebook's menu bar will continuously 
update as you re-size the notebook. If your target screen resolution is 1280 x 1024, and 
you have decided to allocate 3/8ths of the width to the notepad, you could manipulate the 
window until you see (480 x 990), leaving some space for the Windows taskbar.  If your 
target user has a Windows based platform, you do not want to use screen's full height or 
the notebook will be partially hidden behind the Windows taskbar.  
   
Use the Save all changes icon ( ) located on the right side of the notebook to save the 
notebook with its size and position.  
   

Now that you have established the size of the notebook, and thus the size of its pages, 
you can add features to the pages. 
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Creating Custom Interface Feature Pages 
  

Now that you have created and sized the notebook, it is time to add features to the feature 
pages. The user interacts with features in the notebook to enter numbers, select files, 
make choices from a limited set of options and see results. As the author of a custom user 
interface notebook it is your task to arrange a collection of features so the user can 
specify all the parameters needed to get his or her job done. The way that you lay out the 
features within the notebook, and use help pages, enables you to lead the user through a 
logical sequence of actions to accomplish the required task. 

If your notebook does not yet contain feature pages, or you need additional ones, use the 
procedure described in Adding Pages to the Notebook to add them. 

  

Feature Page Layout: 

 
  

A "feature" page is easily distinguished from a "help" page by its gray background. 
Features can only be added to "feature" pages. They cannot be added to "help" pages. In 
order to add features to the page you must be in "author" mode. 

Within a page, features are laid out in two columns. The left column will only be as wide 
as the widest feature that it contains. All features placed in the right column will expand 
to fill the remaining width. Use blank spaces within features in the left column to control 
sizing of the two columns. Adding blank spaces to the longest feature in the left column 
will increase the width of the left column, thereby decreasing the width of the right 
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column. Add or remove blank spaces to the longest feature in the left column until the 
desired column balance is achieved.  

Typically the left column will contain labels explaining the purpose of the corresponding 
feature in the right column, although you are not restricted to this convention. The first 
feature that you place in a form will always go to the left column. 

  

What Features Are Available? 
The following feature types are available for use in any combination on the feature pages 
of your notebook. 

FEATURE DESCRIPTION 

 
Labels the purpose of adjacent features. 

 

Text Fields are used to enable the user to input 
character information to, or receive results 
from VERICUT. 

 

Numeric Fields are used to input one or more 
numeric values. Can also be used to input 
numeric data requiring calculations like 
"3+31/64". 

 
File Selection Boxes are used to input file 
names or browse for the file using the icon. 

 

Choice Lists are used to present a limited set 
of options in a drop-down list 

 
Check Boxes are used for options requiring 
only a simple on/off condition. 

 

Radio Buttons are used as an alternate method 
of presenting a limited set of options. There 
can only be one set of radio buttons used on 
each feature page. Only one of the radio 
buttons will be active at a time. When one is 
selected, all others in the set become 
deactivated. 

 
Buttons are used to trigger actions like file 
conversion or display a secondary window. 

 
MDI Buttons are used to input machine 
control functions. 
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MDI Numeric Fields are used to input numeric 
data to machine control functions. 

  
 
Adding Features: 

 

While in "author" mode (use F7 key on your keyboard if necessary 
if necessary), move the cursor to an unoccupied area of the page 
and click the right mouse button. You will see a pop-up menu like 
the one shown on the left, enabling you to select one of the various 
feature types described above. As each feature is added to the page 
you will notice that initially they contain question marks "???" for 
text. Type over the "???" with the desired text. You can edit the 
text of an existing feature by clicking in it and making the changes. 
Remember that features on the page are positioned in just two 
columns. The first feature is added in the left column. Initially it 
appears in the center of the page. As soon as you add another 
feature to the right of it, it repositions the first one from the center 
to the left edge of the page. 
Continue adding the desired features to the page, or until the page 
is full. At that point, add another feature page and continue. Note 
that you can insert a feature between two existing rows by 
carefully positioning the cursor between them. 

  

 

You may have noticed that the pop-up menu of feature types has another 
choice, Paste, that we have not discussed yet. If you right-click on one of 
the features that you have already put on the page, you will see the pop-up 
menu shown on the left. Select either the Cut or Copy options, then right-
click on an empty area of the page. The feature type pop-up menu discussed 
above will display. Selecting the Paste enables you to move or copy the 
feature. This is also the way that you can move or copy features to another 
page if necessary. Delete enables you to remove an existing feature from 
the page. 

  
 
Connecting the Features to VERICUT: 
To this point the features that you have added to your notebook may look great but they 
are not yet functional. They need to be connected to the parameters and functions of 
VERICUT so that they produce the desired result when put to use by the user. These 
connections to VERICUT are accomplished by using the Details option that appears 
when you right-click on a feature. This is the same pop-up menu that contained the Cut 
and Copy options discussed above. 

 The interaction that follows is dependent on the feature type, although some feature 
types require similar interaction. Each of the topics listed below is described in detail on 
the following sections. 
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Labels and Text Fields  

Numeric Fields  

File Selections  

Choice Lists and Radio Buttons  

Check Boxes  

Buttons  

MDI Buttons and Numeric Fields  

   
Once you have finished adding functional feature pages to the notebook, it's time to add 
some help pages.  
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Custom Interface - Labels and Text Fields 
While in "author" mode, right-clicking on either a label or a text field on a feature page 
and selecting Details, displays essentially the same window. The only difference is that 
the one for label features has a set of radio buttons that enable you to adjust its alignment. 
The tree that dominates these windows is identical. It is organized to reflect VERICUT's 
menu structure. Each "leaf" in the tree represents a text parameter. When selecting 
between using a label or a text field, keep in mind that a user can only read a label, but 
can edit the content of a text field. Most label features in a notebook will not need to be 
associated with a VERICUT parameter. They will simply be used to describe other 
features on the feature page. 
To connect a feature to a parameter, simply expand the tree till you find the parameter 
you are looking for, select it and click OK. You can also use these windows to check on 
an existing association, in which case you would use the Cancel button afterwards.  
  
Label Feature Window   

  
  
  
Label features can be used to display the text 
output of certain VERICUT parameters. The label 
feature window to  the left illustrates how a label 
can be used for this purpose. The label is associated 
with the second line on X-Caliper's Feature/History 
tab, which presents the coordinates of a selected 
geometry feature's datum (such as a sphere's 
center). When the user selects a geometry feature in 
the VERICUT graphics area, the text of the label 
will change to display the resulting text, just as it 
would be displayed in the X-Caliper window. 
 It is also possible to associate a text field feature 
with such a parameter, but it is probably not a good 
idea to do so unless the user will need to copy and 
paste the text to another application.  
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Text Feature Window   

  
  
  
The text feature window to the left illustrates how a 
text field feature can be associated with the 
operating system's print command for use by 
VERICUT's ShadeCopy function.  
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Custom Interface - Label/Text Field Parameter List 
  
  

File Shade Copy Print Command   
    Annotation   
        
        
Setup Motion Start At   
    Stop At   
        
  G-Code Block Skip Character   
        
  APT Settings Rotation Center   
    Goto Format   
        
        
Analysis X-Caliper  Feature/History Feature 1 
      Feature 2 
      Feature 3 
      Feature 4 
      Feature 5 
      Feature 6 
      History 1 
      History 2 
      History 3 
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Custom Interface - Numeric Fields 
  

While in "author" mode, right-clicking on a numeric field on a feature page and selecting 
Details, displays the window illustrated below. The title of the window is the current text 
from the numeric field. Note that you can also specify the maximum number of decimal 
places used to display the parameter. For an integer, such as the number of cuts between 
automatically saved ShadeCopy images, use zero decimal places.  

The tree that dominates the window is organized to reflect VERICUT's menu structure. 
Each leaf in the tree corresponds to a numeric parameter that appears in one or more of 
VERICUTS's standard user interface windows. Each of them can be placed on a feature 
page independently, though some will almost always appear in sets.  A good example is 
the direction of the light that illuminates each view, represented by an (I, J, K) vector. 
The three parameters that control the location of a stock model relative to the stock 
component's datum are another, but they can be combined with three choice lists to 
provide some extra functionality that is not currently available in the standard VERICUT 
user interface. 

To connect a feature to a parameter, simply expand the tree until you find the parameter 
you are looking for, select it and click OK. You can also use these windows to check 
existing associations, in which case you would use the Cancel button afterwards.
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Numeric Field Feature Window   

  
  
  
Defining the three dimensions of a stock block is 
another good example. 
 In the numeric field feature window displayed on 
the left, a numeric field feature is associated with 
the Length (X) dimension of a stock model block. 
When combined on the feature page with numeric 
fields associated with the Width (Y) and Height (Z) 
values, the user can quickly and easily define a 
stock block 
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Custom Interface - Numeric Field Parameter List 
  
  
File Convert IGES   Tolerance 
          
    Surface   Tolerance 
        Offset 
        Base Location 
          
    VDAFS   Tolerance 
          
    Binary CL   Minimum 

Cutter Height 
          
  Model Export Grid Count     
    Global Angle     
    Tolerance (Grid)     
    Plane Size     
    Number of Slices     
    Local Angle     
    Tolerance (Slice)     
          
  Properties Circle Radial 

Tolerance 
    

    Interpolation 
Tolerance 

    

    Minimum Error 
Volume 

    

    Model Tolerance     
    Cutting 

Tolerance 
    

          
  AutoSave In Process # of Cuts   
          
    Shade Copy # of Cuts   
          
      Margins Left 
        Right 
        Top 
        Bottom 
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      Render   
        Width 
        Height 
          
      View Angle   
          
    VERICUT Solid # of Cuts   
          
          
          
View Attributes Light (IJK)     
          
  Section Cuts     
    Delay     
          
          
Model Block Length (X)     
    Width (Y)     
    Height (Z)     
          
  Auto Block Offset     
          
  Cone Height (Z)     
    Base Radius     
    Top Radius     
          
  Cylinder Height (Z)     
    Radius     
          
  IGES File Tolerance     
    Offset Amount     
    Base Location     
          
  Location 

Relative tp 
Parent 

X     

    Y     
    Z     
          
          
Setup Motion Start At Line Number   
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    Stop At Num of Cuts   
      Line Number   
          
    Stop At Max 

Errors 
    

    Stop At Max 
Warnings 

    

    Fast Feed     
    Skip Cut     
    Min. Cutter 

Height 
    

    Holder 
Clearance 

    

          
  G-Code Settings   Ignore Data 

after Column 
        Rotary Feed 

Motion Tol 
        Rotary Rapid 

Motion Tol 
          
    Turning   CSS Maximum 

RPM 
          
    WireEDM   Wire Diameter 
        Work Table XY 

Plane 
        XY Plane to UV 

Plane 
          
  APT Settings Max Tool Axis 

Angle 
    

    Tool Axis Reset 
Angle 

    

    Default 
CLEARP 

    

    GOHOME R 
Dist 

    

          
  Machine Default Near 

Miss 
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Analysis AUTO-DIFF Solid Gouge 
Tolerance 

  

      Excess 
Tolerance 

  

          
    Point Gouge 

Tolerance 
  

      Excess 
Tolerance 

  

      Gouge Check 
Distance 

  

      Excess Check 
Distance 

  

      Default 
Normal (IJK) 

  

          
    Profile Gouge 

Tolerance 
  

      Excess 
Tolerance 

  

          
    Constant Gouge 

Check 
Tolerance   

          
    Compare by 

Region 
Minimum 
XYZ 

  

      Maximum 
XYZ 

  

          
          
OptiPath Override All 

Feedrates % 
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Custom Interface - File Selection 
  

While in "author" mode, right-clicking on a file selection feature on a feature page and 
selecting Details, displays the window illustrated below. The title of the window is the 
current text from the feature, in this case the file's path and name.  

The tree that dominates the window is organized to reflect VERICUT's menu structure. 
Each "leaf" in the tree represents an input or output file.  

To connect a file selection feature to a file type, simply expand the tree till you find the 
file type you are looking for and select it.  To connect a widget to a file type, simply 
expand the tree till you find the one you are looking for and select it. 

You can also supply a prompt which will be used in the file selection window when the 
user clicks on the browse icon ( ) to the right of the feature. If the file type has one or 
more commonly used extensions, you can specify them as a filter for this window also. In 
this case we have just used "*.olb" to narrow the choices to OptiPath libraries, but for 
toolpaths you could use a compound filter, such as "*.tp;*.apt;*.cls". The user can always 
override the filter.  

When you are satisfied with the properties of the file selection feature, click on the "OK" 
button. You can also use these windows to check existing associations, in which case you 
would use the Cancel button afterwards.  
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File Selection Feature Window  

 

  
  
  
  
  
In the example window on the left, a file 
selection feature is being associated with the 
OptiPath library. 
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Custom Interface - File Selection Parameter List 
  
  
File User File     
  Working Directory     
        
  Convert IGES Input File 

      Output File 
        
    PolyFix Input File 
      Output File 
        
    Surface Input File 
      Output File 
        

    VDAFS Input File 
      Output File 
        
    Binary CL Input File 
      Output File 
      APT Table File 
        
    Export Model File   
    Edit   
        
  ShadeCopy Output File   
        
  AutoSave In Process Auto Save 
      Auto Error 
        
    Shade Copy Auto Save 
      Auto Error 
        
    VERICUT Solid Auto Save 
      Auto Error 
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Info G-Code Report     
  Control Report     
        
        
Model Stock Model File   
    IGES File   
        
  Design Model File   
    IGES File   
        
  Cut Stock     
        
        
Setup Toolpath     
  G-Code APT Output File   
    G-Code Log File   
  Tool Library     
  Control     
  Machine     
        
        
OptiPath OptiPath Library     
  Optimized File     
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Custom Interface - Choice Lists and Radio Buttons 
  

While in "author" mode, right-clicking on either a choice list or radio button on a feature 
page and selecting Details, displays essentially the same window. The only difference is 
that the one for choice list features has a table of choices at the bottom of the window and 
the one for  a radio button feature has a single drop-down list. The title of  the window is 
either the text of the current choice in the choice list or the caption of the radio button.  

The tree that dominates these windows is identical. It is organized to reflect VERICUT's 
menu structure.  Each "leaf" in the tree represents a set of choices for a single parameter.  

To connect a feature to a parameter, simply expand the tree till you find the parameter 
you are looking for and select it. Select an option from those available in the Choice pull-
down for each Item, then click OK. The interaction is slightly different for choice lists 
and radio buttons and described in more detail below. You can also use these windows to 
check on an existing association, in which case you would use the Cancel button 
afterwards. 
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Choice List Feature Window 

For a choice list feature, 
selecting a parameter in the tree, 
causes the Choice column of the 
table at the bottom of the window 
to be filled with the set of options 
that are appropriate for the 
selected parameter. Each cell of 
the Choice column is itself a 
choice list containing the set of 
options that are appropriate for the 
selected parameter.   
The text that will appear to the 
user in the choice list appears in 
the Item column of the table. 
Double-click on the item to edit 
the text. You can also edit the text 
for each item in the choice list 
from the feature page while in 
"author" mode. 
To associate each item with a 
particular option: 

1. Click on an item in the 
Item column so that it 
becomes highlighted. 

2. Click on the corresponding 
row in the Choice column 
to expand the pull-down of 
available options. 

3. Click on the option in the 
pull-down to associate it 
with the item. 

4. When you have finished 
associating the items with 
options, click on the OK 
button. 

You can provide the user with a 
more limited set of options than is 
available in the standard 
VERICUT user interface by 
simply including fewer items in 
the Item column.  
The items that you include can be 
in any order. To change the order 
of items, use the small blank 
buttons on the left edge of the 
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table to drag rows to different 
positions. 

  
  
Radio Button Feature Window   

For radio buttons, selecting a parameter in the tree, 
causes the Choice pull-down at the bottom of the 
window to be filled with the set of options that are 
appropriate for the selected parameter. Keep in 
mind that there can only be one set of radio buttons 
on each feature page so when picking a parameter 
for one radio button, you are actually picking it for 
all the others on the page. The same is true if you 
change the parameter associated with a radio 
button. It will change for all the other radio buttons 
on the page also.  
In either case you will need to associate a particular 
option for each individual radio button. 
To associate an option with a radio button, simply 
click on the Choice pull-down to expand it and 
click on the desired option. Click OK. 
The text for radio buttons can only be edited on the 
feature page while in "author" mode. 
As with choice lists, you do not need to include a 
radio button for all of the available options. Include 
fewer radio buttons on the feature page to simplify 
the interaction for the user. 

  

Most of the parameters in the tree correspond to functionality that is available in 
VERICUT's standard user interface. The exceptions are the three parameters located 
under Model > Relative Location. These parameters control the location of a stock 
block model relative to the stock component's datum and when combined on a feature 
page with certain other features provide some extra functionality for automating the 
placement of a stock block that is not currently available in the standard VERICUT user 
interface.  
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Example - Automatic Stock Block Placement 
  

The following example shows how you can use a custom user interface to automate the 
placement of a stock block at the machine origin. This cannot be accomplished using the 
standard VERICUT user interface. 

The upper three numeric field features are 
connected to the X, Y and Z parameters 
respectively, located under Model > Block in 
the numeric field "Details" tree representing 
the length, width and height of a stock block. 
When the user changes one of the values, all 
models in the stock component are replaced by 
a single block with the specified dimensions.  
The lower three numeric field features are 
connected to the X, Y, and Z parameters 
respectively, located under Model > Relative 
Location in the same tree. When the user 
changes one of these values, the origin of the 
block (the X min, Y min, Z min corner)  is 
positioned at the specified offsets. 
The three choice lists in the lower left corner 
are connected to the parameters located under 
Model > Relative Location in the choice list 
"Details" tree. These features are unique to a 
custom interface and do not correspond to any 
of the features in the standard VERICUT user 
interface. They can be used to locate any of the 
block's corners, mid-edges or mid-faces to the 
specified location. As shown in the sample at 
the left, the center of the bottom face of the 
block is designated as the block's origin.  
If a dimension of the block is changed, the 
position of the block remains unchanged. For 
example if block width is increased to 3, it 
would grow by 1/2 a unit in the +Y and -Y 
directions, thereby keeping the center of the 
bottom face position unchanged. 

  

  

 If you decide to use one or more of these choice lists, it is possible to limit the options 
available to the user. Each list can contain up to four choices but not all choices need to 
be included in the list. For example, the list for the Z axis has options for "Z", "Z Low", 
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"Z Mean" and "Z High". You may decide that "Z Mean" makes no sense in your 
application and could omit that choice from appearing the list.  

However, you should never omit the "X", "Y" or "Z" choices from the choice lists. These 
are needed to position the block by specifying values directly in one of the numeric entry 
fields because none of the predetermined positions is appropriate. For example, if the 
block is 1.5 units high and the user enters a Z location of -0.5, the choice list should not 
display "Z Low", "Z Mean" or "Z High". Instead it should be able to display just "Z".  

You can of course alter the text of the choices, so instead of using "Z Low" and "Z High", 
you could display "Z Minimum" and "Z Maximum", or "Bottom Face" and "Top Face" or 
any other suitable text. 

NOTE: The three parameters for automating the location of a stock block are not 
applicable to other types of primitives, such as cylinders, cones, polygon files or IGES 
files.  
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Custom Interface - Choice List/Radio Button Parameter 
List 
  
  
File Convert IGES Output File Type 
      Output File 

Format 
      Normal Direction 
      Surface Input 

Mode 
        
    PolyFix Input File Type 
      Output File Type 
      Output File 

Format 
        
    Surface Input File Type 
      Output File Type 
      Output File 

Format 
        
    VDAFS Output File Type 
      Output File 

Format 
      Normal Direction 
        
    Binary CL Input File Type 
        
  Export Model File Type   
    File Format   
    Output Color   
    Coordinates   
    Units   
    Process   
    Slice Direction   
        
  Colors Brightness   
        
  Properties Default Units   
    Display Resolution   
    Default Machining Type   
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    Base Cut Tolerance On   
        
  Shade Copy Type   
    Method   
    Shading By   
    Orientation   
    Paper Size   
    Light Location   
        
        
View Attributes View Type   
    Draw Mode   
    Background   
        
        
Model Location Relative 

to Parent 
X   

    Y   
    Z   
  Normals     
  Units     
  Visibility     
  Mixed Mode     
        
        
Setup Toolpath Toolpath Type   
    Tool Change By   
        
  Motion Start At   
    Stop At   
    Drill Cycle   
    Tool Display   
    Cut Color Method   
    Control Point   
        
  G-Code Settings Programming 

Method 
        
    Block Skip Apply Switch 

Value 
        
    4-Axis Sync Method   
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  Apt Settings Default Toolpath Units   
    RAPID Motion   
    GOHOME Motion   
    ROTATE   
    ROTABL   
    ROTHED   
    Philosophy   
    Angle Value   
    Direction   
        
  Machine Floor/Wall Orient   
    Ignore Collision between 

Cutter and Stock 
  

        
        
Analysis AUTO-DIFF Stock Display   
    Design Display   
    Comparison Method   
    Comparison Type   
    Normal Direction   
        
        
OptiPath OptiPath Control     
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Custom Interface - Check Boxes 
  

While in "author" mode, right-clicking on a checkbox feature on a feature page and 
selecting Details, displays the window illustrated below. The title of the window is the 
current text associated with the check box. 

The tree that dominates the window is organized to reflect VERICUT's menu structure. 
Each "leaf" in the tree represents an on/off parameter available in the standard VERICUT 
user interface.  

To connect a feature to a parameter, simply expand the tree till you find the on/off 
parameter you are looking for, select it and click OK. You can also use these windows to 
check existing associations, in which case you would use the Cancel button afterwards.  

  

Check Box Feature Window  

 

  
In the example window on the left a check box 
feature is being associated with the on/off flag that 
determines whether an APT output file is 
generated corresponding to the processed G-code 
toolpath. 
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Custom Interface - Check Box Parameter List 
  
  
File Convert Surface Project Rectangle 
        
    Binary CL Output Circles 
        
  Export Model Binary   
    Millimeter   
    Group By Color   
    Detect Scallop Planes   
        
  Colors Recycle Cut Color   
        
  Properties Millimeter   
    Stock Consistency Check   
    Model Export Cut Mode   
        
  AutoSave In Process Cutter Change 
      # of Cuts 
      File End 
      Auto Error 
        
    Shade Copy Print Command 
      Annotation 
      Cutter Change 
      # of Cuts 
      File End 
      Auto Error 
      Color 
      Portrait 
      Add output file to 

Report 
      Render 
      Specify image size 
      Shadows 
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    VERICUT Solid Cutter Change 
      # of Cuts 
      File End 
      Auto Error 
        
View Orient Zoom creates new View   
    Standard Rotation Image   
        
  Section Section on mouse pick   
        
  Axes Component   
    Model   
    Machine Origin   
    Workpiece Origin   
    Coordinate System   
    Tool Tip Zero   
    Driven Point Zero   
    Active Coordinate System   
        
        
Info Status SubSystem   
        
    Position Record Number 
      Toolpath Record 
      Machine Axes 
      Tool Tip 
        
    Tool Record Number 
      Change Record 
      Sequence 
      Geometry 
      Description 
      Number 
      ID 
        
    Status Errors 
      Warnings 
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      Time 
      Time % 
      OP Time 
      Distance 
      Distance % 
      Coolant 
        
    Feed Feedrate 
      OP Feedrate 
        
    Speed Spindle 
      OP Spindle 
        
    OP Info Volume Removal Rate 
      Chip Thickness 
        
    Graph Tool Use 
      Cutting Conditions 
        
        
Model Model File Outward   
    Millimeter   
        
  Component 

Attributes 
Disable Auto Direction   

    Reverse Direction   
        
  Import Offset Surface   
    Extend to Rectangle   
        
  Delete Material Update While Simulating   
        
  Save Cut Stock Save With Features   
        
        
Setup Motion Stop At Max Errors   
    Stop At Max Warnings   
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    No Animation   
    Check for Spindle Off   
    FastMill   
    Ignore Undercuts   
    Display Holder in 

Workpiece View 
  

    Tool/Fixture Collision 
Only (no cutting) 

  

    Calculate Min. Cutter 
Extension 

  

        
  G-Code Settings Process Cutter Comp. 
      Scan Toolpath Files 
      Ignore Data After 

Column 
      Apply Acceleration to 

Cycle Time 
        
    Block Skip Immediate 
      Switch 1  
      Switch 2 
      Switch 3 
      Switch 4 
      Switch 5 
      Switch 6 
      Switch 7 
      Switch 8 
      Switch 9 
        
    Turning RPM changes with 

RAPID and CSS 
        
    Process Options Create Apt Output File 
        
  Apt Settings Millimeter   
    MULTAX   
    Process Circles   
    Reverse Circles   
    Detect Chordal GOTO's   
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    Reset Tool Change   
    Process Unigraphics or 

CATIA Matrix 
  

    Ignore unrecognized 
Major words 

  

        
    Rapid Motion Square 
        
    GOHOME Motion Retract 
        
    Angle Value Absolute 
        
    Detect 4-Axis Rotary 

Motion 
  

        
  Machine Machine Simulation On   
    Transparent Stock   
    Collision Detect   
    Overtravel Detection On   
        
    Axis Priority Pos/Neg 
      Negative 
        
        
Analysis AUTO-DIFF Settings Stock Display 
      Design Display 
        
    Options Design Consistency 

Check 
      Keep Design Solid 
      Disable Report 
      Report Uncut 

Differences 
      Show Point Vectors 
      Constant Gouge Check 
        
    Compare by Region On 
      Apply Regions Over 

Entire Stock 
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      Improve Cut Stock 
Tolerance 
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Custom Interface - Buttons 
  

While in "author" mode, right-clicking on a button feature on a feature page and selecting 
Details, displays the window illustrated below. The title of the window is the current text 
from the button. 

The tree that dominates the window is organized to reflect VERICUT's menu structure. 
Each "leaf" in the tree represents an action available in the standard VERICUT user 
interface.  

To connect a feature to a parameter, expand the tree until you find the parameter you are 
looking for, select it and click OK. You can also use these windows to check existing 
associations, in which case you would use the Cancel button afterwards.  

A button can contain an icon in addition to, or instead of, the caption. An icon is derived 
from a GIF or JPEG file which you select while in this dialog. An icon's height is limited 
to 16 pixels. If you select a larger icon, it will be shrunk to fit within the button's height, 
but its aspect ratio is maintained. The GIF or JPEG file will be copied to the book's folder 
if necessary, so that the entire book can be handled as a unit. Use the Icon field, at the 
bottom of the Button Feature window, to enter or select the image file to use. 

  

Button Feature Window  

 

  
  
  
  
  
In the example window on the left a button feature 
is being associated with a request to browse 
VERICUT's help files. When the user presses the 
button, VERICUT Help will display. 
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Custom Interface - Button Parameter List 
  
  

File User File New 
    Open 
    Save 
    Save As 
      
  In Process Open 
    Save 
    Save As 
      
  Working Directory   
      
  Convert IGES 
    PolyFix 
    Surface 
    VDAFS 
    Binary CL 
      
  Export Model   
      
  Edit Toolpath 
    File 
      
  Colors   
  Properties   
      
  Report Create Text Report 
    Create HTML Report 
    Create PDF Report 
    Report Template 
    User-Defined Tags 
      
  Print   
  Shadecopy   
  Close Book   
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  Exit VERICUT   
      
      
View Layout One View 
    Left and Right 
    Top and Bottom 
    1 Left, 2 Right 
    1 Top, 2 Bottom 
    Four Views 
    Add View 
    Delete View 
    Cascade 
    Tile Horizontally 
    Tile Vertically 
    View to Back 
    Always in Front 
      
  Orient Dialog 
    XY 
    YZ 
    ZX 
    YX 
    ZY 
    XZ 
    H-ISO 
    V-ISO 
    Zoom In 
    Zoom Out 
    Fit 
    Fit All 
    Refine 
    Last Refine Display 
    Reverse 
    Reset 
      
  Attributes   
  Section   
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  Select/Store View   
  Axes   
      
      
Info Toolpath   
  Status   
  Machine Offsets   
  File Summary   
  VERICUT Log   
  Clear Logger   
      
      
Model Model Definition   
  Auto Block   
  Component Tree   
  Load Stocks   
  Delete Material   
  Revolve Profile   
  Sweep Profile   
      
Setup Toolpath   
  Motion   
  G-Code Settings 
    Variables 
  Apt Settings   
  Cycle Definitions   
  Coordinate Systems   
  Tool Manager   
      
  Control Open 
    Save 
    Save As 
    Words 
    Word/Address 
    Mdi 
    Settings 
    Advanced Control Options 
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  Machine Open 
    Save 
    Save As 
    Settings 
      
      
Analysis X-Caliper   
  AUTO-DIFF Dialog 
    Apply 
      
  Comparator   
  Toolpath Review   
  Inspection Sequence   
  Die Sinking Simulation   
      
      
OptiPath OptiPath Control   
  OptiPath Manager   
  Compare Toolpath Files   
      
      
Help Browse   
  About   
      
      
Simulation Reset Model   
  Rewind Toolpath   
  Single Step   
  Play to End   
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Custom Interface - MDI Buttons and Numeric Fields 
  

While in "author" mode, right-clicking on an MDI button feature on a feature page and 
selecting Details, displays the window illustrated below. The title of the window is the 
current text from the MDI button. 

 

MDI Button Feature Window 

In the "SubSystem" field, enter the index 
number of the subsystem (not the 
subsystem name) that the MDI Action 
command is to be applied to.  
In the "MDI Action" field, enter the 
command(s) to be executed when the MDI 
button is pressed by the user, then click 
OK. 
You can also use the window to check 
what command(s) are currently associated 
with the MDI button, in which case you 
would use Cancel afterwards.  
A default MDI button will contain the icon 
( ), in addition to the caption. But you 
can provide another icon from a GIF or 
JPEG file which you select while in this 
dialog. An icon's height is limited to 16 
pixels. If you select a larger icon, it will be 
shrunk to fit within the button's height, but 
its aspect ratio is maintained. The GIF or 
JPEG file will be copied to the book's 
folder if necessary, so that the entire book 
can be handled as a unit.  

  

While in "author" mode, right-clicking on an MDI numeric feature on a feature page and 
selecting Details, displays the window illustrated below. The title of the window is the 
current MDI command combined with the value from the MDI numeric field.
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MDI Numeric Feature Window  

 

In the "SubSystem" field, enter the 
index number of the subsystem (not 
the subsystem name) that the MDI 
Action command is to be applied to.  
In the "MDI Action" field, enter the 
command to be executed when the 
value in the MDI numeric feature 
field is changed or when the MDI 
icon ( ) is pressed, then click OK. 
Use the Decimal Places field to 
specify the maximum number of 
decimal places to display. For an 
integer, use zero decimal places.  
Once you have entered the desired 
MDI Action command and specified 
decimal places, click OK.  
You can also use the window to 
check what command and decimal 
place value is currently associated 
with the MDI numeric feature, in 
which case you would use Cancel 
afterwards.  

As with an MDI button, you can 
change the icon used with an MDI 
numeric field by specifying an 
appropriate GIF or JPEG file. 
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Creating Custom Interface Help Pages 
 

Now that you have created and sized the notebook and added some features to the feature 
pages, it is time to add some help pages to assist the user in using the custom user 
interface to accomplish their job. Use help pages in the notebook to instruct the user on 
how to use the features or guide then through a sequence of actions to accomplish the 
required task. 

A "help" page is easily distinguished from a "feature" page by the white background. 
Only text and illustrations can be added to "help" pages. In order to add, remove or 
modify text or add, remove or replace illustrations to a help page you must be in "author" 
mode (F7 key). 

If your notebook does not yet contain any help pages, or you need additional ones, use 
the procedure described in Adding Pages to the Notebook to add them. 

Help Page Layout: 
 Each help page is created blank. Click on the help page and begin to type your 
instructions. Use the column of icons located on the right side of the notebook (when in 
"author" mode) to position, place emphasis on portions of text or add "style" to your help 
page. Use the bottom icon in the column to add illustrations to your help page. Each of 
the icons is described in more detail below. 

The first four icons are used to control the appearance of the text. They can be used in 
two ways. As you type you can change the current "mode" by clicking on one of the 
icons. Subsequent text will exhibit the change until you click the same icon again to 
revert to regular characters. Or you can highlight an existing portion of the text and 
update its appearance by clicking on one or more of the icons. A double click will 
highlight a word. A triple click will highlight a line. You can also apply multiple style 
types to your text as illustrated here using bold, italics and underline on the same text. 

 

 

Bold 
Italics 
Underline 
Text Color 
Align Left 
Center 
Align Right 
Add image 
Insert Hyperlink 
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Bold — Use to make selected text bold. 

Italics — Use to make the selected text in italics. 

Underline — Use to underline the selected text. 

Text Color — Displays a color pallet enabling you specify a color for text. Pick one of 
the colored squares to proceed. The darker colors show up best on the white background 
of a help page.  

The next three icons are used to control the position of the text displayed on the page. 

Align Left — Use to align the selected text to the left side of the page. This is the default. 

Center — Use to center the selected text on the page. 

Align Right — Use to align the selected text to the right side of the page. 

Add Image — Use to add illustrations to your help page. The images used for 
illustrations can be in GIF or JPEG format. When you select an image file it is copied to 
the notebook folder so that all elements of the notebook are kept together. Each image 
will be centered in the page and will be at its stored size. If you need to adjust the size of 
an illustration, do so with an image editing software before using on your help page.  

Insert Hyperlink — Use create a hyperlink between the highlighted text and an HTML 
file. Highlight the desired text, select the Insert Hyperlink icon, then use the file selection 
box that displays to specify the file to create the hyperlink to. 
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Sample Help Page: 

 
 
The figure above illustrates a simple example of how you can use a help page to instruct 
the user on how to use the features contained on the feature page below. 
  

Now that you have a complete custom VERICUT interface notebook, it's time to do some 
testing. 
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Testing the Custom Interface 
  

While a notebook is in "author" mode, (size displayed adjacent to the menu items and 
columns of icons displayed on both sides) any changes to the content of features are not 
communicated to VERICUT. To test that all features are connected to the correct 
parameters and function as intended, the notebook needs to be in "user" mode. Toggle 
between these modes with the F7 key on the keyboard 

Unlike many of VERICUT's windows, the notebook window does not use the concept of 
an Apply or OK button to invoke sets of changes. When the user changes the content of a 
feature on a notebook's feature page, that change is sent to VERICUT immediately. For 
many parameters, a change in value does not cause any immediate response. For 
example, changing the number of cuts to be processed when the "Play" button is hit has 
no effect until the toolpath is processed. 

On the other hand, some feature changes will cause an immediate response from 
VERICUT. For example, using a file selection feature associated with the user file will 
cause VERICUT to retrieve the selected file immediately. Similarly, if you have numeric 
fields associated with the dimensions of a block, changing one of the values will cause 
VERICUT to immediately apply the change. With experience you will learn which 
parameters will prepare for a future response and which ones will result in an immediate 
response from VERICUT. 

As you test the notebook try to view it as the targeted user will. Is the purpose of each 
feature clear? Would some different wording in the labels make more sense, or perhaps 
some extra labels? Could an illustration on a help page replace a bunch of words? Do the 
views presented by the notebook's default user file display the process effectively or 
could they be improved? Above all, is it simpler to use and save time for the user? 

If you decide that refinements are needed in the default user file, closing the notebook 
while in "author" mode causes VERICUT's standard user interface to be displayed so that 
you can make those changes.  

  

When you are satisfied with the notebook's behavior, it is time to make your custom 
VERICUT user interface available for use. 
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Making the Custom Interface Available for Use 
  
Notebook folder and file descriptions: 
All of the files that define a notebook are stored in a single folder, the name of the folder 
being the name of the notebook. Some or all of the following file types may be present: 

• HTML files for the help pages. 
Their names will be of the form "Pagexxx.html", where "xxx" is the page number. 

• GIF and JPEG files referenced by the HTML pages. 

• XML files for the notebook and it's feature pages. 
Their names will be of the form "Pagexxx.xml", where "xxx" is the page number. 

• "Page000.xml" which contains information pertinent to the whole notepad. 

Notably absent from the above list is the default user file for the notebook and any files 
referenced by it. It may be beneficial to store the default user file and any associated files 
in the notebook folder to simplify data management. That way, if a notebook's folder 
location is changed, all of the files associated with it move with it.  
   

Making the notebook available: 
Deploying a customized notebook to a target user involves making the folder available. 
This can be done by establishing a network mapping to the folder, or by copying the 
folder to the user's machine. If the default user file and the files which it needs are not in 
the same folder, you may find that the relocated notebook is unable to access the default 
user file. If this is the case, on the target machine use the F7 key to briefly get into 
"author" mode again, switch to the required user file and re-save  the notepad. The user 
file that is displayed at the time you save becomes the notebook's default.  

You can also launch VERICUT each time with a custom user interface instead the 
standard user interface by using the file customizer. bat to start the VERICUT session. 
This file can be found in the \cgtech6x\windows\commands\  folder. The customizer 
.bat file needs to be edited as follows to specify which custom interface notebook to use 
at startup. 

In the customizer.bat file locate the "start" command, shown below, at the end of the file. 

%start_cmd% "%CGTECH_JRE%\bin\javaw" -Xms16m -Xmx64m -Xss4m -
classpath"%CGTECH_CLASSES%;%CGTECH_CLASSES%\CGTech.jar" VeriBook 
%argstr% 
                                                                                                                                                
                                                                

Make sure that the next to the last parameters is VeriBook (not Vericut) indicating that 
VERICUT should be started with a custom user interface instead of the standard user 
interface. 
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Replace the last parameter "argstr" with the path to the desired custom interface 
notebook folder. 

Now simply use customizer.bat to start the VERICUT session with the specified 
notebook instead of with the standard VERICUT user interface. 
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Using a VERICUT Custom User Interface 
 

The following user interface is applicable to the VERICUT Mold & Die and VERICUT 
Grinder products, as well as to any "custom" interface created with VERICUT 
Customizer. 

 

 
 

The user interface consists of two main parts, the "notebook" and the VERICUT main 
window. 

  

The Notebook 
The notebook consists of a menu bar and two different types of pages. Click on the upper 
page corners to page back in the notebook. Click on the lower page corners to page 
forward in the notebook. 

Menu Bar 
File: 

Open — Displays the Select book's folder window allowing you to open another 
custom interface notebook for editing or create a new notebook. 

Recent — Displays a list of recently opened files. To open a file in the list, select the 
desired file. 
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Exit VERICUT — Ends the VERICUT session. 

  

Layout: 

 — Positions the notebook on the left side of the VERICUT main window. 

 — Positions the notebook on the right side of the VERICUT main window. 

 — Overlays the notebook on top of the VERICUT main window. Left click on 
the notebook's header and drag to any position.  

  

Help: 
On VERICUT — Starts VERICUT Help. 

About VERICUT — Opens a window that displays information about the current 
VERICUT session. 

  

Help Pages 
Help pages contain instructions, explanations and pictures to assist you in providing the 
necessary information to VERICUT. Help pages are easily recognized by the white 
background. 

Feature Pages 
Feature pages contain features (buttons, text fields, choice lists, etc.) that enable you to 
pass necessary information to VERICUT for processing. Each of the features on a 
"feature" page is described on the previous "help" page. Feature pages are easily 
recognized by the gray background. 

Some features display another window enabling you to provide additional information to 
VERICUT. Use the F1 key to display more information about the displayed window. 
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VERICUT Main Window 
The VERICUT main window is composed of six distinct areas, each with different user 
interaction. The window header displays the VERICUT version and the current session 
units (inch or millimeter). This window can be resized and/or moved like most other 
windows, via dragging the window header, sides or corners. 
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Toolbar 
 

VERICUT's Toolbar provides quick and easy access to the view manipulation 
functions/features. 

 
To see what is associated with a Toolbar icon, simply position the cursor over the icon 
and a tip appears.  

  

Dynamic viewing options 
These options use mouse actions to dynamically orient the object in view. Mouse actions 
are different, depending on the active option-see the table below for details. Dynamic 
viewing options: 

 

Icon: Name: Action: 

 
Dynamic X Rotation Horizontal rotation- drag 

mouse up/down in direction 
to rotate 

 
Dynamic Y Rotation Vertical rotation- drag 

mouse left/right in direction 
to rotate 

 
Dynamic Z Rotation Screen plane rotation- drag 

mouse left to rotate CCLW, 
right for to rotate CLW 

 
Dynamic XY Rotation Horizontal/vertical 

combined rotation- drag 
mouse up/down/left/right in 
direction to rotate 

 
Dynamic Pan Pan/translate- drag mouse in 

the direction pan 

 
Dynamic Zoom Zoom/magnify- drag mouse 

up to zoom in, down to 
zoom out 
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Shortcut: The following keys provide instant access from the keyboard to dynamic 
viewing options (press and hold keys while dragging): Dynamic Zoom — <Ctrl>, 
Dynamic Pan — <Shift>, Dynamic XY — <Ctrl> + <Shift>. Mouse actions are the same 
as above. 

  

Static viewing buttons 
These buttons use various mouse actions to zoom, fit, and reverse the object in view. See 
the table below for details. 

 

 Icon: Name: Action: 

 
Zoom to Box (standard 
mode) 

Left-click and move mouse 
to trap area to zoom (press 
<Esc> to interrupt 
rubberbanding) 

 
Zoom to Box (create new 
view mode) 

Similar to Zoom (standard 
mode) described above 
except a new view is created 
to display the zoomed area. 

 
Zoom In / Zoom Out Zooms in/out approx. 20% 

each time clicked 

 
Fit Fits object in active view 

 
Refine Display Refines the display to 

improve image quality 

 
Last Refine Display Restores the last refined 

display 

 
Reverse Reverses viewing direction, 

as if you stood behind the 
object 

 
Shortcut: You can quickly toggle between the two Zoom modes (standard or create new 
view) by right-clicking on the Zoom to Box icon in the toolbar. 
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To learn more about interacting with VERICUT through the main window components, 
review the following topics under Interacting with VERICUT, in the Getting Started 
section of VERICUT Help. 

Graphics Area 

Message Area 

Animation Slider 

Busy/OptiPath Lights 

Progress Bar 

Simulation Controls 
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Introduction to VERICUT Reports 
 

VERICUT Report provides the tools needed modify/create report templates enabling you 
to generate "custom" reports.  

 Generate reports that only include information important to your particular work 
environment, in a format that is most meaningful to the users of the report. Eliminate the 
need to search through the wide range of information that is included in a more generic 
"standard" report. 

  

VERICUT Reports:  
• Enables you to generate reports using one of the "standard" report templates 

supplied. The following "standard" report templates are included and can be 
found in the "library" directory of your VERICUT installation: 

inspection.VcTemplate - Use this template to create a basic inspection report that 
includes the inspection sequence table and graphic showing the location of the 
inspection points on the part. This is the default report template that Inspection 
Sequence will use if no other template has been specified. 

NOTE:  Report template inspection.VcTemplate should only be used for 
creating reports from the Inspection Sequence window. Using it to create reports 
from other VERICUT applications will result in incorrect data being displayed in 
the report. 

  

vericut.VcTemplate - This is the default report template that VERICUT will use 
if no other template has been specified. 

vericut_basic.VcTemplate - Use this report template to create a report 
containing overview information about the VERICUT session. Includes a file 
summary, and a Tool Summary table and Tool Use graph for each NC program 
file. 

vericut_optipath.VcTemplate - Use this report template to create a report 
similar to the "basic" report but also includes OptiPath information. 

vericut_shadecopy.VcTemplate - Use this report template to create a report 
similar to the "basic" report but also includes View Capture images specified with 
File > AutoSave: View Capture tab. 

vericut_full.VcTemplate - Use this report template to create a report similar to 
the "View Capture" report but also includes OptiPath information. 

NOTE:  The above five report templates should only be used for creating reports 
using File menu > Create Report > ... in the main VERICUT window. Using 
them to create reports from other VERICUT applications will result in incorrect 
data being displayed in the report. 
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vericut_tools.VcTemplate - Use this template to create a tool library report. This 
is the default report template that Tool Manager will use if no other template has 
been specified. 

NOTE:  Report template vericut_tools.VcTemplate should only be used for 
creating reports from the Tool Manager window. Using it to create reports from 
other VERICUT applications will result in incorrect data being displayed in the 
report. 

• Enables you to modify a "standard" report template by changing the content, layout 
and/or format of the included information and save it as a "custom" report template. 

• Enables you to produce "custom" report templates from "scratch". You decide the 
format, layout and content that best meet your needs. 

• Provides the tools to include a wide variety of information from different sources. 
Include text, tables or pictures. Extract information from the VERICUT user file, 
include information from external files, or "generic tags" that will be updated with 
information specific to a particular user file at the time that the report is created. 

  

What is involved with creating a custom VERICUT report? 
Creating and deploying a custom report for use by VERICUT users involves the 
following steps.  

1. Set up "styles" to be used for the report template 

2. Define "user defined tags" that will be included in the template 

3. Create the page layout for the report template 

4. Using the report template 

 

For more information on creating and using custom report templates, see the following: 

1. See the Report Template topics in the Project Menu Section of VERICUT Help. 

2. See the Working with VERICUT reports in the Using VERICUT section for 
additional information. Using VERICUT can be found in the VERICUT Help 
Library. 
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Create Report 
Location: 

File menu > Create Report, in the main VERICUT window. 

File > Create Report, in the Inspection Sequence window. 

File > Create Report, in the Tool Manager window. 

  

Opens the Save VERICUT Report window enabling you to specify the /path/file name 
for the report file to be created. If "User-Defined" information has not been previously 
defined, (either using the User-Defined Tag Values window or during a previous use of 
Create Report) VERICUT will then prompt you for any unspecified User-Defined Tag 
values, then generate the report using the "current" report template. See Create a Report 
Using a Template in the Using VERICUT section for additional information. Using 
VERICUT can be found in the VERICUT Help Library. 

  

Text — Use this option to create a report in text format. 

HTML — Use this option to create a report in HTML format. 

PDF — Use this option to create a report in PDF format. (PDF report generation based in 
part on iText (www.lowagie.com/iText)). 
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Print View 
Location: File menu > Print View 

Toolbar shortcut:  

Opens a window enabling you to print images of VERICUT view ports. Each view port is 
automatically fit to the printable area and printed on a separate page. All view ports are 
printed. Features on this window are standard print window features that enable you to 
access printer settings, specify number of copies, etc. Consult your printer documentation 
for more information. 
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Record Movie 
Location: File menu > Images > Record Movie 

Toolbar short cut for recording images:   

Opens a window enabling you to record images as a VERICUT Image file, or an AVI 
file. (See how) Images in all view ports are recorded. Images can be recorded 
interactively in VERICUT, or via batch processing. After recording is stopped, you can 
view the file via the File menu > Images > VERICUT Playback or File menu > 
Images > AVI Playback function, depending on the file type. 

This window appears differently, depending on the Output Format choice. See the 
VERICUT Image Record window and AVI Image Record window topics below for 
additional information. 

 

NOTES:  
3. The size of the graphics area directly affects the display size of the recorded Image 

file. Make the VERICUT window larger to record larger images. 

4. Recording animations captures all changes in the graphics area. Recorded tool paths 
with lots of small motions can generate large Image files sizes. Consider using the 
Animation Slider, located at the bottom of the VERICUT main window to reduce 
Image file size. 

5. AVI record is not intended for use with cascaded views. 

6. AVI record does not support capture of the Profile view. 
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VERICUT Image Record window 
Location: File menu > Images > Record Movie 

 

These features are available when recording images in a VERICUT Image file. (See how) 

 

 
  
 

Output Format group: 
These options determine the output format and the /path/filename of the recording file. 

Output Format = VERICUT — Format of the output image file is VERICUT 
Image file. 

Filename — Name of the file to receive recorded images. 

  

Snapshot Events group: 
These options control when a snapshot image is recorded. Each selected event causes a 
snapshot to be recorded when that event occurs.  

Error — Record a snapshot when VERICUT detects an error. 
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Cutter Change — Record a snapshot when the cutter has been changed. 

N Records — Record a snapshot after a specified number of tool path records have 
been processed. 

Processing Complete — Record a snapshot when tool path processing has been 
completed. 

  

Animation Control group: 
These options determine when animation images are recorded, and how they will be 
replayed.  

Disabled — Do not record animation images. 

Forward — Record animation images to play in the forward direction only. 

Forward & Backward — Record animation images to play in forward or backward 
direction. 

  

Append Options group: 
These options control appending images to an existing Image file. 

Append — When active, appends recorded images to the end of an existing Image 
file. 

Append Delay — When appending images, inserts the specified number of seconds 
of delay prior to appending new images. 

  

Pauses group: 
These features control the recording process, and insert delays into the VERICUT Image 
file. 

Insert Stop — Inserts a stop point into the Image file. The stop point is used by the 
Stop at Inserted Stop play back feature. 

Insert Delay — Inserts the specified seconds of delay. 

 

Record — Starts recording images based on current window settings, VERICUT window 
size, shape, and layout. Recording must be stopped before the Image file can be viewed. 

Stop — Stops recording. The Image file can be viewed via File menu > Images > 
VERICUT Playback. 

Snapshot — Records a single snapshot image. 

Close — Closes the Image Record window. 
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AVI Image Record window 
Location: File menu > Images > Record Movie 

 

These features are available when recording images in an AVI file. (See how) 

 

 
 

Output Format group: 
These features define the format and /path/filename for the recorded file. 

Output Format = AVI — Format of the output image file is an AVI file. 

Filename — Name of the file to receive recorded images. 

  

Recording Screen Area group: 
These features control the screen area to record. 

Start Left / Start Top — Identifies the start point (top-left location) of the screen 
area to record. 

Width / Height — Width and height (in pixels) of the screen area to record, as 
measured from the top-left start point. 
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Select Region — Uses a rubber-banding box to indicate region to record. Left-click 
to define the start point of the region, then move the mouse to trap the area to record. 
Press <Esc> to interrupt rubber-banding. 

Select All — Records all views. 

  

AVI Frame Rates group: 
These features set the rate at which to record image frames. Frame rate controls the speed 
at which the AVI file plays back. 

Playback Rate — Number of frames to record per second. Increasing the recording 
frame rate causes the AVI file to play back faster, and decreases the file size. 

  

Pauses group: 
These features control the AVI recording process, and insert delay into the AVI file. 

Pause / Continue — Pauses (or continues) AVI file recording. VERICUT motions 
simulated after pausing are not recorded. 

Insert Delay — Inserts the specified seconds of delay. 

  

Record — Starts recording animation images based on current window settings, 
VERICUT window size, shape, and layout. Recording must be stopped before the Image 
file can be viewed. 

Stop — Stops recording. The AVI file can be viewed via File menu > Images > AVI 
Playback. 

Snapshot — Records a single frame image. 

Close — Closes the Image Record window. 

267267



VERICUT HELP – File menu 
 

Playback VERICUT Movie 
Location: File menu > Images > Playback VERICUT Movie  

Toolbar short cut for playing back VERICUT images:    

 

Opens a "VERICUT Player" window to load and play back an Image file recorded by the 
File menu > Images > Record Movie function. (See how) Images are played in a 
separate "image player" window enabling simultaneous access to the VERICUT main 
window and its functions. The size and view layout of the image player window is as 
recorded. However, this window can be moved, or minimized using standard window 
controls. Recorded machining status is also seen when the Status window is open while 
playing. 

 

 
 

File menu 
Functions in this open new Image files, compare existing Image files, and provide control 
over playing back recorded images. 

Open — Open an existing Image file. 
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Compare Files — Opens a window to configure the player to compare two Image 
files. Features enable you to play both Image files simultaneously, and identify 
differences between them. 

Playback Options — Opens the Image Playback Options window for controlling 
playing back recorded images. See the Playback Options window topic below for 
additional information. 

Close — Closes the VERICUT Player window. 

 
Playback (VCR) icons  
These icons control playing and rewinding recorded images. To see what is associated 
with an icon, position the mouse cursor over the icon and a tip appears. Playback VCR 
icons: 

Icon: Name: Function: 

  Play Play images in the forward 
direction 

  Next Snapshot Advance to the next snapshot

  Skip to End Advance to file end 

  (or press Escape key <Esc>) Stop Stop playing back images 

  Play Backwards Play images in the backward 
direction 

  Previous Snapshot Rewind to the previous 
snapshot 

  Skip to Start Rewind to the Image file 
beginning 
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Image Playback Options window 
 

 
 

Configure group: 
Speed — Controls how fast images are played back. Actual speed varies, depending 
on computer hardware. Stop the play back to access this feature. 

Snapshot Delay — Number of seconds to pause after displaying a snapshot. 

  

Control group: 
These options provide additional stop control by event, or the ability to play in a 
continuous loop (without stopping). Options: 

Stop at Error — Stop replay at an error detected by VERICUT. 

Stop at File End — Stop replay when the end of a toolpath file end has been reached. 

Stop at Cutter Change — Stop replay when the cutter has been changed. 

Stop at Every N Events — Stop replay after a specified number of events (frames) 
have been recorded. 

Stop at Inserted Stop — Stop replay on a stop inserted by pressing "Insert Stop" on 
the File menu > Images > Record Movie window. 

Loop — Play in a continuous loop until interactively stopped via pressing Stop , 
or pressing the Escape key <Esc>. 

   

OK — Applies the settings and closes the Image Playback Options window. 

Apply — Applies the settings and leaves the Image Playback Options window open. 
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Cancel — Cancels the current setting changes and closes the Image Playback Options 
window. 
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Playback AVI Movie 
Location: File menu > Images > Playback AVI Movie 

Toolbar short cut for playing back VERICUT images:   

 

Opens an "AVI Player" window to play back an AVI files recorded by the File menu > 
Images > Record Movie function. (See how) Assuming your system has an AVI player 
installed, the AVI images are played in a separate "image player" window enabling 
simultaneous access to the VERICUT main window and its functions. The size and view 
layout of the image player window is as recorded. 

272272



VERICUT HELP – File menu 
 

View Capture window 
Location: File menu > Images > View Capture 

                File menu > AutoSave > View Capture tab: Properties 

Toolbar short cut for accessing View Capture:   

 

Opens a window to capture VERICUT images and format them for printing or importing 
into desktop publishing applications. View Capture can also output printer-formatted files 
that you can move to other computers or printing devices. Images can be captured and 
output interactively or automatically (via AutoSave), or via batch processing. When 
configuring this window for future use or batch processing, press OK (instead of Output) 
to save the window configuration without outputting a View Capture image file. Hint: 
Avoid having to re-configure this window by creating a master Project file containing the 
modified View Capture values. 

 

 
 

Attributes tab — Features on this tab are used to configure the attributes for formatting 
captured VERICUT images. 

Postscript Settings tab — Features on this tab provide information about centering and 
annotating PostScript format images on the printed page. 

Render tab — Features on this tab enable you to specify the output size of "rendered" 
images. 

OK — Saves the View Capture window settings and closes it without outputting an 
image file. 
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Output — Outputs the current VERICUT image to the specified file. File format is 
determined by the View Capture window configuration. 

NOTE:  Output is not applicable when setting up File menu > AutoSave > View 
Capture tab : Properties. 

Cancel — Closes the View Capture window without saving setting changes or outputting 
an image file. 
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View Capture window, Attributes tab 
Location: File menu > Images > View Capture 

Toolbar short cut for accessing View Capture:   

 

Features on this tab are used to configure the attributes for formatting captured 
VERICUT images. 

 

 
 

Type — Type of format in which to capture VERICUT images. Printer-ready and 
electronic formats are available. Options: 

• PostScript — Postscript format. 

• EPSF — Encapsulated PostScript File. 

• TIFF — Tag Image Format File. 

• JPEG — JPEG compressed format. (JPEG image support based in part on the 
work of the Independent JPEG Group.) 

 

Method — Method of coloring the captured image. Options: 

• Standard — black and white only 

• Grayscale — black and white with shading 

• RGB Color — Red-Green-Blue values for each pixel 

• Palette Color — Red-Green-Blue color tables 

• CMYK Color — Cyan-Magenta-Yellow-Black color tables 

 
Shading By — Method of shading black and white images. Options: 
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• Intensity — Shade by light intensity only, for example: the brightest yellow color 
is the same shade of gray as the brightest blue color. 

• Color — Shade by color differences and light intensity. 

 
Orientation — Controls image orientation on the printed page: Landscape or Portrait. 

 
Output File — Use to specify the name of the file to receive image data when the Output 
button is pressed. Enter the \path\file name in the text field or click on Browse and use 
the Save File selection window to specify the file. 

NOTE:  When images are output via File menu > AutoSave, the file names specified 
on the AutoSave, View Capture tab are used instead. 

 
Add output file to report — When toggled "On",  and Output is pressed, the output 
JPEG images are available for use in "standard" VERICUT reports.  

NOTE:  Add output file to report is not available when setting up File menu > 
AutoSave > View Capture tab : Properties. 

 
Render — Use to toggle the Render feature on and off. When Render is toggled "on" 
and the Output button is pressed, the active view will be rendered and a JPEG file will 
be output with the name specified in the Output File field. (see how) Pressing the "Stop" 
button during rendering will stop the process. 

 By default, the width and height of the active view is used for the size of the rendered 
image. Use Specify image size on the Render tab to specify a different width and/or 
height for the rendered image. 

• Currently, JPEG is the only supported output. 

• Method, Shading By and Orientation are not applicable to Render. 

• AUTO-DIFF models, Travel Axis, design components/models and Temp Stock 
components are not supported by the Render feature . 

NOTE:  Generating a "rendered" image can take considerably longer than generating a 
standard View Capture image. 
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Standard View Capture image Rendered image 
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View Capture window, Postscript Settings tab 
Location: File menu > Images > View Capture 

Toolbar short cut for accessing View Capture:   

 

Features on this tab provide information about centering and annotating PostScript format 
images on the printed page. 

 

 
 

Center / Margins options — Controls image placement on the printed page. Options: 

• Center — Center image in the middle of the page. 

• Margins — Place image according to specified margin dimensions (see below). 

Left / Right / Top / Bottom — Margin dimensions, as measured from the corresponding 
edges of the paper. 

Paper Size — Size of paper to print. 

Annotation — When active, includes annotated text with the image. Annotation includes 
the current date, tool path file name, tool path record number being processed, and user 
specified text. 

Tip: If you want to add a note that uses special characters add an "escape" backslash 
character ("\") before each special character.  

 

Example: 

To enter this annotated text => Part Number (1234) ((due date 12/01/00)) 
Type this in the Annotation field => Part Number \(1234\) \(\(due date 12\/01\/00\)\) 
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View Capture window, Render tab 
Location: File menu > Images > View Capture 

Toolbar short cut for accessing View Capture:   

  

Features on this tab enable you to specify the output size, whether or not to use shadows, 
and light source location for "rendered" images. 

 

 
 

Specify image size — Toggle "On" to use the Width and Height values specified below 
for creating an image using Render. By default, the width and height of the active view is 
used for the size of the rendered image. 

Width — Use to specify the width for a rendered image. 

Height — Use to specify a height for a rendered image. 

Shadows — Toggles Shadows On/Off. 

Light Location — Use to specify one nine fixed light locations. Choose from: Top Left, 
Top, Top Right, Left, Center, Right, Bottom Left, Bottom, and Bottom Right. 

View Angle — This field enables you too define the view angle. Valid range is from 1 to 
80 degrees. 
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AutoSave window 
Location: File menu > AutoSave 

Toolbar short cut for accessing AutoSave:   

 

Opens a window to configure VERICUT to automatically save In Process files, View 
Capture image files, (such as JPEG, PS, EPSF, or TIFF files) or VERICUT Solid (.vct) 
files. Saving is based on user specified events or when VERICUT detects errors during 
tool path processing. Auto-saving is especially useful to save data during batch 
processing. 

 

 
 

 

In Process tab — Features on this tab control automatic saving of In Process files. 

View Capture tab — Features on this tab control automatic saving of ShadeCopy image 
files. 

VERICUT Solid tab — Features on this tab control automatic saving of VERICUT 
Solid files. 
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OK — Saves all tab settings and closes the AutoSave window. 

Cancel — Closes the AutoSave window without saving settings. 
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AutoSave window, In Process tab 
Location: File menu > AutoSave window 

                Project menu > Output window 

VERICUT toolbar short cut:   

  

Features on this tab control automatic saving of In Process files, or "IP files". 

 

 
  

Auto Save options — These options control when VERICUT automatically saves IP 
files. Click on the box to the left of the event to toggle On/Off. Each selected event 
causes a file to be saved when that event occurs. Options: 

• Cutter Change — Save an IP file when the cutter has been changed. 

• # of Cuts — Save an IP file after a specified number of cuts. Enter the number of 
cuts in the # of Cuts text field. 

• File End — Save file at  the end of  tool path processing. Choose either End of 
each File (end of each toolpath file) or End (end of the NC program) from the 
pulldown list. 

In Process File — Use to specify the base name for IP files saved. Enter the 
\path\filename in the text field or click on Browse and use the selection window to 
specify the file. 
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Unique file names are maintained by appending the tool path number and line number of 
the record causing the event to the end of the base file name. Naming convention for 
auto-saving files is: <IPfilename>n1_n2.ip where "<IPfilename>" is the name 
specified in the In Process File field, "n1"=sequential tool path number, and 
"n2"=number of the record causing the auto-save event. 

The following examples assume the AutoSave (or Output) window configuration shown 
below. 

 

 
 

Example 1:  One tool path processed, tool change on record #10 => test1_10.ip 

Example 2:  Two tool paths processed, tool change on record #10 in both tool paths 
=> test1_10.ip (from tool change in tool path #1), test2_10.ip (from tool change in 
tool path #2) 

Example 3: Two tool paths processed, tool path one tool change on record #10, tool 
path two tool change on record #5 => test1_10.ip (from tool change in tool path #1), 
test2_5.ip (from tool change in tool path #2) 

 

Auto Error On — When active, VERICUT automatically saves an IP file when an error 
is detected. 
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In Process File — Specifies the base name for IP files saved due to errors. Similar to In 
Process File for the Auto Save options (see above), unique file names are maintained by 
appending the line number of the record causing the error to the end of the specified IP 
file name. 
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AutoSave window, View Capture tab 
Location: File menu > AutoSave 

                Project menu > Output 

VERICUT toolbar short cut:      

  

Features on this tab control automatic saving of View Capture image files (JPEG, PS, 
EPSF, or TIFF). 

 

 
 

Print Command — When toggled "Off", sends graphical data to the specified View 
Capture image file. When toggled "On", executes the print command that sends raw 
graphical image data to the printer. 

By default, the "prshade" command executes the "prshade" command file containing 
operating system commands typically used to print images on your computer. If printing 
fails, correct the entry in the Print Command field, or use an ASCII text editor (NOT a 
word processor) to edit the "prshade" command file to have the proper print command for 
your computer/printer. 

Properties — Opens the View Capture window to access settings for file formatting 
and printing. 

  

Auto Save options 
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These options control when VERICUT automatically saves View Capture image files. 
Click on the box to the left of the event to toggle On/Off. Each selected event causes a 
file to be saved when that event occurs. Options: 

• Cutter Change — Save a View Capture image file when the cutter has been 
changed. 

• # of Cuts — Save a View Capture Image file after a specified number of cuts. 
Enter the number of cuts in the # of Cuts text field. 

• File End — Save a View Capture image file at the end of tool path processing. 
Choose either End of each File (end of each NC program file), or End of each 
Setup, or End (end of the program) from the pull-down list. 

• View Capture File — Use to specify the base name for View Capture image files 
saved as a result of Auto Save options described above, when the Print 
Command checkbox is toggled "Off". Enter the \path\file name in the text field 
or click on Browse and use the selection window to specify the file. The naming 
convention used for saved files is as described for IP files-see In Process tab for 
details. 

  

Auto Error options 
These options control when VERICUT automatically saves Vie Capture image files due 
to errors. 

• Auto Error On — When toggled "On", VERICUT automatically saves a View 
Capture image file when an error is detected. 

• View Capture File — Use to specify the base name for View Capture image files 
automatically saved as a result of errors detected when AutoError On is toggled 
"On", and the Print Command checkbox is toggled "Off". Enter the \path\file 
name in the text field or click on Browse and use the Save File selection window 
to specify the file. The naming convention used for saved files is as described for 
IP files-see In Process tab for details. 
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AutoSave window, VERICUT Solid tab 
Location: File menu > AutoSave 

                Project menu > Output 

VERICUT toolbar short cut:   

  

Features on this tab control automatic saving of VERICUT Solid (vct.) files. 

  

 
  

Auto Save options 
Use these options to specify the events when VERICUT should automatically save 
VERICUT Solid files. Click on the box to the left of the event to toggle On/Off. Each 
selected event causes a file to be saved when that event occurs. Options: 

Cutter Change — Save a VERICUT Solid file when the cutter has been changed. 

# of Cuts — Save a VERICUT Solid file after a specified number of cuts. Enter the 
number of cuts in the # of Cuts text field. 

File End — Save a VERICUT Solid file at the end of tool path processing. Choose either 
End of each File (end of each NC program file), or End of each Setup, or End (end of 
the program) from the pull-down list. 
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VERICUT Solid File — Use to specify the base name for VERICUT Solid files saved 
due to Auto Save options. Enter the \path\file name in the text field or click on Browse 
and use the selection window to specify the file. 

  

Auto Error options 
Use these options to specify whether or not VERICUT automatically saves VERICUT 
Solid files when an error is detected. 

On — Click on the box to the left to toggle On/Off. When active, VERICUT 
automatically saves a VERICUT Solid file when an error is detected.  

VERICUT Solid File — Use to specify the base name for VERICUT Solid files saved 
when AutoError is active. Enter the \path\file name in the text field or click on Browse 
and use the selection window to specify the file. 

 NOTE: The naming convention used for saved VERICUT Solid files is the same as 
described for IP files-see In Process tab for details. 
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Recent Files 
Location: File menu > Exit 

 

Provides a list of recently opened Project files or User files. Select the desired file from 
the pull-down list. 

List contents are stored in the VERICUT Preferences file. 
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Exit  
Location: File menu > Exit 

 

Exits (quits) the VERICUT program. Any files that were opened during the VERICUT 
session, such as the Log file, Image file, etc. are automatically closed. You can also exit 
VERICUT by clicking "X" at the top right corner of the VERICUT main window. 

NOTE:  Session information is not automatically saved by VERICUT upon exiting. It is 
the responsibility of the user to decide if session information should be saved before 
exiting. 
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Edit menu 
Text File (edit) 
Location: Edit menu > Text File 

 

Opens a text editor window-just load any ASCII text file and start editing. The following 
is a general description of the features available for searching and editing text and tool 
path files throughout VERICUT. The features available in a particular window may vary 
depending on the purpose of the window that they appear in. 

 

Menu Bar: 
The menu bar located at the top of the window provides easy access to major functions. 
Each menu contains groups of related functions. Left-click on any menu name to display 
the list of functions in that menu. Click on the function in the menu you want to use. The 
name of the current file is also displayed in this area. 

File:  
Open — Open a file. 

Save — Save the current file. 

Save As — Save the current file under a different name. 

Print — Print the file. 

Exit — Close the window. 

Edit: 
Cut — Cuts the highlighted text in the file listing and puts it in the paste buffer.  

Copy — Copies the highlighted text in the file listing to the paste buffer. 

Paste — Puts the contents of the paste buffer at the location of the cursor in the file 
listing. 

Restore — Restores the highlighted changes to the original state. 
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Icon Bar: 

 
  

The items in the Icon Bar enable you to search for, and/or replace, specific items in the 
file listing, print the file, or exit the window. Moving the cursor over the icon will display 
name of the option. Each feature (from left to right) is described below. 

 

 Open File — Opens a file selection window enabling you to select another file. 

 Save File — Save the current file. 

Line Number or Search Text — Use this text field to enter a line number, or a string of 
text, to search for. 

 Goto Line Number — Moves the cursor in the file listing to the line number 
specified in the Line Number or Search Text field. 

 Search Forward — Searches forward in the file listing for the text string specified 
in the Line Number or Search Text field. 

 Search Backward — Searches backward in the file listing for the text string 
specified in the Line Number or Search Text field. 

Replacement Text — Use this text field to enter a "replacement text" string. 

 Replace One — Replace one occurrence of text string in the Line Number or Search 
Text field (or the highlighted text in the file listing) with the text string in the 
Replacement Text field. 

 Replace All — Replace all occurrences of the text string in the Line Number or 
Search Text field with the text string in the Replacement Text field. 

 Undo Highlighted Changes — Restores the highlighted changes to the original 
state. 

 Print — Print the file. 

 Close Window — Closes the window. 
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NC Program (Edit) 
  

VERICUT Users: 
VERICUT Location: Edit menu > NC Program 

Toolbar short cut for accessing the NC program editor:   

 

Selecting Edit menu > NC Program displays a list of all NC programs and subroutines 
in the project file. Choosing one of the NC program files/subroutines opens a text editor 
window with the selected MC program file/subroutine file loaded and ready for editing. 

  

Mold and Die Users: 
Mold and Die Location:   Analyze, View Files, Print page > Edit the Tool Path File 

Notebook Feature:       

 

Edit the Tool Path File opens a text editor window with the "current" tool path file 
loaded and ready for editing. 

  

Cutter Grinder Users: 
Cutter Grinder Location:   Analyze, View Files, Print  page > Edit Grinding Program 

Notebook Feature:      

 

Edit Grinding Program opens a text editor window with the "current" grinder program 
file loaded and ready for editing.  

  

Standard text editing features are provided, such as: copy/cut, paste, search, etc. For more 
information on using the editing features, see Text File under Edit menu. 

 

WARNING:  Editing the NC program file can cause undesirable results, especially 
when edits are made to portions of the tool path which have already been processed by 
VERICUT. These edits can cause the tool path record number pointer to be out of sync 
with the edited tool path file. In these cases it is recommended to rewind the tool path file 
after editing, and restart the simulation with the last unedited record prior to the first 
addition/deletion. 
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Color window 
 
VERICUT Users: 
VERICUT Location: Edit menu > Colors 

Toolbar short cut for accessing the Color window:   

  

Mold and Die Users: 
 Mold and Die Location:   Other Settings page > Colors 

Notebook Feature:       

  

Cutter Grinder Users: 
Cutter Grinder Location:   Other Settings page > Colors 

Notebook Feature:      

  

Colors opens a window to define the colors seen in VERICUT. Colors are changeable at 
any time. The affect of changing colors is immediate. 
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Assign tab — Features on this tab are used to assign Error, Reset Cut and Background 
colors. 

Cut Colors tab — Features on this tab assign colors to machine cuts made in the 
workpiece. 

Define tab — Features on this tab define colors seen in VERICUT, and control light 
brightness. 

  

OK — Saves tab settings and closes the VERICUT Color window. 

Apply — Saves tab settings and leaves the VERICUT Color window open. 

Cancel — Closes the VERICUT Color window without saving tab settings. 
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Color window, Assign tab 
 

Features on this tab are used to assign Error, Reset Cut and Background colors. 

 

 
 

Error — Color for highlighting unsafe machining conditions (default: "Red"). The "error 
color" will help you identify the following potentially dangerous situations: 

Material removed while cutting too fast (known as a "fast feed" error) 

Cuts in clamps, fixtures, bolts, and other hardware holding the workpiece 

Material removed by non-cutting portions of the tool, such as: tool holders, 
extensions, etc. 

Gouges in a design model (via AUTO-DIFF) 

Reset Cut — Color applied to all cuts in the workpiece when a Reset Cut Color 
operation is performed (see below). By default this color is set the same color as the stock 
model to give the appearance of uncut stock, however, any defined color can be selected. 

Floor, Ceiling, Wall — Colors of the floor, ceiling and walls displayed in a machine 
view when Background is set to Walls in the View menu > Attributes window. A 
sample machine is shown below with the floor, ceiling and walls in the background. The 
tile affect on the floor is created by alternating the Floor and Ceiling colors. 
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Shaded Background — Use to specify the color that will be displayed when the view 
Background attribute is set to Shaded. 

Reset Cut Color — When selected, the colors of all cuts in the workpiece are changed to 
the single color specified by Reset Cut (see above). 
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Color window, Cut Colors tab 
  

Features on this tab assign colors to the machine cuts made in the workpiece. The items 
displayed on this tab will vary depending on the Color Method selected. 

  

Color Method 
Method of determining colors used to shade machined cuts. Options are:  

 
Cut Color Table — Cut color is determined by the Cut Sequence/Color list defined in 
the Cut Color Table.  

  

 
  

Cut Seq. / Color list — List of colors used for material cut with a safe cutting feed rate 
(less than the Fast Feed threshold). The cut color list associates colors with cut sequences 
in the NC program file. A new cut sequence is assumed when a tool with a different 
shape is loaded for cutting. All portions of the cutting tool shape are considered for 
differences. When the number of cut sequences exceeds the number of cut colors defined 
in the table, Recycle Cut Color determines the cut color for the remaining tools (see 
below). 

Double-click on the cut sequence number in the table to edit it. Double-click on a color in 
the table and select from the pull-down color list to change a color. Add or remove colors 
from the pull-down list using the Shade Colors list feature on the Color window, Define 
tab.  
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Add, Delete — Adds (or deletes) cut colors in the list. 

Recycle Cut Color — When selected, recycles colors in the cut color list when the tool 
path contains more tools than cut colors defined. For example, assume that 4 cut colors 
are defined. When tool 5 is encountered VERICUT recycles cut color 1, tool 6 uses cut 
color 2, and so on. When this option cleared, the last defined cut color is used for cut 
sequences that follow the last defined cut sequence color. Using the example above, tool 
4, 5 and 6 would receive the cut color defined for cut sequence 4. 

  

Tool Color — Cut color is determined by the tool color property stored in a VERICUT 
Tool Library. 

  

Feed Range Color — Cut color is determined by the feed rate programmed in the NC 
program file. 

  

 
  

Feed Range / Color list — List of colors used for material cut within a specified feed 
rate range. The cut color list associates colors with feed rates in the NC program file. 
Using the sample table shown above, cuts using a feed rate between 0 and 25 will be 
displayed Aquamarine. Cuts using a feed rate between 25 and 49 will be displayed Light 
Steel, and so on. 

Double-click on the Feed Range number in the table to edit it. Double-click on a color in 
the table and select from the pull-down color list to change a color. Add or remove colors 
from the pull-down list using the Shade Colors list feature on the Color window, Define 
tab. 
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Add, Delete — Adds (or deletes) cut colors in the list. 

  

TP File Color — Cut color is determined by the Cut Sequence/Color list defined in the 
Cut Color Table method described above except that the Cut Sequence changes as the NC 
program file changes instead of when the tool changes. If a Project file only uses one NC 
program file, then all cuts will be the same color. 
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Color window, Define tab 
 

Features on this tab define colors seen in VERICUT, and control light brightness. 

 

 
 

Shade Color list — List of colors that can be used to shade solid objects seen in 
VERICUT, such as: models, cutting tools, and machined cuts (maximum 128 colors). 
The number of shade colors also affects shade quality. The color band at the bottom of 
the window displays the shade variations of the selected color in the list, as impacted by 
the total number of defined colors. Once defined, assign the colors to solid objects using 
the features on the Assign tab and the Cut Colors tab. 

Add, Delete — Adds (or deletes) colors in the list. 

Red-Green-Blue slidebars — Control the amount of red, green, and blue color 
components mixed to define a color. The exact value is shown in the field to the right of 
each slidebar (0=none to 255=maximum). 

Color list — Opens a window of pre-mixed colors selectable for background, 
foreground, and shade colors. 

Brightness — Controls the amount of light for shading solid objects. Options are: High, 
Normal and Low. 

  

Flat Colors group: 
Background — Select this option to change the color of the graphics area background 
when View menu > Attributes: Background is set to "Flat". You can also change the 
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background to display a shaded color, or machine views can display ceiling, floor, and 
walls. 

Foreground — Select this option to change the color of items drawn on top of the 
VERICUT display, for example: coordinate system axes, lines indicating the bounding 
region of selected models/components, etc. 

The Background and Foreground colors should be different, or foreground-colored items 
may "blend in" with the background. 
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View Menu 
Layout (view) 
Location: View menu > Layout  

 

The options in the Layout menu control how many views of the VERICUT model are 
seen, and how they are arranged. All views are contained within the VERICUT main 
window. The size and orientation of the model in each view is individually controlled. 
View port size and layout are saved in the user file.  

One view is considered by VERICUT to be the "active view". A view is made active by 
clicking in it, and is designated by a colored window header. Many VERICUT functions 
are effective only in the active view, including most viewing functions. 

Standard — Sets views of the VERICUT model to one of the standard view layout 
choices. By default standard view layouts are tiled, but you can change this using other 
functions in the Layout menu, or via standard window management features, such as 
dragging, resizing, etc. 

Add View — Adds a view. You can add as many views as desired. What is seen in a 
view (workpiece, machine, etc.) is determined by the view attributes- ref. View menu > 
Attributes. 

Shortcut: You can quickly change the attributes or orientation of a view by right-
clicking in the view, and selecting from the displayed menu. 

Delete View — Deletes a view. You can also delete a view via clicking "X" at the top 
right corner of the view window. 

Cascade — Cascades views in an overlapping arrangement. Note that cascaded view 
layouts are not saved by VERICUT. 

Tile Horizontally — Tiles views in a horizontal arrangement. 

Tile Vertically — Tiles views in a vertical arrangement. Examples follow. 

Cascaded Tiled horizontally Tiled vertically 

   

 

View to Back — Moves the "active" view to the back. This function can also be accessed 
using the right mouse button in the active view. 
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View to Front — Moves the selected view to the front. Selecting "View to Front" 
displays a list of all available views allowing you to select the desired view to be moved 
to the front even if it is obscured by other views in the graphics area.  

Always in Front — Makes the active view remain "always in front" until it is 
specifically moved to the back or until another view is specified as "always in front". 
This function can also be accessed using the right mouse button in the active view. 
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View Orient window 
Location: View menu > Orient 

 

Opens a window to orient the view, including: rotate, zoom, pan, reverse, etc. You can 
view machining from any angle or distance, and change the view at any time during the 
simulation. Views of the workpiece, NC machine, or cutting tools seen in the Tool 
Manager are oriented in the same manner, as described by the sections that follow. In 
general, click in a view to make it active, then change view orientation as required. View 
rotations are described with respect to the "view coordinate system". 

 

 
 

Dynamic Viewing Options: 
These options use mouse actions to dynamically orient the object in view. Mouse actions 
are different, depending on the active option-see the table below for details. Dynamic 
viewing options are also available on the VERICUT Toolbar.  
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Toolbar Icon: Name: Action: 

 
Dynamic X Rotation Horizontal rotation- drag mouse up/down in 

direction to rotate 

 
Dynamic Y Rotation Vertical rotation- drag mouse left/right in 

direction to rotate 

 
Dynamic Z Rotation Screen plane rotation- drag mouse left to rotate 

CCLW, right for to rotate CLW 

 
Dynamic XY 
Rotation 

Horizontal/vertical combined rotation- drag 
mouse up/down/left/right in direction to rotate 

 
Dynamic Pan Pan/translate- drag mouse in the direction pan 

 
Dynamic Zoom Zoom/magnify- drag mouse up to zoom in, down 

to zoom out 

 

Shortcut:  The following keys provide instant access from the keyboard to dynamic 
viewing options (press and hold keys while dragging):  

Dynamic Zoom — <Ctrl>,  

Dynamic Pan — <Shift>,  

Dynamic XY — <Ctrl> + <Shift>.  

Mouse actions are the same as above. You can also use the "Up" or "Down" arrows on 
your keyboard to zoom in or out. 

 

Standard drawing view buttons- XY, YX, YZ, ZY, ZX, XZ, V-ISO, H-ISO — 
Orients the object in the selected standard drawing view and automatically fits the object 
in the view. 
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Rotation Options: 
Angles — Absolute rotation about the view coordinate system X Y Z axes, respectively. 
The three values are separated by spaces. 

 

Increment — Degrees of incremental rotation to apply when a rotation button is pressed 
(see below). 

 

Rotation buttons (X+/X-, Y+/Y-, Z+/Z-) — axis and direction in which to apply 
incremental rotation specified by the Increment value. 

 

Spin Center — Specify a point to be used as the center of rotation during dynamic 
rotations. Click in the Spin Center field so that it becomes active, then either enter XYZ 
values (separated by spaces) in the field and click on the Apply button or click on a 
position in the view to specify the Spin Center point. The values are applied to the 
"active" view. If a workpiece view is the active view, the coordinates are relative to the 
origin of the workpiece coordinate system. If the "active" view is a machine view, the 
coordinates are relative to the origin of the machine coordinate system.  

Press  to display the Spin Center marker and activate the point for the active view. 
To de-activate Spin Center point, press the button again. You can specify a different 
rotation point for each view. When you close the View Orient window, the Spin Center 
markers will no longer be displayed but the activated Spin Centers will remain active. 
When you use one of the dynamic rotation features described above in a view with an 
active Spin Center, the Spin Center point will be used as the center of rotation instead of 
the view coordinate system origin. 

Shortcut:  You can quickly change the spin center location by right-clicking in the view, 
select Spin Center from the displayed menu, then select the desired position in the 
graphics area. 

 

Orient on Feature — Resets the view, normal to the feature selected in the graphics 
area. The modified view is centered on the position of the selection vector. 

 

Zoom creates new View — When toggled on, creates a new view for the zoomed area 
instead of modifying the current view. Also changes the icon in the toolbar to the Zoom 
(create new view mode) icon. 

Shortcut:  You can quickly toggle between the two Zoom modes (standard or create 

new view) by right-clicking on the Zoom to Box icon , or ,  in the toolbar. 
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Static Viewing Options: 
These buttons use various mouse actions to zoom, fit, and reverse the object in view. See 
the table below for details. Static viewing options are also available on the VERICUT 
Toolbar.  

 

Button name: Toolbar Icon: Action: 

Zoom (standard mode) 

 

  (Zoom to Box) 

Left-click and move mouse 
to trap area to zoom (press 
<Esc> to interrupt 
rubberbanding) 

Zoom ( with Zoom creates 
new View toggled On) 

  (right click on Zoom to 
Box) 

Similar to Zoom (standard 
mode) described above 
except a new view is created 
to display the zoomed area. 

Zoom In / Zoom Out 
   

Zooms in/out approx. 20% 
each time clicked 

Fit 
  (left click) 

Fits object in active view 

Fit All 
  (right click) 

Fits objects in all views 

Refine   (Refine Display) Refines the display to 
improve image quality 

Reverse 

  

  

  

Reverses viewing direction, 
as if you stood behind the 
object (see also: "reverse" 
VERICUT command record)

none 
  (Last Refine Display) 

Restores the last refined 
display 

 

Shortcut:  You can quickly reverse or orient the model in one of the defined views by 
right-clicking in the view and selecting from the displayed menu. 

Reset — Resets the view to the last orientation accepted by pressing Apply, or as it was 
when the Orient window was opened. 
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View Attributes window 
Location: View menu > Attributes 

 

Opens a window to control the attributes of a view, such as: what is seen in a view, light 
source, shading, etc. In general, click in a view to make it active, then change attributes 
as required. Each view has its own view attributes. 

 

 
 

View Type — Controls what is seen in a view.  

Options are: 
Workpiece — Displays the stock workpiece and machining that occurs on it. This 
view supports full inspection capabilities on the machined part, including X-Caliper 
measurements and AUTO-DIFF model comparisons. 

Machine — Displays a 3-D NC machine, when defined. The uncut stock can be seen, 
however, material removal does not occur in this view type. 

Machine/Cut Stock — Same as above, except material removal does occur. (Does 
not support machined part inspection-use a Workpiece view type for this activity.) 
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Profile — Displays a 2-D profile view of a turned workpiece in a G-code tool path 
simulation, as if it were spinning and sectioned along the turning axis. The profile is 
created when cutting begins.  

NOTE:  Ensure a Spindle component is defined in the machine and turned on by 
codes in the G-code tool path file. 

 

Draw Mode — Controls how machine components are displayed.  

Toolbar short cuts for Draw Shaded , and Draw Lines , draw mode.  

Options are: 

Shade — Shaded solids 

Lines — Wireframe 

Hidden — Wireframe with back-facing lines hidden 

Mixed — shade, lines or hidden, as defined by the component's Mixed Mode 
attribute (Ref. Project menu > Model Setup > Define: Component Attributes tab) 

 

Light — I J K vector direction in which the light source points. The three values are 
separated by spaces, as described in the view coordinate system. A second light source 
shines on the opposite side of the model. 

 

Background — Controls the background seen in a view. Colors for backgrounds are 
defined via the Edit menu > Colors function.  

Options: 
Flat — Monochromatic. 

Shaded — Light-to-dark shading. 

Walls — Walls, floor, and ceiling-machine views only. 
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Sample backgrounds:  

Shaded 

 

Walls Flat 

 

Shortcut: You can quickly change the view type and background by right-clicking in the 
view, and selecting from the displayed menu. 

 

Attach Comp. — Attaches the view point and line of sight for a view to the selected 
component. By default, a Workpiece view is attached to a Stock component, thus the 
workpiece remains stationary while the tool moves about it. Similarly, by default in a 
Machine view the view is attached to the machine's Base component, thus the machine 
base appears stationary while its axes move. Whatever component is selected as the 
attach component becomes stationary in the simulation, while all other objects are 
simulated as moving relative to that component. 

Shortcut: You can quickly change the component the view is attached to by right-
clicking in the view, and selecting from the displayed menu. 

 

Translucent — 

Controls when the stock model is displayed as translucent (can be seen through).  

Translucent can only be applied to an active workpiece view. Once the attribute is set, 
more than one workpiece view can be displayed "translucent".  It is only valid with a 
"refined display". 
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All VERICUT functions can be used with a translucent view. However, when the model 
is rotated, sectioned, or zoomed, the resulting view is a solid. Use Refine Display to re-
display the translucent view. Almost any model feature can be seen using combinations 
of Translucency, Reverse, Section, and Zoom. 

NOTE:  Translucent cutters may intermittently disappear while cutting a translucent 
model. Display the tool as a solid to eliminate this "flashing" affect. 

Toolbar short cut:   

Options are: 
Off — Translucency is off and the workpiece is displayed as a solid (can not be seen 
through). 

Normal — Causes material in front of a machined surface to become translucent. 
When a machined surface is not present behind material, the material is displayed in 
solid. 

Extended — Similar to Normal , except when a machined surface is not present 
behind material, the material is still displayed with translucency. 

  

Translucent "Off" Translucent "Normal" Translucent "Extended" 

   

  

Shortcut:  You can quickly change Translucent settings by using the toolbar short cut: 

  Use the left mouse button on the icon to toggle Translucent "on" or "off". When the 
Translucent icon is toggled "on", use the right mouse button to quickly toggle between 
Translucent "Normal" and Translucent "Extended" modes. The change is immediately 
applied to the "active" workpiece view. 

Accelerated (OpenGL) — Toggles Hardware Graphics Acceleration On/Off.  

You can also right-click in the graphics area and use Accelerated (OpenGL) in the 
displayed menu to toggle Hardware Graphics Acceleration On/Off 

Perspective View — This feature is only available when Accelerated (OpenGL) is 
toggled "On". When Perspective View is toggled "On", a perspective view is displayed 
in Machine and Machine/Cut Stock views. 
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Field of View Angle — This feature is only available when Accelerated (OpenGL) and 
Perspective View are both toggled "On". It enables you to control the Field of View 
Angle of the perspective view. Move the slider to the left to decrease the view angle and 
to the right to increase it. 

Clipping Plane — This feature is only available when Accelerated (OpenGL) and 
Perspective View are both toggled "On". It enables you to control the position of the 
"clipping plane" in the perspective view. Move the slider to the left to move the "clipping 
plane" closer to the plane of the screen. Move it to the right to move the "clipping plane" 
further into the view (away from the plane of screen). All objects between the "clipping 
plane" and the plane of the screen are blanked from the display. For example, this feature 
could be used to blank parts of the machine (like doors) to better view the part on the 
machine. 

Cut Stock Display — This feature enables you to control the way that the Cut Stock is 
displayed (and therefore the processing speed). Moving the slider to the left will display a 
"sharper" image of the Cut Stock but will result in longer processing times. Moving the 
slider to the right results in a Cut Stock display with a less sharp image, but processing 
time will be faster. 
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View Attributes Window, General tab 
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View Attributes window, OpenGL Settings tab 
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View Attributes window, OpenGL Settings tab, Display 
Options 
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View Attributes window, OpenGL Settings tab, 
Floor/Wall Textures tab 
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View Section window 
 
VERICUT Users: 
 VERICUT Location: View menu > Section 

VERICUT toolbar short cut:   

  

Mold and Die Users: 
Mold and Die Location:   Views and View Layouts page > Display Section 

Notebook Feature:      

  

Cutter Grinder Users: 
Cutter Grinder Location:   Change Views and View Layouts page > Display Section 

Notebook Feature:      

 

 
 

Opens the Section window enabling you to define section planes through a VERICUT 
model in a workpiece view. You can define as many section planes as desired, in any 
orientation. (See how) Section plane orientation and distance are described with respect 
to the active coordinate system.  Restore the original model by clicking anywhere off the 
part in the workpiece view, or click Restore on the Section window. You can continue 
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cutting on the sectioned model, or restore the original (un-sectioned) model. Machine 
cuts are applied to the entire model regardless of how it is displayed after sectioning. 

 

Section on mouse pick — Immediately sections the model through the point selected 
with mouse. The section plane orientation is controlled by the characteristics of the plane 
highlighted in the Section planes table. 

 
Section planes table: 

 On — Toggles on and off to activate/deactivate defined section planes in the table. 
Only the active planes will be used to determine the portion of the model that will be 
displayed after the section planes are applied. 

NOTE:  The on/off state of this toggle is only used in conjunction with the Section 
button below. It has no effect on which plane/direction vector is displayed in the 
active workpiece view. The plane /direction vector that is displayed in the active 
workpiece view is determined by the plane that is highlighted in the section planes 
table. 

Pl Type — Specifies section plane orientation. Standard options include six 
orientations that are perpendicular to axes of the active coordinate system (POS X, 
POS Y, POS Z, NEG X, NEG Y and NEG Z).  POS and NEG define the direction 
of the normal vector of the section plane with respect to the coordinate system axis. 
The normal vector points away from the portion of the part that will be displayed 
when it is sectioned. Using the Custom option, you can define a section plane at any 
orientation by entering the I, J, and K components of the desired normal vector in the 
Normal I J K fields (see below). 

Normal I, Normal J, Normal K — Specifies the I J K coefficients of a vector 
perpendicular to the desired section plane. These values are automatically set when Pl 
Type is set to one of the six standard options and cannot be changed. When Pl Type is 
set to Custom, the values can be changed to define the direction vector of the desired 
section plane. Values entered do not have to define a unit vector (vector length=1). 
Any combination of values can be entered to define the normal vector. 

Distance — Distance along the normal vector (see above), measured from the active 
coordinate system origin to the desired location of the section plane. Key in a value or 
pick a point on the model with the mouse. A positive value is measured along the 
specified normal vector, a negative is measured in the reverse direction. 

Start / End — When selected, defines the starting and ending planes for automatic 
sectioning. (See "Automatic sectioning features" below). 

The following actions can be accomplished by either selecting the associated button 
in the Section window or selecting it from the pull-down that results from using the 
right mouse button while the cursor is in the section planes table. 

Add — Use to add additional section planes to the table. 

Delete — Use to delete the highlighted section plane from the table. 
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Reverse — Use to reverse the direction vector of the highlighted plane to display the 
opposite side of the model after sectioning. 

  

Automatic sectioning features: 
This group of features displays a series of animated sectioned views, beginning with 
the plane identified as the "Start" plane (Start selected), and ending with the "End" 
plane (End selected). The start plane direction vector must point away from the end 
plane and the end plane vector must point away from the start plane for proper 
automatic sectioning to take place. Automatic section cuts are equally spaced. 

Cuts — The number of equally spaced section planes that will automatically be 
applied between the start and end section planes. 

Delay — Seconds of delay to pause between each automatic section cut display. 

Auto Section — Begins the automatic sectioning sequence. To interrupt an automatic 

sectioning, press  Stop, or click in the VERICUT main window and press the 
Escape <Esc> key. 

 

Section — Applies the active section plane(s) in the Section planes table to the model. 
The resulting "sectioned" model is displayed in all workpiece views. 

Restore — Restores the solid model from the sectioned display. The sectioned model is 
for display purposes only. When cutting has been performed with a sectioned view 
displayed, the results are the same as if the entire model was displayed.. 

Close — Closes the Section window. 
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Select/Store View window 
 
VERICUT Users: 
VERICUT Location: View menu > Select/Store 

  

Mold and Die Users: 
Mold and Die Location:   Change Views and View Layouts page > Custom Views 

Notebook Feature:      

  

Cutter Grinder Users: 
Cutter Grinder Location:   Change Views and View Layouts page > Custom Views 

Notebook Feature:      

  

Opens the Select/Store View window enabling you to store, modify and apply custom 
views. (See how) Defined views are shown in the "View List". Each custom view is 
stored with the View Type and orientation of the view that was active at the time it was 
stored. There is no limit to the number of views you can store. 

 

 
 

VERICUT Shortcut:  You can quickly reverse the orientation, or change the view to 
one of the standard or stored custom views by right-clicking on the view in the 
VERICUT graphics window, then selecting the desired view name using Select View 
option in the displayed menu. This shortcut is not available for Mold and Die. 
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View List — List of defined views. 

VERICUT Shortcut:  You can quickly Add, Delete, or Activate views in the View 
List by right-clicking on a view and selecting desired action from the displayed menu. 
This shortcut is not available for Mold and Die. 

 

Activate — Applies the View Type and orientation of the stored view highlighted in the 
View List to the active view in the VERICUT graphics window. 

Modify — Modifies the View Type and orientation of the highlighted view in the View 
List to match those of the active view in the VERICUT graphics window. 

Reset — Resets the active view in the VERICUT graphics area to the View Type and 
orientation that it had when the Select/Store View window was opened. 

Add — Adds a new view, after the highlighted view, to the View List. The new view will 
have the same View Type and orientation as the active view in the VERICUT graphics 
window. Double click on the view name to rename the view. Hit <enter> when you are 
through editing. 

Delete — Deletes the highlighted view from the View List. 

Delete All — Deletes all views from the View List. 

Close — Closes the Select /Store View window. 
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View Axes window 
Location: View menu > View Axes 

 

Opens a window to control when various axes and coordinate systems are displayed. 
Axes are created by VERICUT and are stored in the Preferences file. Coordinate Systems 
(CSYS) are user defined and are stored in the "setup". Once displayed, axes and 
coordinate system symbols remain displayed until toggled "Off" in the View Axes 
window. Solid lines indicate that an axis is parallel or pointing out of the screen. Dashed 
lines indicate that an axis is pointing into the screen. 

 

 
 

Shortcut: You can also change axes displayed by right-clicking in the view, and 
selecting from the Display Axes list in the menu that displays. 
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AXES 

Use the Color Pallet icons , to specify a "global" display color for each type of axes 
described below. 

Component — When selected, displays XcYcZc axes that representing the coordinate 
system of a component. Each component has its own local coordinate system.  

Model — When selected, displays XmYmZm axes that represent the coordinate system 
of a model. Each model has its own local coordinate system. 

Machine Origin — When selected, displays XmcYmcZmc axes that represent the 
coordinate system in which an NC machine is defined. 

Workpiece Origin — When selected, displays XwpYwpZwp axes that represent the 
coordinate system to which Stock, Fixture, and Design components are connected. 

• In a simulation where a machine IS NOT defined, such as when processing APT-
CLS tool path files, the workpiece coordinate origin is the origin of the non-
moving "Base" component to which Stock, Fixture, and Design components are 
connected. In previous VERICUT versions, this was known as the "World 
coordinate system" (XwYwZw axes). 

• In a simulation where a machine IS defined, such as when processing G-code tool 
path files, the workpiece coordinate origin is the origin the machine component 
responsible for carrying the Stock, Fixture, and Design components. 

Tool Tip Zero — When toggled "On", displays the XToolTipYToolTipZToolTip axes 
that represent where the tool tip (the VERICUT control point) of the "active" tool would 
be located, relative to the "active" stock, if all linear axes were positioned at zero. The 
display is based on the actual Machine/Control configuration and therefore may be 
displayed as a right hand axis, a left hand axis or possibly even a non-orthogonal axis. If 
no tool has been loaded, VERICUT assumes a zero length tool. 

The following should be considered when using this feature: 

• Tool Tip Zero is only applicable when processing G-Code Data. 

• The Tool Tip Zero display is based on the "active" tool. If the machine being used 
has more than one tool component, the correct tool component must be set as 
active before valid results can be achieved. 

• The Tool Tip Zero display is based on the "active" stock. If more than one stock 
component on the machine, the correct stock component must be set as active 
before valid results can be achieved. 

• The Tool Tip Zero display shows where the tool tip is and therefore may not be 
particularly useful when programming a 5-axis machine in "gage-length" mode. 
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Driven Point Zero — When toggled "On", displays the "driven point" (identified by the 

 symbol) and the XDrivenPointYDrivenPointZDrivenPoint axes. 

The "driven point" is only displayed in the Machine View. The initial "driven point" 
position is determined based on the following: 

• If there are no rotary/turret components attached to the "active" tool component, 
the initial driven point is the origin of the "active" tool component. 

• If there is 1 rotary/turret component attached to the "active" tool component, the 
initial driven point is the origin of the rotary/turret component. 

• If there are 2 rotary/turret components attached to the "active" tool component, 
the initial driven point is the intersection of the two rotary axes. 

• If there are more than 2 rotary/turret components attached to the "active" tool 
component, the initial driven point is the origin of the highest level rotary/turret 
component. 

The following offsets are then applied to the initial "driven point" (adjusted as needed for 
RTCP): 

• Gage Offset 

• Tool Nose Compensation Offset 

• Tool Length Compensation Offset 

• Turret Offset 

• Gage Pivot Offset 

• Pivot Offset (RTCP) 

• 3D Tool Length Comp Offset (Fanuc) 

The Driven Point Zero axes represent where the driven point of the "active" tool would 
be located, relative to the "active" stock, if all linear axes were positioned at zero. The 
display is based on the actual Machine/Control configuration and therefore may be 
displayed as a right hand axis, a left hand axis or possibly even a non-orthogonal axis. 
The Driven Point Zero axes are displayed in Workpiece, Machine and Machine/Cut 
Stock views. 

The following should be considered when using this feature: 

• Driven Point Zero is only applicable when processing G-Code Data. 

• The Driven Point Zero display is based on the "active" tool. If the machine being 
used has more than one tool component, the correct tool component must be set as 
active before valid results can be achieved. 

• The Driven Point Zero display is based on the "active" stock. If more than one 
stock component on the machine, the correct stock component must be set as 
active before valid results can be achieved. 
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• Some machine configurations do not conform to initial "driven point" rules 
described above and therefore will not produce useful results. An example of this 
would be Maho-Phillips machines using a two position head. The initial driven 
point could not be calculated correctly resulting in invalid results. 

• Dual turret machines typically will not have the active tool defined for both 
turrets, therefore the initial driven point can not be calculated correctly resulting 
in invalid results. 

• Some machine/controller combinations, like the one in the sample file 
bos5vm01.VcProject, may not produce the results that you might expect, but 
based on the above definitions, the displayed results are accurate. 

Spindle Direction — When toggled "On", a graphic is displayed indicating direction that 
the spindle is turning. 

  

Mill Example Lathe Example 

  

  

The Spindle Direction indicator can also be turned On/Off by right-clicking in the 
graphics window and selecting Display Axes > Spindle Direction from the pop-up menu 
that displays. 

Set Axes — When selected, all "axes" are toggled "On" and will be displayed. 

Clear Axes — When selected, all "axes" are toggled "Off" and will not be displayed. 

  

NOTES:  
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1. Axes display status is stored in the Preferences file. Axes that are displayed when 
exit a VERICUT session are displayed the next time you run VERICUT. 

2. Axes are drawn in the Foreground color by default. Use the Color Pallet icon , 
for each axes type to change the display color of the individual axes. 

  

COORDINATE SYSTEMS (CSYS) 
Display Active Coord. Sys. — When toggled "On", the active coordinate system will be 
displayed. 

Coordinate System Table — The Coordinate System Table displays all coordinate 
systems defined for the "current setup".  Each CSYS in the table has a checkbox that 
toggles "On" and "Off", indicating whether it is displayed or not. By default, CSYS are 
drawn in the Foreground color. The color of the CSYS can be changed using the Color 
Pallet button, described below. The background color of each Coordinate System 
Name field indicates the color that the CSYS will be displayed. 

Set CSYS — When selected, all "coordinate systems" are toggled "On" and will be 
displayed. 

 (Color Pallet button) — Use to define the display color for a "coordinate 
system". To specify a color for a particular CSYS, click on the Coordinate System 
Name field, in the Coordinate System Table, so that it becomes highlighted. The 
background color of the Coordinate System Name field indicates the current color of 
the CSYS. Click on the Color Pallet button and select the desired color from the color 
pallet that displays. 

Clear CSYS — When selected, all "coordinate systems" are toggled "Off" and will not 
be displayed. 

NOTES:  
1. Coordinate System display status is stored in the "setup".  

2. Axes are drawn in the Foreground color by default. Use the Color Pallet 

button ,  in the Coordinate Systems section of the View Axes 
window to change the display color of  individual coordinate systems. 

  

See also "VERICUT axes and coordinate systems" in the Using VERICUT section. 
Using VERICUT can be found in the VERICUT Help Library. 
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View Toolbar window 
Location: View menu > Toolbar 

 

Opens a window to control when the Toolbar is displayed and the icons it contains. 
Toolbar icons provide quick and easy access to the most commonly-used VERICUT 
functions/features. The Toolbar can be closed, opened, or customized at any time. (See 
how) 

 

 
 

Display Toolbar — When selected, displays Toolbar groups on the VERICUT main 
window. 

Set All, Clear All — Turns on (or off) display of all Toolbar icons. Corresponding 
options are all selected (or cleared). 

 

Toolbar groups: 

Toolbar Icons: Toolbar name: Functions (click for more info) 

 Close Close Toolbar 

File Open Project 

Save Project 

New Project (See NOTE 1 ) 

Open In Process File 
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Save In Process File 

Working Directory 

Edit NC Program 

Custom Interface 

 
Simulation 
Settings 

Motion 

G-code Settings 

APT Settings 

No Machine Simulation 

AutoSave 

Configuration Save Machine 

Save Control 

Machine Settings 

Component Tree 

Word Format 

Word Address 

Control Settings 

Control Advanced Options 

 
Static View Zoom to Box / Zoom creates new 

View (See NOTE 2 ) 

Zoom In 

Zoom Out 

Fit / Fit All 

Refine Display (See NOTE 3 ) 

Last Refine Display (See NOTE 4 ) 

 Reverse 

 
Cut Options OptiPath 

Standard/FastMill Cut Modes 

Delete Detached Stock 

MDI 
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Dynamic View Dynamic X/Y/Z/XY Rotation 

Dynamic Pan 

Dynamic Zoom 

Project Open Machine 

Open Control 

Setup Models 

NC Program 

Tools 

Output 

Coordinate Systems 

Project Tree 

 
Analysis AUTO-DIFF 

X-Caliper 

Toolpath Review 

Die Sinking Simulation 

Comparator 

 
Display Workpiece View 

Machine/Cut Stock View 

Draw Shaded 

Draw Lines 

Section 

Translucent 

Color 

 
Info View NC Program 

Status 

Graphs 

VERICUT Log 

Clear Log File and Logger 
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Images Image Record 

Image Playback / AVI Playback 
 (See NOTE 5 ) 

View Capture 

Print View 

  

NOTES:  

1. Right-click on the New Project icon to toggle between  (Inch) and  
(Millimeter) mode. 

2. Right-click on the icon to toggle between  (Zoom to Box) and   (Zoom 
creates new View) modes.  

 
Refine Display — When selected, refines the display to be a high-quality image. 
Refining the display can useful to see model details after model manipulation, such as 
zooming, rotating, panning, etc. This action occurs automatically any time cutting is 
started. 

Last Refine Display — When selected, returns a workpiece view to the last refined 
display image. This action is useful to quickly start cutting after manipulating the 
workpiece for viewing: zooming, rotating, panning, etc. 

Image Playback/AVI Playback — The active icon is set automatically based on the 
active image record output format (ref. File menu > Images > Record Movie). 

Clear Logfile and Logger — Clears both the VERICUT Log File and the Logger 
(Message Logger). 

  

For information about the other VERICUT functions accessed by Toolbar icons, click on 
the links above or refer to the function names in the VERICUT Menus and Features 
section of VERICUT Help. 
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Resolution 
Location: View menu > Resolution 

  

Controls the quality of cut model display. Increasing resolution displays a more accurate 
representation of the cut model, and requires more computer resources and processing 
time to display and manipulate the model. A coarse display resolution is automatically 
used when dynamically manipulating the model, such as rotation, zooming, etc. When the 
dynamic action is finished, the display is upgraded to the previous resolution. 

Options: 

Manual — A display resolution which allows most models to be manipulated with 
acceptable performance and display quality. 

Auto — Automatically sets display resolution based on viewing distance from the model. 
Resolution automatically increases when you zoom closer to see details on the model, 
and decreases as you zoom out. 
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Look & Feel 
Location: View menu > Look & Feel 

 

The Look & Feel features change the appearance of VERICUT's user interface. All 
windows are affected. The look and feel of VERICUT can be changed any time. (Not all 
options are available on all systems.) 

Options: 
 

Metal — 
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Motif —  
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Windows — 
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Windows Classic — 
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Text Larger — Use to make the text in VERICUT menus, message logger, windows, 
etc. larger. Each time you click on "Text Larger", the text gets incrementally larger to a 
maximum font size of "14 point". 

The following example shows the Text Larger feature at maximum size (14 point font). 
Notice the text in the menu bar, the View Toolbar window and the message logger 
 

 
 

 

337337



VERICUT HELP – View menu 
 
 

Text Smaller — Use to make the text in VERICUT menus, message logger, windows, 
etc. smaller. Each time you click on "Text Smaller", the text gets incrementally smaller to 
a minimum font size of "6 point ". 

The following example shows the Text Smaller feature at minimum size (6 point font). 
Notice the text in the menu bar, the View Toolbar window and the message logger. 

 

 
 

 

 
To change the user interface look and feel: 
 

1. Select View menu > Look and Feel. 

2. Choose the option, from the pull-down list, that provides the desired appearance. 
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Dynamic Controls 
Location: View menu > Dynamic Controls 

  

View menu > Dynamic Controls options enable you to use the same mouse actions 
while in VERICUT, that are required to perform dynamic pan, zoom or rotate in each of 
the supported CAD systems. This parameter is saved in the Preferences file. 

  

CATIA — Use CATIA's mouse action conventions for dynamic pan, zoom and rotate. 

Pro/E — Use Pro Engineer's mouse action conventions for dynamic pan, zoom and 
rotate. 

Unigraphics — Use Unigraphics' mouse action conventions for dynamic pan, zoom and 
rotate. 

VERICUT — Use VERICUT's standard  mouse action conventions for dynamic pan, 
zoom and rotate. 

Wildfire — Use Pro Engineer Wildfire's mouse action conventions for dynamic pan, 
zoom and rotate. 

  

The following table summarizes how each dynamic feature was implemented for each 
CAD system. 

  

 CATIA Pro/Engineer Unigraphics VERICUT Wildfire 

 Pan Middle mouse 
button, drag 

Hold Ctrl key, 
Right mouse 
button, drag 

Hold Shift key, 
Middle mouse 
button, drag 
(or, Middle & 
Right mouse 
button, drag) 

Hold Shift key, 
any mouse 
button,drag 

Hold down 
SHIFT, the 
middle mouse 
button, and 
drag the 
mouse. 

 Zoom 

Hold Middle 
mouse button, 
click Left or 
Right mouse 
button, drag: 

Up for larger 

Down for 
smaller 

Hold Ctrl key, 
Left mouse 
button, drag: 

Down or Left 
for larger 

Up or Right for 
smaller 

Hold Ctrl key, 
Middle mouse 
button, drag (or 
Left & Middle 
mouse button, 
drag 

Hold Ctrl key, 
any mouse 
button, drag: 

Up for larger 

Down for 
smaller 

Hold down 
CTRL, the 
middle mouse 
button, and 
drag the 
mouse 
vertically. 
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 Rotate 

Hold Middle 
mouse button, 
hold left or 
Right mouse 
button, drag 

Hold Ctrl key, 
Middle mouse 
button, drag 

Middle Mouse 
button, drag 

Hold Shift & 
Ctrl keys, any 
mouse button, 
drag 

Hold down the 
middle mouse 
button and 
drag the 
mouse. 

  

  

 

 

To change the dynamic controls behavior: 

 
1. Select View menu > Dynamic Controls. 

2. Choose the CAD System, from the pull-down list, that you want VERICUT to 
emulate. 
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Info Menu 
NC Program (Info) 
 
VERICUT Users: 
VERICUT Location: Info menu > NC Program 

VERICUT toolbar short cut:   

 
Mold and Die Users: 
Mold and Die Location:   Analyze, View Files, Print page > Display Tool Path Text 

Notebook Feature:       

 
Cutter Grinder Users: 
Cutter Grinder Location:   Analyze, View Files, Print  page > Display Grinding 
Program Text 

Notebook Feature:      

 

Opens a window displaying the NC program file being simulated. In this window, you 
can scroll through the entire file to see all the records, search for text forward and 
backward, print, and more. An arrow pointer indicates the current tool path record being 
processed. The window is updated when a new NC program file is processed, such as 
when a list of NC program files are simulated. (Ref. Project menu > NC Programs). 

The NC Program window is also one of the dockable windows enabling you to dock it 
inside the VERICUT main window if you choose. 

Tip: 
You can edit the tool path file using the Edit menu > NC Program function in 
VERICUT, or Analysis and Viewing page > Edit the Tool Path File in Mold and Die. 
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Status window 
 
VERICUT Users: 
VERICUT Location: Info menu > Status 

VERICUT toolbar short cut:  

 
Mold and Die Users: 
Mold and Die Location:   Preview and Optimize page > View Optimization Info 
While Cutting 

Notebook Feature:       

 
Cutter Grinder Users: 
Cutter Grinder Location:   View Simulation page > View Info While Grinding 

Notebook Feature:      

 

Opens a window that provides status information about the simulation, and what would 
be occurring on the NC machine. Status information includes: tool path record being 
processed, machine and tool tip locations, information about the cutting tool, machining 
conditions, errors and warnings detected by VERICUT. The Status window can be left 
open for monitoring, minimized, closed and opened at any time. Information displayed is 
configurable, and is updated after each tool path record is processed. You can re-
configure the window at any time. 

The Status window is also one of the dockable windows enabling you to dock it inside 
the VERICUT main window if you choose. 
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 Configure — Displays the Status window in configuration mode enabling you to 
specify status features that you want displayed in the Status window. Click on the icon to 
enter configuration mode. Click the icon again to return to the normal display mode. 

 Close Window — Closes the Status window. 

Tips: 
1. Status is recorded by the File menu > Images > Record function, and can be 

seen in the Status window when playing back the Image file. 

2. You can send status information to a text Status file. To accomplish this, set the 
CGTECH_STATUS environment variable to the name of the file before or when 
VERICUT is executed. 
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Status window, configuration mode 
 

The Status window, in configuration mode, enables you to select the items you want 
displayed in Status window. Click in the box to the left of each feature you want included 
in the Status window display. When toggled "On", a checkmark is displayed. Click on the 
checkmark to toggle "Off" the feature. 

  

 
  

  

The following features are available for display in the Status window: 

SubSystem — When a machine with more than one subsystem is in use, this option 
controls which subsystem status to show. 

Program — The name of the current NC program. 

Program Rec.# — The line number of the current NC program record. 
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Program Record — Current NC Program record being processed. Both the record text 
and sequential line number in the file are shown. 

Change Rec.# — The line number of the last tool change record. 

Change Record — The last tool change record processed. Both the record text and 
sequential line number in the file are shown. 

Machine Axes — Locations of machine axes resulting from processing G-Code NC 
Program data. 

Local Axes — The display will be similar to the Machine Axes (only showing the axis 
that exists for that subsystem). The contents of the "Local Axes" fields will represent the 
current X, Y, Z, A, B, C, U, V, W, A2, B2, C2 axis within the local coordinates. 
Typically, this will correspond to the values entered in the MCD file (except when 
specifying machine coordinates, or incremental values). 

Tool Tip — Current X Y Z tool tip location and I J K tool axis orientation with respect to 
the active tool path coordinate system. 

Tool Sequence — Sequential number of the last tool change event. 

Tool Number — Tool number in use (if specified). Examples follow. 

 

Tool path type: Sample tool chg record: Status window "Number":

G-code data T10M6 10 

APT  CUTTER/... none 

APT PPRINT/VERICUT-TC... none 

APT LOADTL/1 1 

UG CLS LOAD/TOOL,4,... 4 

  

Tool ID — ID of a tool retrieved from a VERICUT Tool Library file, if any. A blank 
field indicates the current tool did not come from a tool library. "OVERRIDE" indicates 
that the current tool has been specified via the Override feature. If the ID differs from 
the Number field value described above, the tool was specified via a tool list. 

Tool Geometry — Cutter shape geometry. The method used to define the cutter shape is 
shown in square brackets "[ ]" followed by the description. "PROFILE" indicates a 
profile type of cutter definition. 
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Tool Description — Description of a tool retrieved from a VERICUT Tool Library file. 
A blank field indicates a description for this tool was not defined in the library, or the tool 
did not come from a tool library. 

Errors — Quantity of errors detected by VERICUT. A blank field indicates no errors 
detected. Consult the Log file for details about the errors. 

Warnings — Similar to Errors above, except applies to warnings detected. 

Time — Time anticipated to machine the part (as simulated by VERICUT). To calculate 
anticipated machining time, VERICUT records time for tool motions based on specified 
cutting feed rates and rapid rates. 

Time % — Percentage of time in feed rate mode. This value can be helpful when 
judging tool path efficiency. For example, a high value suggests an efficient tool path, 
since a value less than 100 percent means that the tool is moving at rapid feed and is 
probably not removing material. 

Distance — Tool movement distance in inches or millimeters, depending in the 
VERICUT session configuration. 

Distance % — Percentage of tool movement distance in feed rate mode. Similar to the 
Time versus Time% relationship described above, this value can also be helpful when 
judging tool path efficiency. 

Feedrate — Current programmed feed rate. A blank field indicates no records that 
control feed rate that have been processed. 

Spindle — Current programmed spindle speed. A blank field indicates no records that 
control spindle speed that have been processed. 

Coolant — Current programmed coolant condition. A blank field indicates no records 
that control coolant that have been processed. 

Motion Type — Rapid / Linear / CW / CCW / Thread / Nurbs / Poly 

Abs/Inc — Absolute / Incremental 

Motion Plane — XY / YZ / ZX 

Units — Inch / Metric 

Spindle Mode — CSS / RPM 

Compensation — On / Off 

Cycle — Off / Drill / Face / Deep / Tap /Bore / Mill / Thru / Bore Orient / Bore Drag 

Interpolation — None / Polar / Cylindrical 

OptiPath Time — Time anticipated to machine the part with an optimized tool path file. 
This field is only updated when the current tool path if being optimized by OptiPath. To 
estimate machining time saved by OptiPath, compare this value against the Time field 
value. 

NOTE:  OP Time DOES NOT consider feedrates output as a result of 
Acceleration/Deceleration optimization adjustments. 
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OptiPath Feed — Optimized feed rate, as calculated by OptiPath. 

OptiPath Spindle — Optimized spindle speed, as calculated by OptiPath. 

  

The following features are in effect when OptiPath Mode is set to On, Prompt While 
Cutting or Learn From NC Program. They report maximum volume removal rate and 
chip thickness for each cut calculated by OptiPath for the programmed feedrate. 

Volume Removal — Volume Removal Rate is calculated for any Optimization Method 
and for any tool valid for OptiPath. 

Chip Thickness — Chip Thickness is calculated only if the Optimization Method for 
the current tool is either Chip Thickness, or Chip Thickness and Volume Removal. 
Chip Thickness is not calculated when OptiPath optimizes by any other method. When 
OptiPath Mode is set to Learn From NC Program, Chip Thickness is calculated only 
for tools, which have a convex profile. 
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Graphs window 
VERICUT Location: Info menu > Graphs 

VERICUT toolbar short cut:  

  

The Graphs window enables you to display a Tool Use graph showing information 
related to tool use and/or the Cutting Conditions graph showing selected cutting 
conditions.  

  

 
  

Common Features: 
 Time Interval — Use to specify the time interval represented by the Tool Use graph 
display. Use the Time Interval text field to specify the time interval represented by the 
Tool Use graph.   

/2 — Use to reduce the displayed time interval by a factor of 1/2. 

X2 — Use to increase the displayed time interval by a factor of 2. 
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 Configure — Displays the Graphs window in configuration mode enabling you to 
specify graph display characteristics and features. Click on the icon to enter configuration 
mode. Click the icon again to return to the normal display mode. 

 Close Window — Closes the Graphs window. 

  

Tool Use Graph: 
When toggled "On", the Tool Use graph is displayed which shows the machining time 
spent by each simulated tool. Each tool that cuts the part is shown in the graph with its 
cut color. Tool changes are indicated by a spike in the graph line. Positioning the mouse 
cursor on or above a graph line displays data about that tool. A 4-axis turned part has 2 
graph lines; one for each turret. Machines with additional heads/sub-systems will have a 
graph line displayed for each. A gap in a graph line indicates idle time spent waiting for a 
turret/sub-system to synchronize. Positioning the mouse cursor above a gap in the graph 
displays the amount of idle time. 

 

Tool Use graph features: 

 
 
Sample Tool Use graphs: 
  

Tool Use graph from a milling NC Program: 
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Tool Use graph from 4-axis merged turning NC Program: 

 
  

Cutting Conditions Graph: 
When toggled "On", the Cutting Conditions graph is displayed which shows changes in 
the selected cutting condition features. The picture below shows the Cutting Conditions 
graph display for 4-axis merged turning NC Program, with the Feed Per Minute and 
Spindle Speed features toggled "On". 
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Cutting Condition graph features: 
Select any of the following "cutting condition" features to be displayed in the Cutting 
Conditions graph. Each feature can be toggled On/Off at any time and the graph will be 
immediately updated. 

Depth — Depth of cut. 

Width — Width of cut. 

Volume Removal Rate — Volume removal rate based on programmed values. 

Chip Thickness — Chip thickness based on programmed values. 

Feed Per Minute — Feed per minute based on programmed values. 

Feed Per Tooth — Feed per tooth based on programmed values. 

Feed Per Revolution — Feed per revolution based on programmed values. 

Spindle Speed — Spindle speed. 

Surface Speed — Surface speed. 

Contact Area — The area of the tool that is in contact with the material. 

OP Volume Removal Rate — Optimized volume removal rate, as calculated by 
OptiPath. 

OP Chip Thickness — Optimized chip thickness, as calculated by OptiPath. 

OP Feed Per Minute — Optimized feed per minute, as calculated by OptiPath. 

Op Feed Per Tooth — Optimized feed per tooth, as calculated by OptiPath. 

OP Feed Per Revolution — Optimized feed per revolution, as calculated by OptiPath. 

Show Tool Change — Use to show tool changes in the Cutting Conditions graph. Tool 
changes are represented by a vertical line, in the cut color, at the point of the tool change. 
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Graphs window, configuration mode 
  

The Graphs window, in configuration mode, enables you to specify graph display 
characteristics and features to be graphed. Many of the features are identical to the ones 
in the Graphs window and are described there.  

  

 
  

Tool Use — When toggled "On" (check mark displayed), displays the Tool Use graph 
which shows the machining time spent by each simulated tool. Each tool that cuts the part 
is shown in the graph with its cut color. Click in the box to the left of Tool Use to toggle 
the graph On/Off. 

Cutting Conditions — When toggled "On" (check mark displayed), displays the Cutting 
Conditions graph which shows changes in the selected cutting condition features. Click in 
the box to the left of Cutting Conditions to toggle the graph On/Off. Select any of 
"cutting condition" features to be displayed in the Cutting Conditions graph from the list 
below the graph area. 
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Color Pallets — Use the color pallet associated with each cutting condition feature to 
specify the color that is to represent the feature in the graph. Click on the icon to display 
the color pallet for your color selection. 

Min/Max values — Use the Min/Max values associated with each cutting condition 
feature to specify the lower/upper limits of the range of values representing the vertical 
component of the graph (see the picture below).  

Show Tool Change — Use to show tool changes in the Cutting Conditions graph. Tool 
changes are represented by a vertical line, in the cut color, at the point of the tool change 
(see the picture below). 

Set All — Select all available features to be displayed in the Cutting Conditions graph. 

Clear All — Clear all selected features. 

  

Sample Cutting Conditions graph: 
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Machine Offsets window 
VERICUT Location: Info menu > Machine Offsets 

  

 
  

Opens a window that displays the values that are set for each machine offset and whether 
the particular machine offset is currently active. If you "Single Step" through the 
toolpath, the displayed values update at the end of each motion. When you are using 
"Play to End", the displayed values are updated each time you "Stop" processing or 
when processing stops at the end of the NC program. The Machine Offsets window is 
intended for debugging purposes only. The window displays current values set for each 
offset and whether the offset is currently active. You cannot modify the values directly in 
the Machine Offsets window. The values must be edited in the table or macro in which 
they were originally set. 

 The offsets are grouped into 4 categories:  Work& Shift, Tool, Other, and Total 
Offsets, as shown in the Category column in the window above. Each Category can 
consist of a number of different machine offsets and are displayed in the Offsets column. 
The remaining columns indicate the offset values that are set/applied for each machine 
axis. Each particular offset will only displayed if it contains non-zero values. If all offsets 
within a Category are zero, then the Category will not be displayed. The exception to this 
rule is the Total Offsets Category which will always be displayed. 
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This window also contains a series of flags associated with offsets and transformations. 

 

SubSystem — All values displayed in the Machine Offsets window are specific to a 
particular subsystem. If the machine configuration has more than one subsystem, use this 
feature to select the desired subsystem. 

 

Offset Categories 
 
Work and Shift: 
These offsets are in a separate category because the DynamicWorkOffsets feature 
applies to these offsets. 

Base Work Offset — Base Work Offset is affected by the following macros: 

SetBaseWorkOffset 
CancelWorkOffsets 
EnableWorkShiftOffsets 
DisableWorkShiftOffsets 
CancelAllWorkOffsets 
BaseWorkOffsetValues 

For information about these, and all, VERICUT macros, see the VERICUT Macros 
section of VERICUT Help. 

NOTE:  This offset is automatically applied during reset. 

 

Work Offset — Work Offset is affected by the following macros:  

WorkCoord 
AdditionalWorkCoord 
SetBaseWorkOffset 
CancelWorkOffsets 
EnableWorkShiftOffsets 
DisableWorkShiftOffsets 
CancelWorkOffsets 
CancelAllWorkOffset 

For information about these, and all, VERICUT macros, see the VERICUT Macros 
section of VERICUT Help. 

 NOTE:  This can also be set from the Configuration menu > Control Settings: 
Offsets tab. 
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Secondary Work Offset — Secondary Work Offset is affected by the following macros: 

SecondaryWorkCoord  
SecondaryRefWorkCoord 

For information about these, and all, VERICUT macros, see the VERICUT Macros 
section of VERICUT Help. 

 

Shift 1 — Shift 1 is affected by the following macros: 

ChangeWorkCoord 
AbsoluteShift, IncrementalShift 
EnableWorkShiftOffsets 
DisableWorkShiftOffsets 
CancelShiftOffsets 
CancelAllWorkOffsets 
SiemensShiftOffsetA 
SiemensL137COffset 
SiemensL137CoffsetCancel 

For information about these, and all, VERICUT macros, see the VERICUT Macros 
section of VERICUT Help. 

 

Shift 2 — Shift 2 is affected by the following macros: 

AbsoluteShiftNum 
OkumaCopyStart 
OkumaCopyEnd 
OkumaShiftRotate 
OkumaCancelShiftRotate 
SiemensShiftOffsetB. 

For information about these, and all, VERICUT macros, see the VERICUT Macros 
section of VERICUT Help. 

 

Shift 3 — Shift 3 is affected by the following macros: 

NumLengthCompX 
NumLengthCompY 
NumLengthCompZ 

For information about these, and all, VERICUT macros, see the VERICUT Macros 
section of VERICUT Help. 

 

Total — The combined total of all of the above offsets. 
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Adjusted Total — The resulting total after the corresponding rotations have been  

applied. 

 

Tool:  
In many cases, an offset will be applied to the machine based on the tool offset and the 
orientation of the tool. The tool offset can actually be composed of several pieces; some 
of which are mutually exclusive. 

Gage Offset — This value is typically calculated from the tls file. It is the "Gage Offset" 
minus the "Ctrl Pt". You can override the value from the tls file with an entry in the Gage 
Offset Table. This value is typically set with a tool change. Its value can also be updated 
with a call to the ToolOffsetUpdate macro 

 

Tool Length Offset — This value is typically only used if the Programming Method is 
set to Tool Length Compensation. This value can, however, be used in all 3 Programming 
Methods. The value will be set based on the corresponding entry in the Tool Length 
Compensation table. If no entry exists, and the Programming Method is set to Tool 
Length Compensation, this value will be set to the Z value of the Input Program Zero + 
the Z value of the Gage Offset. Tool Length Offset is affected by the following 
ToolLengthComp... macros: 

ToolLengthCompUpdate 
ToolLengthCompPos 
ToolLengthCompNeg 
ToolLengthCompOff 
ToolLengthCompValue ToolLengthCompToolnum 
SiemensPlaneSelectionArg. 

For information about these, and all, VERICUT macros, see the VERICUT Macros 
section of VERICUT Help. 

 

Tool Nose Comp — Tool Nose Comp is affected by the following ToolNoseComp... 
macros: 

ToolNoseCompApply 
ToolNoseCompCancel 
ToolNoseCompToolNum 
ToolNoseCompValue 

For information about these, and all, VERICUT macros, see the VERICUT Macros 
section of VERICUT Help. 

 

Turret Offset — The turret offset is defined to be the XYZ distance from the active tool 
to the center of its corresponding Turret. This offset can be turned on and off. When 
turned on, this offset will be set with calls to either TurretActivateTool or 
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TurretToolChange macros. It can also be reset to zero if the current gage offset is set to 
zero and the apply turret offset flag is set accordingly. This flag is set with the 
ApplyTurretOffset macro. 

For information about these, and all, VERICUT macros, see the VERICUT Macros 
section of VERICUT Help. 

 

GagePivotOffset — This offset is used as an alternative approach to RTCP (Dynamic 
Tool Offsets). RTCP has been based on the concept of the spindle face being the driven 
point when there is no tool in the spindle. When a tool is loaded, and then rotated, both 
the gage offset and the pivot offset needs to be adjusted. When driving the center of the 
pivot, and then adjusting for the gage and pivot offset, the calculation is different. This 
offset is used for this latter approach. Its functionality is currently limited. The capability 
is turned on with the ApplyGagePivotOffset macro, and its value is updated whenever 
the tool offsets are updated. This capability is mutually exclusive with RTCP. 

For information about this, and all, VERICUT macros, see the VERICUT Macros 
section of VERICUT Help. 

 

Current RTCP Pivot Offset — The pivot offset can set be set in the RTCP Pivot 
Offset Table. If the corresponding entry does not exist, it will be auto-calculated based 
on the active tool component and the position of the corresponding parent rotary 
components. The application of this offset can be turned on, or off, using the 
ApplyPivotOffset macro. When applied, it will be adjusted based on the orientation of 
the tool. It assumes that in its initial state, no offsets are to be applied. The initial state is 
set at start of processing, and can be updated with a call to the SetPivotOffset macro. 

For information about these, and all, VERICUT macros, see the VERICUT Macros 
section of VERICUT Help. 

 

Applied Total — This is the sum of the Tool offsets, which are currently being applied.  

NOTE:  Not all of the offsets listed will be applied. For example: Gage Offset values 
might be specified, but may not be applied because the Programming Method is set to 
Gage Length.  

 

Adjusted Total — This value takes the applied total, possibly adjusts it based on the 
orientation of the tool, and then applies it to the corresponding axis. See the following 
macros: 

XToolOffsetCompName 
YToolOffsetCompName 
ZToolOffsetCompName. 

For information about these, and all, VERICUT macros, see the VERICUT Macros 
section of VERICUT Help. 
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Other:    
Dynamic 3D Tool Offset — See Tool3dOffset in the VERICUT Macros section of 
VERICUT Help. 

 

3D Tool Length Comp — The Tool Length Offset as describe above, is an offset, which 
applies only to Z. There is special handling of this value within the software, and has 
therefore not been grouped with the Tool offsets. This offset can be applied to any axis. 
See FanucToolLengthComp and ToolLengthCompOff in the VERICUT Macros 
section of VERICUT Help. 

 

Input Program Zero — This offset is typically set in the Input Program Zero (Special 
Z) table. The values are automatically activated during initialization, and can be updated 
with calls to UpdateIPZ and AutoUpdateIPZ macros.  When the Programming 
Method is set to Tool Length Compensation, the Z value of the IPZ will not be applied. 
In this programming method, the Z value might later be used in the calculation of the 
Tool Length Offset. 

 

Input Machine Zero — This offset is set in the Machine Zero table and is 
automatically activated during initialization. Typically, this offset is not used. 

 

Miscellaneous — Other offsets that might be applied – intentionally not defined. 

 

Total — Sum of the above offsets. 

 

Total Offsets:  
Sum of all offsets being applied.   

NOTE:  This does not include rotation planes. 

 

Active Translations/Rotations: 
The following become highlighted when the particular translation/rotation is active. 
RTCP Pivot Offset is shown in its "active" state in the sample Machine Offsets window 
shown at the start of this topic. 

Gage Offset — If the Programming Method is set to Tool Tip, the Gage Offset will be 
applied. 

 

RTCP Pivot Offset — This flag is set if in RTCP mode and the pivot offset is applied. 
See macros: 
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RtcpOn 
RtcpOff, RotaryControlPointOnOff 
ApplyPivotOffset.  

This flag is also set if in a special Fanuc Tool Length Comp Mode and the apply pivot 
offset flag is set to 2. See macros: 

FanucToolLengthCompAxisOn 
ToolLengthCompOff. 

For information about these, and all, VERICUT macros, see the VERICUT Macros 
section of VERICUT Help. 

 

3D Rotation Planes — This flag is set if Rotation Planes are currently being applied. See 
macros: 

RotationPlane 
RotationPlane2 
RotationPlaneCancel 
RotationPlaneCancel2 
FidiaRotate 
FidiaRotate2 
FidiaRotateCancel 
FidiaRotateCancel2 
NumPlane 
VirtualYAxis 

For information about these, and all, VERICUT macros, see the VERICUT Macros 
section of VERICUT Help. 
 
Turret Offset — This flag is set with the ApplyTurretOffset macro. 

 

2D Rotations — 2D rotations are defined within the active plane (XY, YZ or ZX).  The 
2D rotation flag is set with calls to the following macros:  

RotateXYZ 
RotateCancel 
RotateOrigin 
RotateMacro 

For information about these, and all, VERICUT macros, see the VERICUT Macros 
section of VERICUT Help. 
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Mirroring — If mirroring about any axis is set, this mirror flag will be set. Mirroring is 
activated with calls to the following Mirror... macros:  

MirrorX 
MirrorY 
MirrorZ 
MirrorA 
MirrorB 
MirrorC 
MirrorA2 
MirrorB2 
MirrorC2 
MirrorXValue 
MirrorYValue 
MirrorZValue 
MirrorAValue 
MirrorBValue 
MirrorCValue 
MirrorA2Value 
MirrorB2Value 
MirrorC2Value 
MirrorCancel 
MirrorXCancel 
MirrorYCancel 
MirrorZCancel 
MirrorACancel 
MirrorBCancel 
MirrorCCancel 
MirrorA2Cancel 
MirrorB2Cancel 
MirrorC2Cancel 

For information about these, and all, VERICUT macros, see the VERICUT Macros 
section of VERICUT Help. 

 

Gage Pivot Offset — This feature is turned on with the ApplyGagePivotOffset macro. 

 

RPCP — This feature can be set using the Configuration menu > Control Settings: 
Rotary tab. It can also be set with the following macros: 

RpcpOn 
RpcpOff 
RotaryControlPointOnOff 

For information about these, and all, VERICUT macros, see the VERICUT Macros 
section of VERICUT Help. 
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File Summary window 
  
VERICUT Users:  
VERICUT Location: Info menu > File Summary 

 

Mold and Die Users: 
Mold and Die Location:   Analyze, View Files, Print page > Show Files Used 

Notebook Feature:       

 

Cutter Grinder Users: 
Cutter Grinder Location:   Analyze, View Files, Print page > Show Files Used 

Notebook Feature:      

  
Opens a window reporting a summary of environment variables and files currently in use 
by VERICUT. All standard text viewing features are supported, such as: search 
forward/backward, go to line number, print, etc. 
 

A "Copy all files" option  provides a quick and easy way to store a copy of the files 
in a new directory. This action is useful when preparing a set of files to send to CGTech, 
or other destination. 
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Sample File Summary window: 
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G-Code Report 
Location: Info menu > G-Code Report 

 

Creates a G-Code Report file containing information about how the current NC control 
configuration will interpret a G-code tool path file. Reported information includes: 
machine codes present in the tool path and macros (actions) they will call, variables used 
(if any), cutting tools used, subroutines defined and referenced, and more. 
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Control Report 
Location: Info menu > Control Report 

 

Creates a Control Report file containing information about how the current NC control 
configuration will interpret machine codes. Reported information includes all the G-
codes the control is configured to handle and macros (actions) they will call, subroutines, 
and other supported control features. 
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VERICUT Log 
  
VERICUT Users: 
VERICUT Location: Info menu > VERICUT Log 

Toolbar shortcut:  
  
Cutter Grinder Users: 
Cutter Grinder Location:   Analyze, View Files, Print page > View Log File 

Notebook Feature:      

 
Opens a window containing the VERICUT Log file. This file contains session 
information, such as error, warning and informational messages about the verification 
session. In this window, you can view, print, change then name, or reset Log file 
contents. 
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Clear Log File and Logger 
Location: Info menu > Clear Log File and Logger 

Toolbar shortcut:  

  

This feature enables you to clear both the Message area, also known as the "message 
logger", and the Log file. 
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Project Menu 
Introduction to the Project Setup menu 
 

The features on the Project Setup menus provide the tools required for the day to day use 
of VERICUT for setting up jobs for verification and simulation. The following basic 
concepts are needed to understand the process of setting up a job for VERICUT. 

 

 
 

Project — A project consists of one or more setups (see Setup below) enabling you to 
simulate multiple operations in a single VERICUT session. Multiple Setups within a 
project can be for the same, or different machines. A Project with a single Setup is 
logically equivalent to the User file of past VERICUT releases. 
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Setup — A Setup is a collection of VERICUT settings and files (machine, control, tool 
library, etc.), NC program files, and Setup models (Stock, Fixture, Design) that define the 
machine operation to be simulated. A Setup is logically equivalent to the User file of past 
VERICUT releases. 

Current Setup — The Setup menu choices such as CNC Machine, NC Programs, etc., 
apply only to the Current Setup. A setup can be designated "current" either by selecting it 
using the Current Setup option in the Project menu, or by selecting it in the Project Tree. 
The "current" setup is indicated by a checkmark in the Current Setup menu and is 
displayed as bold in the Project Tree (See Setup 3 in the picture above). 

Active / Inactive Setup — A Setup can be designated as being in either an Active, or 
Inactive state. When a Setup is designated as Inactive, it is not simulated, as if it were not 
present in the overall process. An Inactive setup can however be designated as the 
"current" setup and modified. Inactive Setups are indicated by red text in both the Current 
Setup menu and in the Project Tree (See Setup 2 in the picture above). 
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Current Setup 
Location: Project menu > Current Setup 

  

Selecting Current Setup displays a pull-right menu showing a list of available Setups. A 
check mark is displayed next to the current setup (See Setup 3 in the picture below). 
Picking a setup on the list makes it the current one. Inactive setups are displayed in red 
text (See Setup 2 in the picture below). 
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Add New Setup 
Location: Project menu > Add New Setup  

  

Add New Setup appends a new setup after the current setup. All settings from the current 
setup are copied to the new setup. Once the new setup is added, it becomes the current 
setup. 
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Delete Current Setup 
Location: Project menu > Delete Current Setup 

  

Delete Current Setup deletes the current setup and makes the next setup in the list the 
current setup (Example 1). If the setup at the end of the list is deleted, then the previous 
setup becomes the current setup (Example 2). There must always be at least one setup in 
a project. Therefore the last remaining setup cannot be deleted. 

   

Example 1:   

 

Before using Delete Current 
Setup, Setup: 2 is the "current" 
setup. 

 

After using Delete Current 
Setup, Setup:2 is deleted and 
Setup:3 (the next in the list) 
 becomes the "current setup. 
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Example 2: 
   

 

Before using Delete Current 
Setup, Setup: 4 (the last in the 
list) is the "current" setup. 

 

After using Delete Current 
Setup, Setup:4 is deleted and 
Setup:3 (the previous in the 
list)  becomes the "current 
setup. 
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Import Setup 
Location: Project menu > Import Setup  

  

Copies a setup from either a pre-V6.0 user file or from a V6.0 project file and appends it 
after the current setup.  

  

 
  

Project File selection window — Use the Project file selection window to specify the 
project file that the setup is to be imported from. 

Setup List — After selecting the project file, a list of setups contained in the project file. 
Select one or more setups to be imported. Use the Shift and Ctrl keys on the keyboard to 
select multiple setups. 

Import — Use to import the highlighted setups into the "current" project file. 

Close — Closes the Import Setup window without importing any setups. 
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CNC Machine window 
Location: Project menu > CNC Machine  

  

CNC Machine opens a dialogue for selecting the Machine and Control file to use for the 
current setup. 

  

 
  

Machine 
Machine files contain data that describes NC machine construction, kinematics, and other 
properties. 

Enter the \path\file name in the text field of the Machine file to be used or click on the 
Browse button and use the file selection window that displays to specify the machine file.  

You can also click on the arrow button  at the end of the Machine text field to display 
a list of all the Machine files contained in the "library" directory of your VERICUT 
installation and select the desired Machine file from the list. 

  

Control 
Control files contain data that describes how the NC control processes machine code 
data. 

Enter the \path\file name in the text field of the Control file to be used or click on the 
Browse button and use the file selection window that displays to specify the control file.  

You can also click on the arrow button  at the end of the Control text field to display 
a list of all the Control files contained in the "library" directory of your VERICUT 
installation and select the desired Control file from the list. 

376376



VERICUT HELP – Project menu 
 

Setup Models 

Define (Modeling window) 
VERICUT Users: 
VERICUT Location: Project menu > Setup Models > Define 

VERICUT toolbar short cut:  

  
Mold and Die Users: 
Mold and Die Location:   Analysis and Viewing page > Specify a Design Model 

Notebook Feature:      

 

Opens the Modeling window to define or import the models that represent the solid 
objects used in the simulation. VERICUT uses "components" to describe the function of 
various solid objects, while models provide 3-D size and shape for material removal and 
collision checking. To learn more, see "About modeling in VERICUT" in the Using 
VERICUT section. Using VERICUT can be found in the VERICUT Help Library. 
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Active Component — Component active for editing. The active component is 
automatically set when you select items from the graphics area or Component Tree 
window. However, you can select a different component via picking it from the option 
list. 

Component Type — The active component's type is shown in an un-editable field for 
reference purposes. To change the component type, use the Component Tree window 
Edit menu. 

Selected — Identifies what is selected for editing: a Model or the Component. This 
option is automatically set when you select items from the graphics area or Component 
Tree window. However, you can change what is selected for editing via clicking the other 
option. 

 

Model tab — Features on this tab add and modify models attached to components to 
provide 3-D shape. The models can be simple parametric shapes, or refer to external 
model files. 

Position tab — Features on this tab move a component or model. 

Component Attributes tab — Features on this tab define the attributes of a component. 

Import tab — Features on this tab import IGES model files for use as stock, fixture, 
design, or machine component models. 

 

OK — Applies the changes and closes the Modeling window. 

Apply — Applies the changes and leaves the Modeling window open. 

Cancel — Closes the Modeling window without applying changes. 

 

Tips: 
1. Right-click shortcut menu: Features used to manipulate components are displayed 

in a shortcut menu when a component is selected and the right mouse button is 
clicked in the Component Tree window. Similarly, features used to manipulate 
models are displayed when a model is selected and the right mouse button is 
clicked. 

2. Delete components or models by selection the object in the graphics area, then use 
the <Delete> key on your keyboard 

3. You can move objects in the Component Tree window via dragging them from 
one parent component to another, or copy them via holding down the <Ctrl> key 
and dragging. 

4. Click repeatedly on a model in the graphics area to toggle selection between the 
model and its component. Refer to the Component Tree window to review what is 
selected. 
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5. Using the center mouse button of a three button mouse, click repeatedly on a 
model in the graphics area to toggle selection between different models along the 
line of sight from the pick point. Use this technique to select models hidden from 
view by an object in the foreground. 
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Modeling window, Model tab 
Location: Project menu > Setup Models > Define 

Toolbar short cut:   

 

Features on this tab are used to add and modify models attached to components to 
provide 3-D shape. (See how) The models can be simple parametric shapes, or refer to 
external model files. 

 

 
  

Type — Type of model being defined. The active choice configures the model 
description area below this option with the values needed to define the selected model. 
The table below lists the available model types and corresponding descriptions. 
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Model type: Appears in the Component 
Tree: 

Description 

Block 
 

 

Length (X), Width (Y), 
Height (Z), Color, Auto 
Block, Offset 

Block specific features: 
Length (X), Width (Y), Height (Z) — Dimensions of the block. 

Auto Block — When defining a Block type model, this feature automatically defines and 
locates a stock block based on tool positions in the current tool path file(s). Rapid and 
APT-CLS “FROM” tool positions are ignored during this calculation. The block size and 
location guarantee that the tool path will cut the block. 

Offset — Offset applied to a block created using Auto Block (see above). The offset is 
applied in all dimensions. 

  

Cone 
 Height (Z), Base 

Radius, Top Radius, 
Color 

Cone specific features: 
Height (Z), Base Radius, Top Radius — Dimensions of the cone (height, radius at the 
base of the cone and the radius at the top of the cone). 
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Cylinder  Height (Z), Radius, 
Color 

Cylinder specific features: 
Height (Z), Radius — Dimensions of the cylinder. 

  

Model File  

 

 

 

 
 

Model File, Sketcher, 
 Normals*, Units, 
Color 

Model File specific features: 
Model File — Enter the /path/filename of the model file or use the Browse button to 
display a file selection window and use it to select the model file. 

Sketcher — Displays the Profile Sketcher window enabling you to edit or create a 
"Sweep solid (.swp)" or "Revolve (.sor)" model file. This feature is only available 
when the selected file is a Revolve or Sweep file type. To create a new Revolve or 
Sweep model file, clear the Model File text field and press Sketcher, select the profile 
type (Revolve or Sweep) from the window that displays, then OK to display the Profile 
Sketcher window. Cancel dismisses the Profile Type window. 

Normals — This feature applies to STL file models only and indicates the direction in 
which surface normals defined in the STL data point, relative to the model. Select 
Inward, Outward, or Computed (let VERICUT determine the direction of the surface 
normals). 

Units —Units (Inch or Millimeter) of the model file.  

 

Common Features 
Color — Color of the model. Available colors are the Shade Colors defined on the Edit 
menu > Colors: Define tab. Models connected to the component have the option to 
"Inherit" or override the component's defined color. 

Add — Adds the model defined by the current window values to the active component. 

Visible — Toggles "on" or "off" to indicate whether or not the model file should be 
displayed in the graphics area. 
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Preserve Stock Transition — Use to create the coordinate systems required for 
transitioning the cut stock from one setup position to another. Preserve Stock Transition 
is only active when a stock component model is selected.  

When Preserve Stock Transition is pressed, two coordinate systems named "setup 
sequence:setup name" are created and added, where setup sequence is a number 
representing the nth setup in the project, and setup name is the text name of the setup. 
One CSYS is added to the current setup, attached to the Stock Component parent of the 
selected model. It is created with Use for Cut Stock Transition toggled "On", 
designating it as a coordinate system  used for transitioning the cut stock from one setup 
position to another. The other CSYS is added to the first setup in the project, and is 
located at the origin of the stock component who's name matches current setup stock 
component. The following illustrates how to use Preserve Stock Transition: 

1. Configure Setup #1. 

2. Simulate. 

3. Configure Setup #2. 

4. Move cut stock into position using cut features and assembly modeling to position 
the cut stock 

5. Press Preserve Stock Transition. 

6. Simulate. 

7. Configure Setup #3. 

8. Move cut stock into position. 

9. Press Preserve Stock Transition. 

10. Simulate.  

11. and so on ... 
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Modeling window, Position tab 
Location: Project menu > Setup Models > Define 

Toolbar short cut:   

 

Features on this tab move an object: component or model. 

 

 
 

Translate tab — Features on this tab translate the selected object via indicating "from" 
and "to" points to move the object. 

Rotate tab — Features on this tab rotate the selected object about a rotation center point. 

Assemble tab — Features on this tab move the object by assembling (mating or aligning) 
it with other objects. 

Matrix tab — Features on this tab move the selected object via a twelve parameter 
transformation matrix. 

CSYS tab — Features on this tab enable you to move a selected component/model from 
one coordinate system to another. 

Mirror tab — Features on this tab enable you to mirror a model about a specified axis 
(plane). 
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Location features 
The Location features are common to all of the above tabs and show the selected object's 
position and angle, and can be used to move the object or verify its current location. 
Values are shown relative to the parent component or machine origin, whichever is 
selected: Relative Location or Machine Location, respectively. 

Location Relative to Parent — When selected, indicates object location is shown 
relative to the parent component origin. Examples follow. 

Positioning a component — component is moved relative to the parent component 
origin. 

Positioning a model — model is moved relative to the component origin. 

Location Relative to Machine Csys — When selected, indicates object location is 
shown relative to the machine origin. 

Position — Specifies the absolute XYZ position of the object, separated by spaces. 

Angles — Specifies the absolute XYZ rotation of the object, separated by spaces. 

Undo — Returns the object to its previous location, or as it was when the Modeling 
window was opened. 
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Modeling window, Position tab, Translate tab 
Location: Project menu > Setup Models > Define: Position tab 

 

Features on this tab translate the selected object via indicating "from" and "to" points to 
move the object. Movement occurs each time you press the Move button. (See how) If 
the applied movement is incorrect, press Undo (on the Position tab) to return the object to 
its previous location. 

 

 
  

Translate tab features 
From / To — Specifies the locations to move the object from and to, relative to the 
machine origin. XYZ values can be entered (separated by spaces), or selected by clicking 
in the field then clicking on a model. As you move the mouse over the VERICUT model, 
a crosshair and vector show you the pending pick-point location. Graphical selection 
supports picking corner points and midpoints of uncut model geometry, or virtually any 
point on machined features. 

  

Move — Moves the selected object by the incremental distance, as calculated from the 
"From" point to the "To" point location. 
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Modeling window, Position tab, Rotate tab 
Location: Project menu > Setup Models > Define: Position tab 

 

Features on this tab rotate the selected object about a rotation center point. Movement 
occurs each time you press one of the rotation direction buttons: X+/X-, Y+/Y-, Z+/Z-. 
(See how) If the applied movement is incorrect, press Undo to return the object to its 
previous location. 

 

 
 

Rotate tab features 
Center of Rotation — Specifies XYZ point location about which to rotate the object. 
XYZ values can be entered (separated by spaces), or selected by clicking in the field then 

clicking a position on a model. To see the center of rotation, press . To remove the 
center of rotation symbol press the button again, or close the window. 

Increment — Specifies incremental degrees of rotation to apply when one of the rotation 
direction buttons are pressed. 

Rotation direction buttons — (X+/X-, Y+/Y-, Z+/Z-) When pressed, applies the 
incremental rotation specified in the Increment field. Rotation occurs about the Center 
of Rotation, relative to the machine origin. 

387387



VERICUT HELP – Project menu 
 

Modeling window, Position tab, Assemble tab 
Location: Project menu > Setup Models > Define: Position tab 

 

Features on this tab move the selected object by assembling (mating or aligning) it with 
other objects. Objects are assembled by mating or aligning one to three planar surfaces 
with surfaces on other models. (See how) If a non-planar surface is selected, VERICUT 
constructs a tangent plane at the pick point. The relationship of surfaces being mated or 
aligned is known as a "constraint".  

  

Follow these general steps to define a constraint for assembly: 

1. Choose the constraint type. 

2. Select a surface on the object to move. 

3. Select the surface to move the object relative to. 

4. Press Apply. 

  

 
 

Assemble tab features 
Constraint Type — Specifies how to constrain selected surfaces during object 
movement. After selecting two surfaces to define a constraint, VERICUT moves the 
object and highlights the satisfied constraint with a checkmark. Options: 

Mate — Moves the object so the selected surface opposes the surface selected on the 
second object (surface normals oppose each other). 

Align — Moves the object so the selected surface is aligned with the surface selected 
on the second object (surface normals point in the same direction). 
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Consider the starting condition below for the examples that follow. 

 

 
   

 

Mated surfaces — the left side of the magenta model is mated with the right side of the 
yellow model. 
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Aligned surfaces — the left side of the magenta model is aligned with the left side of the 
yellow model. 

   

 
  

Offset — Distance and direction in which to offset constrained surfaces, applied normal 
to the surface. 

Reset — Resets constraints to receive new data. 

Undo — Returns the object to its previous location, or as it was when the window was 
opened. 
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Modeling window, Position tab, Matrix tab 
Location: Project menu > Setup Models > Define: Position tab 

 

Features on this tab move the selected object via a twelve parameter transformation 
matrix. (See how)  If the applied movement is incorrect, press Undo (on the Position tab) 
to return the object to its previous location. 

  

 
 

Matrix tab features 
Matrix table — The transformation matrix table is similar to the matrix used in 
programming APT tool paths. Its twelve parameters reveal the geometrical attributes of 
the local (transformed) coordinate system (CSYS) in terms of the machine origin.  

 

The format of the matrix table is as follows: 

  I J K D 

X I1 J1 K1 D1 

Y I2 J2 K2 D2 

Z I3 J3 K3 D3 

  

Each row represents an axis of the local CSYS. The first three columns represent the 
vector associated with each axis:  I1, J1, K1 as the positive X-axis vector; I2, J2,K2 as the 
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positive Y-axis vector; and I3, J3, K3 as the positive Z-axis vector. The fourth column 
values D1, D2, D3 represent the coordinates of the origin point of the local CSYS. 

NOTE:  If you prefer to see the Matrix Table displayed with the I, J, K along the vertical 
axis and the X, Y, Z along the horizontal axis, set the environment variable, 
CGTECH_MATRIX_FORMAT=VERTICAL. 

Update — Updates the object location to reflect the matrix table transformation. After 
updating, press OK or Apply to move the object. 

Apply Inverse On Update — When selected, inverts the matrix so that its twelve 
parameters reveal the geometrical attributes of the machine origin in terms of the local 
(transformed) coordinate system. 
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Modeling window, Position tab, Csys tab 
Location: Project menu > Setup Models > Define: Position tab 

 

Features on this tab enable you to translate the selected object from one coordinate 
system (Csys) to another. Select the "From" Csys and the "To" Csys to move the object. 
Movement occurs each time you press the Move button. (See how) If the applied 
movement is incorrect, press Undo (on the Position tab) to return the object to its 
previous location. 

  

 
  

Csys tab features 
From / To — Specifies the coordinate system to move the object from, and to. Select the 
appropriate Csys from each of the pull-down lists. 

Move — Moves the selected object from the "From" Csys to the "To" Csys orientation. 
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Modeling window, Position tab, Mirror tab 
Location: Project menu > Setup Models > Define: Position tab 

 

Features on this tab enable you to mirror a model about a specified axis (plane).  

  

 
 

Mirror tab features 
Mirror Off — The Mirror attribute is turned off. 

Mirror in X (about the YZ plane) — The Mirror attribute is set to Mirror in X, or about 
the YZ plane. 

  

Mirror Off Mirrored in X (about the 
YZ plane) 
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Mirror in Y (about the ZX plane) — The Mirror attribute is set to Mirror in Y, or about 
the ZX plane. 

  

Mirror Off 

 

Mirrored in Y (about 
the ZX plane) 

 

  

Mirror in Z (about the XY plane) — The Mirror attribute is set to Mirror in Z, or about 
the XYplane. 

  

Mirror Off 

 

Mirrored in Z (about 
the XY plane) 

 

395395



VERICUT HELP – Project menu 
 

  

  

NOTES:  
  

1. The following model types can be mirrored: 

VERICUT polygon files (polygon, sweep solid or solid of revolution (SOR) 

STL files 

VRML files 

2. The model is mirrored in its local coordinate system (not the active coordinate 
system) 

3. The mirror attribute is part of the model structure and is saved with the model 
data when saved to the project file or machine file. 

4. When VERICUT reads a Project file or machine file, the models that have the 
mirror attribute set will be mirrored when loaded. 
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Modeling window, Component Attributes tab 
Location: Project menu > Setup Models > Define 

Toolbar short cut:   

 

Features on this tab define the attributes of a component. (See how) VERICUT handles 
components and their solid models differently depending on the component's type and 
attributes. Most attributes apply to components used in building NC machines. 

 

 
 

Color — Color of the component. Available colors are determined by the colors defined 
on the Edit menu > Colors: Define tab. 

Visibility — Controls the views in which the component is visible. Options: 

Blanked — Component is blanked from all views and cannot be seen. 

Workpiece View — Component is seen in the workpiece view. 

Machine View — Component is seen in the machine view. 

Both — Component is seen in both the workpiece and machine views. 

See also: VERICUT command records that control displaying/loading/removing model 
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Machine group: 
VERICUT uses a "moving tool philosophy" to describe motion directions, and reflect 
how the machine maintains the tool-to-workpiece relationship. This philosophy is used 
regardless of whether the Tool or Stock component is actually moving. Examples follow. 
Consider a standard 3-axis vertical milling machine where the Z-axis moves the tool 
up/down, and the X or Y-axis moves the workpiece. 

Example 1: 
 Z+ command causes the Z-axis to carry the tool in the Z+ direction relative to the 
workpiece- therefore using the moving tool philosophy describes positive motion 
direction as "Z+". 
Example 2: 
X+ command causes the X-axis to carry the workpiece in the X- direction relative to 
the tool. In this case, the tool is considered to move in the X+ direction relative to the 
workpiece- therefore using the moving tool philosophy describes positive motion 
direction as "X+", even though the workpiece is moving in the X- direction. 

Motion Axis — Specifies the axis of motion for a linear, rotary or turret type component, 
relative to the component coordinate system. Use a "moving tool philosophy" to specify 
the motion axis and direction, even though the component may actually move on the 
machine instead of the tool. 

Linear motion component: the motion axis is the axis in which linear motion occurs. 

Rotary and turret components: the motion axis is the axis about which rotation 
occurs. The positive rotation direction is counterclockwise when viewed from the 
positive end of the motion axis towards the component origin. 

Tool and spindle components: the motion axis is the aligned with the tool axis, 
typically "Z". 

Disable Auto Direction — When toggled "On" (checked), disables VERICUT's sense of 
the "moving tool philosophy" for that particular component.  

When Disable Auto Direction is toggled "Off" (not checked), VERICUT checks to 
determine whether or not the component is "part side". A component is considered "part 
side", when one of its child components is a Stock component. If the component is "part 
side", VERICUT automatically reverses the direction of motion. 

This feature is intended for use in situations where a component starts connected to one 
machine component , then later gets disconnected and reconnected to a different machine 
component (for example, moving a "stock" component from one "fixture" component to a 
different "fixture" component). If moving the component changes the "part side/not part 
side" relationship of the components, Disable Auto Direction should be toggled "On" 
(checked) causing the component motion direction to remain constant regardless of 
where the component is connected. 
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If the relationship between two components is sometimes "part side", and sometimes "not 
part side", then the Disable Auto Direction should be used, and the component motion 
direction set explicitly with Reverse Direction feature (described below).   

In the example below, the machine is configured like: 

Base 

   Y 

      X 

         A 

             Fixture1 

         U 

            A2 

               Fixture2 
Sometimes the Stock is connected to Fixture1, and sometimes it is connected to Fixture 2. 
Components A, U, and A2 should have Disable Auto Direction toggled "On", and 
Reverse Direction should be used to control the component's motion direction. 

Reverse Direction — When toggled "On" (checked), reverses the component motion 
direction. 

Mixed Mode — Controls how the component is displayed when displayed in Mixed 
draw mode. 

Connect To — Component to which the active component is connected. The component 
being connected to is known as the "connect component". Components must be 
connected in the same way as they are in the real world. Improper connections cause 
incorrect NC machine movement and simulation, especially when rotary components are 
involved. 

Rapid Rate — Feed rate for motion-type components moving in rapid positioning mode 
(e.g. G0). For linear motion components the value entered is units/minute where "units" 
reflect the units of the tool path file. For rotary motion components the value entered is 
degrees/minute. 

SubSystem — Subsystem which commands a linear or rotary motion type component to 
move. Any alpha-numeric sub-system name can be entered (may include spaces). Enter 
"*" (without the quotes) for motion axes included in all machine subsystems. Subsystems 
are used in machines with multiple motion components that are commanded to move via 
the same G-code word, for example "X". By default, a machine uses one subsystem for 
all motion components, assuming they are commanded to move via unique G-code 
words. 

When multiple motion components are driven by the same G-code word, such as can 
occur in 4-axis lathes or mills with multiple independently controlled heads, define 
different subsystems to control which component moves when the motion command is 
processed. Then, configure the control so that other codes in the tool path activate the 
appropriate subsystem for movement. A full set of tables are available to support each 
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machine subsystem. See Sample-Demo Files, in the VERICUT Help Library for 
examples of machines that use multiple subsystems. 

Tool Index — Index number of a Tool component. When defining machines with 
multiple tool load positions, such as a multi-spindle mill or a turret lathe machine with 
tools loaded in the turret, define additional Tool components with different index 
numbers. Values entered are integer numbers. Use the "ActiveTool" macros to activate 
each Tool component for tool changes. For example, call "ActiveTool2" to activate the 
Tool component with Tool Index=2, and so on. 

Toolchain Parameters — Displays the Toolchain Parameters window enabling you to 
specify toolchain component characteristics. Toolchain Parameters is only active when 
the Active Component is Tool Chain. 

 

Accel/Decel group: 
Acceleration / Deceleration — Velocity at which the NC machine component can 
accelerate (or decelerate). Values entered are units per second per second, where units 
could be inches or millimeters for linear axes, depending on the machine units, or degrees 
for rotary axes. 

Max Feed Velocity — Maximum speed axes can travel while in feed mode. The value 
entered is in units per minute, where units could be inches or millimeters for linear axes, 
depending on the machine units, or degrees for rotary axes. 

Max Velocity for Direction Change — Maximum feed rate for motions that cause an 
axis to decelerate to zero velocity, such as occurs when turning at a corner. 
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Toolchain Parameters window 
Location: Project menu > Setup Models > Define: Component Attributes tab 

  

The features on this window define toolchain characteristics. See Toolchain Operation for 
more information. 

  

 
  

Number of Pockets — Use to define the number of tools in the toolchain. The 
VERICUT will automatically create this number of equally spaced tool components 
along the toolchain's perimeter geometry. The toolchain perimeter is defined by the first 
sweep model file attached to the toolchain component. This file is normally not displayed 
except for debugging purposes. Other models may be used to define the associated 
toolchain machine structure. 

 These tool components are named Pocket1, Pocket2, ..., PocketN.  They are created each 
time the machine definition file is loaded, are not saved, and may not be edited. The 
position of Pocket1 is defined by the start point of the first boundary geometry segment 
(line or arc). Pocket1 is also defined as the "select" or "exchange" position. The perimeter 
geometry is scaled about Pocket1 to achieve the pocket-to-pocket spacing entered in the 
GUI.  Normally this adjustment should be small. 

Pocket order — Use to define the direction for pocket numbering. Select Clockwise or 
Counter Clockwise from the pull-down list. 

Pocket-to-pocket time — Defines the time (in seconds) required to move the toolchain 
one position. 
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Tool exchange time — Use to define the time (in seconds) required to move the selected 
tool into the machine's spindle and return the unloaded tool to the toolchain. 

Pocket-to-pocket distance — Defines the distance between adjacent tool centers along 
the toolchain's perimeter. 

Replace tool in its original pocket — Use to specify where the tool being unloaded 
from the spindle is to be placed in the toolchain. When toggled "On", the unloaded tool is 
returned to its original pocket position. Otherwise, the tool being unloaded is placed in 
the pocket emptied by the tool being loaded. 

Display pockets in component tree — Use to specify whether or not the toolchain's 
associated tool components are displayed in the component tree. When toggled "On", tool 
components will be displayed in the component tree. The default is not to display the 
tools components since large toolchains can contain a hundred or more tools.   

Tool-to-tool collision checking — Use to specify collision checking when a tool is 
placed in the toolchain during a tool exchange. When toggled "On", the tool being 
unloaded and returned to the toolchain is checked for collisions with the tools in adjacent 
pocket positions.   

Tool length checking — When toggled "On", tool lengths are checked against the 
Maximum tool length value when they are initially put in the toolchain. If the tool length 
exceeds the Maximum tool length value, an error is output. 

Maximum tool length — Use to specify the maximum tool length value used for Tool 
length checking. 
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Modeling window, Import tab 
Location: Project menu > Setup Models > Define 

Toolbar short cut:   

 

Features on this tab import IGES model files for use as stock, fixture, design, or machine 
component models. (See how) The component type determines how the converted IGES 
model will be used in VERICUT. An option is also available to create a solid model from 
an IGES surface. The surface can be used as is, or offset before converting it into a solid. 
During import, VERICUT converts the IGES model data into a VERICUT Polygon file 
(.ply extension) and automatically refers the converted file. This window functions 
similar to the IGES Converter window-ref. File menu > Convert > IGES. 

 

 
 

IGES File — Name of the file containing the IGES data to import. Either enter the 
/path/filename in the IGES File text field, or click on the Browse button and use the file 
selection window that displays to select the file. 
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Tolerance — Specifies the amount of chordal deviation allowed in 3-D space from the 
IGES surface when creating the converted surface. The converted surface is 
approximated using "facets", or triangles. 

 

 
 

Offset Surface group: 
Offset Surface — When active, creates a solid model from an open IGES surface. 

Offset Amount — Distance and direction in which to offset the design surface, as 
applied normal to the input surface. For example: ".100" applies an offset of .100 to the 
surface in the Z+ direction. A value like "-.100" applies the offset in the Z- direction, 
effectively "shrinking" the model. 

Base Location — Specifies the Z value of the plane to become the base of the solid 
model. The surface is projected along the Z-axis to this plane. 

Extend to Rectangle — When active, expands surface edges to create a rectangular base. 
The size of the rectangular base is determined by the X-Y bounding region of the surface 
data. 

Add — Adds the VERICUT polygon model defined to the active component. 
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Load Stocks 
Location: Project menu > Setup Models > Load Stocks 

 

After cutting, selecting this option causes VERICUT to load new stock models for Stock 
components having models defined, but a cut stock model does not exist. This capability 
is used when simulating a series of parts being machined through multiple machining 
stages. This type of manufacturing is often referred to as "staged machining". 

  

In general, the following actions take place in staged machining: 

1. Simulate the first stage cutting operation. (Creates a "Cut Stock" workpiece that 
appears as  in the Component Tree window) 

2. Move (e.g. cut and paste) the cut stock to a different Stock component defined to 
represent the next cutting stage. 

3. Select Load Stocks to load a new uncut stock model in the first cutting stage. 

4. Continue cutting-typically cutting the first and second stages, but may cut all 
stages even though workpieces have not yet been placed in subsequent cutting 
stages. 

5. Repeat actions as required to cut a workpiece through all cutting stages required 
to complete the final part configuration. 
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Delete Detached Stock 
 
VERICUT Users: 
VERICUT Location: Project menu > Setup Models > Delete Detached Stock 

Toolbar short cut:  

  

Cutter Grinder Users: 
Cutter Grinder Location:   View Simulation page > Delete or Keep Material 

Notebook Feature:      

  

Opens the Delete Material window enabling you to delete or keep pieces of material. (See 
how) This feature is typically used to delete pieces of excess stock that have been cut free 
from the workpiece. However, pieces of other models can also be deleted. 

 

 
 

Items are selected for Delete/Keep in the Workpiece View. Any number of items can be 
selected. Selected items are immediately highlighted with the Error color. Once you click 
Delete (or Keep) the items are removed from all views. However, the selected items are 
not actually deleted until you click OK.  

NOTE:  Once model pieces are deleted, model pieces can not be restored. 

 

Update While Simulating — When toggled "On", VERICUT checks during the 
simulation for detached material based on the stock's relationship to all sibling and parent 
fixture models. If the detached stock does not intersect, or is not tangent to, a parent or 
sibling fixture model, then the piece is considered "unattached" and is automatically 
deleted. This logic applies to both milling and turning operations. 

For turning mode, VERICUT checks at the end of each block. For milling mode, 
VERICUT checks at each tool change, at the end of each file, whenever VERICUT is 
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stopped (except for"single step"), at Clamp/Unclamp events, and whenever the 
CheckForLooseMaterial macro is called. See the example in the next section. 

Tab Removal — Use this feature to remove tabs left on the machined part (used for 
holding the part during the machining process) from a VERICUT cut model. VERICUT 
will project the cutter used to cut the selected machined surface, through the bottom of 
the part, removing the tab area. More than one position on the machined surface may 
need to be selected to remove the entire tab area. 

 

Before Using Tab Removal   After Using Tab Removal 

 

  

  

 

 

OK — Use this feature to permanently delete the items selected for Delete/Keep, or 
activate Update while Simulating and close the Delete Material window. 

Delete — After selecting the items to be deleted (they will be highlighted), click Delete 
to remove selected items from all views. Click OK, described above, to permanently 
delete the items. 

You can also use Delete to delete the un-displayed portion of a sectioned view. Without 
selecting any items, click on Delete. You will be prompted with the message "The cut 
stock is sectioned. Delete the sectioned (invisible) material?" Yes/No". A "Yes" response 
permanently deletes all un-displayed (invisible) sectioned material. A "No" response does 
not. Using the Keep in this manner will produce the same results. 

Keep — After selecting the items to keep (they will be highlighted), click Keep to 
remove all un-selected items (not highlighted) from all views. Click OK, described 
above, to permanently delete the items. 

Unselect — Use this feature any time while selecting items for Delete/Keep to un-select 
all selected items (they will no longer be highlighted). This feature becomes inactive once 
you click on Delete/Keep. 

Cancel — Use to un-select all items, cancel any Delete/Keep action, and close the Delete 
Material window. 
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Delete Detached Stock - Update While Simulating 
Example 
 

Update While Simulating Toggled "Off": 
Notice that when Update While Simulating is toggled "Off", the pieces of excess stock 
that have been cut free from the workpiece remain displayed, as shown in the pictures 
below. 
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Update While Simulating Toggled "On": 
Notice that when Update While Simulating is toggled "On",  most of the pieces of 
excess stock that have been cut free from the workpiece have been automatically deleted, 
as shown in the picture below. The reason that they were not all automatically deleted is 
because of slight differences in the holding fixtures. In setups 2 and 3, the remaining 
excess stock pieces are at least partially in contact with the fixture so they were not 
automatically deleted.  
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Create Model File 
VERICUT Location: Project menu > Setup Models > Create Model File > Revolve / 
Sweep 
  

Opens the Profile Sketcher window enabling you to define a profile to be used to create 
a solid model either by rotating the profile about the Z-axis (Revolve), or by sweeping the 
profile along the Z-axis (Sweep).  

  

Revolve — Click this option to open the Profile Sketcher window in "solid of revolution" 
mode. 

Sweep — Click this option to open the Profile Sketcher window in "sweep solid" mode. 
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Profile Sketcher Features 
Locations:  

Project menu > Setup Models > Create Model File > Revolve 

Project menu > Setup Models > Create Model File > Sweep 
  

Project menu > Setup Models > Define > Model tab: Type=Model File > Sketcher > 
Revolve 

Project  menu > Setup Models > Define > Model tab: Type=Model File > Sketcher > 
Sweep 
  

Project menu > Tools > Add(Modify) Cutter 
>Tool Component tab: 

Project menu > Tools > Add(Modify) Insert 
 >Tool Component tab: 

Project menu > Tools > Add(Modify) Holder 
>Tool Component tab: 

 

 

 (Revolve Profile) 

  

Project menu > Tools > Add(Modify) Holder 
>Tool Component tab: 

 (Sweep Profile) 

  

The Profile Sketcher provides an easy graphical means of describing a profile of  in 2-D 
drawing space. Profiles are sketched by connecting a series of lines and arc segments. 
You can select points, enter point/arc data into the Profile entity list, or pick then edit 
entity values in the list. You can also import the 2-D geometry from a DXF file. The 
profile displayed in the sketcher window is constantly updated regardless of how you 
supply profile entity data, making it easy to see what you've defined.  
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The Profile Sketcher can be opened in either "Revolve" mode, where an "open" 2D 
profile is rotated about the Z-axis to create a solid model or cutter/holder, 

  

 
  

or in "Sweep" mode, where a "closed" 2-D profile is "swept" a specified distance along 
the Z-axis to create a solid model or a cutter insert/holder. 
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The Profile Sketcher is accessible from Project menu > Setup Models > Create Model 
File > Revolve/Sweep and from Project menu > Setup Models  > Define: Model tab to 
create profiles that can be rotated about an axis, or swept along an axis to create solid 
models. It is also accessible in Tool Manager to Add/Modify cutters, inserts and holders.  

The options available in the Profile sketcher will vary slightly depending on whether it 
was accessed from one of the Model menu windows or from Tool Manager. Most of the 
features are common regardless of where the window was accessed from and have 
identical functionality. Those features that are specific to a particular function are located 
at the bottom of the window are described in the Special Features section below.  

 

Common Features 
Entity list — Lists the point/arc entities that define the profile. The list is created by 
graphical selection, or by pressing Add to add entities to the list. Existing data can be 
edited directly in the Entity list.. 

Add / Delete — Adds (or deletes) a single entity to/from the Entity list. Once added, the 
entity type (Point or Arc) can be changed, or data values edited. 

Delete All — Deletes all entities in the Entity list. 

ImportDXF — Opens the DXF Geometry window enabling you import two 
dimensional tool geometry from files which comply with a de facto CAD system 
standard, the Data eXchange Format (DXF) to add (or modify) individual cutter (or 
holder) components in existing tool records. 

Fillet Size — Use this text field to specify the size of the fillet to be created. Use with 
Create Fillet described below. 

Create Fillet — Use to create a fillet at the selected point. Use Fillet Size described 
above, to specify the size of the fillet. 

 

Shortcut: Add, Delete, Delete All, Import DXF, Create Fillet, and Undo (described 
below) are also available by right-clicking in the Sketcher window. 

 

Sketcher window — Displays the current defined tool profile (blue line), based on the 
entity list. The profile in the window is constantly updated to reflect current list data. The 
following symbols may be seen in the sketcher window: 

 Tool origin — The tool origin is assumed by VERICUT to be the control point, 
or driven point, on the tool. Typically, tool profiles are sketched relative to the tool 
origin to provide proper cutting by the tool. However, the tool origin can be relocated 
at any time via dragging the origin point. Tool origin display is controlled by the 

Origin  feature on the sketcher Toolbar (see below). 
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 (blue dot) Entity point — This symbol indicates a point on the profile or an arc 
center point. You can change the profile shape by dragging entity points to different 
locations. The corresponding entity in the list is automatically updated. 

 (green dot) Selected entity point — This symbol indicates the entity selected for 
editing. The corresponding entity in the list is also highlighted for editing. 

  

NOTE:  Selecting a line segment in the Sketcher window selects both end points for 
editing. Drag the line segment to the desired location and both end points are 
automatically updated in the Sketcher window as well as in the Profile Entity List. 

  

 (red dot)  Target selection point — This symbol follows the mouse and is the 
target for graphical selection. Values displayed with the Sketcher axes below the 
sketcher window reflect the target selection point location. 

 

Sketcher axes — Axes that depict the coordinate system in which the tool profile is 
being constructed. Values displayed with the axes reflect the target selection point 
location, relative to the tool origin. 

Sketcher Toolbar — The icons on this Toolbar zoom in/out, fit, and pan the tool profile 
in the sketcher window. See the table below for details. Sketcher icons: 

 

Shortcut: The following keys provide instant access from the keyboard to dynamic 
viewing options (press and hold keys while dragging): Dynamic Zoom — <Ctrl>, 
Dynamic Pan — <Shift>. 

 

Arc / Pt — Controls the profile entity type being defined via graphical selection. 

Arc Direction — Controls the direction of an Arc being defined via graphical selection. 

Grid Size — When selected, displays a grid in the sketcher window. When a grid is 
displayed, target and selected points snap to the nearest grid line intersection. Grid 
spacing is specified in the data field located right of the GridSize label, and can be 
changed at any time. Clear the checkbox to remove the grid and select or drag points 
anywhere in the 2-D drawing space. 

Sketcher Message area — Located below the sketcher window, this uneditable text field 
displays error and informational messages to assist you with defining tool profiles. If 
actions in the Tool Manager and/or sketcher window are not as expected, check the 
VERICUT main window message area for additional relevant messages. 
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Icon: Name: Action: 

  Pan Pan/translate- drag mouse in the direction pan 

  Zoom In / Zoom 
Out 

Zooms in/out approximately 20% each time they 
are clicked 

  Fit Fits the tool in the sketcher window 

  Origin When selected, displays the tool origin point 

  Undo Select to "undo" the previous action(s). 

 
Special Features 
The following are only available in the Sweep Profile window: 

Zmin / Zmax — Used to specify the starting and ending location along the Z-axis when 
creating a "swept" solid model. 

  

The following are available in the Tool Manager, Add (Modify) cutter window: 

Flute Length — Used to specify the length of the cutter having flutes, or teeth, that can 
remove material. 

Offset (Z) — Used to specify the offset applied to the cutter. The offset is applied in the 
Z direction (along the tool axis).  

Color — Color that the tool component is to be displayed in VERICUT. For additional 
information, see Tool Display Colors in the Tool Add/Modify window, Common 
Features section. 
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The following are available in the Tool Manager, Add (Modify) Insert and the Tool 
Manager, Add (Modify) Holder windows: 

Thickness — Used to specify the thickness of the insert or holder (sweep profile only). 

Color — Color that the tool component is to be displayed in VERICUT. For additional 
information, see Tool Display Colors in the Tool Add/Modify window, Common 
Features section. 

 

NOTE:  For additional information on these Tool Manager features, see the specific tool 
component in the Tool Add/Modify window. 
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DXF Geometry window 
Locations:  Profile Sketcher window  > Import DXF 

                   Tool Manager window > File > Import > DXF Tool  

  

Opens the DXF Geometry window enabling you to import two dimensional geometry 
from files which comply with a de facto CAD system standard, the Data eXchange 
Format (DXF).  

The Profile Sketcher window is accessible Project menu > Setup Models > Create 
Model File > Revolve/Sweep and from Project menu > Setup Models > Define: Model 
tab to create profiles that can be rotated about an axis, or swept along an axis to create 
solid models. It is also accessible in Tool Manager to Add/Modify cutters, inserts and 
holders.  

 The options available in the DXF Geometry window will vary slightly depending on 
whether it was accessed from one of the Model menu windows, 

 

 
   

or from Tool Manager.  
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Many of the features are common regardless of where the window was accessed from and 
have identical functionality, Those features that are specific to either of the Model menu 
windows or Tool Manager windows are noted in the feature descriptions below.  

 

Importing DXF Profile Data: 
DXF File — Use to specify the DXF file containing the tool data. Enter the /path/file 
name in the text field or click on Browse and use the Select DXF File window to specify 
the file. 

Mill/Turn — (Tool Manager only) Select Mill or Turn to specify the "type" of tool data 
being imported. 

Inch/Millimeter — (Tool Manager only) Select Inch or Millimeter to specify the "units" 
of the tool data being imported. 

Component Table — 
After specifying the DXF file, a record is created in the Component Table for each layer 
contained in the file. You can re-order the records in the table by clicking on the button in 
the first column of the record and dragging it to the desired position. 

DXF Layer — This column displays the name, or number, identifier of the layer. 

Profile — (Create Model File only) This column is used to identify the profile that is to 
be used. 

Cutter — (Tool Manager only) This column is used to identify the "cutter" geometry 
data to be imported. Click on the box in the appropriate layer row to activate it 
(checkmark is visible). 

Holder — (Tool Manager only) This column is used to identify "holder" geometry data 
to be imported. Click on the box in the appropriate layer row(s) to activate it (checkmark 
is visible). 

  

NOTE:  When the DXF Geometry window is accessed from the Tool Manager, only 
layers that have been indicated as "cutter" or "holder" will be imported. If the DXF 
window was accessed using Add > DXF Tool in the Tool Manager, only one "cutter" 
component can be imported, but multiple "holder" components can be imported for each 
tool record.  

  

Import — Imports the geometry data into the appropriate Profile Sketcher window, or in 
the case of Add > DXF Tool in the Tool Manager,  into the appropriate tool record/tool 
component. 

Cancel — Use to close the DXF Tool Geometry window. 
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DXF File Requirements: 
Only the ENTITIES section of a DXF file is scanned by VERICUT. The BLOCKS 
section is ignored, so BLOCK references within the ENTITIES section will not be 
expanded. REPEAT entities are also ignored. The only geometric entity types processed 
are LINE, ARC, CIRCLE, POLYLINE, LWPOLYLINE, TRACE, SOLID, 3DLINE and 
3DFACE . 

For Creating Solid Models 
Import "open" 2D profiles to be rotated about the Z-axis to create "revolved" solid 
models. Putting the start and end points of the profile off of the Z-axis will result in a 
solid model that is open in the center like the one shown in the "Revolved Solid Model" 
picture below. To create the model with a solid center, make sure that the start and end 
points of the profile are on the Z-axis. 

  

Open Profile 

 

Revolved 
Solid Model 
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Import "closed" 2-D profiles to be "swept" a specified distance along the Z-axis to create 
a solid model or a cutter insert/holder. 

  

  

Closed 
Profile 

 

Swept Solid 
model 

 

 

For Creating Cutters, Inserts and Holders 
VERICUT expects only one tool per DXF file. Each component (cutter or holder) of the 
tool should be on its own named or numbered layer. There can be no more than one cutter 
component, but multiple holder components are permitted. The DXF file may contain 
other layers which are unrelated to the definition of the tool's geometry. Within each 
component layer, LINEs, ARCs, CIRCLEs, POLYLINEs, LWPOLYLINEs, TRACEs, 
SOLIDs, 3DLINEs and 3DFACEs can be used to define the profile of the tool.  

For a milling tool, the Y coordinate of the DXF data corresponds to the tool's axis of 
rotation, known as the Z axis in VERICUT's Tool Manager. The X coordinate of the 
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DXF data corresponds to the Tool Manager's X axis. An exception to this is a DXF file 
recognized by its use of layer names as being generated by TDM Systems', Tool Data 
Management (TDM) system. In such a file, the X-axis is the tool's axis of rotation, with 
the tool tip on the right, and the Y coordinate is the radial distance from the rotation axis. 
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DXF Data 

 

  

DXF Data from TDM  

In VERICUT 
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For a turning tool, the X coordinate of the DXF data corresponds to the lathe's axis of 
rotation, known as the Z axis in VERICUT's Tool Manager. The Y coordinate of the 
DXF data corresponds to the Tool Manager's X axis. 

  

In VERICUT 

 

 

DXF Data 
  

 
  

 

Cutter on Layer 1 

Holder on Layer2 
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NC Programs ( NC Program window) 
 
VERICUT Users: 
VERICUT Location: Project menu > NC Programs 

Toolbar short cut:   

  

Mold and Die Users: 
Mold and Die Location:   Setup page > Select Tool Path Files and Tools 

Notebook Feature:      

  

Cutter Grinder Users: 
Cutter Grinder Location:   Setup page > Select Grinding Programs 

Notebook Feature:      

  

Opens a window to specify the NC program file(s) to simulate, and controls how 
VERICUT receives descriptions of cutting tools. In general, VERICUT can obtain 
descriptions of cutting tools by processing parametric cutter description records found in 
the NC program file, or can be configured to retrieve them from a VERICUT Tool 
Library file. 

 

 
 

NC Program Type — Type of NC program file for VERICUT to simulate. By default, 
VERICUT simulates G-Code or "machine code data" NC programs destined for a 3-axis 
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mill machine with a "Fanuc-like" control. Using this option, you can quickly configure 
VERICUT to simulate NC programs from all popular CAM systems. Options: 

G-Code Data — G-Code NC program file. With this choice, VERICUT uses a 
Machine file, Control file, and G-Code settings (ref. Project menu > Processing 
Options > G-Code > Settings) to interpret codes present in the file. 

VERICUT APT — Generic ASCII APT NC program file from virtually any source, 
including ACL format. 

UG CLS — Unigraphics CLS NC program file. 

CATIA APT — CATIA APT source NC program file. This file must be processed 
from CATIA using the CATUTIL function and typically has a ".APTSOURCE" 
extension. 

CV APT — ComputerVision APT NC program file. 

CADRA APT — CADRA APT NC program file. 

APT (RevPost) — ASCII APT NC program file created from reverse post-
processing G-Code data Refer to "Reverse post-process G-Codes to APT" in the 
Configuring For Toolpath Simulation section of Using VERICUT for more 
information. Using VERICUT can be found in the VERICUT Help Library. 

Pro/MFG APT — Pro/Manufacturing APT NC program file. 

NCL APT — NCL APT NC program file. 

 

In addition to the NC program types above, VERICUT's converters enable you to 
simulate NC programs from various CAM systems. See the following sections for more 
information: 

• File menu > Convert > Binary CL.  See the "Binary Converter" topic in the 
Converters and CAD/Cam Interfaces section. Converters and CAD/Cam 
Interfaces can be found in the VERICUT Help Library. 

• "Reverse post-process G-Codes to APT" in the Configuring For Toolpath 
Simulation section of Using VERICUT for more information. Using VERICUT 
can be found in the VERICUT Help Library. 

 

Tool Change By — Controls how VERICUT receives descriptions of cutting tools. 

Cutter Desc. — Process parametric cutter descriptions in the NC program file. 
Examples: CUTTER and VERICUT-TC comment records. 

VERICUT TC — Process by PPRINT/VERICUT-TC cutter statements in the 
toolpath file. 

Tool Number — Process NC program records that reference tool or pocket numbers 
and retrieve associated tools from a Tool Library file. Examples: TnM6 (G-Code NC 
programs), LOADTL or LOAD TOOL, and TURRET. When using Tool Change by 
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Tool Number, The tool number is matched with the pocket number (ex: tool #5 in 
pocket #5). 

List — Refer to a list of tool change event-to-tool ID references that retrieve 
associated tools from a Tool Library file. The list is accessed via the Use Tool List 
feature, as described later in this section. 

File Name — Use a tool from a Tool Library file as specified for each NC program 
file in the list. 

Tool Name — This option is only applicable when NC Program Type is set to UG 
CLS. Tool Name refers to the tool identifier in the TOOL PATH/ statement in the 
UG CLS file. 

Use Selected Files — When used in conjunction with the Use checkboxes in the 
Toolpath list, enabling you to select only specific toolpath files from the list for 
VERICUT processing. If this option is not checked on, all toolpaths in the list will be 
processed in the order that they appear in the list. 

Initial Tool — When active, VERICUT loads an initial tool from a Tool Library file. 
This action occurs automatically when the Project file is loaded, the NC program is 
rewound, or the model is reset. Choose the ID of desired tool using the option list next to 
this feature. This feature is useful when simulating NC programs for machines that have a 
tool loaded at the time tool processing is started, therefore do not have information about 
the first tool. 

You can also use this feature to preload multiple tools in a milling machine (e.g. tool 
change carousel), via selecting Initial Tool, but leaving the corresponding field blank.  If 
you specify a tool number, then that tool is forced in to all tool component positions. 

NOTES:  
1. This feature should not be used if you are using multiple toolpaths. 

2. This action also occurs when a "Turret" type component is present, such as 
commonly used with turret lathe setups. 

Tool Override — When active, overrides the current cutter description with a specified 
tool from a Tool Library file. This action occurs immediately. Choose the ID of desired 
tool using the option list next to this feature. VERICUT uses the override tool until you 
select a different tool ID or clear the Tool Override checkbox. When cleared, the tool 
that would have been in use becomes the active tool. 

NC Progam list — Also known as the "toolpath list", displays all of the NC program 
files available in the project file. The NC Program list consists of some, or all, of the 
following columns of information depending on the way that the NC Program Type and 
Tool Change By options are set. 

List Order buttons — NC programs are processed by VERICUT in listed order. List 
order is changed via left-dragging the List Order button in the first column of each 
toolpath entry in the list. Only NC programs that have not been simulated by VERICUT 
can be reordered.  Reset the model to reorder NC programs that have been already been 
simulated. 
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Use — This column is only displayed when the Use Selected Files option, described 
above, is toggled "On". Use the checkboxes in this column to select certain files in the 
toolpath list for VERICUT processing. By default all toolpaths are selected (checked) for 
processing. 

NC Program — displays the path and file name of each toolpath currently available for 
VERICUT processing.  

 

Tip: Double clicking on the NC program file name displays the NC Program Editor 
window with the NC program file ready for editing. 

 

NC Program Origin — Use to specify the coordinate system that corresponds to each 
toolpath. Change the CSYS by clicking on current value in the Toolpath Origin column 
then select the desired CSYS from the pull-down list of available coordinate systems. The 
option None makes the toolpath origin relative to the Workpiece Origin for CL Data, and 
relative to the Machine Origin for G-Code data. 

To change multiple Toolpath Origins at the same time, select the desired toolpaths using 
one of the following methods: 

Select multiple files in sequence — Click first file name in the sequence, then press 
and hold the <Shift> key while clicking the last file name. You can also click on the 
first file name in the sequence, while still holding down the mouse button, drag the 
cursor to the last file name in the sequence. 

Select additional files — Press and hold the <Control> key while selecting each 
additional file. 

With either method, selecting a file name a second time while holding down the 
<Control> key unselects the file. 

Then right-click in the list area and select Origin from the shortcut menu. Select the 
desired CSYS from the pull-down list to update the NC program Origin for all 
highlighted NC programs. 

Curve Fit — This column is only visible when Toolpath Type is set to G-Code Data. 
Use the check boxes in this column to select specific toolpaths for Curve Fitting. When 
you check one or more toolpaths for Curve Fit processing, the Curve Fit button, 
described below, becomes active enabling you to access the NC Program Curve Fitting 
Control window to set curve fit parameters and start the curve fit process. 

Tool ID — This column is only visible when Tool Change By is set to File Name. It 
specifies the ID of a tool from the current Tool Library file to use with each NC program 
file.  

Tip: Right-click in the list area to access a shortcut menu for adding, replacing, changing 
the NC program origin, deleting, or editing the highlighted toolpath in the list. The Add, 
Delete and Replace options are the same as the buttons described below. Copy / Paste 
enable you to copy the highlighted NC program and paste it at the end of NC Program 
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List. The Origin option is the same as the NC Program Origin option described above. 
The Edit option displays the NC Program Editor window with the highlighted NC 
program ready for editing. If Use Selected Files  is toggled "On", Unselect All appears 
in the menu to enable you to uncheck all boxes in the Use column with a single pick. 

Add — Opens a file selection window enabling you to add one or more NC program files 
to the list.  

Replace — Displays a file selection window enabling you to select a toolpath file to 
replace the selected (highlighted) toolpath file in the list. If there is only one toolpath in 
the list, you do not need to select (highlight) it. Just click on Replace to display the file 
selection window and pick the replacement file. VERICUT will replace the existing NC 
program file with the new one. You can also double click on an NC program file name in 
the list to display the "file selection box". To select multiple NC program files for 
replacement, use any combination of the techniques below. 

Select multiple files in sequence — Click first file name in the sequence, then press 
and hold the <Shift> key while clicking the last file name-all files in between those 
selected are also selected. 

Select additional files — Press and hold the <Control> key while selecting each 
additional file. Selecting twice de-selects the file. 

Delete — Deletes the selected NC program file from the list. To select multiple NC 
program files for deletion, use any combination of the techniques described above under 
Replace. 

Clear — Clears the list of all NC program files. 

Curve Fit — Displays the NC Program Curve Fitting Control window that enables 
you to set parameters for use during curve fitting. See the NC Program Curve Fitting 
Control window topic, also in this section. 

Use Tool List — When Tool Change By=List, this feature opens a window to create 
and maintain a list of references that link tool change events to tools stored in a Tool 
Library file. You can use this list to supply tools from the library for sequential tool 
changes, or to replace tools specified for use in the NC program file. See the Tool 
Change List window topic, also in this section. 
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NC Program Curve Fitting Control window 
 

The curve fitting option is targeted at 3-axis G-Code NC programs containing long 
sequences of relatively short cutting motions. VERICUT detects sequences of planar 
motion and fits arcs (or NURBS) whenever the motion can conform to a specified 
tolerance. Arcs are only replaced along the machine's major axes (XY, YZ and XZ).  The 
resulting NC program files may be smaller, produce an improved surface finish, and 
process faster in VERICUT than the original NC program file. (See how) 

Curve fitting makes a single pass through the G-Code NC program(s) and writes new NC 
program file(s) containing the modified motions. The original NC program files are not 
changed. Curve fitting may be selectively applied to NC programs by checking the curve 
fit box in the NC Program list. 

 The "Curve Fit" button brings up the NC Program Curve Fitting Control window 
enabling parameters to be set and the curve fitting process to be executed. 
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Arc Fitting — Select this feature to fit arcs during Curve Fit processing. Selecting this 
feature also activates the Arc Fit Parameters described below. 

 NURBS Fitting — Select this feature to fit NURBS during Curve Fit processing. 
Selecting this feature also activates the NURBS Fit Parameters described below. 
NURBS Curve Fitting is supported for the Fanuc G6.2 (Generic control), the Siemens 
(BSPLINE format), and the Toshiba G6 machine controls. 

 Output NC Program — Specifies the name of the new G-Code NC program file 
containing the results of the curve fitting process. The Output NC Program file name 
must be different from that of the original NC program file name. Curve Fitting will not 
permit the original NC program file to be overwritten. When curve fitting multiple NC 
program files, a modified NC program file is output for each NC program file processed. 
Each output file has an ascending sequence number appended to the end of the base file 
name. For example: assume Output NC Program ="path.mcd" is entered (without the 
quotes). Curve Fit processing of 2 NC programs outputs the following files: 

 

path001.mcd => modified NC program from NC program 1 

path002.mcd => modified NC program from NC program 2 

 

If a dot "." is the last character of the output NC program file name, then three digits are 
appended to the file name as the extension. Continuing with the above example: assume 
Output NC Program ="path." is entered. Curve Fit processing of the same 2 NC programs 
outputs the following files: 

 

part.001 => modified NC program from NC program 1 

part.002 => modified NC program from NC program 2 

 

If an asterisk "*" is used in the output NC program file name, the original NC program 
file name is used as the output file name in place of the asterisk. If characters follow the 
asterisk, the input NC program file name extension is replaced with the characters 
following the asterisk.  
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Examples follow: 

Original NC program file: Output NC Program file 
name: 

Output file name: 

dir1/filename.mcd dir2/* dir2/filename.mcd 

dir1/filename.mcd dir2/*.filter dir2/filename.filter 

dir1/filename.mcd dir2/*cf dir2/filenamecf 

dir1/filename.mcd dir2/*cf.mcd dir2/filenamecf.mcd 

 filename.mcd *.cf filename.cf 

  

Only a single asterisk is acted on in the optimized NC program file name, with one 
exception: asterisk dot asterisk ("*.*"). This case behaves exactly like the single asterisk 
file name described above. This is NOT a regular expression replacement, therefore any 
characters before the asterisk are ignored and lost. When there is more than one asterisk, 
only the first one is replaced 

 

Examples follow: 

Original NC program file: Optimized NC Program 
file name: 

Output file name: 

dir1/filename.mcd dir2/*.* dir2/filename.mcd 

dir1/filename.mcd dir2/cf* dir2/filename.mcd 

dir1/filename.mcd dir2/cf*.ext dir2/filename.ext 

dir1/filename.mcd dir2/*cf.* dir2/filenamecf.* 

  

Arc Plane Selection — Check boxes for major planes where arc fitting is requested. 
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Arc Fit Parameters: 
The following options are only active when Arc Fitting has been selected above. 

Fit Tolerance — Maximum deviation allowed for the fitted arc from the NC program 
points being fitted.  All points replaced by a circular motion must be within this distance 
from the arc. In addition, the midpoint of all motion segments being replaced must be 
within this distance from the arc.  

Planar Tolerance — Maximum deviation from the plane formed by the motions being 
tested. Points within this tolerance are adjusted to the plane defined by the sequence.  

Minimum number of arc points — Lower limit on the number of points required to 
define an arc. 

Smallest Arc Radius — Lower limit on radius of arcs created.  Smaller arcs will remain 
a sequence of points.  

Largest Arc Radius — Upper limit on radius of arcs created.  Larger arcs will remain a 
sequence of points.  

  

NURBS Fit Parameters: 
The following options are only active when NURBS Fitting has been selected above. 

NURBS Tolerance — Maximum amount that the NURBS interpolated curve can deviate 
from the from the linear cut segments being replaced. 

Minimum number of NURBS points — Minimum number of linear cut segments 
required before a NURBS curve fit is attempted. 

NURBS Order (3or4) — Use to specify the "order of the NURBS. Select 3 or 4 
depending on what "order of NURBS" is supported by the machine controller. 

 Accel/Decel — This feature applies Accel/Decel settings from the NC machine 
configuration to adjust optimized feed rates. VERICUT looks ahead in the NC program 
file and slows the machine prior to direction changes, as well as changes feed rates based 
on the machine axes ability to accelerate and decelerate. For more information on the 
individual options, see Accel/Decel options on the OptiPath window. 

 Remove Colinear Points — When toggled "On", this feature eliminates colinear points 
during Curve Fit processing. 

 G-Code Output Options — Displays the General and OptiPath & Curve Fit tabs of 
the Control Settings window. 
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NOTES:  
1. If you happen leave the 12 tab Configuration menu > Control Settings window 

open and it gets hidden behind other windows then use  G-Code Output Options 
 you may see all 12 tabs instead of  just 2 tabs. This is because it is the same 
window, displayed differently depending on where it is called from. 

2. When you use F1 Help on the 2 tab G-Code Output Options window, the 
documentation for the 12 tab Configuration menu > Control Settings window 
will display. The information for the General and OptiPath & Curve fit tabs is the 
same for both cases. 

  

OK — Updates the settings saved with the job and dismisses the NC Program Curve 
Fitting Control window. 

Process — Updates the parameters and processes the files selected for curve fitting. 
Processing multiple NC programs may require running the Curve Fit process more than 
once if the NC programs require different Curve Fit tolerances. For example, one pass 
might be used for roughing NC programs and use a larger tolerance. A second pass would 
then be used for finish NC programs using a smaller tolerance.  

NOTE:  When using Curve Fit, you must take into account the tolerances used by the 
CAM system to create the original NC program(s). Using large Curve Fit tolerances may 
cause the tool to deviate an unacceptable amount from the intended surface. 

Upon completion of processing, the curve fit results are displayed in the following 
message: 

Number of arcs created = xxx .  

Number of moves replaced = yyy.  

Blocks read = nnn   

Blocks output = zzz 

Do you wish to use the new file(s) as the active NC program file(s)? 

A "Yes" answer will replace the list of NC programs for the current job with the modified 
NC program files produced by Curve Fit. A "No" answer will not replace the NC 
programs in the list. 

 Cancel — Dismisses the NC program Curve Fitting Control window without executing 
Curve Fitting or saving Curve Fit parameters. 

  

Curve Fitting with a Tool List 
When Tool Change By is set to List, the Use Tool List button is becomes active. The 
Tool Change List window will contain a Curve Fit column of check boxes. One or more 
of these boxes must be checked for the appropriate curve fitting to be processed. If the 
Curve Fit column is hidden, adjust the width of the visible columns. 
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Arc Quadrant Output 
Some machines require that circular blocks do not cross quadrant boundaries. To output 
this type of circular blocks, the macro CircleCurveFitQuadrants should be used as a 
Start of Processing Event macro. The default allows blocks to cross quadrant boundaries. 
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Tool Change List window 
 

Opened via pressing Use Tool List on the Project menu > NC Programs window, the 
features on this window maintain a list of references that link tool change events to tools 
stored in a Tool Library file. You can use this list to specify tools to use with sequential 
tool changes, or to replace tools specified for use in the tool path file. 

  

 
  

List Tool Change By — Specifies the tool change event used to build the tool list from. 
Select an option, then press Build Tool List to have VERICUT automatically create the 
tool change event list. Options are: 

Cutter Desc. — Changes tools when parametric cutter description records in the tool 
path file are encountered, for example: CUTTER and VERICUT-TC comment 
records. 

VERICUT TC — Changes tools when VERICUT-TC statements in the toolpath file 
are encountered. 

Pocket Num. — Changes tools when tool path records that reference tool or pocket 
numbers are encountered, for example: TnM6 (G-code tool paths), LOADTL or 
LOAD TOOL, and TURRET. 

Prog. Stop — Changes when "program stop" codes are encountered, for example: 
M0 (G-code tool paths) and STOP. 

Pocket Num per File — Similar to Pocket Num., except creates additional entries in 
the list for duplicate tool numbers that appear in different tool path files. 
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Tool Change Event/Tool ID list — List of tool change events expected to occur during 
the simulation as indicated by the active List Tool Change By option (see above), and 
IDs of the tools to use for each. Event text must match the tool change record text exactly 
as it appears in the NC program file. Type or left-click and choose the tool ID from an 
option list. Right-click to add and delete tool list entries. For the Cutter Desc. and Prog. 
Stop options, the list represents the sequential order of tool changes found in the tool path 
file(s), and tools to use for each. A Pocket Num. list is a cross-reference index between 
tool or pocket numbers referenced in the tool path file(s) to tool IDs in a VERICUT Tool 
Library. A Pocket Num per File list is similar to Pocket Num., except creates additional 
entries in the list for duplicate tool numbers that appear in different tool path files. 

  

The Tool Change List consists of the following columns of information. 

  

Event — displays the tool change event. 

Cutter ID — the ID of the tool. 

Holder ID — the ID of the holder associated with the tool. 

Optipath Settings — the OptiPath settings associated with the tool. 

File # — the file in the Toolpath List that the tool is associated with. 

Curve Fit — this column is only visible when Toolpath Type in the Toolpath 
window is set to G-Code Data and one or more of the NC programs in the NC 
Programs list has Curve Fit toggled on. 

Initial Pocket — this column is related to the use of tool chains. It enables you to 
specify the pocket that the tool will be initially located. 

 

When using Tool Change by List, the default initial pocket numbers are assigned as 
follows. The first called tool is assigned to pocket 1, regardless of the tool number. The 
second called tool is assigned to pocket 2, and so on. You can then change the pocket 
number for each tool as necessary. When you do a Reset, the tool will display in the 
assigned pocket. This feature is useful when using large tools that could interfere with 
each other if located in adjacent pockets. Change the pocket location to ensure that all the 
tool changes are collision-free. Another use would be to optimize the tool change time for 
very short operations by minimizing the tool selection time. 

  

Add — Adds a new tool change event to the tool change event list. Event data can be 
entered, or in the case of tool component IDs and OptiPath settings-can be selected from 
option lists. 

Delete — Deletes the selected tool change event from the tool change event list. 

Clear — Clears all tool change events from the list. 
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NOTE:  Always reset VERICUT (press  on the VERICUT main window) after 
making changes. 

  

Prompt for OptiPath Settings while building the tool list — When active, causes 
VERICUT to prompt for OptiPath settings during interactive tool path optimization. At 
each tool change event an Optimization Settings window opens. Configure this window 
as desired to optimize the cutting sequence, or choose "Do not optimize this tool". An 
OptiPath Library file is created as you go containing the optimization settings defined for 
each optimized tool. 

For more information about optimizing tool paths, see "About optimizing tool paths" in 
the Using VERICUT section. Using VERICUT can be found in the VERICUT Help 
Library. 

Skip Duplicate Cutter Descriptions — When active, causes VERICUT to skip 
duplicate cutter descriptions when building the tool change event list. This feature is 
useful for suppressing redundant tool changes often output by CAM systems for different 
cutting operations by the same cutter. 

Build Tool List — Builds a tool list by scanning the files in the tool path list and looking 
for the tool change events specified by the List Tool Change By feature (see above). 
When multiple tool path files are listed, a comprehensive tool change events list is 
created with all tool change activity from all listed tool paths. Sample output is shown in 
the following image. 
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Tools (Tool Manager window) 
 
VERICUT Users: 
VERICUT Location: Project menu > Tools 

Toolbar shortcut to access the Tool Manager:   

  
Mold and Die Users: 
Mold and Die Location:   Setup page > Work Directory 

Notebook Feature:      

  
Cutter Grinder Users: 
Cutter Grinder Location:   Setup page > Create Wheels 

Notebook Feature:      

 

Opens a window to create and maintain VERICUT Tool Library files containing 
descriptions of cutting tools, or tool assemblies. Library tools are used by VERICUT 
when the Project menu > NC Program function is configured to do so.  
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In general, double-click on a tool component to modify, or key in supporting values into 
the associated data fields. Right-click to access shortcut menus for defining and 
modifying tools. Tools can be defined interactively in VERICUT, or outside of 
VERICUT by running the Tool Manager "toolman" command file. 

The Tool Manager main window is composed of 4 distinct areas (Menu Bar, Tool Table, 
Tool Display, and Message area), each with different user interaction. Each of these areas 
is discussed in detail in the topics that follow. 

The window header displays the current tool library file. This window can be resized like 
most other window, via dragging the window header, sides or corners. These areas are 
discussed in detail in the following topics. 

Tips: 
1. Right-click shortcut menus: Features used to manipulate tools are displayed in a 

shortcut menu when a tool is selected and the right mouse button is clicked in the 
Tool Manager window. Similarly, features used to manipulate tool components 
are displayed when they are selected and the right mouse button is clicked. 
Finally, features used to manipulate the tool graphics is displayed when the right 
mouse button is clicked in the Tool Display area. 

2. You can move objects in the Tool Manager window via dragging them from one 
parent tool to another, or copy them via holding down the <Ctrl> key and 
dragging. 
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Tool Manager window, Menu Bar 
 

The menu bar, located across the top of the Tool Manager window, provides easy access 
to Tool Manager functions. Each menu item contains groups of related functions. Left-
click on any menu name to display the list of functions available for that menu item. If an 
arrow appears to the right of a function in a menu, move the mouse over the arrow to 
display a sub-menu of additional functions. Click on the function, in the menu, that you 
want to use. An expanded function list, for the Add menu is shown below. 

  

 
  

File menu 
Features in this menu are used to create new, open, or save Tool Libraries, generate Tool 
Manager Report files, and close the Tool Manager window. 

 New / Open / Save / Save As — Creates new, opens existing, or saves Tool Library 
files. 

Save Selected Tool — Use to save the selected tool to a specified tool library file. 
Selecting Save Selected Tool displays a file selection window enabling you to specify a 
/path/filename for the tool library file.  

Import —  

DXF Tool — Opens the DXF Tool Geometry window enabling you to import two 
dimensional tool geometry from files which comply with a de facto CAD system 
standard, the Data eXchange Format (DXF).  

Export Selected Tool — Use to export highlighted tool in the specified format (STL 
or VRML) Displays a file selection window enabling you to specify a /path/filename 
for the file. 

Create from APT NC Program — Causes the Tool Manager to scan the tool path files 
for cutter statements (including CUTTER, PPRINT-VERICUT TC, etc), and create a tool 
library file named <user filename>.tls. The APT tool path tools replace the current tool 
library contents. Tools are numbered sequentially, beginning at 1. 

Import OptiPath Library — Opens the Open OptiPath library file window, enabling 
you to import an existing OptiPath Library file.  
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Create Report — Use to create and view a tool manager report. See Create a Report 
Using a Template in the Using VERICUT section for additional information. Using 
VERICUT can be found in the VERICUT Help Library. 

Choose one of the following formats: 

Text — Create an inspection sequence report in text format. 

HTML — Create an inspection sequence report in HTML format. 

PDF — Create an inspection sequence report in PDF format. 

Report Template — Displays the Report Template window enabling you to select 
and/or modify an existing tool manager report template or create a new one. 

User-Defined Tag Values — Opens the User-Defined Tags window enabling you to 
assign/edit user-defined tag values used by the current tool manager report template. 

Close — Closes the Tool Manager window. 

  

Edit menu 
Features in this menu are used to edit tools in the library and their cutter/holder 
components. (Functions are also available via right-clicking on a tool component.) 

Modify — Opens the Tool Add/Modify window enabling you to modify the selected 
tool component (cutter, insert, probe tip, holder). The features displayed on the window 
will vary depending on the selected tool component. This option is not available when a 
tool is highlighted.  

Rename — Enables you to rename the highlighted tool/tool component. 

Delete — Deletes the selected tool/tool component. 

Cut / Copy / Paste — Enables you to cut, copy or paste the selected tool/tool component 
within the same tool library file. 

Search Tool — Displays the Search Tool window. 

Search OptiPath — Displays the Search OptiPath Record window. 

Stack — Use to automatically stack tool components on top of each other. 

  

View menu 
Features in this menu provide control over viewing tools in the display area, such as: 
view orientation, lighting, and symbols used to indicate driven point, gage point, etc. 

Orient — Opens the View Orient window enabling you to orient the view of a tool. 
Features include: rotate, zoom, pan, reverse, etc. 

Attributes — Opens the View Attributes window, enabling you to display/not display 
Driven Point, Gage Point, and Axes symbols, as well as define a light source direction 
vector for the Tool Display graphics window. 
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Show All — Expands all tools in the ID list displaying the tool components associated 
with each tool. 

Hide Tool Components — Closes all tools in the ID list displaying only the tools in the 
list but none of the tool components.  

  

Add menu 
The features in this menu are used to add a new tool, or to add cutter, insert or holder tool 
components to the selected tool. The features available will vary depending on what is 
selected in the Tool table. These features are also available via right-clicking on a tool 
and selecting from the shortcut menu.  

Milling Tool Wizard — Displays the Milling Tool Wizard window to assist you in 
defining Milling tools. 

Tool — 
New — Adds a new tool to the library. Select the tool type (Mill, Turn, or Probe), 
then key in a unique ID to start the new tool definition. 

Select Existing — Displays the Search Tool window. 

Tool Component — Displays the Tool Add/Modify window enabling you to add tool 
components to the highlighted tool. 

OptiPath — 
New — Displays the OptiPath window enabling you to define a new OptiPath 
record for the highlighted tool. 

Select Existing — Displays the Search OptiPath Record window. 

Driven Point — Use to add one or more a Driven Point records to the highlighted tool. 

Cutter Compensation — Use to add one or more cutter compensation records to the 
highlighted tool. 
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Milling Tool Wizard 
 

The Milling Tool Wizard enables you to quickly and easily define tool assemblies for 
your tool library. 

  

 
  

ID (tool) — Use to key in a unique ID for the new milling tool. 

Description — Use to add a description for the milling tool / tool assembly. 

Append cutter shape to description — When toggled "on", adds the cutter shape 
description for the cutter defined below to the above description. 
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ID (holder) — Use the text field to enter an ID for the "holder" component. 

Holder Type 
None — Use to specify no "holder" component in the tool assembly.    

New — Displays a window enabling you to add an "extension" component to the tool 
assembly. See Tool Add/Modify window: Component tab, in Holder mode for 
details. 

Search Holder — Displays the Search Tool window enabling you to search for 
existing holders. 

ID (extension) — Use the text field to enter an ID for the "extension" component. 

Extension Type 
None — Use to specify no "extension" component  in the tool assembly.   

New — Displays a window enabling you to add an"extension" component to the tool 
assembly. See Tool Add/Modify window: Component tab, in Holder mode for 
details. 

Search Holder — Displays the Search Tool window enabling you to search for 
existing extensions/holders.  

ID (cutter) — Use the text field to enter an ID for the cutter component.  

Cutter Type 
None — Use to specify "no" cutter component in the tool assembly. 

New Revolved Cutter — Displays a window enabling you to add a revolved cutter 
component to the tool assembly. See Tool Add/Modify window: Component tab, in 
Revolved Cutter mode for details. 

New Insert Cutter — Displays the Milling Insert window enabling you to describe 
inserts and a cutter body to be added to the tool assembly.  

Search Revolved Cutter — Displays the Search Tool window enabling you to 
search for existing revolved cutters. 

Search Insert Cutter — Displays the Search Tool window enabling you to search 
for existing mill insert cutters. 

L2 — Use the text field to enter the exposed length of the "extension" component. This 
distance is used to position the "holder" component along the tool's Z-axis. 

L1 — Use the text field to enter the exposed length of the "cutter" component. This 
distance is used to position the "extension/holder" component along the tool's Z-axis. 

Gage Point — Use the text field to enter the gage point. 

Driven Point — Use to specify the cutter's driven point. 

Stack — When toggled "on", automatically stacks tool components on top of each other. 
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Calculate highest point on Z — When toggled "on", VERICUT calculates the highest 
point on the Z-axis of the tool and uses it for the Gage Point. 

 New — Creates the new tool record and leaves the Milling Tool Wizard window open to 
create the next milling tool. 

Close — Use to close the Milling Tool Wizard window. 
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Milling Insert window 
 

Accessed from the Milling Tool Wizard window, the Milling Insert window enables you 
to quickly and easily define inserted milling tools for your tool library. 

  

 
  

General Insert 
 The General Insert features enable you to easily define "ISO standard", as well as 
"custom" tool insert shapes. The parameters and diagram will vary depending on the 
Insert Type selected from the pull-down list. Only the parameters required to describe a 
particular insert type will be displayed. Use the diagram to identify what measurement 
each parameter represents. The following insert types are available in the pull-down list: 

  

A - 85 degree parallelogram 

B - 82 degree parallelogram 
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C - 80 degree diamond 

C - 100 degree diamond 

D - 55 degree diamond 

E - 75 degree diamond 

H - Hexagon 

K - 55 degree parallelogram 

L - Rectangle 

M - 86 degree diamond 

O - Octagon 

P - Pentagon 

R - Round 

S - Square 

T - Triangle 

V - 35 degree diamond 

W - 80 degree trigon 

Custom diamond 

Custom parallelogram 

  

For additional information on these insert types, see General Insert features in the Tool 
Add/Modify Window, Common Features section. 

  

Cutter Body 
 The Cutter Body features enable you to easily define the cutter body and position the 
inserts. Enter the desired value in the text field for each parameter. Use the diagram to 
identify the measurement that each parameter represents. Use the Location Aids 
described below to position the inserts.  

Locate by nominal diameter    — Positions the center of the insert corner radius 
on the tool diameter. 

Locate by outside diameter     — Positions the outside edge of the insert on the 
tool diameter. 
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Add — Adds the defined inserts and cutter body to the tool library and closes the Milling 
Insert window.  

Close — Closes the Milling Insert window without adding inserts/cutter body to the tool 
library. 
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Tool Manager window, Tool Table 
 

Table of tools defined in the Tool Library file. Tools listed in the table are arranged by 
ID, but can be sorted by any attribute via clicking on the table header. You can also 
search for tools in the library using the Search feature. Double-click the tool ID or click 
the + / - symbols to expand or collapse branches of a tool assembly to see its cutter/holder 
components. Stretch the window or use the scroll bars to see all the table data. 

  

 
  

Tool Table Data: 
ID — Alpha-numeric text that identifies the tool in the Tool Library. IDs typically 
correspond to tool or pocket numbers referenced by the tool change record that will call 
the tool from the library. For example, ID " 1" would normally be used for a tool called 
by a G-code data block "T1M6", or an APT tool change record "LOADTL/1". However, 
you can use a tool list to cross-reference tools having IDs in a library that are different 
from those in the tool change record. See Project menu > NC Programs for details. 
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The following symbols are used in the Tool ID tree: 

  Tool    

  Tool Components:   

   Insert Cutter 

   Revolved Cutter 

   Probe Tip 

   Holder 

   OptiPath Record 

   Driven Point Record 

   Cutter Compensation Record 

    

  

Hint:  Use IDs and descriptions that make it easy for others to find tools they need. 

  

Description — Describes the tool or tool assembly. Any alpha-numeric text can be 
entered in this field. Special characters are not recommended. 

Units — Controls the unit measurement system (Inch or Millimeter) in which to describe 
the tool. If the tool units are different from the session units when loaded, then tool 
description values are converted appropriately. 

Gage Point — Specifies the location of the tool assembly gage point. By default, the 
gage point is located at the tool origin. Values entered move the gage point relative to the 
tool origin, or you can select a gage point by clicking in the Gage Point field then 
clicking on the tool in the Tool Display. As you move the mouse over the tool, a point 
and normal vector show you the pending pick-point location.  

When processing G-code tool paths, VERICUT uses the gage point in the following two 
ways: 

Controls how the tool loads in the NC machine — When a tool is loaded for cutting, 
the gage point is located at the NC machine's Tool component origin. 

Sets the adjustment needed to drive the tool in "Tool Tip" and "Tool Length 
Compensation" programming methods — These programming methods enable an NC 
programmer to assume the positions in the tool path are controlling the tool, instead 
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of NC machine axis positions. VERICUT uses the gage point to determine where the 
driven point is (a.k.a. "control point") relative to the gage point. 

Missing or incorrect gage point values causes a tool to load incorrectly on a 3-D machine, 
or causes improper cutting.  

Sample gage points for milling tools: 

 
 

Sample gage points for turning tools: 
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The "Gage Point" view attribute displays a hollow target symbol  at the gage point 
location (ref. Tool Manager: View menu > Attributes).  

NOTE:  Gage Offset table values can be used to override Tool Manager-defined Gage 
Offset values for setting the adjustment to calculate the driven control point (condition #2 
above). However, they do not affect how the tool is loaded in the NC machine (condition 
#1 above). 

When the Gage Offset table is used to adjust tool motions, the NC control must be 
configured to call the ToolOffsetAptAdj macro when a tool change occurs, or when the 
tool control point changes, to adjust the motions seen in Workpiece views. The 
ToolOffsetAptAdj macro allows the machine simulation to be driven with multiple tool 
control points, when a single tool control point was defined in the Tool Manager.  

If this macro is not called on or after the tool change command, or when the tool control 
point changes, then Workpiece views may not reflect the adjustment to the Tool 
Manager-defined Gage Offset. 

Orientation — Specifies the orientation of the tool assembly when loaded for cutting. 
Three values are entered (separated by spaces) to define the X, Y, Z rotation angles, 
respectively. Angle values are in degrees, relative to the tool origin. Rotation occurs 
about the tool's gage point. 

NOTE:  This feature is only applicable when NC Program Type is G-Code Data. 

 

Teeth — Automatically indicates the number of teeth of the tool referenced by the 
Optipath record selected from the OP Description pull-down list. 

NOTE: You have the ability to manually edit the number of teeth (either by typing in a 
value or selecting a value from the pull-down list) but be aware that if the number of 
teeth entered does not match the number of teeth specified in the OptiPath record, the tool 
will not be optimized. 

 

Comments — This field enables you to add comments related to the tool. The comment 
text is stored with the tool ID. 

  

Driven Point record — Specifies an offset for the tool control point, or "driven point". 
Material is removed based on motion commands and the tool shape relative to the control 
point. For milling tools, a positive value moves the control point in the positive tool axis 
direction (closer to the spindle), while a negative value moves the control point in the 
opposite direction. For turning tools, XYZ values (separated by spaces) are entered 
relative to the spindle axis (Z), and cross-slide axis (X). 

452452



VERICUT HELP – Project menu 
 

Sample Driven Point values for a milling tool: 

 
 

 

Sample Driven Point values for a turning tool: 

 
  

 

When defined, the "Driven Point" view attribute displays as a hollow target symbol 
 at the control point location. (Ref. Tool Manager: View menu > Attributes) 

Cutter Compensation record — Specifies the cutter compensation value for a particular 
tool. 

   

 

Shortcuts:  
1. Double click a tool component in the Tool Table to display the Tool Add/Modify 

window to enable modification of the tool. 
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2. Right-click in the Tool Table to display the following menu: 

  

Modify     

Rename     

Delete      

Cut     

Copy     

Paste     

Add Tool  New  Mill 

Add Tool Component Select Existing ... Turn 

Add OptiPath  New Probe 

Add Driven Point Select existing ...   

Add Cutter Compensation     

Search Tool     

Search OptiPath     

Stack     
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Tool Manager window, Tool Display 
 

Tool Display area — Displays the tool selected in the Tool Table. Colors distinguish 
holders from cutter components. Target symbols indicate the tool's driven point and gage 
point. Use the View Orient functions to visually manipulate the tool in the display area. 

 

 
 
 
Shortcuts:  
 

1. Double click a tool component in the Tool Display area display the Tool 
Add/Modify window to enable modification of the tool. 
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2. Right-click in the Tool display area to display the following menu: 

  

    Fit    

    Reverse   

    Select View  XY 

  Driven Point YX 

  Gage Point YZ 

  Axes ZY 

  ZX 

  XZ 

  V-ISO 

  H-ISO 
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Tool Manager window, Message Area 
 

The message area, also known as the "message logger", is located at the bottom of the 
Tool Manager window, and by default displays the most recent message VERICUT has 
provided. VERICUT provides error, warning, and informational messages to assist you 
while working in the Tool Manager. 

To review previous messages, click on the message line-the most recent message is listed 
last. Click again to close the message logger. 
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Tool Manager - Tool Add/Modify window 
Location:  

Project menu > Tools:    Add menu > Tool > New > Mill (or Turn, or Probe), or  

Add menu > Tool Component 

Edit menu > Modify 
 

Opened via adding or modifying tool/tool components, this window is used to describe 
tool component shape, color, location, and other attributes. Features displayed on the 
Components tab of this window will vary, depending on the tool/tool component type 
that you selected to add/modify. The Tool Component tab for a Revolved Cutter 
component type is shown below. 
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Tool Component tab — Features on this tab are used to define the shape of a tool 
component in a tool assembly. Features displayed on the Tool Component tab vary, 
depending on the tool/tool component type that you selected to add/modify.  

Assembly tab — Features on this tab are used translate or rotate a component in a tool 
assembly, or to move the selected component by assembling (mating or aligning) it with 
other objects in the tool assembly. 

  

Add — Use to apply the specified data to the new tool component. 

Modify — Use to apply the modified data to an existing tool component. 

Close — Close the Tool Add/Modify window without applying the data. 
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Tool Add/Modify window, Tool Component tab 
(Revolved Cutter) 
 

Opened via adding or modifying a Revolved Cutter tool component, this window is used 
to describe the shape of a selected "Cutter" component in a mill tool assembly. Options 
are available to define the cutter via parametric shapes, profile sketcher, or reference a 
cutter in another tool assembly. 

Tool shape icons — Selecting an icon configures the bottom half of the window to 
define the selected cutter shape.  

Options: 

Icons Name Description 

 

 Flat Bottom End Mill 
Diameter (D) 

Height (H) 

 

 

 Ball Nose End Mill 
Diameter (D) 

Height (H) 

 

 

 Bull Nose End Mill Diameter (D), Corner 
Radius (R), Height (H) 
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 Drill 
Diameter (D), Drill 
Point Angle (A), 
Height (H) 

 

 

 7 Parameter D, R, E, F, A, B, H 

 

 

 10 Parameter D, R1, E1, F1, A, B, H, 
R2, E2, F2 

 

 
Profile Opens the Profile Sketcher in "SOR" mode. 

 
Reference 

Displays the Reference features  enabling you 
to reference a mill cutter in another tool 
assembly. 

  

The following options are common to all Tool Add/Modify mill cutter windows 
except Reference: 

 
Flute Length — Length of the cutter having flutes, or teeth, that can remove material. 
This value is measured from the bottom-most portion of the cutter. Zero assumes the 
entire cutter length has flutes, or teeth that can cut material. An error similar to "SHANK 
removed material..." is reported when the non-cutting portion of the cutter removes 
material. Material removed is shaded using the red Error color. 
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Shank Diameter — Diameter of the tool shank. 

Color — Color that the tool component is to be displayed in VERICUT. For additional 
information, see Tool Display Colors in the Tool Add/Modify window, Common 
Features section. 

Spindle Direction — Use to specify the appropriate spindle rotation direction for the 
tool. Choose either CW (clockwise) or CCW (counterclockwise). 

NOTE:  For revolved milling cutters, CW/CCW is defined looking down (negative Z) 
the tool axis. 

 

Tips for defining milling cutters: 
1. Diameter is measured from the intersection points of the cutter side with the 

bottom flat or angle. 

2. D is automatically calculated when D=0, and the corner radius (R) and side angle 
(B) are specified. (Good tip for defining tapered endmills.) 

3. E and F are automatically calculated when diameter and corner radius are 
specified. 
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Examples of milling cutter shapes that can be defined via the 7 Parameter option: 
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Tool Add/Modify window, Tool Component tab (Mill 
Insert Cutter) 
 

Opened via adding or modifying a milling Insert Cutter tool component, this window is 
used to describe the insert shape, position and orientation for the "Cutter" component in a 
mill tool assembly. Options are available to define the cutter insert via ISO standard 
shapes, profile sketcher, or reference a cutter insert in another tool assembly. 

 

Tool shape icons — Selecting an icon configures the bottom half of the window to 
define the selected cutter shape.  

 

Options: 

Icons Name Description 

 
General Insert Displays the General Insert features enabling you 

to define ISO standard insert shapes. 

 
Profile (sweep) Opens the Profile Sketcher in "sweep" mode. 

 
Reference Opens the Reference window enabling you to 

reference an insert in another tool assembly. 

 
Model File Displays the Model File features enabling you to 

specify a model file to be used as an insert. 

 

NOTE:  For inserted milling cutters, tool spinning direction is determined by the insert 
thickness direction. 
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Tool Add/Modify window, Tool Component tab (Turn 
Insert Cutter) 
 

Opened via adding or modifying a turning Insert Cutter tool component, this window is 
used to describe the insert shape, position and orientation for the "Cutter" component in a 
turning tool assembly. Options are available to define the cutter insert via ISO standard 
shapes, profile sketcher, or reference a cutter insert in another tool assembly. 

 

Tool shape icons — Selecting an icon configures the bottom half of the window to 
define the selected cutter shape.  

 

Options: 

Icons Name Description 

 

 
General Insert Displays the General Insert features enabling you 

to define ISO standard insert shapes. 

 

 
Groove Insert Displays the Groove Insert features enabling you 

to define ISO standard groove insert shapes. 

 

 
Thread Insert Displays the Thread Insert features enabling you 

to define ISO standard thread insert shapes. 

 

 
Profile (sweep) Opens the Profile Sketcher in "sweep" mode. 

 

 
 

Reference Displays the Reference features enabling you to 
reference an insert in another tool assembly. 

 

 
Model File Displays the Model File features enabling you to 

specify a model file to be used as an insert. 
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Tool Add/Modify window, Tool Component tab (Probe 
Tip) 
 

Opened via adding or modifying a probe tip tool component, this window is used to 
describe the shape, position and orientation of a probe tip component in a probe tool 
assembly. 

 

Probe Tip — Features on this tab enable you to describe the shape of a probe tip 
component. 

 

Sphere Diameter — Diameter of the sphere at the end 
of the probe tip. 

Stem Diameter — Diameter of the probe tip stem. 

Probe Length — Length of the probe tip. 

Maximum RPM — The maximum speed that a probe 
tool can spin before a spindle On/Off error is output. 
The default value is 0. 

Color — Color that the tool component is to be 
displayed in VERICUT. For additional information, 
see Tool Display Colors in the Tool Add/Modify 
window, Common Features section. 

 

 

466466



VERICUT HELP – Project menu 
 

Tool Add/Modify window, Tool Component tab 
(Holder) 
 

Opened via adding or modifying a Holder tool component, this window is used to 
describe the shape of a selected "Holder" component in a tool assembly. Options are 
available to define the holder via parametric shapes, profile sketcher, or reference a 
holder in another tool assembly. More than one holder can be used in a tool assembly. An 
error similar to "HOLDER removed material..." is reported when the non-cutting portion 
of the cutter removes material. Material removed is shaded using the red Error color. 

 

Holder icons — Selecting an icon configures the bottom half of the window with the 
parameters required to define the holder shape.  

 

Options: 

Icons Name Description 

 

 Block 

Length (L) 

Width (W) 

Height (H) 

 

 

 Cylinder 

Radius (R) 

Height (H) 

Tolerance 

 

 

 Cone 

Bottom Radius (R1) 

Top Radius (R2) 

Height (H) 

Tolerance 
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Profile - SOR Opens the Profile Sketcher in "SOR" mode. 

 
Profile - Sweep Opens the Profile Sketcher in "Sweep" 

mode. 

 
Reference 

Displays the Reference features enabling you 
to reference a holder in another tool 
assembly. 

 
Model File Displays the Model File features enabling 

you to select a model file to define the holder.

 

The following option is common to all Tool Add/Modify Holder windows: 
Do Not Spin with Spindle — When toggled "On", indicates that the holder component 
does not spin. 

 

The following option is common to all Tool Add/Modify Holder windows except 
Reference: 
Color — Color that the tool component is to be displayed in VERICUT. For additional 
information, see Tool Display Colors in the Tool Add/Modify window, Common 
Features section. 
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Tool Add/Modify window, Common Features 

Profile Sketcher Features 
  

See Profile Sketcher Features in the Setup Models section above. 
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Reference feature 
 

Tool Add/Modify, Reference feature enables you to "reference" a tool component in 
another tool library file for use in the current tool library file. 

 
Reference features: 
Reference File — Enter the /path/filename of the tool library file containing the tool 
component to be referenced in the text field or use the Pick button to display the 
Reference Id Pick List window and use it to select the tool library file. 

Reference ID — Enter tool ID of the tool component to be referenced in the text field or 
use the Pick button to display the Reference Id Pick List window and use it to select the 
tool component to be referenced. 

Pick — Displays the Reference Id Pick List window enabling you to select the tool 
component to be referenced from the list. The first time that Pick is selected during a 
VERICUT session, a standard file selection window is displayed so that you can select a 
tool library file. After the tool library file has been selected, the Reference ID Pick List 
window is displayed so that you can select the tool component.  

On subsequent selections of the Pick button during a session, the Reference Id Pick List 
window is displayed with the previously selected tool library file. Enter the 
/path/filename in the Tool Library text field or use the Browse button to display a file 
selection window and use it to change the tool library file 

Sample Reference ID Pick List window: 
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General Insert features 
  

General Insert features enables you to define "ISO standard", as well as "custom" tool 
insert shapes. The parameters and diagram will vary depending on the Insert Type 
selected from the list. Only the parameters required to describe a particular insert type 
will be displayed.  

 

Insert Type Parameter Description 

A - 85 degree parallelogram 

L - Length 

W - Width 

Thickness 

R - Corner Radius 

A  - Lead Angle 

Color * 

B - 82 degree parallelogram 

L - Length 

W - Width 

Thickness 

R - Corner Radius 

A  - Lead Angle 

Color * 
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C - 80 degree diamond 

D - Inscribed Diameter 

Thickness 

R - Corner Radius 

A - Lead Angle 

Color * 

  

C - 100 degree diamond 

D - Inscribed Diameter 

Thickness 

R - Corner Radius 

A - Lead Angle 

Color * 

D - 55 degree diamond 

D - Inscribed Diameter 

Thickness 

R - Corner Radius 

A - Lead Angle 

Color * 
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E - 75 degree diamond 

D - Inscribed Diameter 

Thickness 

R - Corner Radius 

A - Lead Angle 

Color * 

H - Hexagon 

D - Inscribed Diameter 

Thickness 

R - Corner Radius 

A - Lead Angle 

Color * 

K - 55 degree parallelogram 

L - Length 

W - Width 

Thickness 

R - Corner Radius 

A  - Lead Angle 

Color * 
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L - Rectangle 

L - Length 

W - Width 

Thickness 

R - Corner Radius 

A  - Lead Angle 

Color * 

M - 86 degree diamond 

D - Inscribed Diameter 

Thickness 

R - Corner Radius 

A - Lead Angle 

Color * 

O - Octagon 

D - Inscribed Diameter 

Thickness 

R - Corner Radius 

A - Lead Angle 

Color * 
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P - Pentagon 

D - Inscribed Diameter 

Thickness 

R - Corner Radius 

A - Lead Angle 

Color * 

R - Round 

D - Inscribed Diameter 

Thickness 

Color * 

S - Square 

L - Length 

Thickness 

R - Corner Radius 

A  - Lead Angle 

Color * 
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T - Triangle 

D - Inscribed Diameter 

Thickness 

R - Corner Radius 

A - Lead Angle 

Color * 

V - 35 degree diamond 

D - Inscribed Diameter 

Thickness 

R - Corner Radius 

A - Lead Angle 

Color * 

W - 80 degree trigon 

D - Inscribed Diameter 

Thickness 

R - Corner Radius 

A - Lead Angle 

Color * 
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Custom diamond 

D - Inscribed Diameter 

Thickness 

R - Corner Radius 

A - Lead Angle 

T - Tip Angle 

Color * 

Custom parallelogram 

L - Length 

W - Width 

Thickness 

R - Corner Radius 

A - Lead Angle 

Color * 

  

* Color — Color that the tool component is to be displayed in VERICUT. For additional 
information, see Tool Display Colors in the Tool Add/Modify window, Common 
Features section. 

  

Location Aids  

 These features are only available for mill Inserts. They enable you to easily position the 
insert with respect to the tool diameter. 

  (Diameter) — Use this text field to specify the diameter of the tool. 

Locate by nominal diameter    — Positions the center of the insert corner radius 
on the tool diameter. 

Locate by outside diameter  — Positions the outside edge of the insert on the tool 
diameter. 
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Groove Insert features 
  

Groove Insert features enables you to define "ISO standard" groove insert shapes. The 
parameters and diagram will vary depending on the Insert Type selected from the list. 
Only the parameters required to describe a particular insert type will be displayed. 
Groove Insert features are only available for defining turning cutters. 

 

Insert Type Parameter Description 

Square, double end 

W - Width 

L - Length 

Thickness 

R - Corner Radius 

C 

D 

Color * 

Radius, double end 

W - Width 

L - Length 

Thickness 

R - Corner Radius 

D 

Color * 
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40 degree V, double end 

W - Width 

L - Length 

Thickness 

R - Corner Radius 

C 

D 

Color * 

45 degree chamfer, 
double end 

W - Width 

L - Length 

Thickness 

R - Corner Radius 

C 

D 

Color * 

Square, single end 

W - Width 

L - Length 

Thickness 

R - Corner Radius 

C 

D 

Color * 
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Chamfer, single end 

W - Width 

L - Length 

Thickness 

R - Corner Radius 

C 

D 

A - Chamfer Angle 

Color * 

Round, single end 

L - Length 

Thickness 

R - Corner Radius 

C 

Color * 

Radius, single end 

L - Length 

Thickness 

R - Corner Radius 

C 

Color * 

  

* Color — Color that the tool component is to be displayed in VERICUT. For additional 
information, see Tool Display Colors in the Tool Add/Modify window, Common 
Features section. 
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Thread Insert features 
 

Thread Insert features enables you to define "ISO standard" thread insert shapes. The 
parameters and diagram will vary depending on the Insert Type selected from the list. 
Only the parameters required to describe a particular insert type will be displayed. Thread 
Insert features is only available for defining turning cutters. 

 

Insert Type Parameter Description 

55 degree, triangle 

D - Inscribed Diameter 

Thickness 

R - Corner Radius 

E 

Color * 

 

60 degree, triangle 

D - Inscribed Diameter 

Thickness 

R - Corner Radius 

E 

Color * 

 

481481



VERICUT HELP – Project menu 
 

30 degree, trapeze triangle 

D - Inscribed Diameter 

Thickness 

R - Corner Radius 

E 

F - Flat 

Color * 

 

ACME, triangle 

D - Inscribed Diameter 

Thickness 

R - Corner Radius 

E 

F - Flat 

Color * 

 

Buttress, triangle, right 
hand 

D - Inscribed Diameter 

Thickness 

R - Corner Radius 

E 

F - Flat 

Color * 
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Buttress, triangle, left hand 

D - Inscribed Diameter 

Thickness 

R - Corner Radius 

E 

F - Flat 

Color * 

 

60 degree, double end, 
asymmetric 

W - Width 

L - Length 

Thickness 

R - Corner Radius 

E 

Color * 

 

60 degree, double end, 
symmetric 

W - Width 

L - Length 

Thickness 

R - Corner Radius 

E 

Color * 
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ACME, double end 

W - Width 

L - Length 

Thickness 

R - Corner Radius 

E 

F - Flat 

Color * 
 

Buttress, double end 

W - Width 

L - Length 

Thickness 

R - Corner Radius 

E 

F - Flat 

Color * 
 

  

* Color — Color that the tool component is to be displayed in VERICUT. For additional 
information, see Tool Display Colors in the Tool Add/Modify window, Common 
Features section. 
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Model File features 
  

Model File — Enter the /path/filename of the model file or use the Browse button to 
display a file selection window and use it to select the model file. 

Sketcher — Displays the Profile Sketcher window enabling you to edit or create a 
"swept solid (.swp)" or "solid of revolution (.sor)" model file. This feature is only 
available the selected file is a SOR or SWEEP file type. To create a new SOR or SWEEP 
model file, clear the Model File text field and press Sketcher. 

Normals — This feature applies to STL file models only and indicates the direction in 
which surface normals defined in the STL data point, relative to the model. Select 
Inward, Outward, or Computed (let VERICUT determine the direction of the surface 
normals). 

Color — Color that the tool component is to be displayed in VERICUT. For additional 
information, see Tool Display Colors in the Tool Add/Modify window, Common 
Features section. 
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Add DXF Tool window 
 
See Import DXF in the Setup Models section above. 

486486



VERICUT HELP – Project menu 
 

Tool Manager View Attributes window 
 

 
  

The following features enable you to control view attributes related to the Tool Manager, 
Tool Display area. 

Driven Point — Use to display/not display the driven point symbol . 

Gage Point — Use to display/not display the gage point symbol . 

Axes — Use to display/not display the axes representing the tool origin. 

Light (IJK) — I J K vector direction in which the light source points. The three values 
are separated by spaces. 
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Tool Display Colors 
 

The display color for tools (cutters and holders) in all VERICUT views is determined by 
the conditions described below: 

If a tool component (cutter or holder) has a specific color defined in Tool Manager, then 
this color is used to display the component in all views. The cuts made by the cutter are 
also shaded with this color when Color Method, on the Color window: Cut Colors tab, 
is set to "Tool Color". Available colors are defined in the Shade Colors list on the Edit 
menu > Color window: Define tab. 

If a tool component (cutter or holder) is defined with "Inherit" as the color in Tool 
Manager, then it will be displayed using a "default" color. The "default" color is defined 
as the color of the tool's first cutter component or, if the color of the tool's first cutter 
component is defined as "Inherit", the "default" color is defined as the current cut color 
from the Cut Color Table on the Color window: Cut Colors tab. 

An inserted milling cutter, created by spinning several inserts, is displayed in the 
"default" color. 
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Assembly tab 
Location:  Project menu > Tools:  Add menu > Add Tool Component, or  

Project menu > Tools: Edit menu > Modify 
 

Features on this tab are used translate or rotate a component in a tool assembly, or to 
move the selected component by assembling (mating or aligning) it with other objects in 
the tool assembly. 

  

 
  

Translate group: 
Features in this group translate the selected object via indicating "from" and "to" points to 
move the object. Movement occurs each time you press the Move button. If the applied 
movement is incorrect, press Undo to return the object to its previous location. 

Features on this tab work the same as Translate features for modeling. (See how) 

From / To — Specifies the locations to move the object from and to, relative to the tool 
origin. XYZ values can be entered (separated by spaces), or selected by clicking in the 
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field then clicking on a tool component shape. As you move the mouse over the tool, a 
crosshair and vector show you the pending pick-point location. 

Move — Moves the selected object by the incremental distance, as calculated from the 
"From" point to the "To" point location. 

 

Rotate group: 
Features on this tab rotate the selected object about a rotation center point. Movement 
occurs each time you press one of the rotation direction buttons: X+/X-, Y+/Y-, Z+/Z-. If 
the applied rotation is incorrect, press Undo to return the object to its previous location. 

Features on this tab work the same as Rotate features for modeling. (See how) 

Center of Rotation — Specifies XYZ point location about which to rotate the object. 
XYZ values can be entered (separated by spaces), or selected by clicking in the field then 

clicking on a model. To see the center of rotation, press . To remove the center of 
rotation symbol press the button again, or close the window. 

Increment — Specifies incremental degrees of rotation to apply when one of the rotation 
direction buttons are pressed. 

Rotation buttons — (X+/X-, Y+/Y-, Z+/Z-) Applies the incremental degrees of rotation 
specified in the Increment field. Rotation occurs about the Center of Rotation relative to 
the tool origin. 

 

Assemble group: 
Similar to assembling models, objects are assembled by mating or aligning one to three 
planar surfaces with surfaces on other tool components. (See how) If a non-planar surface 
is selected, VERICUT constructs a tangent plane at the pick point. The relationship of 
surfaces being mated or aligned is known as a "constraint". Follow these general steps to 
define a constraint for assembly: 

1. Choose the constraint type. 

2. Select a surface on the object to move. 

3. Select the surface to move the object relative to. 

4. Press Apply. 

Constraint Type — Specifies how to constrain selected surfaces during object 
movement. After selecting two surfaces to define a constraint, VERICUT moves the 
object and highlights the satisfied constraint with a checkmark. Options: 

Mate — Moves the object so the selected surface opposes the surface selected on the 
second object (surface normals oppose each other). 

Align — Moves the object so the selected surface is aligned with the surface selected on 
the second object (surface normals point in the same direction). 
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Offset — Distance and direction in which to offset constrained surfaces, applied normal 
to the surface. 

 

Absolute group: 
Position — Specifies the absolute XYZ position of the object relative to the tool origin. 
Values in this field are separated by spaces. 

Angles — Specifies the absolute XYZ rotation of the object relative to the tool origin. 
Values in this field are separated by spaces. 

Reset — Resets constraints to receive new data. 

Undo — Returns the object to its previous location, or as it was when the window was 
opened. 
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Search Tool window 
Location:  Project menu > Tools:     Add menu > Tool > Find Existing or  

Edit menu > Search Tool  
  

Search Tool enables you to search existing tool libraries for tools with the specific 
attributes. 
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Libraries group: 
Files — Use to search one or more tool library files for tools meeting the specified search 
criteria.  

Directories — Use to search one or more directories of tool library files for tools 
meeting the specified search criteria. 

Browse — Displays a selection window to assist you in selecting the files/directories to 
be searched.  

  

Tool group: 
ID — Search for the specified tool ID. 

Description — Search for a specified string of text within the tool's Description field. 

Comments — Search for a specified string of text within the tool's Comment field. 

Units — Select Any, Inch or Millimeter from the pull-down list. 

Component Type — Use to search for tools that include a specific tool component type. 
Select Any, Revolved Cutter, Insert Cutter, Probe Tip, or Holder from the pull-down list. 

Teeth — Use to search for tools containing cutters with a specific number (or within 
range of) of teeth. 

  

Revolved Cutter group: 
Diameter — Use to search for revolved cutters with a specific diameter (or within a 
diameter range). 

Flute Length — Use to search for revolved cutters with a specific flute length (or within 
a flute length range). 

Height — Use to search for revolved cutters with a specific heights (or within a height 
range). 

Corner Radius — Use to search for revolved cutters with a specific corner radius (or 
corner radii within a range). 

  

Insert Cutter group: 
Insert Style — Use to search for a specific insert style (General, Groove, or Thread). 
Select one of the following insert styles from the pull-down list" 
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Insert Style Description 

Any   

GENERAL INSERT A 85 Degree Parallelogram 

 

GENERAL INSERT B 82 Degree Parallelogram 

 

GENERAL INSERT C 80 Degree Diamond 

 

GENERAL INSERT C 100 100 Degree Diamond 

 

GENERAL INSERT D 55 Degree Diamond 

 

GENERAL INSERT E 75 Degree Diamond 
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GENERAL INSERT H Hexagon 

 

GENERAL INSERT K 55 Degree Parallelogram 

 

GENERAL INSERT L Rectangle 

 

GENERAL INSERT M 86 Degree Diamond 

 

GENERAL INSERT O Octagon 

 

GENERAL INSERT P Pentagon 

 

GENERAL INSERT R Round 
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GENERAL INSERT S Square 

 

GENERAL INSERT T Triangle 

 

GENERAL INSERT V 35 Degree Diamond 

 

GENERAL INSERT W 80 Degree Trigon 

 

GENERAL INSERT CD Custom Diamond 

 

GENERAL INSERT CP Custom Parallelogram 

 

GROOVE INSERT S2 Square, double end 
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GROOVE INSERT R2 Radius, double end 

 

GROOVE INSERT V2 40 Degree V, double end 

 

GROOVE INSERT C2 45 Degree Chamfer, double end 

 

GROOVE INSERT S1 Square, single end 

 

GROOVE INSERT C1 Chamfer, single end 

 

GROOVE INSERT O1 Round, single end 

 

GROOVE INSERT R1 Radius, single end 

 

497497



VERICUT HELP – Project menu 
 

THREAD INSERT T55 55 Degree, triangle 

6

THREAD INSERT T60 60 Degree, triangle 

 

THREAD INSERT TT 30 Degree, trapeze triangle 

 

THREAD INSERT TA ACME, triangle 

 

THREAD INSERT TBR Buttress, triangle, right hand 

 

THREAD INSERT TBL Buttress, triangle, left hand 

 

THREAD INSERT A60 60 Degree, double end, asymmetrical 
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THREAD INSERT S60 60 Degree, double end, symmetric 

 

THREAD INSERT DA ACME, double end 

 

THREAD INSERT TDB Buttress, double end 

 

  

Insert Size — Use to search for insert cutters with a specific insert size (or within a range 
of insert sizes). 

Thickness — Use to search for insert cutters with a specific thickness (or within a 
thickness range). 

Corner Radius — Use to search for insert cutters with a specific corner radius (or corner 
radii within a range). 

  

Probe Tip group: 
Sphere Diameter — Use to search for probe tips with a specific sphere diameter (or 
within a diameter range). 

Stem Diameter — Use to search for probe tips with a specific stem diameter (or within a 
diameter range). 

Probe Length — Use to search for probe tips with a specific length (or within a length 
range). 

  

Holder group: 
ID — Use to search for a holder with a specific ID. 

  

499499



VERICUT HELP – Project menu 
 

Search — Start the search of the specified tool library (libraries) based on the attributes 
specified above. 

  

Tool List: 
Displays a list of the tools found during the search. The Tool List display and interaction 
is the same as the Tool Table in the Tool Manager, with the one exception that the tool 
library file name is also displayed here. 

  

Duplicate — Duplicates the selected tool in the current tool library. 

Reference — Creates a reference to the selected tool in the current tool library. 

Close — Closes the Search Tool window. 
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OptiPath window 
 
VERICUT Users: 
Location: Project menu > Tools:      Add menu > OptiPath > New, or  

Edit menu > Modify (when an OptiPath tool 
component is highlighted) 

Mold and Die Users: 
Mold and Die Location:   Other Settings page > Add/Modify Speed and Feed Settings 

Notebook Feature:      

 

Opens a window enabling you to create and maintain OptiPath records that describe how 
to optimize feed rates and/or spindle speeds for various tools and cutting conditions. The 
OptiPath data is used by VERICUT during tool path optimization. The OptiPath window 
shows the optimization values for the selected tool. 
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OptiPath record data 
Description — Use to enter a description for the OptiPath record. 

Material — Stock material to be cut. Enter a new material name, or click on the 
arrow to select from a list of materials defined in the library. Any combination of 
alpha or numeric characters can be used. 

Machine — NC machine that will be used to cut the workpiece. Enter a new machine 
name, or click on the arrow to select from a list of machines defined in the library. 
Any combination of alpha or numeric characters can be used. 

Unit Power — Power required to remove one cubic unit of material per minute. The 
power specification differs, depending on the units set for the OptiPath record (ref. 
Settings tab below). 

Accel/Decel — When active and a G-code tool path is being optimized, this feature 
applies Accel/Decel settings from the NC machine configuration to adjust optimized feed 
rates. VERICUT looks ahead in the tool path file and slows the machine prior to direction 
changes, as well as changes feed rates based on the machine axes ability to accelerate and 
decelerate. Options: 

Off — Does not adjust optimized feed rates for acceleration/deceleration. 

Exact Stop — Assumes all axes must stop and be positioned exactly at the 
programmed location before the next block is processed. This option is recommended 
when sharp corners are required between motion blocks. 

Continuous — Allows small errors in positioning in order to maintain a more 
constant velocity during corners or direction changes. 

NOTES:   
1. The block preceding an un-optimized block is not processed through Accel/Decel 

logic. 

2. Accel/Decel settings apply to all linear and circular motions, including those in 
air. 

 

OptiPath Cutter Shape Graphic — The cutter shape automatically displays for the tool 
in the Tool Library that the OptiPath record is associated with. VERICUT refers to the 
cutter shape to calculate material removal volume and other machining related data via 
features on the OptiPath Manager Feed/Speed tab. 

Feed/Speed tab — Features on this tab are used to describe and test various cutting 
conditions to optimize, as well as control how optimization will be performed for the 
selected tool. 

Settings tab — Features on this tab specify important settings for the optimization 
process, such as: the OptiPath record units, when to add (interpolate) more cuts, 
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resolution, minimum/maximum optimized feed rates, how to optimize circle and NURBS 
motions, and more. 

Hard Material tab — The features on this tab enable you to adjust the optimized feed 
rate for ‘hostile’ cutting conditions (non-climb, thin radial width, and side-loaded cuts) 
when cutting hard materials. 

Spindle tab — The features on this tab limit RPM fluctuations and specify feed per tooth 
load maintained during Surface Speed optimization. 

Plunge tab — The features on this tab control the optimized feed rate for motions along 
the tool axis that plunge into or retract from material. 

Entry/Exit tab — The features on this tab control the optimized feed rate for entering 
and exiting material. 

Angle tab — The features on this tab adjust the optimized feed rate for 3-axis linear cuts 
ramping in material. 

Depth Table tab — The features on this tab controls how optimized feed rates are 
calculated for cutting at various depths during Optimize by Tables optimization. 

Width Table tab — The features on this tab adjust the optimized feed rate for cuts that 
are less than full cutter width during Optimize by Tables optimization. 

  

Add — Adds the OptiPath data and optimization parameters to the newly created 
OptiPath record. 

Modify — Applies the modified OptiPath data and optimization parameters to an 
existing OptiPath record. 

Close— Closes the OptiPath Manager window. 
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OptiPath window, Feed/Speed tab 
Location: Project menu > Tools:      Add menu > OptiPath > New,  or  

Edit menu > Modify (when an OptiPath tool 
component is highlighted) 

 

Features on this tab are used to describe and test various cutting conditions to optimize, 
as well as control how optimization will be performed for the selected tool. As methods 
are selected, some of the features become locked (unavailable for editing). However, they 
respond to show you the relationships between feed per tooth, RPM, cutter shape, and 
feed rate through various cutting conditions. In general, this is a three step process: 

1. Configure the features in the Cutting Condition group to represent a known 
successful cutting condition which is typical for the tool. 

2. Select the desired optimization method(s). 

3. Again use the Cutting Condition group to test how optimization will be 
performed. 

After configuring the features on this tab, be sure to review the other tabs in the OptiPath 
window for proper optimization values. 

  

Cutting Condition group: 
This group of features is used to describe and test various machining conditions to 
optimize. You can enter or adjust the sliders to set the desired values. As values change, 
the cutter graphic is updated to reflect the current cutting condition. The unit of measure 
for the values is determined by the units selected on the Settings tab. 

NOTE:  If the sliders don't go far enough to reach the desired value or the value in the 
corresponding data field turns red, then another optimization setting is limiting input. If 
all settings on the Feed/Speed tab look okay, then check values on the Settings tab, such 
as Maximum/Minimum Cut feed rates. 

Axial Depth / Radial Width — Depth and width of cut. 

Feed per Minute — Feed rate calculated from feed per tooth, spindle speed, and number 
of cutting teeth on the cutter. 

Feed per Tooth — Thickness of material or "chip load" removed by each tooth on the 
cutter. 

  

Optimization Method group: 
This group of features is used to control how optimization will be performed for the 
selected tool. Note that all methods optimize air cuts (tool motions not in contact with 
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material). However, the Air Cut Feed Rate method optimizes only the cuts entirely in 
air. 

Tip: When Chip Thickness and Volume Removal methods are combined (both 
selected), VERICUT calculates optimized feed rates for each, then uses the feed rate 
having the smaller value. This has the affect of protecting you against excessive chip 
thickness or volume conditions that can occur using only one of these optimization 
methods. 

Chip Thickness — When selected, optimizes cutting by flat, ball, and bull nose endmills 
based on maintaining a specified chip thickness. This method increases the feed rate 
when width of cut is less than 50% cutter diameter, or when depth of cut is less than the 
tool corner radius. Good for optimizing high speed machining and for semi-finishing and 
finishing operations using carbide cutting tools where the danger of "chip thinning" 
exists. It is especially effective for mold and die applications machining hard materials. 
Use the slidebar or enter the chip thickness in the data field. If unknown, unselect all 
optimization methods and use the Cutting Condition sliders to calculate it. For more 
information on chip thinning, see "The Chip Thinning Problem" in the Using 
VERICUT section. Using VERICUT can be found in the VERICUT Help Library. 

Volume Removal — When selected, optimizes based on a constant volume of material 
to be removed. This option is good for optimizing tools that encounter widely varying 
cutting conditions, such as hogging or roughing operations that cut at different cut depths 
and widths. Use the slide bar or enter the volume removal rate (cubic units) in the data 
field. If unknown, unselect all optimization methods and use the Cutting Condition 
sliders to calculate it. 

Spindle Speed — When selected, outputs spindle speed values that support optimized 
feed rates. This value is also considered for Cutting Condition calculations (see above). 
Use the slide bar or enter the spindle speed (revolutions per minute) in the data field. 

Surface Speed — When selected, optimizes feed rates and spindle speeds based on 
constant surface speed (CSS). Good for optimizing finish machining by ball or bull-nosed 
endmills and high speed machining, this option varies spindle speeds to maintain a 
constant surface speed at the maximum tool contact diameter. Feed rates are adjusted to 
maintain a constant feed per tooth ("chip load") in material. Use the slide bar or enter the 
CSS value in feet/minute (FM) for inch tool paths, meters/minute (MM) for metric tool 
paths. If unknown, unselect all optimization methods and use the Cutting Condition 
sliders to calculate it. Use features on the Spindle tab to limit RPM fluctuations and 
specify the feed per tooth load to be maintained. 

NOTE:   CSS optimization is for use on high speed NC machines capable of varying 
spindle speed quickly without harming spindle motor hardware. 

Spindle Power — Power required to remove material. The value entered differs 
depending on the active units for the OptiPath record: 

Inch units => horsepower required to remove 1 cubic inch of material 

Metric units => kilowatts required to remove 1 cubic centimeter of material per 
second 
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Air Cut Feed Rate — This option is useful for reducing time of proven tool paths, 
without affecting cutting feed rates and resulting surface finishes. When the checkbox is 
cleared, this feature controls the feed rate used by all other optimization methods to 
optimize air cuts. 

Default option — when selected, the air cut feed rate is determined as follows: 

G-code tool path = Max Feed Velocity of the machine's X-axis. 

APT tool path = Fast Feed value. 

To specify an air cut feed rate value, clear the Default checkbox and enter a value in the 
data field. The feed rate entered should reflect the maximum speed at which machine 
axes can move simultaneously in feed mode (e.g. G01). 

Optimize by Tables — When selected, optimizes based on specified feed rates for 
various cut depths, widths, and angles. This option is good for optimizing tools used in 
hogging or roughing operations where more control over cutting feed rates for various cut 
depths, widths, or angles is desired. Use the features on the Depth Table, Width Table, 
and Angle tabs to configure settings for this method. 

Fill — Automatically fills table data fields with values calculated using the Cutting 
Condition sliders. The following values are supplied: 

Depth Table => defines five equally spaced cut depths based on cutter height and a 
cutting feed rate for each, based on volume of material removed. Also supplies the 
calculated volume removal rate for the value for Max.Volume Removal Rate. 

Width Table => calculates a percentage of calculated feed rate for each % Width 
value based on volume of material removed. 
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OptiPath window, Settings tab 
Location: Project menu  > Tools:     Add  menu > OptiPath > New,  or  

Edit menu > Modify (when an OptiPath tool 
component is highlighted) 

 

Features on this tab specify important settings for the optimization process, such as: the 
OptiPath record units, when to add (interpolate) more cuts, resolution, 
minimum/maximum optimized feed rates, how to optimize circle and NURBS motions, 
and more. 

After configuring the features on this tab, be sure to review the other tabs in the OptiPath 
Manager window for proper optimization values. 

 

Modify Existing Cuts Only — When selected, this option calculates the most efficient 
feed rate for each motion. VERICUT uses the Resolution value (see below) to divide 
each motion into samples and calculates an optimum feed rate for each sample. The feed 
rate calculated for the sample with the most severe cutting conditions is retained as the 
optimized feed rate for that motion. This option is recommended when disk space is 
limited for storing optimized tool path data, or when tool positions are relatively close 
together. A tool path optimized with this choice has more efficient feed rates and the 
same or slightly more records than the original. 
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Sample optimization results using the Modify Existing Cuts Only option: 

 
 

Add More Cuts — Similar to Modify Existing Cuts Only except motions are divided 
up when cutting conditions warrant feed rate changes. A tool path optimized with this 
choice has very efficient feed rates, but many more records than the original. The 
Minimum Feedrate Change value (see below) controls the quantity of feed rates output 
to the optimized tool path file. This option is recommended when disk space is ample, or 
when optimizing widely varying cutting conditions, such as: intermittent cutting, deep 
versus shallow cuts, etc. 
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Sample optimization results using the Add More Cuts option: 

 
 

Inch / Millimeter options — Controls the unit measurement system in which 
optimization data is entered. If the OptiPath record units are different from the session 
units, the record values are converted appropriately when loaded. 

Resolution — Controls the frequency or "sampling distance" used to analyze each tool 
path motion. Each feed rate controlled motion is partitioned into samples based on this 
distance. The samples are then analyzed during feed rate calculation.  

Options: 

Distance — Uses the sampling distance in the corresponding data field. Distance is 
measured along the tool motion. Using a resolution equal to 1/2 to 1/4 of the tool 
diameter is recommended. 

Auto — Automatically calculates the resolution distance based on the size of the 
cutting tool relative to the displayed model. This choice is recommended when little 
or no knowledge of cutting methods or feed rates is available. 
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Example of Resolution applied when optimizing tool path motions: 

 
 

Minimum Feedrate Change — Specifies the minimum change from the current 
optimized feed rate that will cause a new optimized feed rate to be output. This feature 
controls the quantity of feed rates output to the optimized tool path file. A small value 
causes more optimized feed rates to be output than when a larger value is entered. 

Default option — When selected, sets the default Minimum Feedrate Change = 1 IPM or 
25 MMPM, whichever applies. 

Clean-up Feedrate — Feed rate used when the tool is adjacent to, but not removing 
material. This condition is commonly referred to as a "spring pass". 

Default option — When selected, sets the default clean-up feed rate as follows: 

G-code tool path => 50% of the Max Feed Velocity of the machine's X-axis. 

APT tool path => 50% of the Fast Feed value. 

 

Tip: Set the Clean-up Feedrate to be less than the Air Cut Feedrate, since actual 
cutting leaves small amounts of material from tool deflection. 

 
Circle Feedrate — Controls when and how feed rates are optimized for circular motions 
(e.g. G02-3). Circle feed rate optimization produces a single optimized feed rate for the 
entire circular motion regardless of the active Modify Existing Cuts Only or Add More 
Cuts option.  

Options: 
Programmed — Uses the original programmed feed rate. 

Fixed — Uses the feed rate in the corresponding data field. 

Optimize — Calculates an optimized feed rate based on the maximum material 
removed throughout the circular motion. 
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Break-up — OptiPath will attempt to break up circles only if both this option and the 
Add More Cuts option has been selected. 

For APT, only one output format is supported: 

CIRCLE/ xc, yc, zc, i, j, k, rad      - defines circle center, plane and radius 

GOTO/x,y,z,ijk                             - defines the ending point of the motion 

 

Circle feed rates are not optimized under the conditions listed below. These circles 
receive the original programmed feed rate. 

• helical (spiral) circle motions 

• circle motion where the tool axis is not perpendicular to the circle axis 

• G-code data circle motion programmed in inverse time feed rate mode (e.g. 
G93) 

 
Radius Control — When toggled On, OptiPath adjusts the feedrate for circular motions. 
During circle motions, OptiPath determines the maximum contact point away from the 
tool center line and adjusts the feed rate so the desired feed rate is achieved at that point. 
Radius Control is only available when Circle Feedrate is set to Optimize or Break-up. 

NOTE:  If the effective cutting radius, R, is bigger than the circle radius, r, OptiPath 
adjusts (lowers) the feedrate by the factor r/R which is < 1. If R is less than r (r/R > 1), no 
adjustment is done (OptiPath will not increase the feedrate calculated based on the tool 
center). 

NURBS Feedrate — Controls when and how to optimize NURBS motion feed rates 
(e.g. G06, G06.2). The active Modify Existing Cuts Only or Add More Cuts option 
does not affect feed rates calculated by this feature.  

Options: 
Programmed — Uses the original programmed feed rate. 

One Feedrate — Calculates the most efficient feed rate for NURBS motions. The 
feed rate calculated for the most severe cutting condition used as the optimized feed 
rate. 

Multi Feedrate — Calculates multiple feed rates for NURBS motions when cutting 
conditions warrant feed rate changes. 

Feedrate Wear Reduction — Reduces the calculated feed rate based on the amount of 
material that has been removed. The value entered is the percentage of reduction to be 
applied after each cubic unit of material removed. Zero indicates no adjustment for wear. 

Example: assume "Feedrate Wear Reduction=.2". The calculated feed rate is reduced 
.2% after each cubic unit of material has been removed. After five cubic units removed 
the calculated feed rate is reduced 1% (.2% x 5). 
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Limits: 
Minimum Cut Feedrate — Specifies the minimum optimized feed rates that can be 
output when removing material. 

Default option — When selected, sets the default minimum feed rate = 1 IPM or 25 
MMPM. 

Maximum Cut Feedrate — Specifies the maximum optimized feed rates that can be 
output when removing material. 

Default option — When selected, sets the default maximum feed rate as follows: 

G-code tool path => 45% of the Max Feed Velocity of the machine's X-axis. 

APT tool path => 45% of the Fast Feed value. 

Maximum Cut Depth — Specifies the maximum cut depth that can be output when 
removing material. 

Default option — When selected, sets the default maximum cut depth = 5 (inch) or 
150 (metric). 

Maximum Volume Removal Rate — Specifies the maximum volume removal rate that 
can be output when removing material. 

Default option — When selected, sets the default maximum volume removal rate = 
100 (inch) or 1500000 (metric) 

Maximum Chip Thickness — Specifies the maximum chip thickness that can be output 
when removing material. 

Default option — When selected, sets the default maximum chip thickness = .02 
(inch) or .05 (metric). 

Maximum Surface Speed — Specifies the maximum surface speed rate that can be 
output when removing material. 

Default option — When selected, sets the default maximum surface speed = 1000 
(inch) or 300(metric). 

512512



VERICUT HELP – Project menu 
 

OptiPath window, Limits tab 
 
 
 
 
 
 
 

***** NEW FOR V6.1 *****
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OptiPath window, Hard Material tab 

Location: Project menu > Tools:      Add menu > OptiPath > New,  or  

Edit menu > Modify (when an OptiPath tool 
component is highlighted) 

  

Features on this tab enable you to specify feedrate adjustment factors for special cutting 
conditions encountered during the optimization process 

Feedrates may need to be adjusted (typically slower than what OptiPath would normally 
calculate) based on the following 'hostile' conditions when cutting hard materials. 

 

Non-Climb or "Conventional" cutting 
Non-Climb cutting, or "Conventional" cutting occurs when the cutter tooth enters 
material close to parallel to the direction of motion. See the following diagram: 

 
 

The cutting condition worsens as the tooth entry angle decreases. When the tooth entry 
angle is near zero the cutting edge contacts material parallel to the direction of motion 
and requires excessive force to push the edge into material. The tooth finally enters 
material when pressure between the cutter and material increases and the tooth rotates 
past the tangent contact.  
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The picture below shows the worst condition. 

 
 

Thin radial width, typically only one tooth is engaged in material 
When the width of material becomes so small that only one tooth of the cutter is engaged, 
the tool is no longer well supported and an otherwise reasonable feed rate becomes too 
aggressive. As the spindle spins the tool transitions between a tooth engaged and cutting, 
and no tooth engaged, causing the tooth to "bang" into material each time it enters. This 
"banging" causes premature cutting edge breakdown and reduces tool life. 

Determining the number of teeth engaged depends on the number of teeth in the cutter, 
the material contact axial depth, the width and location of the contact, and the flute helix 
angle. 

 
 

Side-loaded cutting, material is exclusively on the "climb" side of the 
cutter 
When the tool is cutting with all material on the right of the tool center (for a clockwise 
rotating spindle), the cutting pressure forces the tool to deflect in the opposite direction. 
The deflection seriously affects cutting performance, increases cutting forces, and causes 
premature edge breakdown. 

 These hostile conditions generally occur when cutting hard or difficult to machine 
materials such as tool steel, stainless steel, and high temperature alloys. Since there is no 
good scientific or empirical information to apply to these hostile conditions, the 
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following features enable you to adjust the feed rates under each of these Hard Material 
conditions. 

Adjust Feedrate for Non-Climb Cut —  

Adjust Feedrate for Thin Radial Width Cut —  

Adjust Feedrate for Side-Loaded Cut —  
Each feature consists of a checkbox to toggle the feature On/Off, and a numeric field 
enabling you to enter a factor to be applied to the calculated feed rate for each of these 
conditions. The number represents a percentage of the calculated feed rate.  

When a feature is toggled "On", the factor is applied to the calculated feedrate each time 
that the particular condition is detected. 

Since these cutting conditions are not mutually exclusive, any combination (or all) of the 
features can be toggled "On" at the same time and any, or all, of the factors may be 
applied to the same calculated feed rate as appropriate for the cutting conditions. 

After configuring the features on this tab, be sure to review the other tabs in the OptiPath 
Manager window for proper optimization values.

516516



VERICUT HELP – Project menu 
 

OptiPath window, Spindle tab 
Location: Project menu > Tools:      Add menu > OptiPath > New,  or  

Edit menu > Modify (when an OptiPath tool 
component is highlighted) 

  

The features on this tab limit RPM fluctuations and specify feed per tooth load 
maintained during Surface Speed optimization. 

After configuring the features on this tab, be sure to review the other tabs in the OptiPath 
Manager window for proper optimization values. 

Minimum RPM Change — Specifies the minimum change from the current optimized 
spindle speed required to output a new spindle speed. This feature controls the quantity of 
spindle speed changes output to the optimized tool path file. Small Minimum RPM 
Change values, cause more spindle speed changes to be output than larger values.  

Tip: Start with a value such that only 3-4 changes can occur across the RPM range. 

Default option — When selected, sets the default minimum RPM change = 1000. 

 

Minimum RPM — Specifies the minimum spindle speed that can be output during 
optimization. 

Default option — When selected, sets the default minimum RPM as follows: 

G-code tool path => machine spindle minimum set by SpindleSpeedMin macro, 
if not set then 100 RPM. 

APT tool path => 100 RPM. 

 

Maximum RPM — Specifies the maximum spindle speed that can be output during 
optimization. 

Default option — When selected, sets the default maximum RPM as follows: 

G-code tool path => machine spindle maximum set by SpindleSpeedMax macro, 
if not set then 20000 RPM. 

APT tool path => 20000 RPM. 
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OptiPath window, Plunge tab 
Location: Project menu > Tools:      Add menu > OptiPath > New, or  

Edit menu > Modify (when an OptiPath tool 
component is highlighted) 

  

The features on this tab control the optimized feed rate for motions along the tool axis 
that plunge into or retract from material. 

After configuring the features on this tab, be sure to review the other tabs in the OptiPath 
Manager window for proper optimization values. 

Plunge Feedrate — Controls when and how feed rates are calculated for plunging along 
the tool axis into material.  

Options: 
Off — Disable plunge feed rate control. 

Feed/Minute — Uses the feed rate entered in the corresponding data field. 

% of Prog. — Adjusts programmed feed rates based on the percentage entered in the 
corresponding data field. 100% uses the programmed feed rate as is, 50% cuts the 
feed rate in half, etc. 

NOTE:  Plunge Feedrate overrides Angle table feed rate for 90 degree cutting angle 
(plunge motion), or the Entry Feedrate for entry on plunge motions. 

 

Clearance Distance — Specifies the distance from material to instate the feed rate for 
plunging. 

 

Retract Feedrate — Controls when and how the feed rates are calculated for retracting 
along the tool axis away from material.  

Options: 
Off — Disable retract feed rate control. 

Feed/Minute — Uses the feed rate entered in the corresponding data field. 

% of Prog. — Adjusts the programmed feed rate based on the percentage entered in 
the corresponding data field. 100% uses the programmed feed rate as is, 50% cuts 
feed rate in half, etc. 

NOTE:  Retract Feedrate overrides Angle table feedrate for -90 degree cutting angle 
(retract motion). 
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OptiPath window, Entry/Exit tab 
Location: Project menu > Tools:      Add menu > OptiPath > New, or  

Edit menu > Modify (when an OptiPath tool 
component is highlighted) 

  

The features on this tab control the optimized feed rate for entering and exiting material. 
The feed rate takes affect at a specified distance from material contact and remains in 
affect until the tool has cut a specified distance into material, or the entry motion ends. 

After configuring the features on this tab, be sure to review the other tabs in the OptiPath 
Manager window for proper optimization values. 

Entry Feedrate — Controls when and how feed rates are calculated for entering 
material.  

Options: 
Off — Turns off Entry (or Exit) Feedrate calculation and application during 
optimization. 

Feed/Minute — Uses the feed rate entered in the corresponding data field. 

% of Prog. — Adjusts the programmed feed rate based on the percentage entered in 
the corresponding data field. 100% uses the programmed feed rate as is, 50% cuts 
feed rate in half, etc. 

% of Calc. — Similar to % of Prog., except adjusts the calculated feed rate. 

 

Affect of Entry Feedrate applied on a motion entering material: 
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NOTES: 
1. When entry motions are optimized with the Modify Existing Cuts Only option, 

calculated entry feed rates are considered among other cutting conditions to 
determine the appropriate feed rate for motions which enter material. 

2. Plunge Feedrate overrides entry controlled feed rate for entry on plunge motion. 

 

Clearance Distance — Specifies the distance from material to instate the feed rate for 
entering. 

Cut Distance — Specifies the distance to cut into material using the Entry Feedrate, 
after which normal feed rate optimization resumes. 

Exit Feedrate — Controls when and how the feed rates are calculated for exiting 
material. Options are same as described above for Entry Feedrate. 

Clearance Distance — Specifies the distance after breaking free from material to 
continue using the feed rate for exiting, after which the Air Cut Feedrate resumes. 

Cut Distance — Specifies the distance away from breaking out of material to use the 
Exit Feedrate. 
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OptiPath window, Angle tab 
Location: Project menu > Tools:      Add menu > OptiPath > New, or  

Edit menu > Modify (when an OptiPath tool 
component is highlighted) 

  

The features on this tab adjust the optimized feed rate for 3-axis linear cuts ramping in 
material. While these features are normally used to reduce the feed rate for ramping 
downward, they can also be used to affect feed rates for upward ramping motions. 

After configuring the features on this tab, be sure to review the other tabs in the OptiPath 
Manager window for proper optimization values. 

 

Adjust Feedrate for Entry Angle — When active, adjusts feed rates for ramping 
motions based on the table configuration. 

Angle table — Table of cut angles and corresponding % feed rate adjustments to apply 
when the tool ramps into material. Values can be entered or supplied via dragging the 
control points on the graph. Add after, or delete table entries via right-clicking on them 
and choosing the appropriate option (or use the Add / Delete buttons below the table). 
Cuts at angles less than the minimum listed in the table receive the adjustment specified 
for the minimum angle. Similarly, when the maximum specified cut angle is exceeded, 
the adjustment specified for the maximum angle is used. 

Angle column — Lists up to five cut angles (in descending order) that describe the range 
of expected cut angles to adjust. Values can be from -90 to 90, where "0" represents 
horizontal milling, "90" represents plunge motion along the tool axis, and "-90" 
represents retract motion. 

% Feedrate column — Lists % feed rate adjustments to apply to calculated feed rates 
when ramping in material at the corresponding angle. 100% uses the calculated feed rate 
as is, 50% cuts feed rate in half, etc. 
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Sample Angle table: 

 
 

NOTES:  
1. Angle adjusted feedrate for 90 degree cutting angle is overridden by Plunge 

Feedrate if active. 

2. Planar milling motions (0 degree angle) are not adjusted. 
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OptiPath window, Depth Table tab 
Location: Project menu > Tools:      Add menu > OptiPath > New, or  

Edit menu > Modify (when an OptiPath tool 
component is highlighted) 

  

The features on this tab controls how optimized feed rates are calculated for cutting at 
various depths during Optimize by Tables optimization. The calculated feed rate can be 
used as calculated, or adjusted using the Angle and/or Width tables, as well as features 
on other tabs in this window. 

After configuring the features on this tab, be sure to review the other tabs in the OptiPath 
Manager window for proper optimization values. 

 

Feedrate value type option list — Controls the how to interpret the feed rates in the 
Depth table.  

Options: 
Feed/Minute — Calculates optimized feed rates based on absolute feed rates 
specified for various cut depths. Specify feed in units specified on the Settings tab. 

% of Prog. — Calculates optimized feed rates based on percentages of programmed 
feed rates specified for various cut depths. "100" uses the programmed feed rate as is, 
"50" cuts the feed rate in half, etc. 

Feed/Tooth — Calculates optimized feed rates based on feed per tooth, or chip load 
specified for various cut depths. Specify feed per tooth in units used by the tool path 
file (IPR or MMPR). 

Depth table — Table of cut depths and corresponding feed rates to apply when cutting at 
a specified depth. Values can be entered or supplied via dragging the control points on 
the graph. Add after, or delete table entries via right-clicking on them and choosing the 
appropriate option (or use the Add / Delete buttons below the table). Cuts at depths less 
than the minimum listed depth in the table receive the feed rate specified for the 
minimum depth. Similarly, when the maximum specified cut depth is exceeded, the feed 
rate specified for the maximum depth is used and an error identifying the condition is 
written to the Log file. 

Depth column — Lists up to five cut depths (in descending order) that describe the 
range of cutting by the tool. 

Feedrate column — Lists feed rates to apply when the tool is cutting at the 
corresponding depths. Feed rate values are interpreted differently based on the active 
feed rate value type option (see "Feedrate value type option list" above). 
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Sample Depth table: 

 
  

Tip: Un-select all optimization methods and use the Cutting Condition sliders to 
determine appropriate feeds and speeds for a known successful cutting condition, then 
select Optimize by Tables and press Fill to automatically enter Depth Table values. 

  

Feedrate Control Options — Controls when and how volume removal rate is 
considered in feed rate calculations during optimization by tables.  

Options: 
Off — Disable volume removal rate considerations. 

Const. Volume Below Min. Depth — Specifies a constant volume of material is to 
be removed when the depth of cut is less than the lowest Depth table entry. The 
volume removal rate is expressed in cubic units, where “units” refers to the units 
specified on the Settings tab. If unknown, un-select all optimization methods and use 
the Cutting Condition sliders to calculate it. 

The example below shows the affect of Constant Volume Below Minimum Depth 
on feed rate calculations for a ball-nose endmill when the lowest Depth Table entry is 
equal to the radius of the tool. 

  

 
  

Max. Volume Removal Rate — Specifies the maximum volume removal for the 
tool. Optimized feed rates are bounded such that the rate at which material is removed 
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never exceeds this value. The volume removal rate is expressed in cubic units, where 
"units" refers to the units specified on the Settings tab. If unknown, un-select all 
optimization methods and use the Cutting Condition sliders to calculate it. 
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OptiPath window, Width Table tab 
Location: Project menu > Tools:      Add menu > OptiPath > New, or  

Edit menu > Modify (when an OptiPath tool 
component is highlighted) 

  

The features on this tab adjust the optimized feed rate for cuts that are less than full cutter 
width during Optimize by Tables optimization. When the tool is cutting with less than 
full diameter the feed rate can typically be higher than for a full width cut, also know as a 
"slot cut". 

After configuring the features on this tab, be sure to review the other tabs in the OptiPath 
Manager window for proper optimization values. 

 

On — When selected, adjusts feed rates for cuts of varying width based on the Width 
table configuration. 

Width table — Table of cut widths and corresponding % feed rate adjustments to apply 
when removing material with the specified cutter width. Values can be entered or 
supplied via dragging the control points on the graph. Add after, or delete table entries 
via right-clicking on them and choosing the appropriate option (or use the Add / Delete 
buttons below the table). Cuts at widths less than the minimum listed in the table receive 
the adjustment specified for the minimum width. Similarly, when the maximum specified 
cut width is exceeded, the adjustment specified for the maximum width is used and an 
error identifying the condition is written to the Log file. 

% Width column — Lists up to five cut widths (in increasing order) that describe 
the range of expected cut widths to adjust.  

% Feedrate column — Lists % feed rate adjustments to apply to calculated feed 
rates when removing material with the corresponding cut width. 100% uses the 
calculated feed rate as is, 50% cuts feed rate in half, etc. 
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Sample Width table: 
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Search OptiPath Record window 
Location: Project menu > Tools:      Add menu > Tool > Select Existing or  

Edit menu > Search Tool  
  

Search OptiPath Record enables you to search existing tool/OptiPath libraries for records 
with specific attributes. 

  

 
  

Libraries: 
Files — Use to search one or more tool library files for tools meeting the specified search 
criteria.  

Directories — Use to search one or more directories of tool library files for tools 
meeting the specified search criteria. 

Browse — Displays a selection window to assist you in selecting the files/directories to 
be searched.  

  

Search Attributes: 
Description — Search for existing OptiPath records containing a specified string of text 
within the record's Description field. 

Material — Search for existing OptiPath records containing a specific material type. 

Machine — Search for existing OptiPath records containing a specific machine type. 

  

528528



VERICUT HELP – Project menu 
 

Search — Start the search of the specified library (libraries) based on the attributes 
specified above. 

  

OptiPath Record List: 
Displays a list of Optipath records found during the search. The Tool List display and 
interaction is the same as the Tool Table in the Tool Manager, with the one exception that 
the tool library file name is also displayed here. 

  

Duplicate — Duplicates the selected OptiPath record in the current tool library. 

Reference — Creates a reference to the selected OptiPath record in the current tool 
library. 

Close — Closes the Search OptiPath Record window. 
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Processing Options 

Activate 
Location: Project menu > Processing Options > Activate 

  

Activate enables you to set the state of the current setup to active/inactive. An active state 
is indicated by a check mark. 
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Motion window 
  

VERICUT Users: 
VERICUT Location: Project menu > Processing Options > Motion 

VERICUT toolbar short cut:   

  

Mold and Die Users: 
Mold and Die Location:   Advanced Options page > Simulation Settings 

Notebook Feature:      

  

Cutter Grinder Users: 
Cutter Grinder Location:   Advanced Options page > Simulation Settings 

Notebook Feature:      

 

Opens a window used to control the simulation of tool path and machine motions. 
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Start At/Stop At group: 
Start At — Specifies the line, or tool path record at which cutting simulation starts. 
VERICUT fast forwards from the beginning of the NC program to the specified 
line/record while internally processing intermediate tool path records to store values for 
the current feed rate, spindle speed, coolant, tool description, and tool location.  

Options are:  
Beginning — Start processing at the beginning of the first file. 

Line Number — Start processing at the specified line number of selected toolpath 
file. 

NOTE:  A list of all NC programs and job subroutine files defined for the current 
job will display enabling you to select the toolpath file. 

Line Number (Directly) — Start processing at the specified line number without 
internally processing intermediate tool path records. This line number only applies to 
the first toolpath (or the first active toolpath if Use Selected Files, in the Project 
>NC Program window, is being used to select only specific toolpath files from the 
list for VERICUT processing). 

Text — Start processing on the line that contains the specified text. 

Tool ID — Start processing when the specified tool is loaded. 

 

Stop At — Provides options for stopping tool path processing. When applicable, enter 
supporting "stop at" text or values in the field next to this feature. Text entered is not case 
sensitive. 

End — Stop processing at the end of the last toolpath file. 

Num of Cuts — Stop processing after the specified number of cuts. 

Line Number — Stop processing at the specified line number of the selected 
toolpath file. 

NOTE:  A list of all toolpath and job subroutine files defined for the current job will 
display enabling you to select the toolpath file. 

Text — Stop processing on the line that contains the specified text. 

Tool Change — Stop processing when a toolchange occurs. 

Program Stop — Stop processing when a "program stop" record is encountered in 
the tool path. Examples of such records include: M0 (G-code tool paths) or STOP. 

Optional Stop — Stop processing when an "optional stop" record is encountered in 
the tool path. Examples of such records include: M1 (G-code tool paths) or OPSTOP. 

End of each File — Stop processing at the end of each toolpath file. 

End of each Setup — Stop processing at the end of each setup. 
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Stop At Max Errors / Stop At Max Warnings — Number of errors (or warnings) 
which, if detected, stops tool path processing. Toggle "On" and specify the Max 
Error/Max Warning value. 

  

Motion group: 
Fast Feed — Feed rate threshold at which material removal is unsafe (likely to cause tool 
breakage, machine malfunction, or part damage). For example, if the maximum feedrate 
allowed is 180, Fast Feed should be set to 181 or greater. Material removed under these 
conditions is shaded in the Error color (typically red) and causes a "Fast feed rate" error. 

 

 
 

No Animation — Enables you to reduce processing time. When toggled "On", the 
graphics display is not updated until either processing is complete or you Stop the 
processing. At that time the cut model is displayed in it "final" state or the state that it 
was in when processing was stopped. 

Skip Cut — Quantity of animated tool motions to skip before updating the display. Enter 
"0" to display each tool motion. Skipping cuts increases animation speed since the 
display is not constantly updated. The cut model is unaffected. 
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Tool Spindle Always On — When toggled On, VERICUT will assume that the spindle 
is always on and will not check for spindle status (on/off) or output error messages 
related to cutting with the spindle off. 

Drill Cycle — Controls when and how to simulate canned tool axis cycles (e.g. G8n, 
"CYCLE"). While VERICUT simulates most popular cycle motions, there are also 
capabilities to add more and change how existing cycles are interpreted. See "About 
configuring for cycle simulation" in the Using VERICUT section for more information. 
Using VERICUT can be found in the VERICUT Help Library. 

Options: 
Ignore — Ignores cycle motions- the tool moves to each cycle position without 
performing cycle motions. 

Bottom Only — Simulates cycle motions for a hole with one full depth motion- 
pecking or chip-breaking motions are not simulated. 

Full Motion — Simulates all cycle motions, including pecking or chip-breaking 
motions. 

NOTE:  When the "Bottom Only" or "Ignore" options are used, certain motions 
(and checks) are ignored.  This means that there will be no RAPID checks, no 
material removal, no limit checks, no collision checks, no redraws, etc. Because of it's 
importance, checks related to "RAPID to the R-plane" motions are included when 
 "Bottom Only" is selected, but not when "Ignore" is selected. 

 

Need help troubleshooting cycle motion errors? See ERRORS and Problem Solving 
at http://www.cgtech.com/support/errors_problems/errors.htm, for assistance with 
diagnosing error messages and conditions. 

 

Check Spindle Direction — When toggled On, VERICUT check for spindle direction 
against the "valid" direction of the tool.  

For turning tools, "valid" direction is based on the turning tool orientation. Spindle 
direction, (CW or CCW), is determined looking down the Z-axis of the spindle. It is 
assumed that revolving stock material should come onto the insert in the direction of 
positive Y-axis of the tool component. If spindle direction is wrong, or spindle speed is 
not defined, an error is reported to VERICUT logger. Only one error per spindle is 
reported for each operation turning the spindle On or Off. 

The error is reported only if turning tool removes material from stock. For air moves, no 
errors are reported. Also, if an insert removes material in a motion that crosses the 
spindle Z-axis, no error is reported (in this case, one part of the insert is always on the 
correct side, while the other part is on the wrong side, therefore there is no preferable 
spindle direction). 

For milling tools, the direction of the tool spindle (either spindle component or tool 
component attribute) is checked with the "valid" direction of the tool in the spindle. Tool 
spindle direction (CW / CCW) is defined looking down (negative Z) the tool axis. For 
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revolved milling cutters, "valid" direction is based on the setting of Spindle Direction 
(clockwise or counterclockwise) in the tool definition. For inserted milling cutters, 
"valid" direction is based on the insert thickness direction. 

If the direction of the spindle does not match the direction of the tool, then an error is 
reported whenever the tool removes material. The tool removes material in the error color 
(similar to the behavior for turning spindle direction error). The check is done and the 
error reported only when the tool removes material. Motion that does not remove material 
does not report an error.  

The check is done for G-Code only. 

Min. Motion Dist. / Max. Motion Dist. — Enables you to specify a minimum and 
maximum value, defining the range of the Animation Speed slider. The animation speed 
is interpolated between these two values. 

Check Cutting Limits — Toggle On, to have VERICUT do the cutting limit checks 
during simulation. Cutting limit values are set in the OptiPath window, Settings tab.  

FastMill — Toggle "On" to process the toolpath in FastMill mode. You can also use the 

FastMill icon , in the Toolbar to turn on FastMill mode. 

 

NOTES:  
FastMill: 

• does "fixed axis" material removal in any tool orientation. 

• does not do "undercuts". FastMill automatically switches to standard material 
removal when required. 

• can be turned On/Off at any time.  

• can be used with/without tool animation. Toggle No Animation, described 
above, "On" for fastest processing. 

• is compatible with OptiPath, AUTO-DIFF, Model Export, as well as X-
Caliper and any other feature that uses the cut model database. 

FastMill is not effective when: 

• The tool axis changes frequently. 

• The cutter "undercuts", such as when using a dovetail or wheel cutter. 

• Cutter height is less than the cut depth resulting in an undercut condition.  

Ignore Undercuts — Works in conjunction with FastMill, described above. When 
toggled "On" (default), VERICUT does not check each motion for "undercut" conditions 
allowing for faster processing in those cases where you are sure that there are no 
"undercut" conditions in the toolpath. Toggle "Off" when you want VERICUT to check 
for "undercut" conditions as it processes each motion. 

NOTE:  This feature is only active when FastMill is toggled "On". 
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Tool group: 
Tool Display — Controls when and how the tool is displayed. Options are: Off (do not 
display the tool), Solid, or Translucent. Material removal is not affected by this choice. 

Min. Cutter Height — Default height used when the current tool description does not 
specify height, or when specified height is less than this value. Affects milling cutters 
only. 

Control Point — Controls how milling tools are driven. By default, VERICUT drives 
the tool tip. Material is removed based on tool path motion commands and the tool shape, 
relative to the control point. Options: 

Tool Tip — Point located at the bottom-center of the cutter. 

Corner Radius — Point located a distance equal to the cutter corner radius up from the 
tool tip. With ball nose endmills, this point is commonly referred to as the "ball center". 

 

 
 

NOTES:  
1. If Corner Radius is used with non-ball nosed endmills, the offset is calculated 

along the tool axis, from the tool tip to the center of the first arc encountered in 
the tool profile. 

2. To specify a milling tool control point other the tool tip of corner radius, define 
tools via the Tool Manager and specify a control point offset via the tool's 
Properties. 

3. This feature is not applicable to turning tools. Instead, define tools via the Tool 
Manager and specify a control point offset via tool Properties. 
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Display Holders in Workpiece View — When toggled "On", instructs VERICUT to 
display defined tool holders and detect collisions they may have. Holders are non-modal 
and are applied only to the active cutter. An error similar to "HOLDER removed 
material..." is reported when a tool holder removes material. Material removed is shaded 
using the red Error color. 

 

 
 

Calculate Min. Cutter Extension — When active, calculates the minimum height 
required to avoid shank/holder collisions. Minimum cutter extension calculations begin 
with the defined cutter height. If potential holder collisions are detected during the 
simulation, VERICUT extends the cutter to avoid the collision and adds this amount to 
the calculated height. Note that when these calculations are being performed, tool holder 
collisions are not reported since VERICUT extends the cutter to avoid the collision. If 
desired, you can include additional clearance in the calculation via specifying Holder 
Clearance (see below). The final calculated height for each tool is displayed in the Log 
file Tool Summary section under the "Min" column heading. 

Holder Clearance — Specifies clearance to add when calculating minimum cutter 
extension (see above). The clearance value is also included in the Log file minimum 
height values. 
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NOTE:  This feature is only active when Calculate Min. Cutter Extension is toggled 
"On". 

Back to Mold and Die 
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G-Code (G-Code Settings window) 
 
VERICUT Users: 
VERICUT Location: Project menu > Processing Options > G-Code > Settings 

VERICUT toolbar short cut:   

 

Mold and Die Users: 
Mold and Die Location:   Advanced Options page > Job Settings 

Notebook Feature:      

  

Cutter Grinder Users: 
Cutter Grinder Location:   Advanced Options page > Job Settings 

Notebook Feature:      

  

Opens a window to configure settings to support processing G-code NC program files. 
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Settings tab — Features on this tab provide important settings for G-code simulation, 
such as: the G-code programming method, when cutter compensation (CDC) codes are 
processed, tool path scanning, and tolerances used for simulating rotary motions. 

Tables tab — Features on this tab are used to specify work offsets and machine locations 
specific to the current tool path file(s) and to store tool-related offset and compensation 
register data. 

Subroutines tab — The features on this tab are used to specify names of external files 
containing subroutines that can be accessed by VERICUT. 

Block Skip tab — Features on this tab control which levels of block skipping are 
recognized, and specify the block skip character. 

Sync tab — The features on this tab enable you to select which Sync Sub-sytsem is to be 
used. This setting is only applicable if Sync Method on the Control Settings window, 
Sync tab is set to something other then None. This feature is intended as a debugging tool 
enabling you to easily select which sync program they want to run rather then running 
them together at the same time. 

WireEDM tab — Features on this tab configure VERICUT for wire EDM simulations. 

 

OK — Applies the changes and closes the G-Code Settings window. 

Apply — Applies the changes and leaves the G-Code Settings window open. 

Cancel — Closes the G-Code Settings window without applying changes. 
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G-Code Settings window, Settings tab 
VERICUT Location: Project menu > Processing Options > G-Code > Settings 

VERICUT toolbar short cut:  

 

Features on the Settings tab provide important settings for G-Code simulation, such as: 
the G-Code programming method, when cutter compensation (CDC) codes are processed, 
tool path scanning, and tolerances used for simulating rotary motions. 

 

 
 

Programming Method — Describes the relationship between cutting tools and what is 
being driven by tool path file motion commands. (Take care NOT to describe the 
relationship between cutting tools and the driven point controlled by a CAM system.) 
Options: 

Tool Tip — XYZ values represent tool tip positions (center of the tool tip) at all 
times. 

NOTE:  Tool length compensation codes (G43ZnHn/G49) do not appear in tool tip 
programmed tool paths. If these codes are present, use the Tool Length 
Compensation programming method. 

Gage Length — XYZ values represent gage point positions. The gage point is 
typically the spindle face, where the centerline of the tool intersects the machine gage 
line. Gage length values must be supplied using Gage Offset in Tool Manager, or 
via entries in a Gage Offset table. 
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Tool Length Compensation — With comp. active (e.g. G43ZnHn) XYZ values 
represent tool tip positions relative to program zero. With comp. cancelled XYZ 
values represent machine gage point positions relative to machine zero. Use an Input 
Program Zero table to describe where the part zero is. VERICUT automatically 
calculates "H" offset values, or enter values in a Tool Length Compensation table. 
For proper tool loading on a 3-D machine supply gage offset values as described 
above for Gage Length programming method. 

 

 
 

Process Cutter Comp. — When active, applies cutter compensation, or "CDC" offsets 
to the programmed tool path. Enter CDC offset values in a Cutter compensation table, 
as described under "Cutter compensation table" in the Reference chapter. Clear this 
checkbox to ignore CDC-related codes in the tool path file. Output Precision specifies the 
accuracy for calculating CDC offset tool positions.  

NOTE:  Tool paths can not be optimized when CDC offsets are being simulated. 

 

Scan NC Program Files — When active, performs a "scan pass" on NC program files to 
identify jump destinations for looping-branching logic. Tool paths with this type of logic 
must be scanned for proper simulation in VERICUT. 

Ignore Data after Column — Specifies the G-Code data column number to begin 
ignoring remaining data in the block. Use this feature when unmarked comments are 
permitted in designated columns of the G-Code data. Enter the number of the last valid 
G-Code data column in the field next to this feature. 

Apply Acceleration to Cycle Time — When toggled "On", uses the Accel/Decel 
parameter, as set in the OptiPath Manager window, when calculating the cycle Time 
displayed in the Status window. 

Initialize Machine/Control between NC Programs — Enables you to specify whether 
or not to reset the control's states, variables, etc. between NC program files during 
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processing. When toggled "On" (the default), VERICUT resets these values between NC 
program files. This condition is consistent with prior releases. Toggle "Off " to retain 
these values between NC program files.    

Rotary Feed Motion Tol — Tolerance used to calculate intermediate tool positions 
resulting from processing rotary motion when Output Intermediate Points is active (ref. 
Configuration menu >  Settings (Control) : Rotary tab). Decreasing this value 
increases the quantity of intermediate points calculated, and decreases simulation speed. 

Rotary Rapid Motion Tol — Similar to Rotary Feed Motion Tol, except applies to 
rapid rotary motions. 
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G-Code Settings window, Tables tab 
 VERICUT Location: Project menu > Processing Options > G-Code > Settings 

 VERICUT toolbar short cut:  

  

Features on the Tables tab are used to specify "Job Tables" to store work offsets and 
machine locations specific to the current tool path file(s) and "Tool Tables" to store tool-
related offset and compensation data. 

NOTE:  The values set in a "Job Table" are used to override "standard" values that 
were set in a Machine Table for the current NC program file(s). 

  

 
  

Tables list — A list of tables that are currently defined. The Machine Settings tables list 
will contain only "machine" tables. The G-Code Settings tables list will contain both 
"job" tables and "tool" tables. 

Add/Modify — Use to access the Add/Modify Tables window enabling you to add 
additional tables or modify existing tables. To Add a table, simply click on Add/Modify. 
To modify an existing table, select the table to be modified from the Tables list and click 
on Add/Modify. (You can also "double-click" on the table in the Tables list.) 

Delete — Deletes the selected table entry from the Tables list. If it is the last entry for a 
particular table, then the table is also deleted. 

  

Job Table and Tool Table values are stored in the Project file. 
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The following Job Tables can be added or modified with the G-Code Settings window, 
Tables tab: 

 

Base Work Offset 
Initial Machine Location 
Machine Zero             (obsolete, formerly Input Machine Zero) 
Machine Reference Location 
Tool Change Location 
Tool Change Retraction 
Turret Rotations 
Work Offsets 
Program Zero 
Input Program Zero (Special Z )              (formerly Input Program Zero) 
RTCP Pivot Offset 
RPCP Pivot Offset 

  

The following Tool Tables can be added or modified with the G-Code Settings window, 
Tables tab: 

Cutter Compensation 
Gage Offset 
Probe Offset 
Tool Length Compensation 
Tool Nose Compensation 
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Add/Modify Tables window 
  

The following discussion applies to both the Add/Modify Machine Table window, 
accessed from the Machine Settings window: Tables tab and to the Add/Modify G-
Code Table window, accessed from the G-Code Settings window: Tables tab. 

  

 
  

Table Name — Use to identify the table to be added, or modified, if it already exists. 
The Table Name list in the Add/Modify Machine Table window will only contain 
"machine" tables. The Table Name list in the Add/Modify G-Code Table window will 
contain both "job" tables and "tool" tables. 

SubSystem ID — Use to specify ID of the machine subsystem for which the table is 
being defined. 

Register — The Register number that will be used by VERICUT to access corresponding 
table data. For "tool" tables, this number typically corresponds to a tool or offset register 
number. For "job" and "machine" tables, the Register number may correspond to an 
offset register number, or an integer value, as required by a particular table. 

SubRegister — Use of this feature enables you to access multiple sub-values for the 
same tool from tool related tables. For example, groove tools often have multiple 
"driven" points, which then correspond to multiple gage offsets, and possibly multiple 
Cutter Comp values, Tool Nose Comp values, and Tool Length Comp values. 
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SubRegister is only active when the selected "Table Name" identifies a "tool" related 
table. 

Select From/To and Enter Values: 

These features are only active for the following tables: 

Input Program Zero 
Input Machine Zero 
Base Work Offset 
Work Offsets 
RTCP Pivot Offset 
RPCP Pivot Offset 

For the above tables, VERICUT provides two ways to enter table values.  

 

Select From/To/Offset — Enables you to specify table values based on a "relational" 
offset between a "from" point and a "to" point. The "from" and "to" points are designated 
by specifying a particular component or CSYS. VERICUT will use the origin of the 
component/CSYS as the point. You can also specify an offset from the specified 
component/CSYS origin point. Once this relationship has been established, you can 
change the machine configuration or the location of the CSYS origin and the table values 
will updated automatically during the initial Single Step or during Play to End. 

For example:  After Input Program Zero has been defined to be the offset from the Tool 
Component to the "Program Zero" CSYS, you can change the machine configuration, or 
change the location of  "Program Zero" CSYS, and the Input Program Zero offset values 
will be updated automatically during the initial Single Step or during Play to End. 

NOTE:  The offsets are calculated based on where the corresponding origin points are 
located when all linear axes are driven to machine zero (zero with no offsets in place). 

 

When Select From/To is toggled "on", the From/To Feature/Name lists and the Offset 
text fields become activated. Use the From/To Feature lists to specify whether the point 
is associated with a Component or a CSYS (coordinate system). Use the From/To 
Name lists to specify a specific component or coordinate system. 

NOTE:  Only the coordinate systems that have been defined with reference to a machine 
component (i.e., visible in a Machine or Machine/Cut Stock view when Coordinate 
System axis is toggled "on") will appear in the CSYS/Names lists. See the discussion for 
Project menu > Coordinate Systems for more information on VERICUT Coordinate 
Systems. 

 

Use the Offset text fields to enter 3 values, separated by spaces, representing the X, Y, 
and Z offset from the specified origin point. You can also click on the "select" button 

, then  pick a point in the graphics display area. You can pick the point in either a 
workpiece or machine view. VERICUT will calculate the Offset value between the 
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selected point and the designated Feature/Name origin point. Offset is only active when 
Feature is set to Component. 

Calculate when Used — When toggled "On", VERICUT will calculate the table values, 
based on the current positions of the rotary axes, at the time that the table values are used. 

The following general guidelines should be followed regarding the use of "relational" 
offsets. 

1. If the offsets are based on the original rotary axes orientations, or if the offsets are 
independent of the rotary axes orientations, Calculate when Used need not be 
toggled "On". 

2. If the offset is dependent on a specific rotary orientation, and you are sure that the 
rotary axes will be re-positioned before the "relational" offset is applied, 
Calculate when Used should be toggled "On" so that the correct offset is 
calculated based on the current rotary axes positions. 

NOTE:  If the offset is associated with a specific rotary orientation, and you are NOT 
sure that the rotary axes will be re-positioned before the "relational" offset is applied, 
then the offset must be specified in a manner which is independent of the rotary 
orientation. For example: If the offset "TO" value is a certain point on the stock when the 
stock is rotated to A90, you can MDI an A90, have the offset based on the A component, 
and then click on the corresponding point of the stock. This now defines the offset in a 
manner which is independent of the rotation on A. 

 

Enter Offset (or select 2 points) — When toggled "On", the Values 
(XYZABCUVWABC) text field is activated enabling you to enter one to twelve numeric 
values as required by the specific table. Multiple value entries require spaces between the 
values.  

You can also click on the "select" button , then  pick two points in the graphics 
display area. You can pick the points in either a workpiece or machine view. VERICUT 
will calculate the Offset value between the selected points. 

For all other tables, Select From/To and Enter Offset (or select 2 points) are both 
inactive. Enter the values in the Values (XYZABCUVWABC) text field as described for 
Enter Offset (or select 2 points) above. 
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In the sample window shown above, the current table is the Work Offsets table. The 
current table entry is register "54", and contains the values "-14.95 -8 -17.27". The table 
is applicable to subsystem "1" of the machine. 
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G-Code Settings window, Subroutines tab 
VERICUT Location: Project menu > Processing Options > G-Code > Settings 

VERICUT toolbar short cut:  

 

The features on the Subroutines tab are used to specify names of external files containing 
subroutines that can be accessed by VERICUT.  (See how) 

 

 
 

File Names list — List of external files containing subs accessible to VERICUT. 

 

Tip: Right-click in the File Names list area to display a pop-up window with the 
following features: 

Add — Opens the Job Subroutine Files selection box enabling you to add external 
subroutine files to the File Names list. 

Replace — Opens the Job Subroutine Files selection box enabling you to replace the 
highlighted subroutine file in the File Names list with another. 

Delete — Deletes the highlighted subroutine file from the File Names list. 

Edit — Displays the of the highlighted subroutine file in a text editing window. 
Standard text editing features are provided, such as: copy/cut, paste, search, etc. For 
more information on using the editing features see Edit menu > Text File. 
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Add — Opens the Job Subroutine Files selection box enabling you to add external 
subroutine files to the File Names list. (Same as Add in the pop-up window described 
above) 

Replace — Opens the Job Subroutine Files selection box enabling you to replace the 
highlighted subroutine file in the File Names list with another. (Same as Replace in the 
pop-up window described above) 

Delete — Deletes the highlighted subroutine file from the File Names list. (Same as 
Delete in the pop-up window described above) 

Delete All — Deletes all subroutines files from the File Names list. 
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G-Code Settings window, Block Skip tab 
VERICUT Location: Project menu > Processing Options > G-Code > Settings 

VERICUT toolbar short cut:  

 

Features on the Block Skip tab control which levels of block skipping are recognized, and 
specify the block skip character. (See how) 

 

 
 

Block Skip Character — Character which causes the block to be skipped. This character 
must be the first character in the data block for skipping to occur. 

Apply Switch Value — Controls when block skip switch values are referenced by 
VERICUT. 

Options: 
Immediate — Reference switch settings when VERICUT is reset, upon loading a 
new Project file, and any time tool path processing is started. 

On Reset — Reference switch settings only when VERICUT is reset, or upon 
loading a new Project file. 

 

Switch 1-9 — When active, processing is skipped for blocks beginning with the 
designated block skip switch. For example, "Switch 2" corresponds to blocks beginning 
with "2/", "Switch 3" corresponds to blocks with "3/", and so on. 
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G-Code Settings window, Sync tab 
 VERICUT Location: Project menu > Processing Options > G-Code > Settings 

 VERICUT toolbar short cut:  

  

The features on this tab enable you to select which Sync Sub-system is to be used. This 
setting is only applicable if Sync Method on the Control Settings window, Sync tab is 
set to something other then None. This feature is intended as a debugging tool enabling 
you to easily select which sync program you want to run rather then running them all at 
the same time. 
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G-Code Settings window, WireEDM tab 
VERICUT Location: Project menu > Processing Options > G-Code > Settings 

VERICUT toolbar short cut:      

 

Features on the WireEDM tab configure VERICUT for wire EDM simulations. (See 
how) 

 

 
 

Wire Diameter — Specifies the effective cutting diameter of the wire. 

Work Table to XY Plane — Distance from the top of the work table (machine Z zero) 
to the XY reference plane, as measured along the machine Z-axis. This value is usually 
zero, but can be a positive or negative value. The XY reference plane is the Z-axis height 
at which the tool path file X and Y values are driven. 

XY Plane to UV Plane — Distance from the XY reference plane to the UV reference 
plane, as measured along the machine Z-axis. This value must be a positive value. This 
setting is only used when the tool path file contains U and V-axis values to control the 
wire angle. The UV reference plane is the Z-axis height at which the tool path file U and 
V values are driven. 
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G-Code (Variables window) 
Location: Project menu > Processing Options > G-Code > Variables 

 

Features on the Variables window, are used to initialize, maintain, and monitor G-code 
variables. Variables are assumed to have zero for a default value. However, you can 
initialize variables with any numeric or text value. (See how) When this window is open 
during processing, it gives immediate feedback when variables are set or changed by the 
tool path file. Variables are saved to the .usr file if an initial value or a description is 
entered, or if the variable is included in the Tracking Variables list. 

 

 
 

Tracking Variables: 
The Tracking Variables portion of the Variables window enables you to easily track 
variables of special interest without having to scroll through all variables in the Variables 
List (see how). The following information is displayed for all variables selected for 
tracking: 

Name — Name of the variable being tracked. 

SubSystem — Indicates the subsystem (if any) that the variable being tracked is 
associated with.  
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NOTE:  SubSystem in this case pertains to the subsystems defined in the Variables 
window variable tree, NOT the subsystems defined by the machine. 

 

Subroutine — Subroutine (if any) that the variable being tracked is associated with. 

Description — Description of the variable being tracked. 

Type — Type of variable (Number, Text or Array) 

Current Value — The current value of the variable. 

Initial Value — The initial value of the variable. 

 — Use to add the highlighted variable in the Variables List to the Tracking Variables 
list. 

 — Use to remove the highlighted variable from the Tracking Variables list. 

  

Variables List: 
The Variables List, located in the lower portion of the Variables window, displays all 
variables initialized and encountered during tool path processing. 

Name — The Name column displays a tree structure showing a list of all variables, and 
how each variable relates to the overall structure of the NC program (subsystem, 
toolpath, subroutines, etc.). Tree is constantly updated as the toolpath is processed. 

Description — Description of the variable. This field enables you to enter a description 
for the NC Variable. This feature allows you  to document variables for later use, as well 
as simplifying the tracking of states. Instead of just seeing  4001, a more meaningful 
"Motion Type"description can be added. Descriptions that end with an " * "  has been 
automatically generated by VERICUT.  Automatically generated descriptions can result 
from any of the following: 

Setting a variable on the Events window. 

Setting a variable on the Word/Address window. 

Calling one of the Autoset… macros. 

Calling the SetDynamicVars macro. 

Type — Type of variable (Number, Text or Array); also indicates the type of data that 
can be assigned to the variable.  

Current Value — The current value of the variable. 

Initial Value — The initial value of the variable. 

NOTE:  It is possible to create a variable with no defined values. This is done by adding 
a variable with either a description, or by adding the variable to the tracking variable list. 
This is significant because VERICUT treats variables differently depending on whether 
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the variable exists (defined within VERICUT) versus whether the variable has an 
undefined value. 

If you try to access a non-existing variable (a variable that does not show up in variables 
window), VERICUT outputs an error message saying; "un-initialized variable, defaulting 
to zero". 

When you call a G65 subroutine, variables 1-33 get initialized to "undefined" or "vacant" 
except those, which are set on the call to the subroutine. If you try to access an 
"undefined" variable, then VERICUT does not output an error message, or default to 
zero. 

See "Notes about un-initialized variables" in the Using VERICUT section for additional 
information. Using VERICUT can be found in the VERICUT Help Library. 

 

Add — Opens the Variable Add window enabling you specify the characteristics of a 
new variable and add it to the variable list. 

Delete — Deletes the highlighted variable from the variable list. 

Delete All — Deletes all variables in the variable list. 

Close — Close the Variables window. 
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Add Variable window 
 

Accessed by selecting Add in the Variables window, the features in this window enable 
you to specify the characteristics of a new variable and add it to the variable list. 

  

 
 

Name — Name of the variable. 

SubSystem — Use this feature to specify the subsystem that the variable is associated 
with. 

 NOTE:  SubSystem in this case pertains to the subsystems defined in the Variables 
window variable tree, NOT the subsystems defined by the machine. 

 Description — Use this field to add descriptive information about the variable  

Type — Select the Type of variable from the pull-down list; also indicates the type of 
data that can be assigned to the variable.  

Options: 

Number — the variable is real number. For example, value ="0010" => the numeric 
value "10" is used. 

Text — the variable is a text string. For example, value ="0010" => the text string 
"0010" is used. 

Array — The variable is an array. When Array is selected as the variable type, an 
Array Dimension field and an array table are added to the Add Variable window. 

Array Dimension — Use to specify the dimensions of the array that the variable 
represents, for example "3, 4", for a 3x4 array. 

Array Table — Use the array table to initialize specific array values if desired. 
VERICUT automatically adjusts the size if the array based on the dimension set 
with Array Dimension and all values are defaulted to 0.  
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NOTES ON USING ARRAY VARIABLES: 
1. Non-numeric variables must be defined in the Words window to enable proper 

parsing. 

2. In the Variables window, Type must be set to Array, and Array Dimension 
must also be defined. 

3. In the MCD file, the syntax must be of the form:  name[2,1]=5  where the square 
brackets are left and right precedence, and indexes are separated by a commas. 
Each index can also be defined as an expression. For example: name[#7+1,1]=3. 

4. Array variables are also supported in the Word Address window as a variable to 
be set. Non-numeric variables can not be used with override values. 

  

OK — Adds the variable to the Variables List in the G-Code Variable window and 
dismisses the Add Variable window. 

Apply — Adds the variable to the Variables List in the G-Code Variable window and 
leaves the Add Variable window open enabling you to specify additional variables. 

Cancel — Dismisses the Add Variable window without adding the variable to the 
Variables List in the G-Code Variable window. 
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G-Code (Process Options window) 
Location:  Project menu > Processing Options > G-Code > Process Options 

  

Opens a window enabling you to configure the settings required to support processing of 
G-code NC program files. 

  

 
  

G-Code Output Files tab — Features on this tab provide important settings for G-code 
simulation, such as: the G-code programming method, when cutter compensation (CDC) 
codes are processed, tool path scanning, and tolerances used for simulating rotary 
motions. 

Messages tab — Features on this tab are used to specify work offsets and machine 
locations specific to the current tool path file(s). 

Debug tab — Features on this tab are used to store tool-related offset and compensation 
register data. 

User Defined (CTRL) tab — Features on this tab are used to initialize, maintain, and 
monitor variables referenced by, but not set by the tool path file. 
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OK — Applies the changes and closes the Process Options window. 

Apply — Applies the changes and leaves the Process Options window open. 

Cancel — Closes the Process Options window without applying changes. 
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Process Options window, G-Code Output Files tab 
Location:  Project menu > Processing Options > G-Code > Process Options 

  

Opens a window to control conversion, or "reverse post-processing" of G-Code tool 
paths, and specify the names of files resulting from this process. (See how) 

  

 
  

APT Output File — Name of the file to receive ASCII APT tool path records resulting 
when Create APT Output File is active (see below). If blank, the file is not created. 

G-Code Log File — Name of the G-Code Log file to receive error, warning and 
informational messages about G-Code processing. If blank, the file is not created. 

Create APT Output File — When active, converts the G-Code NC Program data into 
ASCII APT NC Program records. Converted data is stored in the specified APT Output 
file (see above). 

View APT Output File — Opens a window containing the APT Output file with ASCII 
APT tool path records created when Create APT Output File is active (see above). 

For information about APT NC Program records and formats, see "Supported APT-CLS 
records".  

View G-Code Log File — Opens a window containing the G-Code Log file. This file 
contains information, such as error, warning and informational messages about G-Code 
processing. In this window, you can view, edit, or reset the G-Code Log file contents. 
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Process Options window, Messages tab 
Location:  Project menu > Processing Options > G-Code > Process Options 

  

Opens a window to set the destination and format of messages output during a 
simulation. (See how)  

  

 
  

Send Error Messages — Destination of messages about errors-potentially severe 
problems that will most likely produce incorrect results on the machine tool. 

Send Warning Messages — Destination of messages about possible problems. 
Scrutinize warnings to decide if they will actually impact the machining process. 

Send Info Messages — Destination of messages providing information about files used, 
the time and date that the process started, etc. 

Send Debug Messages — Destination of debug messages providing additional 
information related to internal calculations, conditions, and variable values. The types of 
debug messages which appear are controlled via Process Options window: Debug tab. 

Send Control Setting Messages — Destination of messages showing the control settings 
in effect when the tool path file was processed. 

Send Input Messages — Destination of messages showing the input tool path file 
records processed. 

563563



VERICUT HELP – Project menu 
 

Send Output Messages — Destination of messages showing the converted tool path 
records resulting from reverse-postprocessing. When Create APT Output File is active 
on the Process Options window: G-Code Output Files tab, output messages are sent to 
the APT Output File specified on the same window. By default, these records are in 
ASCII APT format. However, using the Machine Developer's Kit, other output file 
formats are obtainable. 

Output Filenames Format — Controls how names of files used by VERICUT are 
shown. 

Options:  

Filename Only 
Full Path Names — includes full directory path). 

Output Block Sequence Numbers — Controls when block sequence numbers are 
included with APT output records resulting from conversion. The sequence numbers 
appear in columns 73-80, and are useful for general reference or debugging purposes. 
Options: 

Yes — output block sequence numbers 

No — don't output block sequence numbers 

Output "Word is not defined" Errors — When set to Yes, outputs the "Word is not 
defined" error message when G-code words are encountered that the control is not set up 
to process. To prevent these errors from appearing, ensure this feature is set to No. 

  

Messages can be sent to the destinations listed below: 

• to  APT Output 

• to G-Code Log (not available for Send Output Messages) 

• to Logger  (not available for Send Output Messages) 

• to APT Output and G-Code Log 

• to APT Output and Logger 

• to G-Code Log and Logger (not available for Send Output Messages) 

• to APT Output, G-Code Log and Logger 

• to Nowhere (not available for Send Error Messages, Send Warning Messages or 
Send Output Messages) 

 NOTE:  Not all destination choices are available for all message types. 
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Process Options window, Debug tab 
Location:  Project menu > Processing Options > G-Code > Process Options 

  

Opens a window enabling you to select what debug messages to send to output. (See 
how) Debug messages can provide additional information that may be helpful debugging 
development of files used to simulate G-code NC programs and simulate machine tool 
motions. Set each Debug Message to either Yes (send to output) or No (don't send to 
output). The output destination for debug messages is controlled by "Send Debug 
Messages" on the Process Options window: Messages tab. 

  

 
  

Debug Offsets — When selected, outputs debug messages about offset value changes, 
including: coordinate system offsets/shifts, compensation values in use, etc. 

Debug Delta Information — When selected, outputs debug messages about rotating the 
tool position. 

Debug Rate Calculations — When selected, outputs debug messages about rate 
calculations related to tool movement. 

Debug Loop Logic — When selected, outputs debug messages about values calculated 
by looping or branching logic. 

Debug Macro Arguments — When selected, outputs the macro name, the word, the text 
string value, and the numeric value for the macro being called. 
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Debug Intersect Points — When selected, outputs debug messages related to intersect 
points calculated by CDC calculations. 

Debug Cutter Compensation — When selected, outputs debug messages about CDC 
tool offset positions. 

Debug Cycle Values — When selected, outputs debug messages related to processing 
canned tool axis cycles. 

Debug Substitution — When to selected, outputs debug messages related to string 
substitutions (ref. Configuration menu > Adv. Options: Substitute tab). 

Debug Variables — When selected, outputs debug messages about changes to variable 
values. See also: Project menu > Processing Options > G-Code > Variables window. 

Debug Turning — When selected, outputs debug messages associated with turning, for 
example the distance from the turning axis to the tool control point and calculations 
related to the use of constant surface speed. 

Debug Wire EDM — When selected, outputs debug messages associated with wire 
EDM machining. 

Debug Optipath — When this is turned on, a descriptive message will be printed 
whenever machine simulation determines a block is non-optimizable. 
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Process Options window, User Defined tab 
Location:  Project menu > Processing Options > G-Code > Process Options 

  

Opens a window to configure user defined control settings supplied via a custom CME 
file. This window will appear differently, depending on the CME file in use. CME files 
are created using the Machine Developer's Kit, and specified for use in VERICUT via 
Dev Kit CME tab of the Advanced Control Options window. 

  

 
  

NOTE:  Developer's Kit-defined settings can also appear on the User Defined (CTRL) 
tab of the Control Settings window, as determined by the developer. 
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APT Settings window 
Location:  Project menu > Process Options > APT Settings 

VERICUT toolbar short cut:  

 

Opens a window to configure settings to support processing APT-CLS tool path files. 

 

 
 

Motion tab — Features on this tab provide important settings for APT-CLS tool path 
simulation, such as: how circle and rapid motions are simulated, default tool path units, 
and more. 

Rotary tab — Features on this tab provide control over rotary motions simulated for 
APT-CLS tool paths. 

Turning tab — Features on this tab provide control over lathe turning motions simulated 
for APT-CLS tool paths. 

Cycles tab — Features on this tab enable you to change how VERICUT simulates APT 
or CLS tool path canned cycles, also known as "fixed tool axis cycles". 
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OK — Saves the settings and closes the APT Settings window. 

CANCEL — Closes the APT Settings window without saving setting changes. 
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APT Settings window, Motion tab 
Location:  Project menu > Process Options > APT Settings 

VERICUT toolbar short cut:  

 

Features on this tab provide important settings for APT-CLS tool path simulation, such 
as: how circle and rapid motions are simulated, default tool path units, and more. 

 

 
 

Default Toolpath Units — Default unit measurement system for tool path files that do 
not contain a "UNITS" record. If the tool path file units differ from the session units, 
values in the tool path are converted appropriately while being processed. 

MULTAX — When selected, interprets six parameter GOTO records as 
GOTO/x,y,z,i,j,k where i,j,k is tool axis orientation (superseded by MULTAX/OFF). 
Clearing this checkbox interprets these records as GOTO/x1,y1,z1,x2,y2,z2 - two point 
locations (superseded by MULTAX/ON). 

Max Tool Axis Angle — Maximum angle (in degrees) along a multi-axis motion to 
display intermediate tool positions. A value of "0" (default) does not display intermediate 
positions on multi-axis motions. The cut model is unaffected by this feature. 
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Tool Axis Reset Angle — Minimum angle (in degrees) which is considered a positioning 
move. Multi-axis motions having angles equal to or greater than the reset angle do not 
remove material. Instead, the tool display is turned off through the multi-axis motion, 
then turned on after the multi-axis destination is reached. Cutting resumes at the new tool 
position. 

Process Circles — When selected, processes CIRCLE records to simulate the arc 
motion. Clear this checkbox to ignore "CIRCLE" records, such as necessary when 
CIRCLE records are accompanied by their representative chordal GOTO points.  

NOTE: Simulating circle motions increases performance dramatically over processing 
chordal GOTO points. 

Reverse Circles — When selected, reverses CIRCLE record motions. Clear this 
checkbox to simulate circle motions in the direction programmed. (Circle IJK values 
determine circle direction.) 

Detect Chordal GOTOs — When this option and Process Circles are selected, the 
chordal GOTO points which follow CIRCLE records motions are processed to simulate 
an arc, or circle motion. Clear this checkbox to process the GOTOs as linear tool 
positions. 

Reset Tool Change — When selected, resets the tool display following a tool change. 
This action turns off the tool display until after the tool is changed and the following 
motion is processed. The new tool appears at the end of the motion following the tool 
change. This option is recommended when simulating tool paths for NC machines that 
automatically retract the tool during a tool change. Clear this checkbox to have 
VERICUT change the tool at its current location when a tool change command is 
encountered. 

Process Unigraphics or CATIA Matrix — When selected, processes these tool path 
matrix records to transform the tool path to its base coordinate system: CATIA0 or 
 MSYS. Clear this checkbox to ignore tool path matrix records. This feature is useful to 
automatically orient tool paths to models imported from the same CAD/CAM system. 

Ignore unrecognized Major words — When toggled on, VERICUT ignores 
unrecognized APT major words and no warning messages are output to the VERICUT 
main window message area, or in the Log file. 

Default CLEARP — Distance to retract along the tool axis when a RETRCT record is 
encountered prior to establishing the retract plane. The default CLEARP condition is 
"off" until a CLEARP record defining a clearance plane is encountered. 

RAPID Motion — Controls how to simulate rapid positioning motions. Options: 

Linear — Move in a straight line. 

Square — Move with "squared off" motion, where Z motions are processed 
independently from X and Y. 
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GOHOME Motion — Controls how the tool is returned to the home position when a 
GOHOME record is processed. Options: 

FROM — Move in a straight line to the home position. 

Retract — Move with squared off motion, where the tool is first retracted the distance 
specified by the GOHOME R Dist value, then moved to the home position. 

GOHOME R Dist — When simulating GOHOME record motions via the "Retract" 
option (see above), this value specifies the distance to retract before going to the home 
position. 
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APT Settings window, Rotary tab 
Location:  Project menu > Process Options > APT Settings 

VERICUT toolbar short cut:  

 

Features on this tab provide control over rotary motions simulated for APT-CLS tool 
paths. Note that while machines often rotate the workpiece, in a VERICUT Workpiece 
view the workpiece is fixed and the tool is seen rotating about the workpiece. Both rotary 
cut paths are identical. 
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"ROTATE/BAXIS,ATANGL,90" as seen on a machine with a "B" rotary table, and 
simulated by VERICUT in a Workpiece view: 

 
 

ROTATE, ROTABL, ROTHED — These features control when and how to simulate 
motion caused by the corresponding ROTATE, ROTABL, or ROTHED records, 
respectively. "BAXIS" is the default rotation axis when not specified. The rotary pivot 
point is defined by the Rotation Center. When absolute or incremental rotation is not 
specified, the Angle Value determines how to apply the rotary value. 

Options: 
Ignore — Ignores the rotary command. (Default) 

Rotate — Rotates while cutting. Tool path motions that follow are expected to have 
the rotation applied. 

Rotate/Apply — Similar to Rotate, except also applies the rotated coordinate system 
to subsequent tool path motions. Tool path motions that follow are NOT expected to 
have the rotation applied. 

Position — Rotates without cutting, also known as "positioning". The tool disappears 
from its initial position, then appears at the rotated position. Tool path motions that 
follow are expected to have the rotation applied. 

Position/Apply — Similar to Position, except also applies the rotated coordinate 
system to subsequent tool path motions. Tool path motions that follow are NOT 
expected to have the rotation applied. 

Rotation Center — Center of rotation for rotary motions simulated via the ROTATE, 
ROTABL, or ROTHED features (see above). 

Philosophy — Describes what is being commanded to rotate for rotary motions 
simulated via the ROTATE, ROTABL, or ROTHED features (see above): Table 
(default), or Tool. Changing the rotation philosophy has the affect of reversing rotation 
direction. Note that ROTHED angle values are always assumed to use a rotating Table 
philosophy. 
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Angle Value — Controls how angle values are applied for rotary motions simulated via 
the ROTATE, ROTABL, or ROTHED features (see above) when the commands do not 
specify "ATANGL" or "INCR". 

Options: 
Relative — Incremental angle values. 

Absolute — Absolute angle locations. (Default) 

Note that ROTHED angle values are always assumed to be Absolute. 

Direction — Direction of rotation for simulating for rotary motions simulated via the 
ROTATE, ROTABL, or ROTHED features (see above). 

Options: 
Shortest — Direction which travels the shortest distance. (Default) 

CW — Always clockwise. 

CCW — Always counterclockwise. 

Linear — Refers to angles on a linear axis "wrapped" around the rotary component. 
Rotary values specify absolute locations along the linear-rotary axis, while the sign (+ 
/ -) controls which end of the linear axis is used. 

Detect 4-Axis Rotary Motion — When selected, simulates an arc cut for multi-axis 
motions that fit within an arc path. Clear this checkbox to simulate each multi-axis 
motion independently- recommended when simulating 5-axis contouring-type motions. 
The Interpolation Tolerance value is used to determine which motions are simulated in 
the 4-axis cut. 
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APT Settings window, Turning tab 
Location:  Project menu > Process Options > APT Settings 

VERICUT toolbar short cut:  

 

Features on this tab provide control over lathe turning motions simulated for APT-CLS 
tool paths. 

 

 
 

GOTO Format — Specifies how turning GOTO record values are to be displayed in a 
Workpiece view. In this view, VERICUT simulates turning motion in the ZX plane, 
where Z is the spindle-axis, and X is the cross-slide-axis. This feature acts like a post-
processor for turning tool position data. 

Example 1- Assume you have a turning tool path programmed in GOTO/x,y format. By 
default, GOTO Format "#zval, #xval" displays the first GOTO value as Z-axis motion, 
and the second value as X-axis motion. 

Example 2- Assume you have a turning tool path that was reversed post-processed from 
G-code data such that GOTO records are in GOTO/x,0,z format (center value is "zero"). 
For VERICUT to process this correctly, set GOTO Format= #xval, #yval, #zval. 
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APT Settings window, Cycles tab 
Location:  Project menu > Process Options > APT Settings 

VERICUT toolbar short cut:  

 

Features on this tab enable you to change how VERICUT simulates the APT or CLS 
CYCLE records to simulate tool path canned cycles, also known as "fixed tool axis 
cycles". The Drill Cycle feature controls when and how these records are simulated. 

 

 
 

Cycle Set — Controls which cycle definition set(s) are considered by VERICUT when 
processing APT tool paths. If you add a new cycle set, for a different flavor of APT or a 
different post-processor, you can give it any name you wish and it will appear in this list. 
"ALL" considers all cycle sets defined for use. 

Cycle Definitions — Opens a window to maintain cycle and modals definitions used to 
interpret "CYCLE" records. This feature is especially useful if simulated cycle motions 
are not displayed as expected. When VERICUT can not find definitions to interpret a 
CYCLE record, an error similar to "Invalid CYCLE record" error is issued. In these 
cases, cycle definitions must be modified to interpret the cycle data. 
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 For more information about configuring VERICUT to interpret cycle commands, see 
"About configuring for cycle simulation" in the Using VERICUT section. Using 
VERICUT can be found in the VERICUT Help Library. 
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Supported APT-CLS tool path records 
APT tool path records typically contain a major vocabulary word followed by a slash 
("/"), then a combination of data and/or minor vocabulary words. APT records can be 
preceded by leading spaces or tabs. Spaces can appear anywhere in the record. APT 
record data typically ends prior to column 72. However, a "$" at the end of a record 
continues onto the following line. 

The APT tool path records processed by VERICUT are listed below in alphabetical order. 
See the appropriate section for details. Records not listed are typically ignored by 
VERICUT. 

  
ARC record 
Causes circular motion. The format of this record is similar to CIRCLE record, except 
specifies the arc end point via an additional set of X, Y, Z values. 

 
CATIA0 record 
Specifies a CATIA-style twelve parameter tool path transformation matrix. VERICUT 
processes this record when Process Matrix, on the APT Settings window: Motion tab, 
is active. 

Example: 
$$*CATIA0  

$$*AXS2 

$$ .00000 .00000 1.00000 -6.59040  

$$ .99360 .11299 .00000 -16.50458  

$$ -.11299 .99360 .00000 -3.32025  

 
CHGTOOL record 
Specifies the tool number to be changed into the spindle, same as LOADTL record. This 
record is not processed by default, however, you can use Tool Change By, in the NC 
Program window, to process this record and retrieve cutting tool descriptions from a 
VERICUT tool library. 

Format: 
CHGTOOL/n[,anytext] 

 
CIRCLE record 
Causes circular motion. The GOTO point preceding the CIRCLE record defines the start 
of the circular motion. The GOTO following the CIRCLE defines the circular motion 
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end. Helical motion is generated when the end point measured along the tool axis differs 
from the start point. This record is processed when Process Circles, on the APT Settings 
window: Motion tab, is active. 

Formats: 
CIRCLE/x,y,z,i,j,k,r[,n,n,n,n] - where "x,y,z" defines the circle center point, "i,j,k" is 
the axis orientation. "r" is the circle radius, but is not used since the radius is 
computed from the start, end and center points. The vector defines the positive Z-axis 
of counter-clockwise motion following the right-hand rule. In the 11 parameter 
format, VERICUT only uses the first 7 parameters. 

Examples: 
CIRCLE/1,2,3,0,0,1,5 - CCW circle motion about point 1,2,3, radius of 5 

CIRCLE/1,2,3,0,0,-1,5 - as above, except CW arc motion 

 
CLEARP record 
Defines a clearance plane used by subsequent RETRCT records. See also: Default 
CLEARP on the APT Settings window: Motion tab. 

Formats: 
CLEARP/OFF 

CLEARP/value 

CLEARP/XYPLAN(YZPLAN or ZXPLAN),value - establish a clearance plane 
parallel to the part coordinate XY, YZ, or ZX plane, respectively at "value" distance 
from the part coordinate system origin. Only one plane may be active at one time. If 
no plane option is specified, XYPLAN is assumed. 

CLEARP/PERPTO,value - establishes a clearance plane perpendicular to the tool axis 
at "value" distance from the part coordinate system origin. Clearance plane distance is 
measured in the direction of the tool axis. Changing the tool axis vector changes the 
clearance plane. 

 

CLRPLN record 
Defines a clearance plane, same as CLEARP record. 

 

CLRSRF record 
Defines a clearance plane, same as CLEARP record. 
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CNTRL record 
Defines a control point for use with a NURBS record. 

Formats: 
CNTRL/x,y,z[,i,j,k][,WEIGHT,w] - where "x,y,x" are the control points (or poles) for 
tool postiion, optional "i,j,k" values control the tool axis, and optional "w" specifies 
the weights. 

 

CONT record 
GOTO continuation record, similar to GOTO record. 

Formats: 
CONT/x,y,z 

x,y,z 

: 

CONT/x,y,z,i,j,k 

x,y,z,i,j,k 

: 

 

COOLNT record 
Controls coolant usage. Text following the slash is displayed in the Status window as the 
current coolant condition. 

Formats: 
COOLNT/anytext 

COOLNT/ON[,anytext] 

COOLNT/OFF 

 

CSYS record 
Specifies a ProManufacturing-style twelve parameter tool path transformation matrix. 
VERICUT processes this record when conditions are suitable. A more detailed 
explanation follows. The "$$->FEATNO" record resets back to the identity matrix, and 
"$$->END" ends TRANS/ROTATE/CSYS actions. 

Example: 
$$-> CSYS / 1.0000000000, 0.0000000000, 0.0000000000, 0.0000000000, $ 

0.0000000000, 1.0000000000, 0.0000000000, 0.0000000000, $ 

0.0000000000, 0.0000000000, 1.0000000000, 0.0000000000 
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ProManufacturing APT has combinations of options that determine how ROTATE, 
TRANS, and CSYS are applied. For VERICUT to determine how to apply these 
transformations, all records are processed concurrently. The table below describes cases 
where ROTATE, TRANS, and CSYS are processed. VERICUT ignores these records 
for cases that are not described in the table. 

"ROTATE" 
record present 

"TRANS" 
record present

"$$->TRANS" 
present 

Action 

No No No Ignore CSYS and TRANS 

No No Yes Apply TRANS 

No Yes No Apply CSYS 

Yes No Yes Add TRANS to CSYS, then apply 
CSYS 

Yes Yes No Apply CSYS 

 

CUTCOM record 
CUTCOM record supports cutter compensation for ProManufacturing CL data. If 
VERICUT encounters: 

$$-> CUTCOM_GEOMETRY_TYPE / OUTPUT_ON_PROFILE 

Then sees a CUTCOM/LEFT, or CUTCOM/RIGHT, it reads ahead to the 
CUTCOM/OFF. The profile is then offset to the left or right by the cutter radius and 
VERICUT re-reads the APT, making adjustments as required. The algorithm used is not 
intended to match any particular postprocessor or controller. 

  

If OptiPath is being used, the OUTPUT_ON_PROFILE gets replaced by 
OUTPUT_ON_CENTER in the generated file, and the subsequent GOTOs refer to the 
cutter centerline. 

 

CUTTER record 
Describes the shape of the cutting tool. 

This record is processed by default, however, you can use Tool Change By, in the NC 
Program window, to ignore these and process other records in the tool path file to 
retrieve cutting tool descriptions from a VERICUT tool library. 

582582



VERICUT HELP – Project menu 
 

 

Formats: 
CUTTER/d,r,e,f,a,b,h 

CUTTER/d,r,h 

CUTTER/d,r (requires Min. Cutter Height > 0) 

CUTTER/d (requires Min. Cutter Height > 0) 

CUTTER/XCUT(SHANK or HOLDER),...profile description 

The table below and figures that follow describe how the values "d" through "h" are 
interpreted, based on if the cutter is used for milling or turning. 

 

Value Milling Cutter Turning Cutter 

d diameter nose diameter 

r corner radius not used 

e dist. from tool centerline to corner 
radius center 

not used 

f dist. from tool tip to corner radius 
center 

not used 

a base angle tool angle- degrees from spindle axis 

b side angle side angle- degrees from tool centerline 
to its side 

h height height- measured from tool tip along its 
centerline 
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Generic 7 Parameter Mill Cutter Definition: CUTTER/d,r,e,f,a,b,h 

 
 

Generic 4 Parameter Turn Cutter Definition: CUTTER/d,0,0,0,a,b,h (or 
CUTTER/d,,,,a,b,h) 

 
 

CYCLE record 
Describes a canned tool axis cycle motion (e.g. drilling, reaming, boring, etc.) that is to 
be repeated at subsequent motion locations. The Drill Cycle feature, in the Motion 
window, controls when and how these records are simulated. 

Formats: 
CYCLE/<parameters> - where "<parameters>" provide information about how the 
canned motion is to be applied. 

If canned cycle motions are not displayed as expected ensure that Drill Cycle is not 
set to Ignore. If cycle simulation is still not correct, use Cycle Def on the APT 
Settings window: Cycles tab to configure how VERICUT interprets canned cycle 
commands. 

584584



VERICUT HELP – Project menu 
 

 

CYLNDR record 
Causes circular motion, same as CIRCLE record. 

 

END record 
Ends the tool path transformation matrix caused by a combination of CSYS, ROTATE 
and TRANS records. VERICUT processes this record when conditions are suitable. See 
"CSYS record" for details. 

 

FEATNO record 
Resets the tool path transformation matrix caused by a combination of CSYS, ROTATE 
and TRANS records back to the identity matrix. VERICUT processes this record when 
conditions are suitable. See "CSYS record" for details. 

 

FEDRAT record 
This record sets the feed rate, or speed at which the tool moves. Text following the slash 
is displayed in the Status window as the current feedrate condition. 

By default, a zero feedrate is used until a FEDRAT record is processed. The active feed 
rate value is used until another FEDRAT record is encountered. A RAPID motion 
overrides the active FEDRAT for that motion only. 

Formats: 
FEDRAT/value[,IPM] also: IPR, MMPM, MMPR - where “value” represents 
feedrate in the current mode. The feedrate value, and mode if specified, are displayed 
in the Status window Feedrate field. 

 

FROM record 
This record establishes where the tool is starting from. There is typically one record of 
this type per tool path file and it usually precedes any other motion record in the file. If a 
FROM record is not encountered, then the first GOTO point location is assumed to be the 
from position. 

Formats: 

FROM/x,y,z[,i,j,k] - where "x,y,z" is the starting point and "i,j,k" represents the 
starting tool axis vector. If no ijk information is found, then a tool axis of 0,0,1 is 
assumed. 
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GODLTA record 
Designates incremental cutter movement relative to the current cutter location. 

Formats: 
GODLTA/x,y,z - specifies the incremental distance along each axis to move the tool 
from its current location. For example, if the tool is currently at 4, 5, 6 in xyz when 
GODLTA/1,2,3 is processed, the tool moves to x=5 (4+1), y=7 (5+2), and z=9 (6+3). 

GODLTA/value - moves the cutter along the tool axis the specified amount. 

If there is a transformation active, such as by a previous rotary motion command or a 
stock transformation, then the GODLTA values are transformed accordingly. 

 

GOFWD record 
Designates forward cutter movement relative to the current cutter location. VERICUT 
considers this record only when processing motion generated by GOFWD used with 
CIRCLE or CYLNDR records. Numerous formats are recognized, many of which also 
consider the INDIRV record to determine the "forward" motion direction. 

 

GOHOME record 
Specifies that the cutter return to the home position. The home position is assumed to be 
the location specified by the last FROM record processed. If a FROM record has not been 
processed, then 0, 0, 0 is used. 

Formats: 
GOHOME - move all axes to the home position. The GOHOME Motion feature, on 
the APT Settings window: Motion tab, controls if the cutter is moved in a straight 
line, or is retracted prior to going home. 

GOHOME/XAXIS(YAXIS or ZAXIS) - treated as GOTO statements with the 
specified AXIS element set to the FROM value for that axis. The other two elements 
are set to the current tool path position values. 

 

GOTO record 
Designates a position where the tool is moved to. 

Formats: 

GOTO/x,y,z[,i,j,k] - where "x,y,z" represent the ending location of the tool motion 
and optional "i,j,k" values control the tool axis in multi-axis movements. "0,0,1" tool 
axis orientation is assumed. "GOTO/" text is optional after the first GOTO motion,  
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for example: 

GOTO/x,y,z[,i,j,k] 

x,y,z[,i,j,k] 

: 

 

HEAD record 
Found in tool paths for mill-turn and 4-axis lathe machines, the "HEAD" record specifies 
which machining head is in use. 

Formats: 
HEAD/1- head 1 active 

HEAD/2- head 2 active 

HEAD/BOTH- head 1 active 

HEAD/OFF- head 1 active 

When head 2 is active the tool is changed via a "LOADTL" or "TURRET" record, 
VERICUT prepends the tool ID specified by the LOADTL/TURRET record with the 
characters "2_" to retrieve tools defined for use by head 2. 

Example 1: 
HEAD/1 

TURRET/1 

Looks for ID "1" in the Tool Library (interpreted as tool 1 for use by head 1). 

Example 2: 
HEAD/2 

TURRET/1 

Looks for ID "2_1" in the Tool Library (interpreted as tool 1 for use by head 2). 

 

INDIRV record 
Vector coefficients describing the "forward" motion direction. VERICUT considers this 
record only when processing motion generated by a GOFWD record used with CIRCLE 
or CYLNDR records. 

Format: 
INDIRV/i,j,k 

 

KNOT record 
Defines a knot parameter for use with a NURBS record. 
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Format: 
KNOT/t1,...,t(n-p+2) - where "t1" - "t(n-p+2)" are the knot parameters. 

 

LOAD/TOOL record 
Specifies the tool number to be changed into the spindle, same as LOADTL record. This 
record is not processed by default, however, you can use Tool Change By, in the NC 
Program window, to process this record and retrieve cutting tool descriptions from a 
VERICUT tool library. 

Format: 
LOAD/TOOL,n[,anytext] 

See also HEAD record for information about how the Pro/MFG APT "HEAD" record 
affects how this record is used to retrieve tool from a VERICUT tool library. 

 

LOAD/WIRE record 
For wire EDM machining- causes the wire to be loaded-sets cutting mode in VERICUT 
for wire EDM machining. See also UNLOAD/WIRE record. 

 

LOADTL record 
Specifies the tool number, or pocket number of the tool to be changed into the spindle. 
Optionally, this record may also specify tool length or other aspects about the tool, 
however, VERICUT ignores all parameters following the tool number. 

This record is not processed by default, however, you can use Tool Change By, in the 
NC Program window,  to process this record and retrieve cutting tool descriptions from 
a VERICUT tool library. 

Format: 
LOADTL/n[,anytext] - where "n" is the index number of the tool (number or alpha-
numeric). Leading zeros in the tool ID are also ignored, for example "LOADTL/01" 
is interpreted as "LOADTL/1". Any text following the "/" or number data after tool 
ID is ignored, for example "LOADTL/2,LENGTH,6.500" is interpreted as 
"LOADTL/2". 

See also HEAD record for information about how the Pro/MFG APT "HEAD" record 
affects how this record is used to retrieve tools from a VERICUT tool library. 
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MODE record 
Identifies the machining to be performed: mill or turn. 

Formats: 
MODE/MILL(TURN) 

 

MOVARC record 
Causes circular motion, same as CIRCLE record. 

 

MSYS record 
Specifies a Unigraphics-style nine parameter tool path transformation matrix. VERICUT 
processes this record when Process Matrix, on the APT Settings window: Motion tab, is 
active. 

 

MULTAX record 
Determines if subsequent GOTO motions are multi-axis motions. The multi-axis 
condition is modal. When multi-axis mode is on it remains on until another MULTAX 
record turns it off. 

Formats: 
MULTAX/ON 

MULTAX/OFF 

 

NURBS record 
Defines a NURBS B-spline motion command. NURBS motion commands also utilize the 
CNTRL record and KNOT record as part of the B-spline definition. 

Format: 
NURBS/[p]- where "p" indicates the B-spline order. The "NURBS" record typcally 
spans multiple lines and includes a number of other record types, such as "KNOT", 
"CNTRL", etc. 

Example: 

NURBS/  

KNOT/1.0000000  

CNTRL/61.2424,93.2577,-31.6260  

:  

CNTRL/59.8775,93.2224,-31.6263  
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PPRINT record (general purpose) 

Comment record that typically has no affect on tool motion. "PPRINT" resides in 
columns 1-6. Text following "PPRINT" is typically ignored by VERICUT, however, 
some PPRINT records can perform VERICUT actions. See also "Controlling 
VERICUT with comment records" in the Using VERICUT section. Using VERICUT 
can be found in the VERICUT Help Library. 

 

PPRINT/ATP CBOX record 
Defines a stock block via min/max corner points. This record is processed by VERICUT 
when a stock model is loaded and the model is not yet cut. A new stock block is defined 
and fit into all displayed views. 

Format: 
PPRINT/ATP CBOX xmin,ymin,zmin,xmax,ymax,zmax 

Example: 
PPRINT/ATP CBOX -1,-2,-1,5,7,2 -defines a 6 x 9 x 3 block positioned X= -1, Y= -
2, Z= -1 

 

PPRINT TOOL AXIS record 
Specifies a new tool axis orientation to be applied to subsequent tool positions. The 
specified tool axis is modal and remains in effect until another tool axis orientation is 
specified. 

Example: 
PPRINT TOOL AXIS= XAX=-1.0000 YAX=.0000 ZAX=.0000 

 

PPRINT/VERICUT record 
(or PPRINTVERICUT) Sets a VERICUT user value, or performs a VERICUT 
command or action. PPRINT/VERICUT text must be between columns 1-72. PPRINT 
data can span multiple PPRINT records via ending each PPRINT to be continued in a 
dollar sign. The next line must be a PPRINT/VERICUT record with the same keyword as 
the previous line. Words in PPRINT data can not be split by the dollar sign. Examples are 
provided in the sections that follow. 

See also "Controlling VERICUT with comment records" in the Using VERICUT 
section. Using VERICUT can be found in the VERICUT Help Library. 
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RAPID record 
Overrides the current feed rate and causes a machine tool to move as fast as possible. 
When the RAPID record is processed by VERICUT, the motion following the RAPID 
moves the tool using the Fast Feed setting in the Motion window. 

For example, assume the file below is processed while Fast Feed=100. 

RAPID 

GOTO/1,2,3 

FEDRAT/20 

GOTO/2,3,4 

RAPID 

GOTO/3,4,5 

GOTO/4,5,6 

The motions are simulated by VERICUT as follows: 

feed rate from the current tool location to 1,2,3: 100 

feed rate from 1,2,3 to 2,3,4: 20 

feed rate from 2,3,4 to 3,4,5: 100 

feed rate from 3,4,5 to 4,5,6: 20 

In both examples below, motion from 1, 2, 3 to 4, 5, 6 uses a feed rate of "20": 

Example 1: 
FROM/1,2,3 

RAPID 

FEDRAT/20 

GOTO/4,5,6 

In example 1, a FEDRAT record immediately follows the RAPID record before a motion 
is encountered. Under this condition, the FEDRAT value overrides a RAPID record. 

Example 2: 
RAPID 

FROM/1,2,3 

FEDRAT/20 

GOTO/4,5,6 

In example 2, a FROM record is not considered to be a motion record. Therefore, the 
RAPID record has no affect. 
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RETRCT record 
Retracts the cutter along the tool axis to a specified clearance plane, or by a specified 
amount. 

Formats: 
RETRCT- retract the tool along the tool axis until it reaches the clearance plane 
defined by the previous CLEARP or CLRSRF record 

RETRCT/value- retract along the tool axis the specified amount 

RETRCT/ON- retract to the Z level prior to a cycle record. 

Example: 
GOTO/1,2,3 

RETRCT/ON 

CYCLE/DRILL,1.0,3,IPM,.1 $$ Retracts to Z=3 between cycle positions. 

 

ROTABL record 
Specifies a table rotation. Unless otherwise specified, rotation about the Y-axis is 
assumed. This record is processed when the ROTABL setting, on the APT Settings 
window: Rotary tab, is active. Otherwise, ROTABL is ignored. 

Formats: 
ROTABL/AAXIS(BAXIS or CAXIS),value 

ROTABL/AAXIS(BAXIS or CAXIS),ATANGL,value 

ROTABL/AAXIS(BAXIS or CAXIS),INCR,value 

ROTABL/ATANGL,value 

ROTABL/INCR,value 

 

ROTATE record 
Similar to the ROTABL record, this record specifies a table rotation. ROTATE is 
handled differently, depending on the active setting of NC Program Type, in the NC 
Program window. 

1. Non-ProManufacturing tool path types - when the ROTATE setting, on the APT 
Settings window: Rotary tab, is active the rotary action is simulated by 
VERICUT. Otherwise, ROTATE is ignored. 

2. Pro/MFG APT tool path types- ROTATE is considered along with TRAN and 
CSYS when determining if the tool path is to be transformed. See "CSYS record" 
for details. The "$$->FEATNO" record resets back to the identity matrix, and 
"$$->END" ends TRANS/ROTATE/CSYS actions. 
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Formats: 
ROTATE/AAXIS(BAXIS or CAXIS),value 

ROTATE/AAXIS(BAXIS or CAXIS),ATANGL,value 

ROTATE/AAXIS(BAXIS or CAXIS),INCR,value 

ROTATE/ATANGL,value 

ROTATE/INCR,value 

 

ROTHED record 
Specifies a head rotation. This record is processed when the ROTHED setting, on the 
APT Settings window: Rotary tab, is active. Otherwise, ROTHED is ignored. 

Formats: 
ROTHED/ATANGL,value 

ROTHED/value 

 

SET/MODE record 
This record specifies the machining to be performed: mill or turn. 

Formats: 
SET/MODE,MILL 

SET/MODE,TURN 

 

SPINDL record 
Specifies spindle rotation speed (RPM); direction and gear ranges may also be specified. 
Text following the slash is displayed in the Status window as the current spindle 
condition. 

Formats: 
SPINDL 

SPINDL/rpm[,anytext] 

SPINDL/[anytext,]rpm 

 

SPNDL record 
Specifies spindle rotation speed (RPM), same as SPINDL record. 
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STOP record 
Stops the NC machine at its current location. This record commonly indicates an operator 
function follows, such as: changing the tool, changing the part-fixture setup, etc. 

 

SURFACE record 
Causes circular motion, same as CIRCLE record. 

 

TLAXIS record 
Specifies a new tool axis orientation. The new orientation is modal and is applied to 
following GOTO points that do not have I, J, K values. VERICUT processes this record 
when NC Program Type, in the NC Program window, is set to CATIA APT. 

Example: 
TLAXIS/ .000000, 1.000000, .000000 

 

TRANS record 
Specifies a three parameter tool path translation. VERICUT processes this record when 
NC Program Type, in the NC Program window, is set to Pro/MFG APT and 
conditions are suitable. The presence of ROTATE and TRANS records affect when 
VERICUT processes a TRANS record. See "CSYS record" for details. 

Format: 
TRANS / dx, dy, dz 

where "dx, dy, dz" are the distances in X, Y, and Z to translate the tool positions that 
follow. The "$$->FEATNO" record resets back to the identity matrix, and "$$-
>END" ends TRANS/ROTATE/CSYS actions. 

 

TURRET record 
Similar to LOADTL record, this record often appears in tool paths for turning operations 
to specify the tool number to be changed into location for cutting. This record is not 
processed by default, however, you can use Tool Change By, in the NC Program 
window, to process this record and retrieve cutting tool descriptions from a VERICUT 
tool library. 

The number following "TURRET" is often a composite of two numbers: a tool number 
and offset number. However, VERICUT simply interprets the entire number as a tool 
number. For example, while "TURRET/0101" may indicate tool 01 is used with offset 
01), VERICUT interprets this to mean tool 0101 (or 101) is to be used from the 
VERICUT tool library. 
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Formats: 
TURRET/n[,anytext] 

TURRET/FACE,n[,anytext] 

See also HEAD record for information about how the Pro/MFG APT "HEAD" record 
affects how this record is used to retrieve tools from a VERICUT tool library. 

 

UNITS record 
Sets the unit measurement system of the data in the tool path file: inches or millimeters. 

Formats: 
UNITS/INCHES 

UNITS/MM 

 

UNLOAD/WIRE record 
For wire EDM machining- causes the wire to be unloaded-sets noncutting mode in 
VERICUT for wire EDM machining. See also LOAD/WIRE record. 

 

VECTOR record 
Designates a position where the tool is moved to, same as GOTO record. 
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Output window 
Location:  Project menu > Output 

VERICUT toolbar short cut:  

  

Opens the VERICUT Output files window to setup, create, or view VERICUT's many 
output files. 

  

 
   

In Process tab — Features on this tab control automatic saving of In Process files, or "IP 
files". The features on this tab provide the same functionality as the AutoSave window, 
In Process tab found in the File section. 

View Capture tab — Features on this tab control automatic saving of View Capture 
image files (JPEG, PS, EPSF, or TIFF files). 

VERICUT Solid tab — Features on this tab control automatic saving of VERICUT 
Solid (vct.) files. 
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Logs tab — Features on this tab enable you to specify and view VERICUT Log files, 
Control Report files and OptiPath modified (optimized) NC Program files. It also 
provides access to the OptiPath Control window.  

G-Code Files tab — Use the features on this tab to specify and view the G-Code Log file 
and the APT Output file. 

Movie tab — Use the features on this tab to specify an output file, record, and view 
VERICUT Image files or AVI files. 

   

OK — Saves all tab settings and closes the VERICUT Output Files window. 

Apply — Saves all tab settings and leaves the VERICUT Output Files window open. 

Cancel — Closes the VERICUT Output Files window without saving settings. 
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Output window, In Process tab 
Location:   Project menu > Output window 

VERICUT toolbar short cut:  

  

Features on this tab control automatic saving of In Process files, or "IP files". 

  

 
  

Auto Save options 

These options control when VERICUT automatically saves IP files. Click on the box to 
the left of the event to toggle On/Off. Each selected event causes a file to be saved when 
that event occurs. Options: 

Cutter Change — Save an IP file when the cutter has been changed. 

# of Cuts — Save an IP file after a specified number of cuts. Enter the number of cuts in 
the # of Cuts text field. 

File End — Save file at the end of tool path processing. Choose either End of each File 
(end of each toolpath file) or End (end of the NC program) from the pulldown list. 

In Process File — Use to specify the base name for IP files saved. Enter the \path\file 
name in the text field or click on Browse and use the selection window to specify the file. 
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Unique file names are maintained by appending the tool path number and line number of 
the record causing the event to the end of the base file name. Naming convention for 
auto-saving files is: <IPfilename>n1_n2.ip where "<IPfilename>" is the name specified 
in the In Process File field, "n1"=sequential tool path number, and "n2"=number of the 
record causing the auto-save event. 

The following examples assume the Output window configuration shown below. 

 

 
  

Example 1:  One tool path processed, tool change on record #10 => test1_10.ip 

Example 2:  Two tool paths processed, tool change on record #10 in both tool paths => 
test1_10.ip (from tool change in tool path #1), test2_10.ip (from tool change in tool path 
#2) 

Example 3: Two tool paths processed, tool path one tool change on record #10, tool path 
two tool change on record #5 => test1_10.ip (from tool change in tool path #1), test2_5.ip 
(from tool change in tool path #2) 

Auto Error options 
 On — When active, VERICUT automatically saves an IP file when an error is detected. 

In Process File — Specifies the base name for IP files saved due to errors. Similar to In 
Process File for the Auto Save options (see above), unique file names are maintained by 
appending the line number of the record causing the error to the end of the specified IP 
file name. 
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Output window, View Capture tab 
Location:  Project menu > Output 

VERICUT toolbar short cut:  

  

Features on this tab control automatic saving of View Capture image files (JPEG, PS, 
EPSF, or TIFF). 

  

 
  

Print Command — When toggled "Off", sends graphical data to the specified 
ShadeCopy File. When toggled "On", executes the print command that sends raw 
graphical image data to the printer. 

By default, the "prshade" command executes the "prshade" command file containing 
operating system commands typically used to print images on your computer. If printing 
fails, correct the entry in the Print Command field, or use an ASCII text editor (NOT a 
word processor) to edit the "prshade" command file to have the proper print command for 
your computer/printer. 

Properties — Opens the View Capture window to access settings for file formatting and 
printing. 
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 Auto Save options 
These options control when VERICUT automatically saves ShadeCopy files. Click on the 
box to the left of the event to toggle On/Off. Each selected event causes a file to be saved 
when that event occurs. Options: 

Cutter Change — Save a ShadeCopy file when the cutter has been changed. 

# of Cuts — Save a ShadeCopy file after a specified number of cuts. Enter the number of 
cuts in the # of Cuts text field. 

File End — Save a ShadeCopy file at  the end of  tool path processing. Choose either 
End of each File (end of each toolpath file) or End (end of the NC program) from the 
pulldown list. 

ShadeCopy File — Use to specify the base name for ShadeCopy image files saved as a 
result of Auto Save options described above, when the Print Command checkbox is 
toggled "Off". Enter the \path\file name in the text field or click on Browse and use the 
selection window to specify the file. The naming convention used for saved files is as 
described for IP files-see In Process tab for details. 

  

Auto Error options 
These options control when VERICUT automatically saves ShadeCopy filesdue to errors. 

On — When toggled "On", VERICUT automatically saves a ShadeCopy image file when 
an error is detected. 

ShadeCopy File — Use to specify the base name for ShadeCopy image files 
automatically saved as a result of errors detected when AutoError On is toggled "On", 
and the Print Command checkbox is toggled "Off". Enter the \path\file name in the text 
field or click on Browse and use the Save File selection window to specify the file. The 
naming convention used for saved files is as described for IP files-see In Process tab for 
details. 
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Output window, VERICUT Solid tab 
Location:   Project menu > Output 

VERICUT toolbar short cut:   

  

Features on this tab control automatic saving of VERICUT Solid (vct.) files. 

  

 
  

Auto Save options 

These options control when VERICUT automatically saves VERICUT Solid files. Click 
on the box to the left of the event to toggle On/Off. Each selected event causes a file to be 
saved when that event occurs. Options: 

Cutter Change — Save a VERICUT Solid file when the cutter has been changed. 

# of Cuts — Save a VERICUT Solid file after a specified number of cuts. Enter the 
number of cuts in the # of Cuts text field. 

File End — Save a VERICUT Solid file at  the end of  tool path processing. Choose 
either End of each File (end of each toolpath file) or End (end of the NC program) from 
the pull-down list. 

VERICUT Solid File — Use to specify the base name for VERICUT Solid files saved 
due to Auto Save options. Enter the \path\file name in the text field or click on Browse 
and use the selection window to specify the file. 
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AutoError options 
Use these options to specify whether or not VERICUT automatically saves VERICUT 
Solid files when an error is detected. 

On — Click on the box to the left to toggle On/Off. When active, VERICUT 
automatically saves a VERICUT Solid file when an error is detected.  

VERICUT Solid File — Use to specify the base name for VERICUT Solid files saved 
when AutoError On is active. Enter the \path\file name in the text field or click on 
Browse and use the selection window to specify the file. 

  NOTE: The naming convention used for saved VERICUT Solid files is the same as 
described for IP files-see In Process tab for details. 
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Output window, Logs tab 
Location:  Project menu > Output 

VERICUT toolbar short cut:  

  

Features on this tab enable you to specify and view VERICUT Log files, Control Report 
files and OptiPath modified (optimized) NC Program files. It also provides access to the 
OptiPath Control window. 

  

 
  

Log File 
Use to specify the name of the VERICUT Log file. Enter the \path\file name in the text 
field or click on Browse and use the selection window to specify the file. 

View — Opens a window containing the VERICUT Log file. This file contains session 
information, such as error, warning and informational messages about the verification 
session. Standard text editing features are provided, such as: copy/cut, paste, search, etc. 
For more information on using the editing features, see Text File under Edit menu. 
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Report 
Use to specify the name of the Control Report file. Enter the \path\file name in the text 
field or click on Browse and use the selection window to specify the file. 

View — Opens a window containing a Control Report file containing information about 
how the current NC control configuration will interpret machine codes. Reported 
information includes all the G-Codes the control is configured to handle and macros 
(actions) they will call, subroutines, and other supported control features. Standard text 
editing features are provided, such as: copy/cut, paste, search, etc. For more information 
on using the editing features, see Text File under Edit menu. 

  

OptiPath 
Use to specify the name of the Optimized file. Enter the \path\file name in the text field 
or click on Browse and use the selection window to specify the file. 

Settings — Displays the OptiPath Control window. 

View — Opens a window containing the optimized NC Program file. Standard text 
editing features are provided, such as: copy/cut, paste, search, etc. For more information 
on using the editing features, see Text File under Edit menu. 
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Output window, G-Code Files tab 
Location:   Project menu > Output 

VERICUT toolbar short cut:    

  

Use the features on this tab to specify, and view, Control Reports, APT Output Files and 
the G-Code Log Files. 

  

 
  

Control Report 
Enter the /directory path/filename of the Control Report file in the text field or use the 
Browse button to specify it. This file contains information about how the current NC 
control configuration will interpret various codes.  

View — Opens a window containing the Control Report file. In this window, you can 
view, edit, or reset the Control Report file contents. Standard text editing features are 
provided, such as: copy/cut, paste, search, etc. For more information on using the editing 
features, see Text File under Edit menu. 
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APT Output File 
Enter the /directory path/file name of the APT Output file in the text field or use the 
Browse button to specify it. This file contains information, such as error, warning and 
informational messages about G-Code processing.  

View — Opens a window containing the APT Output file with ASCII APT tool path 
records created when Create APT Output File is active (ref. Process Options window: 
G-Code Output Files tab). Standard text editing features are provided, such as: 
copy/cut, paste, search, etc. For more information on using the editing features, see Text 
File under Edit menu. 

  

G-Code Log File 
Enter the /directory path/file name of the G-Code Log file in the text field or use the 
Browse button to specify it. This file contains information, such as error, warning and 
informational messages about G-Code processing.  

View — Opens a window containing the G-Code Log file. In this window, you can view, 
edit, or reset the G-Code Log file contents. Standard text editing features are provided, 
such as: copy/cut, paste, search, etc. For more information on using the editing features, 
see Text File under Edit menu. 
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Output window, Movie tab 
Location:   Project menu > Output 

VERICUT toolbar short cut:   

  

Use the features on this tab to specify an output file, record, and view VERICUT Image 
files or AVI files. 

  

 
  

Movie 
Use to specify the name of the Image/AVI output file. Enter the \path\file name in the 
text field or click on Browse and use the selection window to specify the file.  

Settings — Displays the Image Record window. 

View — Opens a "VERICUT Player" window (or "AVI Player" window) to load and 
play back an Image file (or AVI file). The type of "player" window that opens depends on 
the Output Format setting in the Record Movie window. 
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Report (Report Template window) 
Location: Project menu > Report > Report Template >Edit in the main VERICUT 
window. 

                 File > Report Template in the Inspection Sequence window. 

                 File > Report Template in the Tool Manager window. 

  

Opens the Report Template window enabling you to define a new, or modify an existing, 
report template (See How).  

  

 
  

The Menu Bar 
File 
New — Displays an empty Report Template window enabling you to create a new report 
template file.  

Open — Displays a file selection window enabling you to open an existing report 
template file. The "current" report template file is stored in the Preferences file. 

Save — Opens a window enabling you to save the current report template file. 

Save As — Opens a window enabling you to save the current report template file under a 
different name or path.  

Recent Files — Provides a list of recently opened Report Template files. To open a file 
in the list, select the desired file. List contents are stored in the Preferences file.  

Close — Closes the Report Template window without saving the report template file. 

 

Edit 
Add — Enables you to add records to a new or existing report template file.  

Edit — Enables you edit the content of the highlighted record. This feature is only 
available for the Page Layout tab. 

Delete — Enables you to delete the highlighted record from the report template file. 

The Tabs 

Page Layout tab — Features on this tab enable you to specify or modify the content and 
page layout of a report template. 
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Styles tab — Features on this tab enable you to specify display characteristics (font, font 
size, color, etc.) to be used for the report template. 

User-Defined Tags tab — Features on this tab enable you to specify "generic" records 
included in a report template that will be updated with information specific to a particular 
user file at the time the report is created. The user file specific information can be 
associated with the User-Defined Tag using the User-Defined Tag Values window. If all 
User-Defined Tag values are not defined prior to creating a report, you will be prompted 
for any missing information at the time the report is created. 

Page Setup tab — Features on this tab enable you to specify or modify page format 
characteristics such as margins, orientation and paper size. The features on this tab are 
intended to be use with PDF format reports, although it may also be useful for HTML 
format reports with certain web browsers. 
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Report Template window, Page Layout tab  
Location:  Project menu > Report > Report Template >Edit in the main VERICUT 
window. 

                File > Report Template in the Inspection Sequence window. 

              File > Report Template in the Tool Manager window. 

 

  

 

The Menu Bar 
 
File 
See Report Template window for a description of the File features. 

 

Edit 
Add — Enables you to add records to a new or existing report template file.  

NOTE:  When starting a new report template, Add will not become active until at least 
one style record has been added using the Styles tab. 

Text — Use to add text related records to a report template. Select the desired option 
from the pull-down list. The options in the list will vary depending on where you 
accessed the Report Template window (VERICUT main window, Tool Manager 
window, or the Inspection Sequence window). 

String — Adds a record to writes out a specified text string. Enter the text in the 
"Content" field of the record. 

Date — Adds a record to write out the date with the format selected from the 
pull-down list. 
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Short — "12/24/03" 

Medium — "Dec 24, 2003" 

Long — "December 24, 2003" 

Full — "Wednesday, December 24, 2003" 

Time — Adds a record to write out the time with the format selected from the 
pull-down list. 

Short — "10:49 AM" 

Medium — "10:49:48 AM" 

Long — "10:49:48 AM PST" 

Page Number — Adds a record to write out page numbers with the format 
selected from the pull-down list. 

# — "1" 

Page # — "Page 1" 

Page # of # — "Page 1 of 3" 

File Name — Adds a record to write out the /path/file name of the type selected 
from the pull-down list. 

Project File — Adds a record to write out the /path/file name of the "current" 
Project file. 

Machine File — Adds a record to write out the /path/file name of the 
"current" Machine file.  

Control File — Adds a record to write out the /path/file name of the "current" 
Control file.  

Tool Library File — Adds a record to write out the /path/file name of the 
"current" Tool Library file.  

OptiPath Library File — Adds a record to write out the /path/file name of 
the "current" OptiPath Library file.  

Toolpath File — Adds a record to write out the /path/file name of the 
"current" NC Program File.  

Log File — Adds a record to write out the /path/file name of the "current" 
Log file. 

Optimized Toolpath File — Adds a record to write out the /path/file name of 
the "current" Optimized Toolpath file.  

Process Data — Adds a record to write out "process" related data of the type 
selected from the pull-down list. 

Material — Adds a record to write out the "material" specified on the 
OptiPath Control window, Settings tab. 
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Machine — Adds a record to write out the "machine" specified on the 
OptiPath Control window, Settings  tab.  

Total Time — Adds a record to write out the total time anticipated to 
machine the part (as simulated by VERICUT). 

Total Number of Errors — Adds a record to write out the number of errors 
detected by VERICUT. 

Total Number of Warnings — Adds a record to write out the number of 
warning detected by VERICUT.  

Total Optimized Time —Adds a record to write out the total time anticipated 
to machine the part (as simulated by VERICUT) using optimized toolpath 
files.  

Total Time Difference— Adds a record to write out the total time difference 
between Total Time and Total Optimized Time.   

Total Distance — Adds a record to write out the total tool movement 
distance. 

Total Cut Distance % — Adds a record to write out the total percentage of 
tool movement distance that occurred while in feed rate mode. 

Total Volume Removed — Adds a record to write out the total volume of 
material removed. 

Tool Change Data — Adds a record to write out "tool" related data, of the type 
selected from the pull-down list, for the current tool. 

Seq — Adds a record to write out the sequential number of the last tool 
change event. 

Record — Adds a record to write out the last tool change record processed. 
Includes both the sequential line number and the record text. 

Tool Description — Adds a record to write out the tool ID and description of 
a tool retrieved from a VERICUT Tool Library file. A blank field indicates a 
description for this tool was not defined in the library, or the tool did not come 
from a tool library.  

Cutter Info — Adds a record to write out cutter shape geometry data. 
Includes both the method used to define the cutter shape (shown in square 
brackets “[ ]”,  for example [Profile]  indicates a profile type of cutter 
definition) followed by the parameter values used to describe the cutter. 

Cutter Height — Adds a record to write out the height of the cutter. 

Flute Length — Adds a record to write out the flute length of the cutter. 

Gage Offset — Adds a record to write out the cutter's gage offset value. 

OptiPath Record — Adds a record to write out the OptiPath tool description 
and the number of teeth for the tool 
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Optimized By — Adds a record to write out the optimization method used for 
the tool. 

Original Time — Adds a record to write out the anticipated cutting time (as 
simulated by VERICUT) for the tool. 

Optimized Time — Adds a record to write out the anticipated optimized 
cutting time (as simulated by VERICUT) for the tool. 

Time Difference — Adds a record to write out the difference between the 
optimized and un-optimized cutting times for the tool 

Distance — Adds a record to write out the tool movement distance. 

Distance % — Adds a record to write out the percentage of tool movement 
distance while in feedrate mode. 

Volume Removed — Adds a record to write out the volume of material 
removed by the tool. 

Errors — Adds a record to write out the number of errors detected by 
VERICUT for the tool. 

Warnings — Adds a record to write out the number of warnings output by 
VERICUT for the tool. 

Min Extension — Adds a record to write out the minimum height required to 
avoid shank/holder collisions with the tool. 

Add User-Defined Tag — Adds a record to write out the value of a "text type" 
User Defined Tag. Use Add User-Defined Tag, to create a new "text type" User-
Defined Tag, or select an existing User-Defined Tag from the pull-down list. 

Table — Displays a window enabling you to add a VERICUT generated table , or 
"custom" table, to a report template. 

Table — Use to specify the type of table to add. 

Add a custom table using: 

Custom Table — 
or choose one of the VERICUT generated tables: 

File Summary Table — outputs a file summary table 

Tool Summary Table — outputs a tool summary table 

Shade Copy Table — outputs a Shade Copy table.  

NOTE:  The "header" column in the in each of the above VERICUT 
generated tables is customizable. On the Page Layout tab, highlight the table 
to be edited. 

or choose one of the existing (if any) "table type" User-Defined Tags at the 
bottom of the list. 

No. of Columns — Enter the number of columns for a "custom" table. 
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No. of Rows — Enter the number of rows for a "custom" table. 

Use the following "Alignment" features to further define a "custom" table. 

Table Width — Use to specify the table width relative to the window/page width. 
 Enter the Table width as a percentage of the window/page width. 

Border Size — Use to specify a border size for a "custom" table. Enter the border 
size in pixels. 

Thumbnail Width — Use to specify the width of "images" included in tables. 
Toggle "On" and enter the width value in pixels. 

Thumbnail Height — Use to specify the width of "images" included in tables. 
Toggle "On" and enter the width value in pixels. 

NOTES:  The following rules apply to Thumbnail Width/Thumbnail Height: 

1. If only one of the Thumbnail dimensions is toggled "On", the active 
dimension will be used and the other direction dimension will be scaled to 
maintain the image aspect ratio. 

2. If neither of the Thumbnail dimensions  is toggled "On", the native image size 
will be used. 

Row Height —Use to specify the row height for a "custom" table. Toggle "On" and 
enter the height value in pixels. 

Maximum Rows/Page — Use to specify the maximum number of rows per page 
when printing a "custom" table. 

Picture — Displays a window enabling you to add VERICUT generated pictures, or 
custom pictures from a file, to a report template. 

Picture — Use to specify the type of picture to add. Select from the pull-down list. 

Add a custom image using: 

From File — outputs the image from the specified file. 

or choose one of the VERICUT generated pictures: 

Tool Use Graph — outputs a Tool Use graph image 

Cutting Graph — outputs a Cutting Conditions graph image. 

Start of Process Image — outputs an image at the start of processing. When 
included within a "tool change loop", a shadecopy image of the part at the 
start of cutting with current tool is output. When included within a "toolpath 
loop", a shadecopy image of the part at the start of the current toolpath is 
output. 

End of Process Image — outputs an image at the end of processing. When 
included within a "tool change loop", a shadecopy image of the part at the end 
of cutting with current tool is output. When included within a "toolpath loop", 
a shadecopy image of the part at the end of the current toolpath is output. 
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Tool Image — outputs an image of the current tool. When included within a 
"tool change loop", an image of the current tool is output at each tool change.  

or choose one of the existing (if any) "picture type" User-Defined Tags at the 
bottom of the list. 

File — Enter the /path/file name of the image file or use Browse to display a file 
selection window and use it to pick the image file. This feature is only active when 
Picture is set to From File. 

Border Size — Use to add a border to the image. Enter the border size in pixels. 

Width — Use to specify the width for the displayed image. Toggle "On" and enter 
the width value in pixels. 

Height — Use to specify the height for the displayed image. Toggle "On" and enter 
the height value in pixels. 

NOTES:  The following rules apply to Width/Height: 

1. If only one of the dimensions is toggled "On", the active dimension will be 
used and the other direction dimension will be scaled to maintain the image 
aspect ratio. 

2. If neither of the dimensions is toggled "On", the native image size will be 
used. 

Page Break — Enables you to manually add page breaks to control printed output. 

Start Toolpath Loop — Use to mark the "start" of a group of records that will be output 
for each toolpath in user files containing multiple toolpaths. 

End Toolpath Loop — Use to mark the "end" of a group of records that will be output 
for each toolpath in project files containing multiple toolpaths. 

Start Tool Change Loop — Use to mark the "start" of a group of records that will be 
output at each tool change. 

End Tool Change Loop — Use to mark the "end" of a group of records that will be 
output at each tool change. 

 NOTE:   PageBreak, Start Toolpath Loop, End Toolpath Loop, Start Tool Change 
Loop, and End Tool Change Loop cannot be edited. They can only be deleted. 

  

The Record Table 
Each record in the table consists of five columns of information. Click on any column in 
a row to highlight a record for editing. The order of the records in the table can be 
changed by clicking on the square button at the beginning of the record and dragging the 
record to the desired position. Each record in the table consists of the following 
information: 

Category — Use the options in this column to specify what "part" of the report the 
record is to be included. With the record highlighted, click on the record "category" and 
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select from the pull-down list (Body, Page Header, Page Footer, First Page Header, or 
First Page Footer). 

Type — Indicates the record type. With the record highlighted, double click Table or 
Picture to display the corresponding window for editing the record. 

Content — Indicates the "content" of the record. With the record highlighted, double 
click on the content of a Table or Picture record to display the corresponding window for 
editing the record. Double click on the "content' of a text string record to add or modify 
the text. 

Alignment — Indicates how the information will be aligned horizontally in the report. 
With the record highlighted, click on the record "category" and select from the pull-down 
list (Body, Page Header, Page Footer, First Page Header, or First Page Footer). 

Style — Indicates the "style" to be used for the record.  With the record highlighted, click 
on the record "style" and select from the pull-down list. The list will contain all for the 
styles that have been defined, using the Styles tab, for the current report template. 
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Report Template window, Styles tab 
Location:  Project menu > Report > Report Template >Edit in the main VERICUT 
window. 

                File > Report Template in the Inspection Sequence window. 

                File > Report Template in the Tool Manager window. 

  

 
 

The Menu Bar 
 
File 
See Report Template window for a description of the File features. 

 

Edit 

Add — Enables you to add "style" records to a report template file.  

Delete — Enables you to delete "style" records from a report template file.  

NOTE:  Add and Delete can also accessed using the Add or Delete button at the bottom 
of the Styles tab or by right-clicking in the Style Record table and selecting Add or 
Delete. 

  

The Style Record Table 
Each record in the table consists of nine columns of information describing a particular 
style record. Click on any column in a row to highlight a record for editing. Each record 
in the table consists of the following information: 
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Style Name — The name used to identify a particular style record, These are the items 
that will appear in the Style pull-down list, in the record table, on the Page Layout tab. 

Font — Indicates the font type to be used for the style record. With the record 
highlighted, click on the Font field and select from the pull-down list. 

Size — Indicates the font size to be used for the style record. With the record highlighted, 
click on the Size field and either select from the pull-down list or type in a font size. 

Bold — Toggle the "Bold" characteristic "On/Off" for the style record. 

Italic — Toggle the "Italic" characteristic "On/Off" for the style record. 

Underline — Toggle the "Underline" characteristic "On/Off" for the style record. 

Font Color — With the record highlighted, double click on the Font Color field to 
display a color pallet. (You can also right-click on a "color" field and select Set Color to 
display the color pallet.) Click on the desired font color in the pallet. Click on the X in the 
upper right corner of the color pallet to dismiss the pallet. 

Background Color — With the record highlighted, double click on the Background 
Color field to display a color pallet. (You can also right-click on a "color" field and select 
Set Color to display the color pallet.) Click on the desired background color in the pallet. 
Click on the X in the upper right corner of the color pallet to dismiss the pallet. 

Border Size — Indicates the border size to be used for the style record. With the record 
highlighted, click on the border size and type in a font size (in pixels). 
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Report Template window, User-Defined Tags tab 
Location:  Project menu > Report > Report Template >Edit in the main VERICUT 
window. 

                File > Report Template in the Inspection Sequence window. 

                File > Report Template in the Tool Manager window. 

  

User-Defined Tags enable you to define "generic" records in a report template, whose 
value is specified at the time that the template is used to create a report. User-Defined 
Tag values can be defined in the User-Defined Tags window or by using PPRINT data 
in the toolpath file. 

  

. 

 

The Menu Bar 
 
File 
See Report Template window for a description of the File features. 

 

Edit 
Add — Enables you to add "User-Defined Tag" records to a report template file.  

Delete — Enables you to delete "User-Defined" records from a report template file.  

  

NOTE:  Add and Delete can also accessed using the Add or Delete button at the bottom 
of the User-Defined Tags tab or by right clicking in the User-Defined Tags Record table 
and selecting Add or Delete. 
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The User-Defined Tag Record Table 
Each record in the table consists of a Tag Name that is used to identify the record and a 
Type (Text, Table or Picture from File). Click on any column in a row to highlight a 
record for editing. Each record in the table consists of the following information: 

Tag Name — The name used to identify a particular User-Defined Tag record. After 
adding a User-Defined Tag record, type in a unique tag name.  

Type — Indicates the "type" of information represented by the tag. After adding a and 
naming a User-Defined Tag record, click in the Type field and select the appropriate data 
type (Text, Table, or Picture From File) from the pull-down list. 

NOTE:  Tag Name and Type can be edited by highlighting the record, then clicking the 
appropriate field and either editing the text or selecting the desired Type from the pull-
down list. Once a Tag Name is referenced in a report template, the User-Defined Tag 
record can no longer be edited. 

621621



VERICUT HELP – Project menu 
 

Report Template window, Page Setup tab 
 

Features on this tab enable you to specify or modify page format characteristics such as 
margins, orientation and paper size. The features on this tab are intended to be use with 
PDF format reports, although it may also be useful for HTML format reports with certain 
web browsers. 
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User-Defined Tag Values 
Location:  Project menu > Report > User-Defined Tag Values 

                File > User-Defined Tag Values in the Inspection Sequence window. 

                File > User-Defined Tag Values in the Tool Manager window. 

  

Opens the User-Defined Tags window enabling you to assign job specific information to 
a "generic" User-Defined Tag, prior to creating a report. Double click on a Tag Value 
field to enter or edit the tag value. If Tag Values are not specified prior to creating a 
report, you will be prompted for them at the time the report is created. Once Tag Values 
have been specified, they are stored in the user file. You can also specify User-Defined 
Tag Values using PPRINT statements in the toolpath file. 
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MDI window 
Location:  Configuration  menu > MDI 

VERICUT toolbar short cut:   

 

Opens a window enabling you to manually enter and process blocks of G-code data. The 
MDI, or "Manual Data Input" function provides a quick and easy way of verifying that 
the machine/control combination responds to G-code data commands as expected. 

 

 
 

SubSystem ID — Use this feature to specify which subsystem the G-code data command 
is to be applied to. 

History — Displays a list of the G-code data commands that have been entered during 
the current VERICUT session.  

To re-use a command from the History list, click on the command so it becomes 
highlighted and click on Apply. The result of the command is immediately displayed in 
the Machine view. 

To remove a command from the History list, click on the command so it becomes 
highlighted, then use the Delete button to remove the command from the History list. Use 
the Clear All button to remove all commands from the History list. 
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Right-click in the History list area to display a pop-up window with the following 
features: 

Delete — Removes the highlighted command from the History list (same as the Delete 
button described above). 

Clear All — Removes all commands from the History list (same as the Clear All button 
described above). 

Replay Current — Processes the command row highlighted in the History list (same as 
using the Apply button described above). 

Multiple Line Mode — Left-click on this feature to activate (indicated by a check mark) 
Multiple Line Mode. When active, much of the MDI behavior changes as described 
below. 

• A highlighted row is not inserted in the Selection field. 

• The content of the Selection field is appended after the highlighted row when 
Apply is pressed. 

• A row's text can be edited directly by double clicking on the row. 

• Rows with duplicate content are allowed. 

• The Replay All feature requires a Machine Simulation license. 

The remaining features are only available when Multiple Line Mode is active. 

Replay All — Processes all of the command rows in the History list, in the order that 
they appear in the list. 

 Re-order the rows in the History list by left-clicking on the square button at the 
beginning of the row and drag the row (while keeping the left mouse button depressed) to 
the desired position.  

NOTE:  Use of Replay All requires a Machine Simulation license. 

Save As — Opens a "Save As" file selection box enabling you to save all command rows 
in the History list to a file.  

Copy — Copies the selected command row(s) to the Windows clipboard. Use the "Shift" 
key to select a range of command rows. Use the "Ctrl" key to select multiple individual 
command rows. 

Paste — Appends the Windows clipboard text after the selected row in the History list. 
You can also paste the contents of the Windows clipboard to a file.  

Selection — Enter the G-code data command in this field, then click on Apply (or use 
the Enter key on your keyboard). The result of the command is immediately displayed in 
the Machine view and the command is added to the History list described above. Errors 
are displayed in the Message area. 

Use Cancel to dismiss the MDI window. 
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NOTES:  
1. Do not attempt to use MDI before machine construction is complete. If the Stock, 

Tool, and all motion components are not present in the machine definition, the 
machine may not respond to motion commands as expected. 

2. After adding motion type components to a machine, always press   (Reset 
Model) before using MDI to test machine movements. 

3. Calls to subroutines and NC macros are not supported in the MDI window. Use a 
short test tool path file instead. 

4. If you want the MDI motions to remove material, you have to press "Single Step" 
once to get VERICUT to build the cut stock database. 
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Coordinate Systems (Coordinate System window) 
Location:  Project menu > Coordinate Systems > Define 

Toolbar shortcut:   

 

Opens a window enabling you to define a coordinate system, also known as a "CSYS". 
(See how) The active CSYS applies to X-caliper measurements, Section plane values, 
and tool path motions (except when orientations are defined in a tool path list). To see 
axes representing the active CSYS (XcsYcsZcs), select View menu > View Axes: 
Coordinate System. A user-defined CSYS is typically used to locate an APT or CLS 
tool path for proper relationship to the workpiece. You can also use a user-defined CSYS 
for defining section planes, or for gathering measurement data. Use Project menu > 
Coordinate Systems > Active Coordinate System to activate the desired coordinate 
system. 

NOTES: 
1. Defining a CSYS is not recommended to locate G-code tool paths simulated on a 

3-D machine, as this can cause the workpiece to move in the machine view. 
Instead, use an Input Program Zero table, or Work Offsets table if work 
offsets are present in the tool path file. 

2. Coordinate systems specified under NC Program Origin on the NC Program 
window, override the active user-defined CSYS. 

3. VERICUT can also be configured to process the following APT-CLS tool path 
records to set the tool path CSYS: CATIA0, MSYS, VERICUT-MATRIX. 
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Coordinate System Name— Enables you to add a new CSYS or select an existing 
CSYS from the list for modification or deletion. Enter a name in the top position of the 
Coordinate System Name list to create a new CSYS, or use New (described below) to 
create a new CSYS and let VERICUT automatically supply a unique name. 

New — Adds a new CSYS to the Coordinate System Name list. VERICUT 
automatically provides a unique name to the CSYS. The following user actions also 
automatically add a new CSYS: 

• Translate tab: pressing Move 

• Rotate tab: pressing one of the rotation direction buttons (X+/X-, Y+/Y-, Z+/Z-) 
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• Construct tab: pressing Update 

• When VERICUT processes one of the following APT-CLS tool path records to 
set the tool path CSYS: CATIA0, MSYS, VERICUT-MATRIX. The coordinate 
system is relative to the first stock's machine component parent. The coordinate 
system is named "filename_nn" where filename is the name of the toolpath file 
and nn is the file's line number containing the matrix definition. Additional 
coordinate systems are not created for matrices with identical values. 

Delete — Deletes the selected CSYS from the Coordinate System Name list. 

CSYS from File — Displays a file selection box enabling you to specify the CSYS file 
to be used. VERICUT will read the file and creates CSYS's attached to the selected 
component (typically the Stock). The Create CSYS While Simulating feature 
(described below) must be toggled Off when using CSYS from File. This functionality is 
also available via the csys_file command line option. 

Attach Coordinate System To — Enables you to attach a CSYS to a particular 
component so that if the component gets repositioned, the CSYS also gets repositioned, 
maintaining the defined relationship. Select the component from the pull-down list. 

Use for Cut Stock Transition — Use to designate that the coordinate system is used for 
transitioning the cut stock from one setup position to another. 

 

CSYS Construct/Modify features: 
The features on the following tabs enable you construct a new, or modify an existing 
CSYS. 

Translate tab — Features on this tab enable you to translate the selected CSYS via 
indicating "from" and "to" points to move the CSYS. Movement occurs each time you 
press the Move button. If the applied rotation is incorrect, press Undo to return the object 
to its previous location. 

Rotate tab — Features on this tab enable you to rotate the selected CSYS about a 
rotation center point. Movement occurs each time you press one of the rotation direction 
buttons: X+/X-, Y+/Y-, Z+/Z-. If the applied rotation is incorrect, press Undo to return 
the object to its previous location. 

Construct tab — Features on this tab enable you to construct a CSYS via defining 3 
points. Each point can be defined using points, planes, vectors, or the center of a hole or 
boss. 

Matrix tab — Features on this tab move the selected CSYS via a twelve parameter 
transformation matrix. 
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Display features: 
These features enable you to override the "global" visibility and color characteristics, as 
set with View menu > Axes: Coordinate System, for the individual coordinate system 
currently displayed in the Coordinate System Name list. 

Visible — When coordinate systems are displayed using View menu > View Axes: 
Coordinate System, Visible enables you to toggle the display of an individual 
coordinate system "Off/On".  

 — Enables you to override the "global" coordinate system display color set using 
View menu > View Axes: Coordinate System, for an individual coordinate system. 
Click on the Color Pallet icon, then select the desired color from the chart. 

 

Location features: 
These features show the selected CSYS's position and angle, and can be used to move the 
CSYS or verify its current location. Values shown are relative to the workpiece origin. 

Position — Specifies the absolute XYZ position of the CSYS, separated by spaces. 

Component Origin — Enables you to position the origin of the coordinate system 
currently displayed in the Coordinate System Name list at the origin of the selected 
component. Toggle Component Origin "On", click in the Position field so that it 
becomes highlighted yellow, then select the desired component in the graphics area. Press 
Apply to move the coordinate system. 

Angles — Specifies the absolute XYZ rotation of the CSYS, separated by spaces. 

Undo — Returns the CSYS to its previous location, or as it was when the Coordinate 
System window was opened. 

Reverse X — Reverses the X axis of the "active" coordinate system. (See note below) 

Reverse Y — Reverses the Y axis of the "active" coordinate system. (See note below) 

Reverse Z — Reverses the Z axis of the "active" coordinate system. (See note below) 

  

NOTE:  In order to maintain a right handed csys, the following will occur when an axis 
is reversed: 

If the X axis is reversed, then the Z axis is also reversed. 

If the Y axis is reversed, then the X axis is also reversed. 

If the Z axis is reversed, then the Y axis is also reversed. 

  

Create CSYS While Simulating — When toggled On (the default), coordinate systems 
are unconditionally created when a matrix statement is encountered in the NC program 

630630



VERICUT HELP – Project menu 
 

being simulated. The coordinate systems are attached to the stock's parent ( the "attach" 
component). This feature must be toggled Off when creating them on your own or  using 
the CSYS from File feature (described above). 

 

OK — Applies the changes and closes the Coordinate System window. 

Apply — Applies the changes and leaves the Coordinate System window open. 

Cancel — Closes the Coordinate System window without applying changes. 
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Coordinate System window, Translate tab 
Location:  Project menu > Coord. System > Define 

Toolbar shortcut:   

  

Features on this tab enable you to translate the selected CSYS via indicating "from" and 
"to" points to move the CSYS. Movement occurs each time you press the Move button. 

  

 
  

From / To — Specifies the locations to move the CSYS from and to, relative to the 
workpiece origin. XYZ values can be entered (separated by spaces), or selected by 
clicking in the field then clicking on a model. As you move the mouse over the 
VERICUT model, a crosshair and vector show you the pending pick-point location. 
Graphical selection supports picking corner points and midpoints of uncut model 
geometry, or virtually any point on machined features. 

Move — Moves the selected CSYS by the incremental distance, as calculated from the 
"From" point to the "To" point location. 

Local Translation — When toggled "on", From/To values are relative to the current 
CSYS.  

NOTE:  This feature is useful when trying to align a CSYS to the center of a machined 
hole. 

632632



VERICUT HELP – Project menu 
 

Coordinate System window, Rotate tab 
Location:  Project menu > Coord. System > Define 

Toolbar shortcut:   

  

Features on this tab rotate the selected CSYS about a rotation center point. Movement 
occurs each time you press one of the rotation direction buttons: X+/X-, Y+/Y-, Z+/Z-. 

  

 
  

Center of Rotation — Specifies XYZ point location about which to rotate the CSYS. 
XYZ values can be entered (separated by spaces), or selected by clicking in the field then 

clicking on a model. To see the center of rotation, press . To remove the center of 
rotation symbol press the button again, or close the Coordinate System window. 

Increment — Specifies incremental degrees of rotation to apply when one of the rotation 
direction buttons are pressed. 

Rotation direction buttons — (X+/X-, Y+/Y-, Z+/Z-) When pressed, applies the 
incremental rotation specified in the Increment field. Rotation occurs about the Center 
of Rotation, relative to the workpiece origin. 

Local Rotation — When toggled "on", the incremental rotation values are relative to the 
current CSYS.  

NOTE:  This feature is useful when trying to align a CSYS to the center of a machined 
hole. 
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Coordinate System window, Construct tab 
Location:  Project menu > Coord. System > Define 

Toolbar shortcut:   

  

The features on this tab enable you to construct a CSYS via a point representing the 
CSYS origin, and two direction vectors representing the axes of the CSYS. Each can be 
defined using points, planes and vectors. 

  

 
  

 While the Construct tab is active, a marker is displayed in the graphics area (see the 
picture below) showing the current position/orientation of the axis being constructed 
based on the Construct tab settings. The display is updated each time you change a value 
on the Construct tab. The marker is automatically clears when you leave the Construct 
tab. 
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Origin (XYZ) — Use these features to define a point representing the origin of the 
CSYS.  

Primary Axis (IJK) — Use these features to define a point or vector representing the 
direction of the CSYS primary axis.  

Secondary Axis (IJK) — Use these features to define a point or vector representing the 
direction of the CSYS secondary axis. 

 

For each of the items above, you can either enter the coordinates of the point, separated 
by spaces, in the text field or select one of the construction methods and pick geometry in 
the graphics area to define the item. Choose one of the construction methods from the 

pull-down list, then click the arrow  and follow the prompts in the message area to 
define the item. The following construction methods are available: 

Point — Use to select a point. 

Vector/Plane — Define a point represented by the intersection of a vector with a 
plane. 

3 Planes — Define a point represented by the intersection of three planes. 

Circle — Define a point represented by the center of a circle. 

 NOTE:  When using one of the point construction methods to define the Primary or 
Secondary Axis, the origin is subtracted from the generated point to define the direction 
vector representing the axis. 

 

 Vector — Define the direction of a CSYS axis by selecting a vector. (not available for 
Origin) 

Plane/Plane — Define the direction of a CSYS axis by a vector represented by the 
intersection of two planes. (not available for Origin) 

 Axis Order — Choose from the pull-down list to assign X, Y or Z to the Primary and 
Secondary axes of the CSYS. 

XY — assigns the Primary Axis to be X and the Secondary Axis to be Y. 

YZ — assigns the Primary Axis to be Y and the Secondary Axis to be Z. 

ZX — assigns the Primary Axis to be Z and the Secondary Axis to be X. 

  

Update — Use the values selected above to update an existing CSYS, or create a new 
CSYS. When the Update button is pressed the following occurs: 

1. The Primary Axis and the Secondary Axis are crossed to determine the third axis. 

2. The third axis is then crossed with the Primary Axis to ensure that the Secondary 
Axis is orthogonal. 
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3. The CSYS currently active in the Coordinate System window is updated with the 
resultant orthogonal coordinate system and the origin. If no CSYS is currently 
active, VERICUT creates a new CSYS and automatically assigns it a unique 
name. 
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Coordinate System window, Matrix tab 
Location:  Project menu > Coord. System > Define 

Toolbar shortcut:   

  

Features on this tab enable you to move the selected CSYS via a twelve parameter 
transformation matrix. 

  

 
  

Matrix Table — The transformation matrix table is similar to the matrix used in 
programming APT tool paths. Its twelve parameters reveal the geometrical attributes of 
the local (transformed) coordinate system (CSYS) in terms of the workpiece origin.  

 

The format of the matrix table is as follows: 

 I J K D 

X I1 J1 K1 D1 

Y I2 J2 K2 D2 

Z I3 J3 K3 D3 

  

Each row represents an axis of the local CSYS. The first three columns represent the 
vector associated with each axis:  I1, J1, K1 as the positive X-axis vector; I2, J2,K2 as the 
positive Y-axis vector; and I3, J3, K3 as the positive Z-axis vector. The fourth column 
values D1, D2, D3 represent the coordinates of the origin point of the local CSYS. 

NOTE:  If you prefer to see the Matrix Table displayed with the I, J, K along the vertical 
axis and the X, Y, Z along the horizontal axis, set the environment variable, 
CGTECH_MATRIX_FORMAT=VERTICAL. 
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Update — Updates the CSYS location to reflect the matrix table transformation. After 
updating, press OK or Apply to move the object. 

Apply Inverse On Update — When selected, inverts the matrix so that its twelve 
parameters reveal the geometrical attributes of the workpiece origin in terms of the local 
(transformed) coordinate system. 
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Active Coordinate System 
Location:  Project menu > Coordinate Systems > Set Active Coord. Sys. 

  

You control the "active" coordinate system, or "CSYS", that VERICUT uses for 
simulating tool path motions, X-Caliper measurements, and sectioning models. A user-
defined coordinate system is typically used to locate an APT or CLS tool path in the 
proper orientation to the workpiece. 

To make an existing CSYS the "active" CSYS, use Project menu > Coordinate Systems > 
Set Active Coord. Sys. and select the desired CSYS from the list of available coordinate 

systems. The active coordinate system is displayed with an  at the origin as shown in 
the illustration below. 

 
Shortcut: You can also change the active coordinate system by right-clicking in the 
view, and selecting Set Active Coord. Sys.  and selecting the desired coordinate system 
from the displayed list.  

  

Use Project menu > Coordinate Systems > Define... to create additional coordinate 
systems. 
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Project Tree 
Location:  Project menu > Project Tree 

 VERICUT toolbar short cut:   

  

The Project Tree is one of the dockable windows enabling you to dock it inside the 
VERICUT main window if you choose. 

 The Project Tree shows all Setups and each Setup's configuration in a tree hierarchy. A 
project can consist of one or more setups. VERICUT processes each "active" setup 
sequentially, starting at the top of the tree.   The functionality available in the Project 
Tree duplicates the functionality available in the Project menu, but in a more visual tree 
format.  

 The following examples describe some of the information available to you from the way 
that the items in the Project Tree are displayed. 

 Project Tree Example 1:  "New" project with a single setup. 

 

The picture at the left shows the 
Project Tree for a "new" project 
containing a single setup. Since it is 
the only setup, it is by default the 
"current" setup, indicated by the 
bold text. 

  

The red text here indicates that no 
data has been assigned to any of 
these items.  

  

The initial machine is defined with 
Stock, Design and Fixture 
components but no models have 
been assigned 
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Project Tree Example 2: A project with multiple setups. 

  

  

  

  

  

The picture at the left shows the 
Project Tree for a two setup job. 
Both setups are fully defined.  

  

Setup: 1 is displayed in black text 
indicating that it is in an "active" 
state. The bold text indicated that 
Setup 1 is the "current" setup. 

  

The NC Subroutines label in Setup: 
1 is displayed in red text indicating 
that no subroutines are used for 
Setup 1. 

  

  

  

  

 

  

  

  

  

All of the items in Setup: 2 are 
displayed in red text indicating that 
Setup 2 is in an "inactive" state. 
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Each item in the Project Tree has a Right Mouse Button Shortcut menu containing 
features specific to the particular item.  

Project Branch 

Setup Branch 

CNC Machine Branch 

Control Branch 

Machine Branch 

Attach Component 

Component Branch 

Model 

Tooling 
NC Programs — displays a button enabling you to display the NC Program 
window. 

NC Program file 
NC Subroutines — displays a button enabling you to display the G-Code Settings 
window, Subroutines tab. 

 

For more information on these, and all, VERICUT Right Mouse Button Shortcut menus, 
see Right Mouse Button Shortcut menus in the Getting Started with VERICUT 
section of VERICUT Help. 
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Configuration Menu 
Machine 

Open (Machine file) 
Location:  Configuration menu > Machine > Open 

Toolbar short cut for opening Machine files:    

 

Opens a window to open (load) a Machine file. Machine files contain data that describes 
NC machine construction, kinematics, and other properties. 

Help on Samples — Opens the VERICUT Help section on "Machine files". Both library 
and sample machines are listed. Find the file you want in the on-line Help, then cut & 
paste the file name into the file selection window. For machines located in the library, set 
Shortcut=CGTECH_LIBRARY and press Open to open the file. For "sample" 
machines, set Shortcut=CGTECH_SAMPLES and press Open. 
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Save (Machine file) 
Location: Configuration menu > Machine > Save 

Toolbar short cut for saving Machine files:   

 

Saves (updates) an existing Machine file with the current NC machine settings. 
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Save As (Machine file) 
Location: Configuration menu > Machine > Save As 

Toolbar short cut for saving Machine files:   

 

Opens a window to save a Machine file. Machine files contain data that describes NC 
machine construction, kinematics, and other properties. Most features on this window are 
standard file selection window features that enable you to navigate through directories, 
filter files, and type or select file names. To save space, the features described below are 
unique to VERICUT file selection windows or this window. 

Units to Save — Controls the units (Inch or Millimeter) in which to store machine 
configuration data. If the session units are different than the units to save, then values are 
converted accordingly when stored in the new file. 
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Machine Settings (Machine Settings window) 
Location: Configuration menu > Machine Settings 

Toolbar short cut for Machine Settings window:    

 

Opens a window to configure settings for an NC machine, such as: collision checking, 
travel limits, axis priority (for rapid motion), location tables, and when machine motions 
are simulated. 

 

 
 

Machine Simulation On — When toggled "On", simulates machine tool motions when a 
3-D machine is displayed in a machine view.  

 

Shortcut: You can quickly toggle Machine Simulation On, "On" or "Off" by clicking 

on the No Machine Simulation icon  in the toolbar. 

 

Transparent Stock — When selected, displays the stock workpiece in a Machine/Cut 
Stock view as transparent while the machine is in motion. 
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Machine Up — Specifies which way is "up" (towards the ceiling) for a machine when a 
machine view displays walls in the background. (Ref. View menu > Attributes: 
Background). The up direction is relative to the machine origin. 

Collision Detect tab — Features on this tab control when collisions between machine 
components are detected, which components are protected, and tolerances used for 
detecting collisions. 

Tables tab — Features on this tab are used to specify important machine locations and 
detail tool change motion. 

Travel Limits tab — Features on this tab define how far each machine axis can go, and 
control when travel limit errors are detected. 

Axis Priority tab — Features on this tab control how machine axes move in rapid 
positioning mode (e.g. G0). 

 

OK — Applies the changes and closes the Machine Settings window. 

Apply — Applies the changes and leaves the Machine Settings window open. 

Cancel — Closes the Machine Settings window without applying changes. 
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Machine Settings window, Collision Detect tab 
Location: Configuration menu > Machine Settings 

Toolbar short cut for Machine Settings window:    

 

Features on this tab control when collisions between machine components are detected, 
which components are protected, and tolerances used for detecting collisions. (See how)  

 

 
 

Colliding components are highlighted using the red Error color, and errors are issued to 
the Log file identifying collision causing block(s) and machine components. 
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Collision Detection — When toggled "On", detects collisions between specified 
components. 

Ignore Collision between Cutter and Stock — Controls when collisions between the 
cutter and the Stock component are ignored. This feature is useful when collision 
detection is desired between the stock and shank or holder portions of the tool assembly 
in the machine view, but not with the cutter.  

Options are: 
No — (default) Does not ignore cutter-stock collisions. All collisions are reported. 

All Tools — Ignores cutter-stock collisions for all tools, even inactive tools in multi-
tool machines. 

Active Tool — Ignores cutter-stock collisions for the active tool. However, collisions 
between stock and inactive tools are detected. 

Default Near Miss — Specifies the default collision tolerance applied to all collision 
cases when Set All is pressed (see below). 

Set All — Sets the default collision tolerance for all collision cases to the Default Near 
Miss value. You can edit the supplied tolerance for individual cases. 

Component/Component collision list — Lists the component-to-component collision 
cases that are checked when collision detection is turned on. 

Component1/Component 2 — These features are used to specify the component-to-
component collision cases to check. The Near Miss value controls how close the 
components are permitted to be before reporting a collision.  

NOTE:  Do not configure for collision detection between components that move (slide 
or rotate) against each other, such as connected motion axes. In these cases, errors may 
occur each time the components move. 

Sub-Components — Toggle On/Off to include Sub-Components of 
Component1/Component2 during collision checking. 

Near Miss — Specifies the tolerance to use for collision checking. Enter a positive value 
to be alerted if components come near each other within the specified clearance, zero to 
indicate components may not touch, or a negative value if components are expected to 
collide by the specified value.  

NOTE:  "Near Miss" tolerances are not supported for collision checking against the cut 
model. The accuracy of collisions with the cut stock is dependent on the "Cutting 
Tolerance". 

 

Add — Adds a new collision case to the list. 

Delete — Deletes the selected collision case from the list. 

649649



VERICUT HELP – Configuration menu 

Machine Settings window, Tables tab 
Location: Configuration menu > Machine Settings 

Toolbar short cut for Machine Settings window:    

 

Features on the Tables tab are used to specify Machine Tables to store important machine 
locations and detail tool change motion. Machine Tables are used to specify "standard" 
data values specific to a particular machine.  

 

 
 

Tables list — A list of tables that are currently defined. The Machine Settings tables list 
will contain only "machine" tables. The G-Code Settings tables list will contain both 
"job" tables and "tool" tables. 

Add/Modify — Use to access the Add/Modify Tables window enabling you to add 
additional tables or modify existing tables. To add a table, simply click on Add/Modify. 
To modify an existing table, select the table to be modified from the Tables list and click 
on Add/Modify. (You can also "double-click" on the table in the Tables list.) 

Delete — Deletes the selected table entry from the Tables list. If it is the last entry for a 
particular table, then the table is also deleted. 

Use the G-Code Settings window: Tables tab to create Job Tables to specify values to 
override "standard" values set in a Machine Table for particular NC program file(s). 
Machine Tables values are stored in the Machine file. 
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The following Machine tables can be added or modified with the Machine Settings, 
Tables tab: 

Base Work Offset 
Initial Machine Location 
Input Machine Zero (obsolete) 
Machine Reference Location 
Tool Change Location 
Tool Change Retraction 
Work Offsets 
Input Program Zero 
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Add/Modify Tables window 
  

The following discussion applies to both the Add/Modify Machine Table window, 
accessed from the Machine Settings window: Tables tab and to the Add/Modify G-
Code Table window, accessed from the G-Code Settings window: Tables tab. 

  

 
  

Table Name — Use to identify the table to be added, or modified, if it already exists. 
The Table Name list in the Add/Modify Machine Table window will only contain 
"machine" tables. The Table Name list in the Add/Modify G-Code Table window will 
contain both "job" tables and "tool" tables. 

SubSystem ID — Use to specify ID of the machine subsystem for which the table is 
being defined. 

Register — The Register number that will be used by VERICUT to access corresponding 
table data. For "tool" tables, this number typically corresponds to a tool or offset register 
number. For "job" and "machine" tables, the Register number may correspond to an 
offset register number, or an integer value, as required by a particular table. 

SubRegister — Use of this feature enables you to access multiple sub-values for the 
same tool from tool related tables. For example, groove tools often have multiple 
"driven" points, which then correspond to multiple gage offsets, and possibly multiple 
Cutter Comp values, Tool Nose Comp values, and Tool Length Comp values. 
SubRegister is only active when the selected "Table Name" identifies a "tool" related 
table. 
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Select From/To and Enter Values: 

These features are only active for the following tables: 

Input Program Zero 
Input Machine Zero 
Base Work Offset 
Work Offsets 
RTCP Pivot Offset 
RPCP Pivot Offset 

For the above tables, VERICUT provides two ways to enter table values.  

Select From/To/Offset — Enables you to specify table values based on a "relational" 
offset between a "from" point and a "to" point. The "from" and "to" points are designated 
by specifying a particular component or CSYS. VERICUT will use the origin of the 
component/CSYS as the point. You can also specify an offset from the specified 
component/CSYS origin point. Once this relationship has been established, you can 
change the machine configuration or the location of the CSYS origin and the table values 
will updated automatically during the initial Single Step or during Play to End. 

For example:  After Input Program Zero has been defined to be the offset from the Tool 
Component to the "Program Zero" CSYS, you can change the machine configuration, or 
change the location of  "Program Zero" CSYS, and the Input Program Zero offset values 
will be updated automatically during the initial Single Step or during Play to End. 

NOTE:  The offsets are calculated based on where the corresponding origin points are 
located when all linear axes are driven to machine zero (zero with no offsets in place). 

When Select From/To is toggled "on", the From/To Feature/Name lists and the Offset 
text fields become activated. Use the From/To Feature lists to specify whether the point is 
associated with a Component or a CSYS (coordinate system). Use the From/To Name 
lists to specify a specific component or coordinate system.  

NOTE:  Only the coordinate systems that have been defined with reference to a machine 
component (i.e., visible in a Machine or Machine/Cut Stock view when Coordinate 
System axis is toggled "on") will appear in the CSYS/Names lists. See the discussion for 
Project menu > Coordinate Systems in VERICUT Help for more information on 
VERICUT Coordinate Systems. 

Use the Offset text fields to enter 3 values, separated by spaces, representing the X, Y, 
and Z offset from the specified origin point. You can also click on the "select" button, 

  and then pick a point in the graphics display area. You can pick the point in either a 
workpiece or machine view. VERICUT will calculate the Offset value between the 
selected point and the designated Feature/Name origin point. Offset is only active when 
Feature is set to Component. 

Calculate when Used — When toggled "On", VERICUT will calculate the table values, 
based on the current positions of the rotary axes, at the time that the table values are used. 

The following general guidelines should be followed regarding the use of "relational" 
offsets. 
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1. If the offsets are based on the original rotary axes orientations, or if the offsets are 
independent of the rotary axes orientations, Calculate when Used need not be 
toggled "On". 

2. If the offset is dependent on a specific rotary orientation, and you are sure that the 
rotary axes will be re-positioned before the "relational" offset is applied, Calculate 
when Used should be toggled "On" so that the correct offset is calculated based 
on the current rotary axes positions. 

NOTE:  If the offset is associated with a specific rotary orientation, and you are 
not sure that the rotary axes will be re-positioned before the "relational" offset is 
applied, then the offset must be specified in a manner which is independent of the 
rotary orientation. For example: If the offset "TO" value is a certain point on the 
stock when the stock is rotated to A90, you can MDI an A90, have the offset 
based on the A component, and then click on the corresponding point of the stock. 
This now defines the offset in a manner which is independent of the rotation on A. 

Enter Offset (or select 2 points) — When toggled "On", the Values 
(XYZABCUVWABC) text field is activated enabling you to enter one to twelve numeric 
values as required by the specific table. Multiple value entries require spaces between the 
values.  

You can also click on the "select" button,  and then pick two points in the graphics 
display area. You can pick the points in either a workpiece or machine view. VERICUT 
will calculate the Offset value between the selected points. 

For all other tables, Select From/To and Enter Offset (or select 2 points) are both 
inactive. Enter the values in the Values (XYZABCUVWABC) text field as described for 
Enter Offset (or select 2 points) above. 
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In the sample window shown above, the current table is the Work Offsets table. The 
current table entry is register "54", and contains the values "-14.95 -8 -17.27". The table 
is applicable to subsystem "1" of the machine. 
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Machine Settings window, Travel Limits tab 
Location: Configuration menu > Machine Settings 

Toolbar short cut for Machine Settings window:    

 

Features on this tab define how far each machine axis can go, and control when travel 
limit errors are detected. (See how)  

 

 
 

Overtravel errors cause the violating machine component to "light up" in the Overtravel 
Color and errors are output to the Log file identifying the problem component. 

 

 
 

Overtravel Detection On — When active, turns on overtravel detection (travel limit 
checking). Components that move beyond specified limits are highlighted in the 
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Overtravel Color and errors are issued to the Log file identifying error causing block(s) 
and machine components. 

Overtravel Color — Color in which components that move past their specified limits are 
shaded. Available shade colors are defined on the Edit menu > Colors: Define tab. 

Component Min/Max travel list — List of motion components in the machine and 
corresponding axis limits. 

Minimum / Maximum — Specifies the minimum and maximum travel limits for the 
motion axis selected in the list 

Ignore — When selected, ignores over travel checking for the corresponding axis. 

Modify — Modifies the selected component/travel entry in the list to have the values 
configured in the window. 
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Machine Settings window, Axis Priority tab 
Location: Configuration menu > Machine Settings 

Toolbar short cut for Machine Settings window:    

 

Features on this tab control how machine axes move in rapid positioning mode (e.g. G0). 
By default, machine axes are interpolated with equal priority to arrive at their destinations 
at the same time. You can change the priority to simulate non-interpolated rapid motion 
such as "dog leg" or "squared off" movement. (See how) 

 

 
 

Single — This option provides a single set of rapid priorities are used. The rapid 
priorities applied to the tool moving in the negative Z direction are the same as those 
applied to the tool moving in the positive Z direction. 

Pos/Neg — This option provides different rapid priorities depending on whether the tool 
is moving in a positive or negative Z direction. With this option, two rapid priority lists 
are provided. Use the Pos/ Neg options to control which list is seen. 

Positive / Negative options — When Pos/Neg priority is selected, these options control 
which rapid priority list is seen: the list applied when the tool is moving in the Positive Z 
direction, or the list for Negative Z tool motion. 

Axis Priority list — List of all machine motion axes and corresponding priorities. 

Priority — Priority for moving motion axes move in rapid. A value of "1" moves that 
axis first. A "2" moves the axis with secondary priority (after those with priority "1"), and 
so on. Axes having the same priority move together. 
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Interpolated — When active, interpolates axes that move together such that they arrive 
at their destination at the same time. Clear this checkbox to have axes move based on 
their defined Rapid Rate- ref. Modeling window: Component Attributes tab. 
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Component Tree (Component Tree window) 
 

VERICUT Users: 
VERICUT Location: Configuration menu > Component Tree 

VERICUT toolbar short cut:    

 

Mold and Die Users: 
Mold and Die Location:   Advanced Options page > Modeling 

Notebook Feature:      

  

Cutter Grinder Users: 
Cutter Grinder Location:   Advanced Options page > Modeling 

Notebook Feature:      

  

Opens a window that shows the "tree" of components and how they are connected, as 
well as provides a fast and easy way of manipulating components and their models. (See 
how) The component tree shows defined components by name and their connect 
positions. Indentation shows how components are connected in the tree. Select a 
component by picking its name in the tree. Actions performed using Components Tree 
window features are performed on the active (selected) component. To learn more about 
modeling and using the component tree, see "About modeling in VERICUT" in the Using 
VERICUT section. Using VERICUT can be found in the VERICUT Help Library. Always 

press Reset  after changing components in the component tree. 

Component Tree — Tree of defined components and models. Indentation indicates that 
a component is connected to a parent component. Component names are listed in bold 
text with connect position values. Models added to a component are listed beneath the 
component name. Click the + / - symbols to expand or collapse branches of items in the 
tree. 
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Sample Component Tree window: 

 
 

File menu —  

Open Machine, Save Machine and Save As Machine functions enable you to open 
or save a Machine file containing data that describes NC machine construction, 
kinematics, and other properties. 

Save Cut Stock allows you to save the highlighted "Cut Stock" model as a 
VERICUT Solid file (.vct). (See How)  This option is only active when the Cut Stock 
model is highlighted in the tree. The default file extension is .vct. 

This functionality can also be accessed using File menu > Save Cut Stock > 
VERICUT Solid. 

 

Edit menu — Functions in this menu manipulate components in the tree, as well as 
specify the component name, type, and attributes. 

Cut / Copy / Paste / Delete — Cuts, copies, pastes, or deletes a selected component 
in the component tree. All connected components and models are also affected. 
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Shortcuts:   
1. Right-click on the component in the component tree, then choose the desired 

option from the menu that appears. You can also move components via 
dragging them from one parent component to another, and copy components 
via holding down the <Ctrl> key and dragging. 

2. Delete components or models by selecting the object in the graphics area, then 
use the <Delete> key on your keyboard. 

 

Rename — Allows you to rename the selected component. Type the new component 
name. 

Component Attributes — Accesses the features on the Modeling window: 
Component Attributes tab-see that section for details. 

Component Type — Enables you to edit the component's "Type" setting which 
determines the component's function in the simulation. Select the desired "Type" 
from the pull-down list. 

Component menu — Functions in this menu Insert or Append new components to the 
selected component in the tree. The component type describes the component's function 
in the simulation. Choose the appropriate component type from the option list, based on 
the component's function in the simulation. Use Edit menu > Component Attributes to 
supply any other attributes that are needed. 

Component types: 
X Linear, Y Linear, Z Linear — Linear motion axes on an NC machine. Motion 
axes are parallel to X,Y,Z axes, respectively-but this can be changed via the Motion 
Axis component attribute. 

A Rotary, B Rotary, C Rotary — Rotary motion axes on an NC machine. The 
component origin is the pivot point of rotation. By default, rotation occurs about the 
X, Y, Z axes, respectively-but this can be changed via the Motion Axis component 
attribute. 

U Linear, V Linear, W Linear — Co-linear motion axes on an NC machine. Motion 
axes are parallel to X,Y,Z axes, respectively-but this can be changed via the Motion 
Axis component attribute. 

A2 Rotary, B2 Rotary, C2 Rotary — Secondary rotary motion axes on an NC 
machine. The component origin is the pivot point of rotation. By default, rotation 
occurs about the X, Y, Z axes, respectively-but this can be changed via the Motion 
Axis component attribute. 

A Turret, B Turret, C Turret — Indexing tool turret that rotates about X, Y, or Z 
axes. Like rotary components, the turret component origin is the pivot point for rotary 
indexing. The presence of these components cause all connected tools to be displayed 
making it possible to detect collisions resulting from turret indexing. A Turret 
component is commanded to move using a tool change command (e.g. Tn). The turret 
indexes based upon activating a Tool component connected to the turret. Tool 
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component orientation determines the tool index position in the turret. Rotary control 
settings determine how turrets rotate, e.g.: rotation direction, etc. 

Base — A non-moving component to which other components are connected. Every 
machine definition begins with this component. 

Fixture — Hardware used to hold the workpiece for machining, such as: base plates, 
clamps, bolts, vises, pallets, etc. VERICUT assumes fixtures are not to be machined. 
Cuts in a fixture are shaded using the red Error color and an error is issued to the Log 
file. 

 

 
 

Stock — Workpiece to be machined. This component type must be present in all 
simulations. 

Design — Solid or surface representation of the theoretical designed part. 

Design Point — Point representation of the theoretical designed part. 

Spindle — Spindle on an NC machine. The function of this component is different, 
depending on the machine type: milling or turning. Milling machine spindle- portion 
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of the machine where cutting tools are loaded. Turning machine spindle - rotating 
component that turns the workpiece about the machine Z-axis. 

Tool — The location where cutting tools are loaded in an NC machine. Every NC 
machine definition must include one or more of these components. 

Guide — Wire guides on a wire EDM machine. 

Electrode — Electrodes for Die Sinking Simulation (EDM machining). 

Tool Chain — The Tool Chain component is used to define and model large tool 
handling mechanisms associated with machining centers. See Toolchain Operation 
in the Using VERICUT section for more information. Using VERICUT can be found 
in the VERICUT Help Library. 

NOTE:  The ToolChain component's location, in the component tree, must not 
precede any tool component(s). An error message will be displayed during loading, 
and during resets, if the ToolChain component precedes tool component(s). 

Attach — The Attach component is used to connect "setup" components in the 
project file to the machine. 

• Setup components are saved in the project file, not the machine file. 
• Stock/fixture/design components are "setup" components 
• "Setup" components can be axes and have kinematics relationships 
• Auxiliary devices can be connected to the Attach component 

How does the "Attach" component work? 

• A machine must have at least one Attach component, but multiple Attach 
components are allowed. If none is found, one is automatically created at the 
end of the first non-tool branch of the machine kinematics tree. 

• Components are contained in both in the machine, and in the setup. 
• A parent component in a "setup" references an Attach component in a 

machine. 

Other — Any non-moving component not represented by one of the preceding types. 
This component type is often used to define housings, gear boxes, shields, etc. 

NOTES: 
1. Right-click shortcut menu: Features used to manipulate components are 

displayed in a shortcut menu when you right-click on a component in the 
Component Tree window. Similarly, features used to manipulate models are 
displayed when you right-click on a model in the tree. 

2. Double-clicking on a model or component in the Component Tree window 
opens the Model Definition window. 

3. You can move objects in the Component Tree window via dragging them 
from one parent component to another, or copy them via holding down the 
<Ctrl> key and dragging. 
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4. Click repeatedly on a model in the graphics area to toggle selection between 
the model and its component. Refer to the Component Tree window to review 
what is selected. 

5. Using the center mouse button of a three button mouse, click repeatedly on a 
model in the graphics area to toggle selection between different models along 
the line of sight from the pick point. Use this technique to select models 
hidden from view by an object in the foreground. 

6. After cutting, a "Cut Stock" model appears as  in the Component 
Tree window. This object can be manipulated using modeling features just 
like any other component or model, allowing you to easily relocate the 
workpiece for additional machining. You can also save the "Cut Stock" model 
as a VERICUT Solid file (.vct). 
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Control 

Open (Control file) 
Location: Configuration menu > Control > Open 

Toolbar short cut for opening Control files:     

 

Opens a window to open (load) a Control file. Control files contain data that describes 
how the NC control processes machine code data. 

Help on Samples — Opens the VERICUT Help section on "Library Control Files". 
Assuming Shortcut=CGTECH_LIBRARY, you can find the file you want in the on-line 
Help, then cut & paste the file name into the file selection window and press Open to 
open the file. 
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Save (Control file) 
Location: Configuration menu > Control > Save 

Toolbar short cut for saving Control files:    

Saves (updates) an existing Control file with the current NC control settings. 
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Save As (Control file) 
Location: Configuration menu > Control > Save As 

Toolbar short cut for saving Control files:   

 

Opens a window to save a Control file. Control files contain data that describes how the 
NC control processes machine code data. Most features on this window are standard file 
selection window features that enable you to navigate through directories, filter files, and 
type or select file names. To save space, the features described below are unique to 
VERICUT file selection windows or this window. 

Units to Save — Controls the units (Inch or Millimeter) in which to store control 
configuration data. If the session units are different than the units to save, then values are 
converted accordingly when stored in the new file. 
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Word Format (Word Format window) 
Location: Configuration menu > Word Format 

VERICUT toolbar short cut:   

 

Opens a window enabling you to specify how the NC control interprets G-code words 
and special characters. (See how) Once words are defined, they can be "grouped" with 
address values via the Configuration menu > Word/Address function to perform 
specific actions by calling CGTech supplied or custom macros. Undefined words cause 
errors when processed, and are not acted on by VERICUT. 

 

 
 

NOTE:  Always reset VERICUT (press  on the VERICUT main window) after 
making changes to the control configuration. 

Word Table — List of machine code, or "G-code" data words and characters that are 
interpreted by the control, arranged in alphabetical order. The list provides a summary of 
word types, sub-types, inch and metric formats, and multipliers and composite formats. 
See Word Table Features below. 

 

Add — Adds a record to the Word Table enabling you to add words or special characters 
to the control configuration.  

Delete — Deletes the highlighted word record from the control configuration. 

OK — Saves additions/modifications and dismisses the Word Format window. 

Apply — Saves additions/modifications and leaves the Word Format window open. 

Cancel — Closes the Word Format window without saving any additions/modifications. 
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Word Table Features 
 

Each column in the Word table represents a specific feature that enables you to define 
how the NC control interprets specific G-code words or special characters. (See how) 

Name — Identifies the word or special character. Each word name must be unique. 

Type — Specifies the type of control function performed by the word. Options: 

Logical — Evaluates a logical expression. See "Logical Sub-type" below for more 
detailed classifications. 

Special — Accesses special NC control functions. See "Special Sub-type" below for 
more detailed classifications. 

Math — Performs a mathematical operation. See "Math Sub-type" below for more 
detailed classifications. 

Function — Calls the control function specified in the Function Name field. 

Type II — Specifies that the word is a three character mnemonic representing a Type II 
data command, e.g. "AXO", "CLS", etc. 

Macro — Word will be paired with a value, then configured via the Configuration 
menu> Word/Address function to call one or more action macros. 

Conditional — Similar to the Functions word type, except performs multiple functions, 
depending on the condition of word use. Conditional words are typically supported by 
special routines written by CGTech or other developers to evaluate word use. 

Sub Type — Sub-types further differentiate word functions. Available sub-types are 
dependent on the word Type.  

Logical Sub Type — Options for evaluating logical expressions: 

Equal 
Not Equal 
Greater than 
Greater Than or Equal 
Less Than 
Less Than or Equal 
AND 
OR 

Special Sub Type — Options for performing special control functions. Click on the 
record "Sub Type" field and select from the list of available options in the pull-down 
menu. 

Skip — Skip remaining data in block. 

Begin Data / End Data — Denotes the beginning (or ending) of G-code data to 
be processed by the control. If a Begin Data special word is defined with out 
specifying an End Data word, the Begin Data word is used for both. 

670670



VERICUT HELP – Configuration menu 

Begin Comment / End Comment — Denotes the beginning (or ending) of a 
comment record. 

Begin Type II / End Type II — Denotes the beginning (or ending) of a Type II 
format record. 

Separator — Character used to separate data that is acted on differently by the 
control, for example a list of arguments or values. 

Variable Tag — Character which identifies the number that follows as a variable 
register number, e.g. "#". Example- "#100" indicates variable register number 
"100" is being referenced. 

Variable Name — Alpha-numeric word that identifies a variable which does not 
have an associated variable register number, e.g. "PPX" (type II variable format). 

End of Block — Denotes the end of the G-code data block. 

Console Message — Identifies the block as a message displayed on the machine 
operator's console. 

Quoted Text — Identifies start/end delimiter for a quoted text string.  The default 
character for delimiting a quoted text string is the double quote (").  If a different 
character(s) is used as a delimiter, it must be defined as a SPECIAL type word 
with a sub-type of Quoted Text. Quoted text is valid in Alpha-Numeric and List-
Alpha-Numeric Word Value types. 

Ignore — Ignores specific words in the tool path file. 

Sin840D CASE — When this word is found, a special 840D parser will be used 
to process the remainder of the block. See "Notes about the Siemens 840 CASE 
and REPEAT commands" in the Using VERICUT section. Using VERICUT can 
be found in the VERICUT Help Library. 

Sin840D DEF — When this word is found, a special 840D parser will be used to 
process the remainder of the block. See "Notes about the Siemens 840 DEF 
command" in the Using VERICUT section. Using VERICUT can be found in the 
VERICUT Help Library. 

Sin840D REPEAT — When this word is found, a special 840D parser will be 
used to process the remainder of the block. See "Notes about the Siemens 840 
CASE and REPEAT commands" in the Using VERICUT section. Using 
VERICUT can be found in the VERICUT Help Library. 

Math Sub Type — Options for performing math operations. Click on the record 
"Sub Type" field and select from the list of available options in the pull-down menu. 

Add 

Subtract 

Multiply 

Divide 

Power 
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Left Precedence 

Right Precedence 

Assignment 

Mod   
The Mod math operation is calculated as follows:  

N - D * INT(N/D) ==> -382 - 180 * INT(-2.12222) ==> -382 - 180 * -2 
==> -22 <-- TRUNC Returns Integer part of number) 

The Mod operator will produce the following results: 

382 Mod 180 = 22 

-382 Mod 180 = -22 

10 Mod 3 = 1 

10.1 Mod 3 = 1.1 

Function Sub Type — The control function that is called when the word is 

processed. Click on  in the record "Sub Type" field and select from the list of 
available options in the pull-down menu. See Functions – Listed Alphabetically 
below.  

You can also enter the name of a "custom" mathematical function, created with the 
CGTech Macro Language (CML), in the Sub Type text field as these will not 
appear in the pull-down list. 

NOTE:  The only time a value should ever be typed in is if it is a CMS function. 

Type II Sub Type — Describes syntax expected in a "Type II" command. Enter one 
or more of the descriptors listed below in the "Sub Type" text field to describe the 
expected syntax. Descriptors used in combinations are separated by commas. 

WV — word/value pair, e.g. "X1" 

T — text string 

V — numeric value 

 

EXAMPLES: 

1. Configuration for set axis offsets command "(AXO,X1,Y2,Z3)": 

Name=AXO 
Type= Type II 
Sub Type = WV,WV,WV 

2. Configuration for call subroutine command "(CLS,SUB1)": 

Name=CLSType= Type II 

Sub Type= T,V,V,V,V,V 
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NOTE:  The "V" descriptors shown in the example above, allow passing 
variables to the subroutine, although none are being passed in the above call 
example. 

Macro Sub Type — Specifies how the control interprets values, or "addresses" that 
follow the word. Click on the record "Sub Type" field and select from the list of 
available options in the pull-down menu. 

Numeric — Interprets word values as numbers. The system reads the numeric 
characters following the macro word until a non-numeric character is found, for 
example: alphabet, symbol, or separator. The non-numeric character indicates the 
beginning of a new word. 

Alphabet — Interprets word values as alphabet characters. The system reads the 
alphabet characters following the macro word until a non-alphabetic character is 
found, for example: number, symbol, or separator. 

Alpha-Numeric — Interprets word values as an alpha-numeric text string. The 
system reads the characters following the macro word until a symbol or separator 
character is found. 

Composite-Numeric — Separates word values into pieces which can be 
individually acted on. The system uses the Composite Format to "parse" the 
numeric characters following the word until a non-numeric character is found, for 
example: alphabet, symbol, or separator. See Composite Format for examples. 
Each separated piece of a composite-numeric word/value is available for calling 
macros via the Configuration menu > Word/Address function, and can be 
graphically selected from a word pick list. 

List-Numeric — Separates an argument list following the word into pieces which 
can be individually acted on. This option is useful in a situation like acting on "n" 
values differently in the sample codes: TEXT(n,n,n,n,...) or TEXT n,n,n,n,... 
Parens may be present but are not required, and commas separate the arguments. 
Up to 32 arguments can be listed. Each argument must be numeric, or a math 
expression which equates to a numeric value. Similar to Composite-Numeric 
value types, each separated piece of a list-numeric word/value is available for 
calling macros. However, these pieces do not appear in the word pick list. Specify 
the pieces via listing the word followed by a space and the sequential number of 
the argument in the list. Following the above example, you could use the 
Configuration menu > Word/Address function to associate macros with "TEXT 
1" (corresponds to the first "n" parameter value, "TEXT 2" (second "n" 
parameter), and so on. 

List-Alpha-Numeric — Same as above description for List-Numeric with one 
addition. The value may be a quoted-text string. In this case the quoted-text is not 
analyzed, and is just passed as text to an associated  Word/Address macro.  

None — Word does not have an associated value. The first character after the 
word indicates the beginning of a new word. 
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EXAMPLES: 
1. Assume the word "PGM" is defined as a Macro word type. The table below 

shows how Sub Type can affect the interpretation of the values paired with 
"PGM". 

Sample data 
block 

Sub Type= 

Numeric 

Sub Type= 

Alphabet 

Sub Type= 

Alpha-Numeric 

Sub Type= 

None 

PGM123ABC 123 none 123ABC none 

PGMABC123 none ABC ABC123 none 

 

2. Consider interpreting the following block of data: "TEST(10,20,30)"  

In Word Format, add word "TEST" as follows: 

Name=TEST 
Type=Macro 
Sub Type=List-Numeric 

In Word/Address, add group to act on first argument in TEST list "10": 

Word=TEST 1 
Range=* 
Macroname=<desired macro> (group is passed a value of "10") 
and then add groups to act on second & third arguments in TEST list "20" and 
"30": 
Word=TEST 2 
Range=* 
Macroname=<desired macro> (passed value: "20") 
  
Word=TEST 3 
Range=* 
Macroname=<desired macro> (passed value: "30") 

  

Conditional Sub Type — The conditional control function that is called when the 

word is processed. Click on  in the record "Sub Type" field and select from the 
list of available options in the pull-down menu. See Conditionals – Listed 
Alphabetically below. You can also enter the name of a "custom" conditional 
function, created with the CGTech Macro Language (CML), in the Sub Type text 
field as these will not appear in the pull-down list. 

NOTE:  The only time a value should ever be typed in is if it is a CMS conditional. 
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Inch Method — Specifies how to interpret inch address values. This feature is 
significant only for values that do not contain a decimal point. Values with a decimal are 
always interpreted via the "Decimal" method. See NOTE below. 

Options: 
Decimal — Interprets values as floating point decimals. 

Leading or Decimal — Interprets values without a decimal as having leading zeros. 
Depending on the active unit system (inch or metric), values are interpreted as 
described by the corresponding "Format" (see below). 

Trailing or Decimal — Similar to Leading or Decimal, except interprets values as 
having trailing zeros. 

 

Inch Format — Specifies the number of digits before and after the decimal point when 
interpreting Inch Method, "leading", or "trailing" zero values. Data entry format is: a.b 
where "a" specifies the number of digits before, and "b" specifies the number of digits 
after the decimal point. See NOTE below. 

Metric Method — Specifies how to interpret metric address values. This feature is 
significant only for values that do not contain a decimal point. Values with a decimal are 
always interpreted via the "Decimal" method. See Inch Method, above, for list of 
options. See NOTE below. 

Metric Format — Specifies the number of digits before and after the decimal point 
when interpreting Metric Method, "leading", or "trailing" zero values. Data entry format 
is: a.b where "a" specifies the number of digits before, and "b" specifies the number of 
digits after the decimal point. See NOTE below. 

Multiply / Multiplier — When Multiply is set to "Yes", the word value is multiplied by 
the amount specified in the Multiplier field. (Note that a multiplier of "1" has no affect on 
the word value.) 

NOTE:  Only available when Type = Macro or Type = Conditional) 

 

Composite Format — Specifies how to break up, or "parse" Composite-Numeric value 
types. Enter one or more numbers separated by spaces to specify the quantity of parsed 
number values and the significant places of each. An asterisk "*" can be used as a wild 
card entry. Each parsed value appears in the word pick list of the Configuration menu > 
Word/Address function to perform individual actions. 
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EXAMPLE: 
Parsing "T" word/values: 

Sample data 
block 

Composite 
Format 

Parsed values 

T0203 2 2 T=203, T1=02, T2=03 

T102 1 2 T=102, T1=1, T2=02 

T0304 or T304 * 2 T=304, T1=03, T2=04 

T10001 * 2 T=10001, T1=100, T2=01 

T102 1 1 1 T=102, T1=1, T2=0, T3=2 

T12345678 2 * 2 T=12345678, T1=12, 
T2=3456, T3=78 

T102.3 * 2.1 T=102.3, T1=1, T2=02, 
T3=3 

T102.3 2.1 T=102.3, T1=10, T2=3 

T12345678.321 2 2.2 T=12345678.321, T1=12, 
T2=34, T3=32 
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Conditionals - listed alphabetically 
 
The conditionals which can be referenced via Configuration menu > Word Format are 
listed below in alphabetical order. Conditionals are passed the text string of the current 
block, up to and including the current word, and returns a word type specifying how the 
current word is to be interpreted (typically identified by the characters "Cond" in the 
function name) 
 

Conditionals 
 
AbCondEqual 
This function determines if the "=" should be interpreted as an assignment or as a logical 
operator. If the "=" is part of a IF or GTO Type II comand, it will be defined as a logical 
operator. Otherwise, it will be determined as an assignment operator. 
 

AbCondLeftParen 
Conditional function that looks at the next two characters to determine if it is a known 
"TYPE II" command. If the following 2 characters are: AB, AP, AT, CC, CL, CN, CS, 
CY, FA, KB, MD, MI, MT, NS, QU, RN, TA, TB, TC, TS, TT, or ZT, then the left paren 
is interpreted as the beginning of a type II command. Otherwise it is interpreted as a 
comment. 
 

AbCondRightParen 
If a comment is currently being processed, then the right paren is interpreted as an "END 
COMMENT" special control word. Otherwise it is interpreted as an "END TYPEII" 
word. 
 

AtanCondDivide 

AtanCondDivide(block_str) 
If the "/" symbol is part of a ATAN argument and its is not imbedded within brackets ([ 
]), then this function returns the type SEPARATOR. Otherwise this function returns the 
type DIVIDE. 
 

CinciCondEqual 
If G10 exists in the block, ignore the current word. If G11 exists in the block, interpret 
the current word as a logical EQUAL. Otherwise, interpret the current word as an 
assignment.
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CinciCondLeftBracket 
If the previous character was "T", ignore the current word. Otherwise, interpret the 
current word as a LEFT PRECEDENCE. Requires values to be initialized by the 
CinciBlockInit macro. 
 

CinciCondLeftParen 
Returns "Begin Type II" if a Type II command follows. Otherwise returns "Left 
Precedence". Requires values to be initialized by the CinciBlockInit macro. 
 

CinciCondRightBracket 
The current word will be either ignored or interpreted as a RIGHT PRECEDENCE 
depending on how the matching CinciCondLeftBracket was interpreted. Requires 
values to be initialized by the CinciBlockInit macro. 
 

CinciCondRightParen 
Returns "End Type II" if currently processing a Type II command. Otherwise returns 
"Right Precedence". Requires values to be initialized by the CinciBlockInit macro. 
 

CinciCondTWord 
If the current word was preceded by a "[", interpret the current word as a VARIABLE 
TAG. Otherwise, interpret the current word as a MACRO. 
 

CinciCondVWord 
Returns "Assignment" if G10 is in the block. Otherwise returns "Command". 
 

CycleCondPWord 
Sets P_1 (default) or P_2 after checking the context of the block containing the P-word. 
P_2 is set when the block contains a G76 and either X, Y, U or W words. 
 

CycleCondQWord 
Sets Q_1 (default) or Q_2 after checking the context of the block containing the Q-word. 
Q_2 is set when the block contains a G76 and either X, Y, U or W words. 
 

CycleCondRWord 

Sets R_1 (default) or R_2 after checking the context of the block containing the R-word. 
R_2 is set when the block contains a G74, G75, G76 and either X, Y, U or W words. 
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CycleCondUWord 
Sets U_1 (default) or U_2 after checking the context of the block containing the U-word. 
U_2 is set when the block contains a G71, G72, G73 and either P or Q words. 
 

CycleCondWWord 
Sets W_1 (default) or W_2 after checking the context of the block containing the W-
word. W_2 is set when the block contains a G71, G72, G73 and either P or Q words. 
 

FadalCondAsteriskWord 
FadalCondAsteriskWord(block_str) 
If the Asterisk Word comes after a "#" character, then this function returns the type 
MULTIPLY. Otherwise this function returns the type COMMENT. 
 

FadalCondEqualWord 
FadalCondEqualWord(block_str) 
If the Equal Word comes after the string “IF”, then this function returns the type EQ . 
Otherwise, this function returns the type ASSIGNMENT. 
 

FadalCondLParenWord 
FadalCondLParenWord(block_str) 

If the Left Parenthesis Word comes after a "#" character, then this function returns the 
type LPAREN. Otherwise this function returns the type COMMENT. 
 

FadalCondNWord 
FadalCondNWord(block_str) 
If the N Word comes after a "#" character, then this function returns the type IGNORE. 
Otherwise this function returns the type COMMAND. 
 

FadalCondRParenWord 
FadalCondRParenWord(block_str) 
If the Right Parenthesis Word comes after a "#" character, then this function returns the 
type RPAREN. Otherwise this function returns the type END_COMMENT. 
 

FadalCondRWord 
FadalCondRWord(block_str) 
If the R Word comes after a “G” character, then this function returns the type 
COMMAND. Otherwise this function returns the type VARIABLE_TAG. 
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GLCondPWord 
GLCondPWord(block_str) 
If the P word is part of a PDO command, in CYCLE mode, or if the next non-space 
character on the block is a "=", then this functions returns the type COMMAND. 
Otherwise this function returns the type VARIABLE_TAG. 
 

GLCondPWord2 
GLCondPWord2(block_str) 
The P word can either be part of a COMMAND, or a VARIABLE_TAG. If P is part of a 
VALUE argument of a TYPE II command, or is preceded by =, +, -, *, /, [, or (, then the 
P will be interpreted as a VARIABLE TAG. If an integer value does not follow the P, 
then the P will be interpreted as a COMMAND. If the integer number is followed by a =, 
+, -, *, /, ], or ), then the P will be interpreted as a VARIABLE TAG. Otherwise the P 
will be interpreted as a COMMAND. This conditional function is an alternative to 
GLCondPWord. You can use which ever function produces the correct results for you. 
 

HeidCondDivide 

• Conditional function which determines how a "/" character is to be interpreted. 
• If a "REP" preceeds the "/" on the line, then it will be interpreted BEGIN 

COMMENT.  
• If a "CYCL DEF 14.1" preceeds the "/" on the line, it is recognize as a list 

separator used between contour subroutines. See "Notes about simulating 
Heidenhain SL pocket cycles" in the Using VERICUT section for additional 
information. Using VERICUT can be found in the VERICUT Help Library. 

• Otherwise it will be interpreted as DIVIDE. 
 

KtCondLeftParen 

KtCondRightParen 
KtCondLeftParen(), KtCondRightParen() 
These functions support the "(" and ")" words when used as mathematical precedence and 
as Begin Type 2 data. 
 

NumCondAWord 
NumCondAWord(block_str) 
If the non-white space character immediately preceding the A Word is a "=", "<" , ">", 
"+", "-", "*", "/", "&", or "!", it is interpret as type FUNCTION, and sets the word to 
mathematical function ATAN. Otherwise the word is interpreted as a COMMAND (or 
MACRO). 
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NumCondCWord 
NumCondCWord(block_str) 
If the non-white space character immediately preceding the C Word is a "=", "<" , ">", 
"+", "-", "*", "/", "&", or "!", it is interpret as type FUNCTION, and sets the word to 
mathematical function COS. Otherwise the word is interpreted as a COMMAND (or 
MACRO). 
 

NumCondDollarSignWord 
NumCondDollarSignWord(block_str) 
If the Dollar Sign Word comes after a "=", and the character "L" or "E" is present, then 
this function returns the type FUNCTION, and sets the word to NUM_INPUT. Otherwise 
this function returns the type CONSOLE_MSG. 
 

NumCondEqualWord 
NumCondEqualWord(block_str) 
If the Equal Word comes after the string "G79" or the string "IF", then this function 
returns the type EQ. Otherwise, this function returns the type ASSIGNMENT. 
 

NumCondEWord 
NumCondEWord(block_str) 
If the E Word comes after a number, or if it begins the block , then this function returns 
the type VARIABLE_TAG. Otherwise this function returns the type FUNCTIONS, and 
sets the word to E_FUNC. 
 

NumCondRWord 
NumCondRWord(block_str) 
If the non-white space character immediately preceding the R Word is a "=", "<" , ">", 
"+", "-", "*", "/", "&", or "!", it is interpret as type FUNCTION, and sets the word to 
mathematical function SQRT. Otherwise the word is interpreted as a COMMAND (or 
MACRO). 
 

NumCondSWord 
NumCondSWord(block_str) 
If the non-white space character immediately preceding the S Word is a "=", "<" , ">", 
"+", "-", "*", "/", "&", or "!", it is interpret as type FUNCTION, and sets the word to 
mathematical function SIN. Otherwise the word is interpreted as a COMMAND (or 
MACRO). 
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NumCondTWord 
NumCondTWord(block_str) 
If the non-white space character immediately preceding the T Word is a "=", "<" , ">", 
"+", "-", "*", "/", "&", or "!", it is interpret as type FUNCTION, and sets the word to FIX. 
Otherwise the word is interpreted as a COMMAND (or MACRO). 
 

OkumaCondNWord 
OkumaCondNWord(block_str) 
This function internally redefines the "N" word during parsing depending upon how it is 
being used: 

• If the next non-space character is numeric and the string "IF" or "GOTO" existed 
previously on the line, then this routine returns the type CONDITIONAL, and sets 
the word to N_GOTO_LABEL. 

• If the next non-space character is numeric and the string "IF" or "GOTO" does not 
previously exist on the line, then this routine returns the type CONDITIONAL, 
and sets the word to N_LABEL. 

• If the next non-space character is not numeric, and the string "IF" or "GOTO" 
existed previously on the line, then this routine returns the type CONDITIONAL, 
and sets the word to N_GOTO_SEQ. 

 
For this functionality to work, the following words must be defined in the Configuration 
menu > Word Format window: 

• Name=N, Type=Conditional, Function Name=OkumaCondNWord 
• Name=N_GOTO_LABEL, Type=Macro, Value Type=Alpha-Numeric 
• Name=N_GOTO_SEQ, Type=Macro, Value Type=Numeric, Inch Method/Metric 

Method=Decimal 
• Name=N_LABEL, Type=Macro, Value Type=Alpha-Numeric 

 
Then, the Configuration menu > Word/Address function must also be configured to 
process the above-listed words, for example in the "Specials" class: 

• Word=N Range=*, Condition=* *, Macroname=Sequence, Scan=Yes, After=No 
• Word=N_GOTO_LABEL Range=*, Condition=* *, Macroname=LabelName & 

GotoLabel, Scan=No, After=No 
• Word=N_GOTO_SEQ Range=*, Condition=* *, Macroname=GotoJump, 

Scan=No, After=No 
• Word=N_LABEL Range=*, Condition=* *, Macroname=LabelMacro, 

Scan=Yes, After=No 
 

OliCondLeftParent 
OliCondLeftParent(block_str) 
If the Left Parenthesis Word comes after a "=" character, then this function returns the 
type LPAREN. Otherwise this function returns the type BEGIN_TYPEII. 

 

682682



VERICUT HELP – Configuration menu 

OliCondRightParent 
OliCondRightParent(block_str) 
If the Right Parenthesis Word comes after a BEGIN_TYPEII word, then this function 
returns the type END_TYPEII. Otherwise this function returns the type RPAREN. 
 

Siemens3RCond 
Siemens3RCond(block_str) 
Same as SiemensRCond(block_str), except it also looks to see if the @ command had 
finish prior to this point in the block. It does this by looking backwards from the current 
point, and checking to see if a non-operator, non-R, non-digit character exists between 
the current point and the @ command. When the R word is used as a command, it 
typically calls the VariableArgument macro. This sets up the addition arguments that are 
then processed by the specific Siemens macro. 
 

SiemensCondLParenWord  
SiemensCondLParenWord() 
If MCALL is on the line, the word type is set to Left Precedence, otherwise it is set to 
Begin Comment. 
 

SiemensCondRParenWord 
SiemensCondRParenWord() 
If MCALL is on the line, the word type is set to Right Precedence, otherwise it is set to 
End Comment. 
 

SiemensRCond 
SiemensRCond(block_str) 
If the R Word comes after a "@" character, then this function returns the type 
COMMAND. Otherwise this function returns the type VARIABLE_TAG. 
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Functions - listed alphabetically 
 
The functions which can be referenced via Configuration menu > Word Format are 
listed below in alphabetical order. Functions are typically passed a single numerical 
value, and return a numerical value. 
 

Functions 
 

abs 
abs(value) 
Returns the absolute value of the specified value. 
 

AbsoluteDimension 
This new functions will handle formats like:  X=AC[2] Y=IC[3] Z=AC[2] I=AC[1] 
J=AC[2] where "[" and "]" are the left and right precedence words.  In the above format, 
AC and IC should be defined as words which then call the function. 
  

If the primary word is X,Y,Z,A,B,C,U,V,or W then:  
AbsoluteDimension will cause the specified value to be interpreted as absolute, 
and if the control is currently in incremental mode, it will convert it.   

If the primary word is I,J, or K then: 
AbsoluteDimension will use the absolute mode, the "Circle Center Mode" 
settings, and the "Incremental Circle Center Method" settings to determine how to 
convert the value.  

If the primary word is anything other then the above, no conversion will be executed, 
and the incoming value will be returned. 
 
Also see: IncrementalDimension 

 

acos_d 
acos_d(value) 
Returns the arc cosine of the specified value. The specified value must be in the range of 
-1.0 to 1.0. The return value is in degrees, and is in the range of 0.0 to180.0. 
 

acos_r 
acos_r(value) 
Returns the arc cosine of the specified value. The specified value must be in the range of 
-1.0 to 1.0. The return value is in radians, and is in the range of 0 to pi. 
 

asin_d 
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asin_d(value) 
Returns the arc sine of the specified value. The specified value must be in the range of -
1.0 to 1.0. The return value is in degrees, and is in the range of -90.0 to 90.0. 

asin_r 
asin_r(value) 
Returns the arc sine of the specified value. The specified value must be in the range of -
1.0 to 1.0. The return value is in radians, and is in the range of -pi/2 to pi/2. 
 

atan2_d 
atan2_d(yvalue, xvalue) 
Returns the arc tangent of yvalue/xvalue. The return value is in degrees, and is in the 
range of -180.0 to 180.0. If yvalue and xvalue are both zero, the return value will be zero. 
 

atan2_r 
atan2_r(yvalue, xvalue) 
Returns the arc tangent of yvalue/xvalue. The return value is in radians, and is in the 
range of -pi to pi. If yvalue and xvalue are both zero, the return value will be zero. 
 

atan_d 
atan_d(value) 
Returns the arc tangent of the specified value. The specified value must be in the range of 
-1.0 to 1.0. The return value is in degrees, and is in the range of -90.0 to 90.0. 
 

atan_r 
atan_r(value) 
Returns the arc tangent of the specified value. The specified value must be in the range of 
-1.0 to 1.0. The return value is in radians, and is in the range of -pi/2 to pi/2. 
 

ceil 
ceil(value) 
Returns the least integral value greater than or equal to the specified value. 
 

cosh_d 
cosh_d(angle) 
Returns the hyperbolic cosine of the given angle specified in degrees. 
 

cosh_r 
cosh_r(angle) 
Returns the hyperbolic cosine of the given angle specified in radians. 
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cos_d 
cos_d(angle) 
Returns the cosine of the given angle specified in degrees. 
 

cos_r 
cos_r(angle) 
Returns the cosine of the given angle specified in radians. 
 

exp 
exp(power) 
Returns the natural logarithm "e" raised to the specified power. 
 

floor 
floor(value) 
Returns the greatest integral value less than or equal to the specified value. 
 

Fractional 
Fractional(value) 
Returns the fractional portion of the specified value. 
 

get_current_N_seqno 
get_current_N_seqno() 
Returns value of the current N word. If the N word was not specified on the current line, 
the value of the last specified N word is returned. 
 

IncrementalDimension 
This new function will handle formats like:  X=AC[2] Y=IC[3] Z=AC[2] I=AC[1] 
J=AC[2] where "[" and "]" are the left and right precedence words.  In the above format, 
AC and IC should be defined as words which then call the function.  
 

If the primary word is X,Y,Z,A,B,C,U,V,or W then:  
IncrementalDimension will cause the specified value to be interpreted as 
incremental, and if the control is currently in absolute mode, it will convert it.   

If the primary word is I,J, or K then: 
IncrementalDimension will use the incremental mode, the "Circle Center Mode" 
settings, and the "Incremental Circle Center Method" settings to determine how to 
convert the value.  

If the primary word is anything other then the above, no conversion will be executed, 
and the incoming value will be returned. 
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Also see: AbsoluteDimension 
 

lntTrunc 
lntTrunc(value) 
Returns the integer portion of the specified value. 
 

ln 
ln(value) 
Returns the natural logarithm of the specified value. The specified value must be positive 
otherwise zero is returned. 
 

log 
log(value) 
Returns the base 10 logarithm of the specified value. The specified value must be positive 
otherwise zero is returned. 
 

NumAtan 
NumAtan(value) 
Similar to atan2_d(yvalue, xvalue), except the return value is in thousandths of a degree. 
 

NumEFunc 
NumEFunc(value) 
If the variable is being assigned to a COMMAND word, a "NUM" specific factor is 
applied to the value of the variable. 
 

NumInput 
NumInput() 
Causes the program to prompt the user for input. If the first character of input is a-z or A-
Z, a value of 1-26 is returned. If the user enters a numeric value, the value entered will be 
returned. 
 

Round 
Round(value) 
Returns the integral value closest to the specified value. 
 

SiemensAxName 
Passed the name of an AXIS, and returns the AXIS (an integer value). 
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SiemensAxString 
Passed an AXIS value, and returns the AXIS name (a string value). 
 

sinh_d 
sinh_d(value) 
Returns the hyperbolic cosine of the given angle specified in degrees. 
 

sinh_r 
sinh_r(value) 
Returns the hyperbolic cosine of the given angle specified in radians. 
 

sin_d 
sin_d(value) 
Returns the cosine of the given angle specified in degrees. 
 

sin_r 
sin_r(value) 
Returns the cosine of the given angle specified in radians. 
 

sqr 
sqr(value) 
Returns the square of the specified value. This function can be used with the word list to 
process statements like:  #1 = SQR(#2 + #3) 
 

sqrt 

sqrt(value) 
Returns the square root of the specified value. 
 

tanh_d 
tanh_d(angle) 
Returns the hyperbolic tangent of the given angle specified in degrees. 
 

tanh_r 
tanh_r(angle) 
Returns the hyperbolic tangent of the given angle specified in radians. 
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tan_d 
tan_d(angle) 
Returns the tangent of the given angle specified in degrees. 
 

tan_r 
tan_r(angle) 
Returns the tangent of the given angle specified in radians.  
 

ToolnumToPocket 
Returns the pocket number given the tool number. Specifically, it searches the tool list for 
the first matching cutter tool id, and returns the corresponding pocket number. If no list 
exist, or if the list is not based on pocket numbers, or if no matching entry can be found, 
the function will return the tool number. 
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Word Address (Word/Address window) 
Location: Configuration menu > Word/Address 

VERICUT toolbar short cut:   

 

Opens a window to "group" G-code words previously defined via Configuration menu > 
Word Format with a range of address values, and associate them with action macros to 
simulate an action in the control, or on the machine. (See how) For simplicity, we'll call 
each of these address/value associations a "group". Each group can be configured to call 
one or more action macros. This functionality allows you to virtually "wire" a custom NC 
control based on machine code information present in the tool path file. Groups with 
similar functions are arranged into a "class". (See how) The listed order of classes in the 
Word/Address window helps determine the timing of when corresponding actions occur. 

 

 
  

The Word/Address window consists of a "menu bar" and a "tree structure" representing 
the configuration of a particular NC control. 

 

The Menu Bar 
File 
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Open — Opens a window enabling you to open (load) a control file. Provides the same 
function as Configuration menu > Control > Open.  

Save — Saves (updates) an existing Control file with the current NC control settings. 
Provides the same function as Configuration menu > Control > Save. 

Save As — Opens a window enabling you to save the current control file under a 
different name or path. Provides the same function as Configuration menu > Control > 
Save As. 

Close — Closes the Word Address window without saving the control file. 

 

Edit 
Add/Modify — Opens the Add/Modify Word/Address window enabling you to add or 
modify groups within the control configuration. 

Cut — Enables you "cut" the object highlighted in the control configuration. 

Copy — Enables you "cut" the object highlighted in the control configuration. 

Paste — Enables you "paste" a previously "cut" or "copied" object after the object 
highlighted in the control configuration. 

NOTE:  When you "Cut", "Copy", or "Paste" an object in the "tree", all objects below 
it in that particular "branch" (children) are cut, copied, or pasted with it. 

 

Utilities 
Find — Opens the Find Word window enabling you to find the groups in a control 
configuration that are associated with a specific word/address value, or call specific 
macros. 

Validate — Opens the Word/Address Validate window enabling you to validate the 
control configuration.  

 

The Control Configuration 
Object Hierarchy 

 
  

The illustration above shows an expanded "group" from the configuration "tree". The top 
level object, "Specials", represents a "class". The second level object (or branch), 
"Variable: 3000 *", represents "Word/Variable and Range", in this case Variable and 
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Range. The third level object (branch), "**", represents a "conditional 
Word/State/Variable and conditional Range/Value ". The lowest level objects (branches), 
"AlarmSignal" and "EndProgram", represent Macro/Variable Names with associated 
data. Each lower level (or branch) is considered to be "a child or children" of the next 
higher level. 

 

Configuration "tree" 
The control configuration of a particular NC control is displayed as a "tree" structure. 
When you expand a "class" object, the "Word/Range" branch shows the word/address of 
the groups within the class. Expand a "Word/Range" object and the "Condition"  branch 
shows conditions defined for the selected group. Finally, expanding a "Condition" object, 
displays the "Macro name" branch which shows the macros associated with the selected 
condition in the group.  

To summarize, expand a "class" to display the "groups" associated with it. Expand a 
"group" to display the different "conditions" associated with it. Similarly, expand a 
"condition" to display the macros/variables associated with the condition. 

Change the order of class, group, condition and macro objects in the control 
configuration by "left clicking" on an object and "dragging" it to the desired position. 
When you reposition an object, all of the objects below it in the branch (children) are also 
repositioned. 

 

Right Mouse Button options 
"Right click" in the Control Configuration window to display a shortcut menu with the 
following features: 

Add/Modify, Cut, Copy, Paste, and Find — These features provide the same 
functionality described under Menu Bar above. 

Contract All Children — Use to contract (remove the display) all "children" of the 
highlighted object. 

Expand All Children — Use to expand (display) all "children" of the highlighted object. 

 

NOTES:   

1. Always reset VERICUT (press  on the VERICUT main window) after making 
changes to the control configuration. 

2. Use the Debug Macro Arguments feature, on the Project menu > Processing 
Options > G-Code > Process Options: Debug tab,  to output the macro name, the 
word, the text string value, and the numeric value for each macro as it is called. 
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Add/Modify Word/Address window 
 

Opened by pressing Add/Modify on the Word/Address window, the features on this 
window enable you to maintain groups/conditions in the control configuration. (See how) 
VERICUT will attempt to add a new group after the group selected in the list. A new 
group condition is added after the selected condition, and so on. However, if the word 
and range of an added group matches that of a previously defined group, the new group is 
automatically added as a condition to the previously defined group. This occurs even 
when the previously defined group resides in a different class. 

Class Name — Enables you to add a new "class" or rename an existing "class".  

Word / Variable option — Controls the type of group being defined. Options: 

Word, Word/Range — These features define a group whose actions are performed 
when a G-code having a corresponding word and address value is processed. Enter 
the group word and range of values into the data fields that appear when this option is 
active. The word must be previously defined via the Word Format function. You can 
type the word character, or select it from a pick list. The Range field commonly 
specifies a single address. However, you can also specify multiple range values 
(separated by spaces), inclusive ranges, or use "*" as a wildcard to denote "all 
values". Setting "Range=NONE" supports processing words (or conditional words) 
without values differently from the same words with values. For example, you can 
configure N010X to be handled differently from N010X0. Examples follow. 

 

Examples of specifying "L" group Word and Range values: 

Group Word Range G-codes acted on by the 
group 

L 2 L2 

L 1 5 L1, L5 

L 1 5-10 L1, L5, L6, L7, L8, L9, L10

L NONE L ("L" without a numeric 
value) 

L * Ln (where "n" is any value) 
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Variable, Variable/Range — These features define a group whose actions are 
performed when a specified variable is set to a corresponding value. Enter the group 
variable name and range of values into the data fields that appear when this option is 
active. Variable ranges are specified in the same manner as for words, as described 
above. 

NOTE:  Typically, Range values are integers. If you need to specify a group of NC 
codes, some of which contain decimal values (for example, G45, G45.1 G46) define 
the group Range as a series (45 45.1 46), rather than as an "inclusive" Range (45-46). 
Inclusive Ranges of real values may be defined by including a decimal point with the 
value. For example, the Range (45.0-46.0) will select all values between 45 and 46. 

Conditions — Use to specify one or more conditions, which if met, causes the group to 
perform different action(s). 

Operator — Choose and or not from the pull-down list. 

Word, Conditional Word/Conditional Value — When Type = Word, the condition 
is based on another word and address value range appearing in the G-code data block. 
This is the most common condition type. Select the desired Condition from the pull-
down list, and then enter the Conditional Value(s). Use the same considerations as 
described above for Word, Word/Range. 

 

For example:      G 81 not (X *) and not (Y *) and not (Z *) calls ErrorMacro 

 
  

State, Conditional State/Conditional Value — When Type = State, the condition is 
based on a machine state. Choose the desired Condition from the pull-down list, and 
then choose a value from the Conditional Value pull-down list. Notice that only 
values that are valid for the selected Condition appear in the list. 
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Variable, Conditional Variable/Conditional Value — When Type = Variable, the 
condition is based on when a variable is set to a corresponding conditional value. In 
the Condition column enter the variable name. In the Conditional Value column enter 
a value, range of values, or logical condition. Logical conditions include <n, >n, <=n, 
>=n, =n (where n is a value or the contents of a variable #name). The value or range 
is an integer, however if a decimal point is used or a variable is referenced the range 
is inclusive. 

Add — Use to add a condition to the conditions list. The new condition will be added 
after the highlighted condition in the list. 

NOTE:  It is never necessary to have the list in any specific order since all items in the 
list must be TRUE for the corresponding macro to be executed. As a personal preference, 
you might want to read the list in a specific order. To this end, the new condition is 
always added after the highlighted condition in the list. You can also change the position 
of a condition in the list by clicking on the button, on the left side of each row, and drag 
the condition to the desired position in the list. 

Delete — Use to delete the highlighted condition from the conditions list. 

Macroname/Variable option — Controls if group calls a macro, or sets a variable. 
Depending on the active choice, features are provided for specifying the macro called 
(select or type in field), or the Variable Name and Variable Description of the variable to 
be set (enter the variable value in the Override Value field). You can select macronames, 
or type them in. Text entered is not case sensitive. Use the automatic filtering capability 
to help you find macros. When you enter text characters in the Macroname field, the list 
of macros is automatically filtered to show those that match the specified text. 

Process during Scan — When active, calls the macro during a "scan pass" prior to tool 
path processing (ref. "Scan Toolpath Files" on the Project menu > Processing Options 
> G-Code > Settings: Settings tab). The default condition is to call the macro during 
tool path processing. 

Process After Motion — When active, performs the group action after motion 
commands in the data block have been processed. The default condition is to perform the 
group action according to the rules of normal G-code data processing. (Ref. "About 
building NC controls" in the Using VERICUT section. Using VERICUT can be found in 
the VERICUT Help Library.) 

Override Value — This feature acts differently, depending on if Macroname or 
Variable is selected: 

With Macroname selected — Specifies a value to pass to the specified macro. If 
blank, the address value accompanying the word is passed. 

With Variable selected — Specifies a value to assign to the specified variable.  

Math expressions and variables understood by the control are supported. Enter "$" to 
specify using the address value accompanying the word. Enter "#", followed 
immediately by the variable name/number, followed by a space, to specify a variable 
value. Multiple variables can be added, separated by a blank space. If the override 
expression does not contain either of these characters, it is evaluated immediately and 

695695



VERICUT HELP – Configuration menu 

only the value is retained. If the expression can not be evaluated immediately, the full 
expression is retained in the control configuration and evaluated separately for each 
block that activates the group.  

 

Examples of using Override Value: (given that the variable, #2 = 3) 

Text entered in 
Override Value 

field 

What is retained in 
control configuration

Sample G-
code data 

block 

Resulting value when 
processed 

SIN(30) .5 X5 .5 (constant value- not 
affected by G-code 
data) 

SIN(30) .5 X10 .5 (see note above) 

$*10 $*10 X5 50 

($+#2)*10 ($+#2)*10 X5 80 

  

Also see "Using Equations/Expression In VERICUT" in the Using VERICUT 
section for more information. Using VERICUT can be found in the VERICUT Help 
Library. 

  

Override Text — Similar to Override Value, except specifies text to pass to the macro. 
Only certain macros are designed to accept override text values. Consult the "Macros - 
listed alphabetically" in the VERICUT Macros section for more information. 

Expression(s) can be used in macro override text. If the override text contains the 
sequence "{expression}" the expression text inside the curly-braces is evaluated and 
replaced with the calculated value.   

For example, if the MessageMacro is used with the following override text: 

"The spindle speed is {#speed} rpm" 
The variable "#speed" is evaluated and if set to 500, the resulting message 
would be: 
"The spindle speed is 500 rpm" 

The syntax for the expression(s) is the same as defined for override values. 

Override Word Format — When toggled "on", the word format specified with the 
macro will be used rather than the default word format. Use the Set button, described 
below, to define the word format for the specific macro. For example, this feature would 
enable you to define a P with a G71 to be decimal, and a P with a G76 to be Trailing 3.4.  
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NOTES:  
1. This feature does not support expressions.  For example, you could not use this 

feature with:  X=54000 + 30000 

2. If there is an Override Value specified, Override Word Format will be ignored. 

 
Set — Used in conjunction with Override Word Format, described above. Displays a 
window enabling you to specify a word format for a specific macro.  

Inch Method / Metric Method — Specifies how to interpret inch (and metric) 
address values. This feature is significant only for values that do not contain a 
decimal point. Values with a decimal are always interpreted via the "Decimal" 
method. Options: 

Decimal — Interprets values as floating point decimals. 

Leading or Decimal — Interprets values without a decimal as having leading 
zeros. Depending on the active unit system (inch or metric), values are interpreted 
as described by the corresponding "Format" (see below). 

Trailing or Decimal — Similar to Leading or Decimal, except interprets values 
as having trailing zeros. 

Inch Format / Metric Format — Specifies the number of digits before and after the 
decimal point when interpreting leading or trailing zero values. Data entry format is: 
a.b where "a" specifies the number of digits before, and "b" specifies the number of 
digits after the decimal point. 

Add — Select when adding a new group or condition. 

Modify — Select when modifying an existing group or condition. 

Close — Close the Add/Modify Word/Address window. 
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Find Word window 
 

Opened using Utilities menu >Find on the Word/Address window, the features on this 
window help you find the groups in a control configuration that are associated with a 
specific word/address value, or call specific macros. 

  

 
  

Words/Range tab — Enables you to find groups associated based on a specific 
word/address value. Pick the desired word from the Word list, and then enter the address 
value in the Range field. 

Macroname tab — Enables you to find groups that call a specific macro. Type or pick 
the name of the desired macro from the Macroname list. 

 After configuring the window to find the desired group, use the buttons at the bottom of 
the window to find the First, Next, or Previous occurrence in the control configuration. 
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Word/Address Validate window 
 
Opens the Word/Address Validate window enabling you to validate the control 
configuration.  

 

 
 

Validate — Starts the validation process. VERICUT searches through the control 
checking for errors or conflicts within the Word/Address groups. If an error\conflict 
is detected, the validation process stops and the entity that has the problem is 
highlighted and a message is output to the message log area. If no errors/conflicts are 
found, the validation process continues until the end of the control configuration is 
reached. 

Next — Use to continue the validation process after an error/conflict is identified. 

Previous — Use to go back to the previous error/conflict. 

Close — Stops the validation process and closes the Word/Address Validate window. 
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Control Settings (Control Settings window) 
Location: Configuration menu > Control Settings 

VERICUT toolbar short cut:   

  

Opens a window enabling you to configure how the machine control will process 
machine code data. 

  

 
  

General tab — Features on this tab are used to configure general guidelines for how the 
control processes machine code data and number equations. 

Motion tab — Features on this tab are used to configure default NC control motion 
states, and the precision used when outputting calculated values. 

Circles tab — Features on this tab are used to configure how the circle center data (e.g. I 
J K) is interpreted.  

700700



VERICUT HELP – Configuration menu 

Cycles tab — Features on this tab are used to configure how fixed tool axis, or "canned" 
cycle motion blocks are interpreted, e.g. G8n. 

Tooling tab — The features on this tab are used to configure default tooling conditions 
and tool change activity.  

Rotary tab — Features on this tab are used to configure how rotary motion commands 
are interpreted, e.g. A, B, C.  

OptiPath & Curve Fit tab — Features on this tab are used to configure settings 
referenced when G-code tool path files are optimized by OptiPath.  

User Defined (CTL) tab — Features on this tab are used to configure user defined 
control settings supplied via a custom CME file. 

Sync tab — Features on this tab configure VERICUT for simulating machining with 
synchronized subsystems. 

Turning tab — Features on this tab configure VERICUT for lathe turning simulations. 

Wire EDM tab — Features on this tab are used to configure wire EDM machining 
settings.  

Cutter Compensation tab — Features on this tab are used to configure how the 
programmed tool path is compensated when cutter diameter compensation, or "CDC" is 
used, e.g. G41-42.  

Offsets tab — Features on this tab are used to configure an initial work offset, or “fixture 
offset”, to be in effect at the start of tool path processing.  

Subroutines tab — Features on this tab are used to configure how subroutine names are 
referenced by the NC control. 

  

OK — Applies the changes and closes the Control Settings window. 

Apply — Applies the changes and leaves the Control Settings window open. 

Cancel — Closes the Control Settings window without applying changes. 
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Control Settings window, General tab 
Location:   Configuration menu > Control Settings 

OptiPath menu > Control > G-Code Output Options tab 

VERICUT toolbar short cut:   

  

Opens a window to configure general guidelines for how the control processes machine 
code data and number equations. (See how) 

  

 
  

Control Type — Sets the type of NC control being used. Choosing the proper option 
establishes a mode of operation consistent with how the control processes NC data. 
Options are: 

Generic — Fanuc and most other controls using standard controller functions. 

NUM — French-made control. This option affects how G-code data is interpreted, for 
example: how variables are initialized and processed, and how to interpret parameters 
to macros that shift the location of the tool path. 

Heidenhain Conversational — Heidenhain Conversational control. This option 
causes VERICUT to recognize the "L" word as an optimizable word. Also, the "L" 
word is included with any cuts added during optimization. 

Calculation Tolerance — Tolerance for rounding mathematical evaluations, such as 
determining if two calculated values are equal to, greater than, or lesser than each other.  

NOTE:  The Calculation Tolerance should be adjusted to eliminate "invalid circle" 
errors caused by circle calculations that produce differences larger than the tolerance 
value when processing G-Code data. 
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Order of Math Operations — Order in which math operations are performed. Options 
are: 

Rules of Precedence — Follow the basic rules of math precedence: 

1. Perform exponential (power). 

2. Perform multiplication and division operations. 

3. Perform addition and subtraction operations, example: 5 + 5.3 * 3 * sin(30)= 
12.95 

Enclosing math operations in parenthesis causes them to be performed before 
those not enclosed in parenthesis. The same rules of precedence are applied to 
math operations enclosed in parenthesis. 

Left to Right — Use left to right sequence, example: 5 + 5.3 * 3 * sin(30)= 15.45 

Default Word — Word assumed by VERICUT for NC data blocks beginning with 
numbers, such as NC data for some Heidenhain controls. For example, for VERICUT to 
interpret blocks like "50G01X5", set Default Word to "N". VERICUT then interprets the 
block without error as "N50G01X5". 

703703



VERICUT HELP – Configuration menu 

Control Settings window, Motion tab 
Location: Configuration menu > Control Settings 

VERICUT toolbar short cut:   

 

Opens a window to configure default NC control motion states, and the precision used 
when outputting calculated values. (See how) These settings are in affect when the 
control and machine are initially powered on. 

 

 
 

Default Motion Type — Default motion type for the control.  

Options are: 

Rapid 
Linear 
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Default Plane Selection — Default motion plane, or "cutting plane" for the control. 
Options are:  

XY 
ZX 
YZ 
 
Default Control Units — Default measurement units for the control. 

Options are: 

Inch 
Metric 
 

Default Command Mode — Default command mode, or "input dimension mode" for 
the control. 

Options are: 

Absolute 
Incremental 
 

Default Feed Mode / Default Feedrate — Default feed rate mode and value for the 
control. 

Feed mode options are: 

Feed per Minute 
Feed per Revolution 
 

Output Initial Spindle Location — When active, causes the machine to move to its 
initial spindle location at the beginning of tool path processing. Enter initial machine 
location values in an Initial Machine Location table. 

Rapid Motion Cancels Cycles — When active, rapid motions (e.g. G0) cancel canned 
cycles (e.g. G81-89). 

Linear Motion Cancels Cycles — When active, linear motions (e.g. G01) cancel canned 
cycles (e.g. G81-89). 

CW Motion Cancels Cycles / CCW Motion Cancels Cycles — When active, clockwise 
(or counterclockwise) circular interpolation motions (e.g. G02) cancel canned cycles (e.g. 
G81-89). 
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Output Rapid Motions as — Controls the format in which rapid motions are written to 
the APT Output file during reverse post-processing. 

Options are: 
Rapid — Output the word "RAPID" followed by a single tool tip location. 

Feedrate — Output "FEDRAT/n" where the feed rate is calculated based on the 
rapid priority of moving axes, and then output the tool tip location(s). When rapid 
priority causes axes to move independently, multiple tool tip positions are output. 

Maximum Inverse Time Output Feedrate — Highest feedrate value which can result 
from interpreting inverse time feed rate values (e.g. G93). The output feed rate is set to 
this rate when in inverse time feed mode and the calculated feed rate is zero or greater 
then the specified maximum. 

Output Precision — Controls the accuracy used to interpret calculated values, such as: 
CDC offset positions, mathematical operations, etc. 

Options are: 
Full Precision — Highest possible accuracy. Note that full precision output values 
can result in higher accuracy than the NC control uses, which may result in 
differences between simulated motion and the actual motion performed by the NC 
control. 

Input Precision — Use the accuracy used in the input tool path file. For example, 
when tool path file data is in 3.4 format, the precision used is also 3.4. 

Specified Precision — Use the accuracy specified via Specified Output Precision 
(see below) 

Specified Output Precision — When Output Precision= Specified Precision, this 
value reflects the accuracy used by the NC control to perform the operations described 
above for Output Precision. 
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Control Settings window, Circles tab 
Location: Configuration menu > Control Settings 

VERICUT toolbar short cut:   

  

Opens a window to configure how the circle center data (e.g. IJK) is interpreted. (See 
how) The Interpolation Tolerance determines the quantity of machine positions which 
simulate arc and helical motions. 

  

 
  

Circle Center Mode — Mode in which to interpret circle center data. 

Options:  
Absolute — Absolute center coordinates. 

Incremental — Incremental distances. (See "Incremental Circle Center Method" 
below).  

G Code Dependent — As described above, except depends on the active input 
dimension mode: absolute or incremental. 

Incremental Circle Center Method — When interpreting incremental circle center 
values, controls how incremental circle center data is interpreted. 

Options:  
From Start to Center Point — Distance from circle start point to circle center. 

From Center to Start Point — Distance from circle center to circle start point. 

Unsigned — Unsigned, positive incremental distance between circle start point and 
circle center). Unsigned incremental circle motion blocks are always positive in 
value, and do not cut circles greater than 90 degrees. 
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Pitch Specified with IJK — This option determines if the CircleCenterX, and 
CircleCenterY, and CircleCenterZ macros can be used to determine the pitch. Only the 
macro which corresponds to the direction perpendicular to the current motion plane will 
be used for the pitch value. The pitch is defined as depth per revolution. The default is 
"No". If set to"Yes", the delta depth distance divided by the pitch will determine the 
number of full loops. If set to "No", the HelicalFullLoops macro should be called, and 
the pitch will be calculated based on the number of full loops, the delta depth distance, 
and the starting and ending angles. 

APT Output for Circular Motion — Controls the format in which circular motions are 
output during conversion to an APT output file. An APT Output file is created when 
Create APT Output File is active. (Ref. Process Options window: G-Code Output 
Files tab) 
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Control Settings window, Cycles tab 
Location: Configuration menu > Control Settings 

VERICUT toolbar short cut:   

  

Opens a window to configure how fixed tool axis, or "canned" cycle motion blocks are 
interpreted, e.g. G8n. (See how) 

  

 
  

Cycle Return Level — Controls where the tool tip is returned (retracted) after 
processing a cycle command.  

Options: 

R Point — Rapid positioning or "R level". 

Initial Point — Initial level from where the cycle motion began. 

Specified Point — Clearance distance from the workpiece as specified by a 
word/address, such as G71Zn with some Okuma controls, or Clearance + Retraction 
(similar to Specified Point, except a retraction clearance can be specified). 
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Cycle Clearance Distance — Distance from the workpiece to the R level. 

 
 

Cycle Rapid method — Controls how rapid positioning is performed between cycle 
executions. 

Options: 
Clearance Plane — FANUC method-R level located at some clearance above the 
workpiece, tool tip placed at the R level). 

Part Surface — Cincinnati Acramatic method-R level located on the workpiece 
surface, tool tip placed .125”, or 3mm above the R level. 

 
 

Cycle Depth Value — Controls how the cycle depth values are interpreted. 

Options: 
Absolute — Absolute cycle depth value. 

Incremental — Incremental distance as described by the Cycle Incremental Depth 
Value below). 
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G Code Dependent — As described above, except depends on the active input 
dimension mode: absolute or incremental. 

Cycle Incremental Depth Value — When interpreting incremental cycle depth values, 
controls how incremental distances are interpreted. 

Options: 
Relative to Cycle Rapid Value — Incremental distance from R level. 

Relative to Cycle Initial Level — Incremental distance from initial level. 

Relative to Part Surface — Incremental distance from the part surface. 

Cycle Rapid Value — Controls how cycle rapid values are interpreted to determine the 
R level.  

Options: 
Absolute — Absolute R level position. 

Incremental — Incremental distance to the R level, as specified by the Cycle 
Incremental Rapid Value. 

G Code Dependent — As described above, except depends on the active input 
dimension mode: absolute or incremental. 

Cycle Incremental Rapid Value — When interpreting incremental cycle rapid values, 
controls how incremental distances are interpreted to determine the R level. 

Options: 
Relative to Cycle Initial Level — Incremental distance from the initial level. 

Relative to Part Surface — Incremental distance from the part surface. 

Cycle Causes Rapid Motion — When active, sets the rapid motion mode with a cancel 
cycle command (e.g. G80). 

Ignore Cycles during Rotary Motion — When active, ignores canned cycles during 
rotary motions. Clear this checkbox to allow cycles during rotary motions. The use of this 
modal becomes more important when the Output Intermediate Points control setting is 
in use. 

Cycle Execute — Controls when cycle motions are executed. 

Options: 
On Motion — Execute cycle on cycle block and each following motion until 
cancelled. (Default) 

As Commanded — Cycle definition block is for setup only; execute cycle when 
commanded by a specific word/address, such as G79 with some Phillips NC controls. 
Requires using the CyclesExecute macro in the NC control configuration for the 
codes that command cycles to be executed. 
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Control Settings window, Tooling tab 
Location: Configuration menu > Control Settings 

VERICUT toolbar short cut:   

  

Opens a window to configure default tooling conditions and tool change activity. (See 
how) 

  

 
  

Initial Tool Component ID — Specifies the Tool Index Number of the tool component 
initially active for tool changes. 

Tool Number Method — Controls how to interpret tool number word/addresses (e.g. 
Tn).  

Options are: 
Select Only — Tool number only selects the tool. The tool is changed by a separate 
command, e.g. M6) 

Select & Change — Tool number selects and changes the tool. A separate tool 
change command is not used. 

Tool Change Retract Method — Method of retracting for a tool change. Methods which 
retract machine axes reference location values stored in a Tool Change Location table. 
Options are: 

No Retract — Change the tool at its current location. 

Retract (Z-Axis only) — Retract the tool only along the Z-axis. 
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Retract All Axes — Retract all machine motion axes to their respective tool change 
locations. 

Retract Tool Side Axes — Similar to Retract All Axes, except applies only to 
motion axes connected between the machine Base and Tool components. 

Use Retraction Table — Refer to the Tool Change Retraction table to determine 
which machine axes to retract. 

Tool Change Cancels Cycles — When active, cancels canned cycles with a tool change. 

Tool Change Causes Rapid Motion — When active, sets the rapid motion mode with a 
tool change. 

713713



VERICUT HELP – Configuration menu 

Control Settings window, Rotary tab 
Location: Configuration menu > Control Settings 

VERICUT toolbar short cut:   

  

Opens a window to configure how rotary motion commands are interpreted, e.g. A, B, C. 
(See how) A "moving tool philosophy" is assumed when describing rotations. 

  

 
  

Output Intermediate Points — When active, generates intermediate tool positions 
during rotary motions. If turned off, only the final tool position of a rotary motion is 
shown. Rotary intermediate points help you see the tool-to-workpiece relationship during 
rotary motions, however, the simulation will be slower. The Interpolation Tolerance 
determines the quantity of machine positions which simulate rotary motions. (Ref. File 
menu > Properties: Tolerance tab) 

OPTIPATH NOTE:  Multi-axis motions are not optimized when Output Intermediate 
Points is active. 

A-axis Rotary Type, B-axis Rotary Type, C-axis Rotary Type — The settings control 
how rotary commands are interpreted (e.g. ABC). Each axis is individually controlled. 
Options: 
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EIA (360 Absolute) — Refers to absolute angle positions. Absolute Rotary 
Direction controls how rotation values determine the direction of rotation. 

 

 
 

Linear — Refers to angles on a linear axis "wrapped" around the rotary component. 
In absolute input dimension mode (e.g. G90), rotary values specify absolute locations 
along the linear-rotary axis, while the sign (+ / -) controls which end of the linear axis 
is used. In incremental input dimension mode (e.g. G91), rotary values specify 
degrees to rotate from the current position, and the sign controls the direction of 
rotation: plus = CCW, minus = CW. 
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Example rotations of a B-axis linear-rotary component: 

Current axis 
position 

Command Rotary motion 

(moving tool 
philosophy) 

Rotary destination

B0 G90B75 75 deg CCW B75 

B0 G90B-75 75 deg CW B285 (B-75) 

B35 G90B75 40 deg CCW B75 

B35 G90B-75 110 deg CW B285 (B-75) 

B150 G90B120 30 deg CW B120 

B150 G90B-120 270 deg CW B240 (B-120) 

N/A  G91B75 75 deg CCW Current +75 

N/A G91B-75 75 deg CW Current -75 

 
A2-axis Rotary Type, B2-axis Rotary Type, C2-axis Rotary Type — The settings 
control how rotary commands for secondary rotary axes are interpreted (e.g. A2, B2, C2). 
Each axis is individually controlled. Options are same as described above for ABC rotary 
types. 

Absolute Rotary Direction — Controls how rotation values determine the direction of 
rotation for EIA (360 Absolute) rotary type components. Options and examples follow. 

Positive -> CCW — Sign controls the direction of rotation: plus = CCW, minus = 
CW, and absolute value of the rotation value specifies the rotary destination.  

NOTE:  You can configure the same behavior using Configuration menu > 
Word/Address and associating the RotaryDirPosCCW macro. 
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Examples of rotary behavior with Absolute Rotary Direction=Positive -> CCW: 

Current axis 
position 

Command Rotary motion 

(moving tool 
philosophy) 

Rotary destination 

NA G90B0 NA B0 

B0 G90B380 20 deg CCW B20 

B20 G90B-90 290 deg CW B90 

B90 G90B60 330 deg CCW B60 

 
Positive -> CW — Similar to Positive -> CCW, except the rotation directions are 
reversed.  

NOTE:  You can configure the same behavior using Configuration menu > 
Word/Address and associating the RotaryDirPosCW macro. 

  

Examples of rotary behavior with Absolute Rotary Direction=Positive -> CW: 

Current 
axis 

position 

Command Rotary motion

(moving tool 
philosophy) 

Rotary 
destination 

NA G90B0 NA B0 

B0 G90B380 340 deg CW B20 

B20 G90B-90 70 deg CCW B90 

B90 G90B60 30 deg CW B60 

 
Always CCW — Rounds the rotation value to increments of 360, then subtracts 360 
until the subtracted value is between 0-360. The rounded value specifies the rotary 
destination. The tool always rotates in a CCW direction about the rotary center point. 

NOTE:  You can configure the same behavior using Configuration menu > 
Word/Address and associating the RotaryDirCCW macro. 
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Examples of rotary behavior with Absolute Rotary Direction=Always CCW: 

Current 
axis 

position 

Command Rotary motion

(moving tool 
philosophy) 

Rotary 
destination 

NA G90B0 NA B0 

B0 G90B380 20 deg CCW B20 

B20 G90B-90 250 deg CCW B270 

B270 G90B60 150 deg CCW B60 

 
Always CW — Similar to Always CCW, except the rotation directions are reversed. 

NOTE:  You can configure the same behavior using Configuration menu > 
Word/Address and associating the RotaryDirCW macro. 

  

Examples of rotary behavior with Absolute Rotary Direction=Always CW: 

Current 
axis 

position 

Command Rotary 
motion 

(moving tool 
philosophy) 

Rotary 
destination 

NA G90B0 NA B0 

B0 G90B380 340 deg CW B20 

B20 G90B-90 110 deg CW B270 

B270 G90B60 210 deg CW B60 

 

Shortest Distance — Uses the rotation value and its sign to specify the absolute 
rotary position. For each rotary motion, the tool rotates the shortest distance about the 
rotary center point to the rotary destination. 
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NOTE:   You can configure the same behavior using Configuration menu  > 
Word/Address and associating the RotaryDirShortestDist macro. 

  

Examples of rotary behavior with Absolute Rotary Direction=Shortest Distance: 

Current 
axis 

position 

Command Rotary motion

(moving tool 
philosophy) 

Rotary 
destination 

NA G90B0 NA B0 

B0 G90B380 20 deg CCW B20 

B20 G90B-90 110 deg CW B270 

B270 G90B60 150 deg CCW B60 

 
Linear — Rounds the rotation value to increments of 360, then subtracts 360 until 
the subtracted value is between 0-360. The difference between the rounded value and 
the current position is the rotary destination while the sign of the difference specifies 
the rotation direction. A positive difference value rotates the tool in a CCW direction 
about the rotary center point, a negative value rotates the tool in a CW direction.  

NOTE:  You can configure the same behavior using Configuration menu > 
Word/Address and associating the RotaryDirLinear macro. 

  

Examples of rotary behavior with Absolute Rotary Direction=Linear: 

Current 
axis 

position 

Command Rotary motion

(moving tool 
philosophy) 

Rotary 
destination 

NA G90B0 NA B0 

B0 G90B380 20 deg CCW B20 

B20 G90B-90 250 deg CCW B270 

B270 G90B60 210 deg CW B60 
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Rotary Tool Control Point — When active, with default settings, Rotary Tool Control 
Point, or "RTCP" causes rotary motion about a specific control point-typically the tool 
tip. When RTCP is not active, rotation occurs about the rotary component origins. This 
feature is intended for use only with tilting head machines. 

RTCP compensates for the gage offset (XYZ distance from tool tip to Tool component) 
and pivot offset (XYZ distance from spindle face/centerline to tool side rotary 
components rotation/pivot point) as tool side rotary components rotate.  

 

Affect of using RTCP with an A-axis rotary component: 

 
 

RTCP only applies to rotary components between a Tool component and the Base 
component (tool side). Rotary components between a Stock component and the Base 
component (part side) do not effect the orientation of the tool, and therefore do not affect 
the tool side offsets. 

RPCP, or Rotary Part Contol Point, is used with part side rotary components, where the 
part is moved relative to the tool tip. RPCP actually rotates the workpiece coordinate 
system as the part side rotary components rotate.  RPCP should only be used when 
programming in the part coordinate system. See reference information on the "RpcpOn, 
RpcpOff" macros, or the "RPCP Pivot Offset table" in the Tables for Processing G-
Codes section for more information. 

NOTES:    
1. The default state for RTCP is set on the Rotary Settings panel. The RTCP state can be 

modified via the RotaryControlPointOnOff or RtcpOn, RtcpOff macros. 

2. See also: "RTCP Pivot Offset table" or "RPCP Pivot Offset table" for possible 
additional configuration for correct RTCP simulation. 

  

RTCP Contour — Use this feature to set the mode for RTCP contouring. "Yes" puts 
RTCP in contouring mode (XYZ offsets are updated and applied continuously during 
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rotary motion). "No" puts RTCP in non-contouring mode (XYZ offsets are not updated 
and applied during rotary motion). Use the RtcpContour macro to over-ride this setting. 
RTCP must be active for this setting to have an effect. 

RTCP With Motion — Use this feature to set the mode for RTCP with motion. "Yes" 
causes the RTCP updated XYZ offsets to only take effect when the corresponding X, Y, 
or Z axes are programmed in a rotary motion block. "No" causes the XYZ offsets to take 
effect immediately, meaning X, Y, or Z axes do not have to be programmed in a rotary 
motion block. Typically, this feature is only applicable when in non-contouring mode 
(RTCP Contour = "No"). Use the RtcpWith Motion macro to over-ride this setting. 
RTCP must be active for this setting to have an effect. 

RTCP Uses — Use this feature to specify which type of pivot offset compensation to 
use. There are two Pivot Offset compensation types: RTCP and Gage. 

RTCP specifies the programmed/driven point is assumed to be the spindle 
face/centerline with no tool loaded. The RTCP Pivot Offset table can be used with 
this type to override the automatic calculation. The centerline of rotation for multiple 
tool side rotary components must intersect. 

Gage specifies the programmed/driven point is assumed to be the rotation/pivot point 
of the tool side rotary component, closest to the Base component. The 
PivotOffsetCompName macro can be used with this type to override where the XYZ 
pivot offset distance will be measured to. The centerline of rotation, for multiple tool 
side rotary components, does not have to intersect. The macros 
TurnOnOffGageOffset and TurnOnOffGagePivotOffset can be used to turn on 
and off the gage offset and the pivot offset, thereby driving either the spindle face or 
the tool tip. If Programming Method is set to Tool Tip, the gage offset is always 
active. RTCP must be active for this setting to have an affect. 

Choose one of the following: 

Default Pivot Offset — Use the RTCP Pivot Offset compensation type. The 
ApplyGagePivotOffset macro can be used to switch to the Gage Pivot Offset 
compensation type. 

Gage Pivot Offset — Use the Gage Pivot Offset compensation type. This option 
should be used for all new jobs. 

NOTE:   The Gage Pivot Offset might currently be turned off, or may be set to 
(0,0,0). 

RTCP Pivot Offset — Use the RTCP Pivot Offset compensation type. 

NOTE:  The RTCP Pivot Offset might currently be turned off, or may be set to 
(0,0,0). 

Only Gage Offset — Do not compensate for XYZ pivot offset. Compensate only for 
the XYZ gage offset. 
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TECH NOTES:  
Traditionally, Rotary Tool Control Point (RTCP) referred to a state in which the tool 
would rotate about the tool tip when a tool-side rotary was rotated. 

Today this feature has a more generic definition. Rotary Tool Control Point refers to a 
state in which the tool side offsets are automatically updated when a tool-side rotary is 
rotated. This means that even though Rotary Tool Control Point is active, the results 
might not be as described above for the following reasons: 

1. The traditional definition assumed that the offsets are adjusted continually as the 
rotary axis is rotated. This is not always the case. In the above diagram, an "A90" 
command is being executed. If the offsets are not updated continuously, the tool 
tip position will not stay fixed, but will "wander", and then end up in its original 
position. The RTCP Contour flag allows for configuration of either type. 

2. The traditional definition assumed that the offsets would be applied immediately 
to all axes even though the corresponding linear axes were not specified on the 
block. This is not always the case. If the offsets are only applied when the 
corresponding linear axes are specified, then in the above case (A90), even though 
RTCP was active, the machine would behave as illustrated on the left. Then when 
XYZ is specified (with the original coordinates), then the updated offsets would 
be applied, and the tool tip would return to its original position. The RTCP With 
Motion flag allows for configuration of either type. 

Some controls only adjust some of the 4 tool side offsets. If this is true, then the tool tip 
will not return to the original position. 
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Control Settings window, Wire EDM tab 
Location: Configuration menu > Control Settings 

VERICUT toolbar short cut:   

  

Opens a window to configure wire EDM machining settings. (See how) 

  

 
  

Maximum Wire Angle — Maximum angle the wire can tilt in any direction from 
vertical alignment. If the wire is tilted beyond this angle, an error message is issued. 

Initial Voltage — When active, indicates voltage to the wire is on at the start of tool path 
processing. 

UV Relative to XY — When active, U and V tool path values are relative to the current 
X and Y axis positions. 

XY Also Moves UV — When active, X and Y tool path values also cause the 
corresponding U and V axis to move. In typical wire EDM machine construction, the U 
and V axes are connected such that they are slaved off the X and Y axes. In other words, 
when the X and Y axes move, the corresponding U and V axes also move by default. The 
XY Also Moves UV setting is intended to work with machines built such that the U and 
V axes are separate from the X and Y axes. 

Work Table to XY Output Plane — Distance from the top of the work table (machine 
Z zero) to the XY output plane (output Z values). The XY output plane is the Z-axis level 
at which X and Y values are assumed to be driven. This value is measured along the 
machine Z-axis, and is usually zero. 
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Control Settings window, Cutter Compensation tab 
Location: Configuration menu > Control Settings 

VERICUT toolbar short cut:   

  

Opens a window to configure how the programmed tool path is compensated when cutter 
diameter compensation, or "CDC" is used, e.g. G41-42. (See how) Enter CDC offset 
values into a Cutter Compensation table. To apply CDC offsets to the programmed tool 
path, ensure Process Cutter Comp. is active. 

  

 
  

CDC ON/OFF Method — Controls how the offset condition is established when CDC is 
turned on, and how the offset is cancelled when CDC is turned off. Options are: 

Ramp ON/OFF — Establish the offset condition with a "ramp-on" motion after CDC is 
turned on. When CDC is turned off, the offset is cancelled with a "ramp-off" motion on 
the next tool move. 

Immediate — Immediately establishes the offset condition when CDC is turned on, and 
assumes the offset has been established by a prior data block (e.g. G43-44 as interpreted 
by the Phillips CNC controls). When CDC is turned off, the offset is cancelled without a 
tool move. 

CDC Ramp ON/OFF with — Specifies the motion types which establish/cancel the 
CDC offset. Options:  

Active Plane Motion — Turn CDC on with a motion in the active cutting plane. 

Any Motion — Turn CDC on with any motion, including motion along the tool axis. 
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Control Settings window, Offsets tab 
Location: Configuration menu > Control Settings 

VERICUT toolbar short cut:   

  

Opens a window to configure an initial work offset, or "fixture offset", to be in effect at 
the start of tool path processing. (See how) 

  

 
  

Initial Work Offset — When active, sets the initial work offset specified by the Initial 
Work Index (see below). 

Initial Work Index — Index, or offset register value, containing the initial work offset. 
The offset remains effective until a different work offset (e.g. G54-59) is processed, or 
until cancelled. Enter the corresponding offset values into a Work Offsets table. 

725725



VERICUT HELP – Configuration menu 

Control Settings window, Subroutines tab 
Location: Configuration menu > Control Settings 

VERICUT toolbar short cut:   

  

Opens a window to configure how subroutine names are referenced by the NC control. 
(See how) 

  

 
  

Type of Subroutine Names — Controls how names of subroutines are referenced. 
Options are: 

Numeric — Use the numeric value; leading zeros are ignored. For example, "O0010" 
is interpreted the same as "O10". 

Text — Use the text string value. For example, "O0010" is not interpreted the same 
as the name "O10". 
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Control Settings window, OptiPath & Curve Fit tab 
Location:  Configuration menu > Control Settings 

VERICUT toolbar short cut:   

  

Opens a window to configure settings referenced when G-code tool path files are 
optimized by OptiPath. (See how)  

The settings are used to control block sequencing and word/value spacing in the 
optimized output tool path file. Note that by default, optimized blocks receive the same 
sequence number, if any, that appears on the original block processed. This typically 
results in multiple blocks having the same sequence number. 

  

 
  

Auto Sequence Numbering — When active, re-sequences optimized tool path records in 
ascending order. The Sequence Increment Value (see below) is used for the beginning 
sequence number, and as the increment value for subsequent sequence numbers. Both 
optimized and non-optimized blocks with sequence numbers are re-sequenced. Sequence 
numbers are not added to un-optimized blocks without a sequence number. 

NOTE:  If the general control setting Default Word="N", then "N" does not appear in 
the sequence number. The result is a sequence number without a word, for example: 
"50G01X5", such as required by Heidenhain controls. 

Add Sequence Number to Added Blocks — When active, adds sequence numbers to 
blocks added during optimization via the Add More Cuts OptiPath setting. 

Sequence Increment Value — Initial value and increment value for re-sequencing 
optimized G-code tool path records. 
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Word Value Spacing — When active, includes a space between word/value pairs in the 
optimized tool path file. Un-optimized records do not receive spacing. When this feature 
is not used, optimized tool path records are not spaced. 
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Control Settings window, User Defined tab 
Location: Configuration menu > Control Settings 

VERICUT toolbar short cut:   

  

Opens a window to configure user defined control settings supplied via a custom CME 
file. This window will appear differently, depending on the CME file in use. CME files 
are created using the Machine Developer's Kit, and specified for use in VERICUT via 
Dev Kit CME in the Configuration menu > Adv. Options function. 

  

 
  

NOTE:  Developer's Kit-defined settings can also appear under Project menu > 
Processing Options > G-Code > Process Options: User Defined tab, as determined by 
the developer. 
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Control Settings window, Sync tab 
Location: Configuration menu > Control Settings 

VERICUT toolbar short cut:   

  

Features on this tab configure VERICUT for simulating machining with synchronized 
subsystems. 

  

 
  

Sync — This term refers to the idea of synchronizing multiple programs (or channels) at 
once. A program could be defined by a separate input file, or by sections of a single input 
file. Each of these programs drives a subsystem. The sync logic will obtain motions for 
all subsystems being synced, and then execute the motion. For example:  If the upper 
system has a motion that will take 3 seconds, and the lower subsystem has a motion that 
will take .5 seconds. The lower subsystem motion and 1/6th of the upper subsystem 
motion will be executed. Then, the next motion will then be retrieved for the lower 
subsystem, and the process continues. The Info menu > NC Program window shows 
which blocks are being processed by the programs. 

 NOTE:  The actual synchronization of the programs based on WAIT or SYNC codes 
are controlled by the Word/Address table. 

  

Sync Method — The Sync Method turns on/off the Sync logic, and specifies the method 
that will be used to determine which data applies to which subsystem. 

Options include: 

None — (Default) Turns off Sync logic.  Normal processing occurs. 

G&L - N/O Block — An "N" sequence numbers mark commands for the first 
subsystem, "O" sequence numbers marks commands for the second subsystem,  and 
"B" sequence numbers marks commands for both subsystems.   
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Okuma - G13/G14 — The input program is divided into sections. Each section 
begins with either a G13 or a G14. The G13 sections will drive the first subsystem, 
and the G14 sections will drive the second subsystem. 

Fanuc - Multiple NC Programs — Independent tool path files are specified for each 
synced subsystem. The order of the subsystems specified must match the order of the 
NC program files in the NC Program list. 

INDEX - Channel 1/Channel 2 — A single NC program file contains two 
subroutines, one for each head. A word/value, for example "M30", toggles between 
"channels" that control each head. These channels will then drive the corresponding 
subsystems. See the IndexCallMainSub macro in the "Macros - listed 
alphabetically" section for more information. 

Gildemeister - $1/$2 — Blocks starting with $1 will be processed by the first 
subsystem, and blocks starting with $2 will be processed by the second subsystem. 
Blocks not beginning with either a $1 or a $2 will be processed by both subsystems. 

Mazak - G109L1/G109L2 — The input program is divided into sections. Each 
section begins with either a G109L1 or a G109L2. The G109L1 sections will drive 
the first subsystem, and the G109L2 sections will drive the second subsystem. 

Allen-Bradley - Primary/Secondary — This sync type has the following attributes:  

1. A block can contain commands for both subsystems (controls). 

2. Each control is processed independently. 

3. The next block is not processed until both controls are done with the previous 
block. 

4. Although the split up of the Info Toolpath is not necessary (or possibly 
desirable) for this sync type, it is still done for consistency with the way we 
handle sync motion. 

5. When "stepping", both the upper and lower Toolpath windows (controls) will 
process 1 block. 

6. The MDI window will ignore the subsystem specified, and will process the 
line as stated by sending it to both controls. 

Citizen - $1/$2/$3 — The input program is divided into sections. Each section begins 
with a $1, a $2, or a $3. The $1 sections will drive the first subsystem, the $2 sections 
will drive the second subsystem, and the $3 sections will drive the third subsystem. 

 Sync SubSystem IDs — This table defines the SubSystems that will be driven by the 
corresponding programs as define by the Sync Method above. The number of 
SubSystems must match the Sync Method defined above. For example the Citizen must 
have 3 Sync SubSystems, and the Okuma must have 2. The Fanuc style could have any 
number of Sync SubSystems. 

 NOTE:  A machine might define a separate subsystem for a head changer, a pallet 
changer, …  These are not Sync SubSystems. The Sync SubSystems corresponds to the 
primary SubSystem this is being driven by each of the Synced programs. 
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Control Settings window, Turning tab 
Location: Configuration menu > Control Settings 

VERICUT toolbar short cut:   

  

Features on this tab configure VERICUT for lathe turning simulations. 

  

 
  

CSS Maximum RPM — When constant surface speed, or "CSS" is controlling spindle 
speed, this value specifies the fastest RPM to turn the workpiece. 

RPM Changes with RAPID and CSS — When selected and CSS is controlling spindle 
speed, rapid motions (e.g. G0) can affect spindle speed, as well as linear and circular 
motions (e.g. G1-3). Clear this checkbox to have only linear and circular motions affect 
RPM. 
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Adv. Options (Advanced Control Options window) 
Location: Configuration menu > Adv. Options 

VERICUT toolbar short cut:   

 

Opens a window to configure advanced NC control options, such as: specify subroutines 
available in the NC control, perform actions at key processing events (e.g. start of tool 
path processing, start processing a block, etc.), substitute text strings, and more. 

 

 
 

Subroutines tab — The features on this tab specify names of external files containing 
subroutines accessible by the NC control. 

Events tab — The features on this tab maintain macros called and variables set based on 
key events that occur during tool path file processing. 

Substitute tab — The features on this tab maintain text strings that are substituted when 
specific text in the tool path file is encountered. 
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OptiPath Substitute tab — The features on this tab maintain text strings that are 
substituted when tool path files are optimized by OptiPath and written to the Optimized 
file. 

Dev Kit CME tab — Features on this tab enable you to specify a custom CME file 
containing custom macros that assist the NC control with processing machine code data. 

 

OK — Saves additions/modifications and dismisses the Advanced Control Options 
window. 

Apply — Saves additions/modifications and leaves the Advanced Control Options 
window open. 

Cancel — Closes the Advanced Control Options window without saving any 
additions/modifications. 
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Advanced Control Options, Subroutines tab 
Location: Configuration menu > Adv. Options 

VERICUT toolbar short cut:   

 

The features on this tab specify names of external files containing subroutines accessible 
by the NC control. (See how) 

 

 
 

File Names list — List of external files containing subs accessible to VERICUT. 

Tip: Right-click in the File Names list area to display a pop-up window with the 
following features: 

Add — Opens the Job Subroutine Files selection box enabling you to add external 
subroutine files to the File Names list. 

Replace — Opens the Job Subroutine Files selection box enabling you to replace the 
highlighted subroutine file in the File Names list with another. 

Delete — Deletes the highlighted subroutine file from the File Names list. 
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Edit — Displays the of the highlighted subroutine file in a text editing window. 
Standard text editing features are provided, such as: copy/cut, paste, search, etc. For 
more information on using the editing features see Edit menu > Text File. 

  

Add — Opens the Job Subroutine Files selection box enabling you to add external 
subroutine files to the File Names list. (Same as Add in the pop-up window described 
above) 

Replace — Opens the Job Subroutine Files selection box enabling you to replace the 
highlighted subroutine file in the File Names list with another. (Same as Replace in the 
pop-up window described above) 

Delete — Deletes the highlighted subroutine file from the File Names list. (same as 
Delete in the pop-up window described above) 

Delete All — Deletes all subroutines files from the File Names list. 
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Advanced Control Options, Events tab 
Location: Configuration menu > Adv. Options 

VERICUT toolbar short cut:   

 

The features on this tab enable you to specify the macros called and/or variables set based 
on key events that occur during tool path file processing. (See how) The Events tab 
displays the event configurations of a particular NC control as a "tree" structure. When 
you expand an "event" object, the macro calls/variable settings associated with that 
particular event are displayed.  

 

 
 

The following Events are available: 

Reset — Event occurs before the tool path file is scanned. 

Start of Processing — Event occurs after the tool path file has been scanned, but before 
the tool path file is processed.  

NOTE:  The ConversionInit macro must always be the first macro listed for this event. 
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End of Processing — Event occurs after the tool path file has been processed. 

NOTE:  The ConversionFinish macro must always be the last macro listed for this 
event. 

 

Start of Block Processing — Event occurs at the start of processing each G-code data 
block. 

NOTE:  The BlockInit macro must always be the first macro listed for this event. 

 

End of Block Processing — Event occurs at the end of processing each G-code data 
block. 

NOTE:  The BlockFinish macro must always be the last macro listed for this event. 

 

Start of Type II Command / End of Type II Command — Event occurs at the start (or 
end) of processing a Type II data command. 

Add / Modify — Opens the EventsAddMod window enabling you to add (or modify) 
event-based macro calls/variable assignments. 

Delete — Deletes the selected event-based macro call/variable assignment. 
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EventsAddMod window 
Location: Configuration menu > Adv. Options: Events tab 

VERICUT toolbar short cut:   

  

Opened by pressing Add/Modify on the Advanced Control Options window, Events 
tab. The features on this window enable you to add (or modify) event-based macro 
calls/variable assignments. Features in this window behave similar to those described for 
word/address groups on the Add/Modify Word/Address window. 

  

 
  

Event — Enables you to select the event that you want to add to or modify. Select from 
the pull-down list. 

Macroname/Variable — Controls calls a macro, or sets a variable. Depending on the 
active choice, features are provided for specifying the macro called (select or type in 
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field), or the Variable Name and Variable Description of the variable to be set (enter the 
variable value in the Override Value field). You can select macro names, or type them in. 
Text entered is not case sensitive. Use the automatic filtering capability to help you find 
macros. When you enter text characters in the Macroname field, the list of macros is 
automatically filtered to show only those that match the specified text. 

Override Value — This feature acts differently, depending on whether Macroname or 
Variable is selected: 

With Macroname selected — Specifies a value to pass to the specified macro. If 
blank, the address value accompanying the word is passed. 

With Variable selected — Specifies a value to assign to the specified Variable 
Number. Use the Variable Description field to describe what Variable Number 
represents. 

Math expressions and variables understood by the control are supported. Enter "$" to 
specify using the address value accompanying the word. Enter "#", followed 
immediately by the variable name/number, followed by a space, to specify a variable 
value. Multiple variables can be added, separated by a blank space. If the override 
expression does not contain either of these characters, it is evaluated immediately and 
only the value is retained. If the expression can not be evaluated immediately, the full 
expression is retained in the control configuration and evaluated separately for each 
block that activates the group. 

  

Examples of using Override Value: (given that the variable, #2 = 3) 

Text entered in 
Override Value 

field 

What is retained in 
control configuration

Sample G-
code data 

block 

Resulting value when 
processed 

SIN(30) .5 X5 .5 (constant value- not 
affected by G-code 
data) 

SIN(30) .5 X10 .5 (see note above) 

$*10 $*10 X5 50 

($+#2)*10 ($+#2)*10 X5 80 

  

Also see "Using Equations/Expression In VERICUT" in the Using VERICUT 
section for more information. Using VERICUT can be found in the VERICUT Help 
Library. 
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Override Text — Similar to Override Value, except specifies text to pass to the macro. 
Only certain macros are designed to accept override text values. Consult the "Macros - 
listed alphabetically" section for more information. 

Expression(s) can be used in macro override text. If the override text contains the 
sequence "{expression}" the expression text inside the curly-braces is evaluated and 
replaced with the calculated value.   

For example, if the MessageMacro is used with the following override text: 

"The spindle speed is {#speed} rpm" 

The variable "#speed" is evaluated and if set to 500, the resulting message would be: 

"The spindle speed is 500 rpm" 

The syntax for the expression(s) is the same as defined for override values. 

 
Add — Select when adding a new macro or variable to the event. 

Modify — Select when modifying an existing macro or variable for the event. 

Close — Closes the EventsAddMod window. 
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Advanced Control Options, Substitute tab 
Location: Configuration menu > Adv. Options 

VERICUT toolbar short cut:   

 

The features on this tab maintain text strings that are substituted when specific text in the 
tool path file is encountered. (See how) Using substitutions lets you to alter how 
VERICUT "sees" data in a block without editing the G-code tool path file. Substitutions 
occur at the beginning of processing each G-code data block, prior to parsing block 
words and values into "tokens". Substitutions in the list are applied in listed order.  

 

 
 

See "About building NC controls" in the Using VERICUT section for more information 
about how G-code blocks are processed by VERICUT. Using VERICUT can be found in 
the VERICUT Help Library. 

Substitution (Input/Output Text) list — Lists text string substitutions that will occur 
when specified input text is encountered.  

Input Text / Output Text — Specifies an input text string to substitute, and the output 
text that VERICUT will use in its place.  

NOTE:  Substitution input/output text is case sensitive. 
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Add — Adds a new substitution to the list. 

Modify — Modifies an existing substitution in the list. 

Delete — Deletes the selected substitution from the list. 

743743



VERICUT HELP – Configuration menu 

Advanced Control Options, OptiPath Substitute tab 
Location: Configuration menu > Adv. Options 

VERICUT toolbar short cut:   

 

The features on this tab maintain text strings that are substituted when tool path files are 
optimized by OptiPath and written to the Optimized file. Using substitutions lets you to 
alter what VERICUT writes to optimized G-code tool path file(s). Substitutions occur at 
the end of processing each G-code data block, prior to outputting to the optimized tool 
path file. 

 

 
 

Window features are the same as described for NC control substitutions-ref. 
Configuration menu > Adv. Options: Substitute tab. 
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Advanced Control Options, Dev Kit CME tab 
Location: Configuration menu > Adv. Options 

VERICUT toolbar short cut:   

 

Features on this tab enable you to specify a custom CME file, or CGTech Macro 
Executable file containing custom macros that assist the NC control with processing 
machine code data. This file can also supply "control settings" that allow users to further 
customize how machine code data is interpreted, and provide access to custom data tables 
for storing job, tool, and machine related data. A custom CME file is typically created by 
CGTech or other services organization using the Machine Developer’s Kit. In this 
manner, end users can customize VERICUT's ability to simulate machine code data 
according to site-specific needs. 

 

 
 

For more information about developing customer CME files, see VERICUT Machine 
Simulation Developer's Guide in VERICUT Development Tools section. VERICUT 
Development Tools can be found in the VERICUT Help Library. 

Dev Kit CME File — Opens a window to specify a custom CME file. Features on this 
window are standard file selection window features that enable you to navigate through 
directories, filter files, and type or select file names. 
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Analysis Menu 
X-Caliper (X-Caliper window)  
 
VERICUT Users: 
VERICUT Location: Analysis menu > X-Caliper 

VERICUT toolbar short cut:      

  

Mold and Die Users: 
Mold and Die Location:   Analyze, View Files, Print page > Measure 

Notebook Feature:    

  

Cutter Grinder Users: 
Cutter Grinder Location:   Analyze, View Files, Print page > Measure 

Notebook Feature:   

  

Opens a window that displays measurements, historical, and mathematical information 
about the VERICUT model. The appearance of the window will vary depending on the 
X-Caliper option being used. X-Caliper shows what is being measured on the model area 
by highlighting the "measure from" point (+) and the "measure to" point (o). Results from 
X-Caliper operations are displayed in the X-Caliper window. Measurements are 
described relative to the active coordinate system. 
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The X-Caliper window is also one of the dockable windows enabling you to dock it 
inside the VERICUT main window if you choose. 

NOTE:  Machined features can only be measured in a workpiece view. 

 

Toolbar — The features in the X-Caliper Toolbar are common to all options except as 
noted below. 

 Enable/Disable Mouse Picks — Toggles to enable/disable the ability pick 
features in a VERICUT workpiece view. Shown here in "enable" mode. 

  or  Set X-Caliper Units — Toggle the icon between inch, and metric, to 
specify the units that you want X-Caliper data displayed in. 

 Measure — Computes measurements based on the current X-Caliper 
window configuration. This feature is useful to have X-Caliper calculate 
measurements based on data keyed in, or edited data. This feature is only active 
for Distance/Angle, Stock Thickness, Air Distance and Closest Point options. 

 Display Tool/Stock Collisions — Use to specifically highlight collisions 
between the tool holder and the stock model in the graphics area. Use the 
Feature/History option to obtain information about the collision (NC Program file, 
Record number, Tool ID, etc.). This feature is only active when holder/stock 
collisions occurred while cutting the part.  
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Disable Holder/Stock Collisions 

toggled "Off" 

Disable Holder/Stock Collisions 

toggled "On" 

  

    

Notice that when toggled "Off", all collisions 
(holder/stock, cutter/fixture, etc.) are 
displayed.  

Notice that when toggled "On", only 
holder/stock collisions are displayed. 
Including the collision areas that were cut 
away by subsequent cuts. 

 

 Clear X-Caliper Report — Clears the results from the X-Caliper window. 

 Print — Displays a Page Setup window enabling you to format the page, 
specify the printer, and print. 

 Save X-Caliper Report — Saves the results from the X-Caliper window to a 
file. Use the file selection window that displays to specify the /path/filename for 
the file to be created. 

 Close Window — Closes the X-Caliper window. 

 

Options — Select the desired X-Caliper option from the pull-down list. The following 
options are available: 

Feature/History — When a cut on the model is selected, this option displays the 
geometric description of the cut feature, and corresponding tool path history. (See 
how)  
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Distance Angle — Use to measure the distance and/or angle between any 
combination of two points, planes, conic axes, model or component origins, or 
edges formed by intersecting planes or cylinders. (See how) 

Stock Thickness — Use to measure solid stock material. (See how) 

Air Distance — Use to measure the air gap between two solid surfaces. (See 
how) 

Closest Point — Use to measure the shortest distance from an XYZ point 
location to the closest point on the model surface. (See how) 

Scallop — Use to measure the height of a scallop formed by parallel intersecting 
cylinders, typically cut by cutter corner radius. (See how) 

Volume — Use to display the following volume values calculated for a selected 
stock workpiece: cut stock volume (cubic units), original stock model volume 
(cubic units), and volume of material removed from the original stock model. (See 
how) 

Stock/Design Distance — Use to measure the distance between the cut stock and 
design models. (See how) 

Highlight Same Planes — Use to display all "cut" features that lie in the same 
plane. 

X-Caliper window — This is where the results from X-Caliper operations are displayed. 

Active Coordinate System — Displays the name of the active coordinate system. 
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X-Caliper window, Feature/History 
Location: Analysis menu > X-Caliper: Feature/History option 

Toolbar shortcut:  

 

When a cut on the model is selected, the Feature/History option is used to display related 
cut feature (mathematical description) and tool path history. The historical data includes: 
NC program file name, record number, and tool path record text responsible for the cut. 
(See how) This function is useful to spot-check machined features, and determine the 
source of an error cut identified in red by VERICUT. 

 

Sample X-Caliper window, Feature/History option: 

 
 

Following are geometric features identified by VERICUT, listed alphabetically: 

Auto-diff model — (X, Y, Z value and surface normal) an uncut surface on a 
model displayed after an auto-difference Solid method comparison. 

Circle — (X, Y, Z center, axis vector and radius) a surface cut by a circular 
motion. 

Cone — (X, Y, Z center, axis vector and side angle) a hole bottom cut by an 
angle tip drill, corner cut by a tapered endmill, or chamfer cut by a turning 
operation. 
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Cylinder — (X, Y, Z center, axis vector and radius) an inside corner cut by 2 
linear motions having an interior angle less then 180 degree, fillet cut by a bull or 
ball endmill moving perpendicular to the tool axis, or diameter cut by a turning 
operation. 

Ellipse — (X, Y, Z center, axis vector, major and minor focal distances) a 
ramping or plunging surface cut by the bottom of an endmill with a flat, or 
partially flat bottom. 

Fixture model — (X, Y, Z value and surface normal) an uncut surface on a 
fixture model. 

Holder Collision Area — (X, Y, Z value and surface normal) a holder/stock 
collision area cut stock model. Data also includes NC program file, record number 
and tool ID. 

Plane — (X,Y,Z value and surface normal) a flat machined surface. Cylinders or 
circles cut using linear motions can also return this identity. 

Ruled surface — (X,Y,Z value and surface normal) a surface cut by a multi-axis 
motion. 

Sphere — (X, Y, Z center and radius) a surface cut by the end of a ball endmill. 

Stock model — (X, Y, Z value and surface normal) an uncut surface on a stock 
model. 

Torus — (X, Y, Z center, axis vector, major and minor radius) a fillet in a corner 
cut by a bull endmill, or fillet left on a diameter by a radiused cutter during a 
turning operation. 

Torus sweep — (X, Y, Z center, axis vector and major radius) This feature is 
typical of an angled (ramping or plunging) surface cut by a bull endmill. 
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X-Caliper window, Distance/Angle 
Location: Analysis menu > X-Caliper: Distance/Angle option 

Toolbar shortcut:  

 

The Distance/Angle option is used to measure the distance and/or angle between any 
combination of two points, planes, conic axes, model or component origins, or edges 
formed by intersecting planes or cylinders. (See how) In general, select the "From" 
feature, then select the "To" feature. X-Caliper shows what is being measured on the 
model by highlighting the "measure from" point (+) and the "measure to" point (o) as 
well as a line representing the distance (or vectors representing the angle) between them. 

 

Sample X-Caliper window, Distance/Angle option: 

 
 

NOTE:  Machined features can only be measured in a workpiece view. 

From / To groups — Each group includes the Feature, Location and Direction used to 

specify what to measure from and what to measure to. Use the From / To arrows , to 
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control which fields are filled in by screen pick data. You can select features on the 
VERICUT model, or enter number values (separated by blank spaces) directly into the 
fields. After selecting the From feature, VERICUT automatically transfers control to the 
To group. After selecting the To feature the X-Caliper window displays the measurement 
data. 

Feature — Controls the types of features to measure between. Select the Feature 
type from the pull-down list.  

Feature descriptions: 

Point — The X, Y, Z of the pick point or entered point coordinates. 

Plane — A flat, unbounded surface. If a curved surface is selected, data retrieved 
represents a plane tangent to the selected model surface at the pick point. 

Axis — Centerline of a cylinder or conic. 

Edge — Edge formed by two intersecting planes or parallel cylinders. Special 
cases follow. 

Plane/Cylinder edge — Only a cylinder with an axis parallel to the plane can 
produce an edge. Tangent conditions produce 1 edge. Intersecting conditions 
produce 2 possible edges, thus the one closest to the cylinder pick-point is used. 

Cylinder/Cylinder edge — Only cylinders with parallel axes can produce an 
edge. Tangent conditions produce 1 edge. Intersecting conditions produce 2 
edges, thus the one closest to the last cylinder pick-point is used. 

 

 
 

Vertex — Enables you to easily select one of the six key points associated with 
the triangles representing the faces of a model. For each triangle, the points 
consist of the three vertices and the midpoint of each of the triangle's three sides. 
VERICUT selects the point closest to your mouse pick. If the mouse pick is over 
the cut stock, Vertex works in the same way as the Point feature described above. 
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Vertex is a useful tool for measuring the trace of tool/fixture collisions on uncut 
fixtures. 

Model Origin — Origin of a selected model. Use the View menu > View Axes 
function to see model origin axes. 

Component Origin — Origin of a selected component. Use the View menu > 
View Axes function to see component origin axes. 

CSYS Origin — Origin of the selected coordinate system axis. Use the View 
menu > View Axes function to display the coordinate systems that are available. 

CSYS Axis — The X, Y, or Z axis of the selected coordinate system. Use the 
View menu > View Axes function to display the coordinate systems that are 
available. 

Location — Represents the XYZ coordinates of the screen pick. 

Direction — Represents IJK of the normal vector at the location of the screen pick. 

Data from the screen pick fills the Location and Direction data fields in the active From 
or To group. If needed, you can edit data in these fields, and then press Measure to 
obtain a measurement 

Measurement results are displayed in the X-Caliper window. Data output includes the 
From / To values input and the measured distance and/or angle. 
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X-Caliper window, Stock Thickness 
Location: Analysis menu > X-Caliper: Stock Thickness option 

 Toolbar shortcut:  

  

The Stock Thickness option is used to measure solid stock material. (See how)  

  

Sample X-Caliper window, Stock Thickness option: 

 
  

Location — Represents the XYZ coordinates of the point to measure from. 

Direction — Represents IJK of the measurement direction vector into material. 

Data from the screen pick fills the Location and Direction data fields. If needed, you can 
edit data in these fields, and then press Measure to obtain a measurement. 

Measurement results are displayed in the X-Caliper window. Data output includes the 
Location and Direction values input, the XYZ point where the direction vector exits the 
material and the  measured stock thickness between the Location and Exit points. 

755755



VERICUT HELP – Analysis menu 

X-Caliper window, Air Distance 
Location: Analysis menu > X-Caliper: Air Distance option 

 Toolbar shortcut:  

  

The Air Distance option is used to measure air gap between two solid surfaces. (See how) 

  

Sample X-Caliper window, Air Distance option: 

 
  

Location — Represents the XYZ coordinates of the point to measure from. 

Direction — Represents IJK of the measurement direction vector away from solid 
material.  

Data from the screen pick fills the Location and Direction data fields. If needed, you can 
edit data in these fields, and then press Measure to obtain a measurement. 

Measurement results are displayed in the X-Caliper window. Data output includes the 
Location and Direction vector values input, the XYZ point where the direction vector re-
enters solid material and the measured air distance between the Location and Entry 
points. 
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X-Caliper window, Closest Point 
Location: Analysis menu > X-Caliper: Closest Point option 

 Toolbar shortcut:  

  

The Closest Point option is used to measure the shortest distance from an XYZ point 
location to the closest point on the model surface. (See how)  

  

Sample X-Caliper window, Closest Point option: 

 
  

Location — Represents the XYZ coordinates of the point to measure from. XYZ values 
must be manually entered. The Closest Point, "From" Location cannot be specified by 
selecting the location graphically. 

Measurement results are displayed in the X-Caliper window. Data output includes the 
From Location, the XYZ coordinates of the closest point on the model, and the 
measured distance between the "from" point and the "closest" point on the model. 
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X-Caliper window, Scallop 
Location: Analysis menu > X-Caliper: Scallop option 

Toolbar shortcut:  

 

The Scallop option is used to measure the height of a scallop formed by two parallel 
intersecting cylinders. (See how) Select the two parallel and intersecting cylinders on the 
VERICUT model that form the scallop. X-Caliper identifies the cylinders being measured 
by displaying intersecting circles on the model. 

 

Sample X-Caliper window, Scallop option: 

 
 

NOTE:  Machined features can only be measured in a workpiece view. 
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Cylinder 1 / Cylinder 2 — Used to define the cylinders to measure from and to. Use the 

choice arrow  to control which cylinder is being picked. Select parallel cylinders on 
the VERICUT model. After selecting Cylinder 1, VERICUT displays a circle 
representing the cylinder in the graphics area and automatically transfers control to 
Cylinder 2. After selecting Cylinder 2, measurement results are displayed in the X-
Caliper window. 

 

 
 

Data output includes Center point, Axis vector and Radius values for each cylinder and 
the Scallop Height measurement. 
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X-Caliper window, Volume 
Location: Analysis menu > X-Caliper: Volume option 

 Toolbar shortcut:  

  

The Volume option calculates and displays the following volume values for a selected 
stock workpiece: current cut stock volume, original stock model volume, and volume of 
material removed from the original stock model. All volumes are in cubic units. (See 
how) 

 In addition to the total volume of the selected model, if model consists of several disjoint 
pieces, the volume of a selected contiguous piece of material can also be analyzed. In this 
case, a bounding box is drawn around the selected piece to indicate what is being 
calculated. If the model is only one piece, no bounding box is drawn. 

  

Sample X-Caliper window, Volume option: 

 
  

Calculated volumes are displayed in the X-Caliper window. Data output includes the 
Current Stock Volume, Original Volume and Removed Volume. 
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X-Caliper window, Stock/Design Distance 
Location: Analysis menu > X-Caliper: Stock/Design Distance option 

Toolbar shortcut:  

  

The Stock/Design Distance option enables you to measure the distance between the cut 
stock and the design models. 

  

Sample X-Caliper window, Stock/Design Distance option: 

 
  

Stock — Use to display the stock model in the workpiece view. Options are provided to 
display the models as Solid or Translucent, or turn the display Off. 

Design — Similar to Stock, above, except that it applies to design model(s). 

From Stock to Design / From Design to Stock — Use to specify the "From" and "To" 
components for the measurement.   
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Direction — Use to specify the I, J, and K components, separated by blank spaces, of a 
vector representing the direction of measurement from Location to the "To" component. 

Location — Represents the XYZ coordinates of the point to measure from on the 
"From" component. 

Direction — Represents IJK of the measurement direction vector toward the "To" 
component. 

 

Pick a location on the "From" component in the workpiece view. X-caliper then 
measures the distance, normal to the pick location, to the nearest point on the "To" 
component. You can also enter the X, Y, and Z components, separated by blank spaces, 
of the desired measurement point on the "From" component. 

Data from the screen pick fills the Location and Direction data fields. If needed, you can 
edit data in these fields, and then press Measure to obtain a measurement. 

Measurement results are displayed in the X-Caliper window. Data output includes the 
measurement method, Location and Direction values related to the "From" component, 
the XYZ point of contact on the "To" component, and the measured Distance between 
the Location and the point of contact on the "To" component. 
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X-Caliper window, Highlight Same Plane 
Location: Analysis menu > X-Caliper: Highlight Same Plane option 

  

Toolbar shortcut:  

  

The Highlight Same Plane option enables you to see all "cut" features that lie in the same 
plane. 

  

Sample X-Caliper window, Highlight Same Plane option: 

 
  

Color — Use to select the color to highlight the planes. Select the desired color from the 
pull-down color list. 

Location — Represents the XYZ coordinates of the screen pick. 

Direction — Represents IJK of the plane's normal vector at the location of the screen 
pick. 

Data from the screen pick fills the Location and Direction data fields. 

Z Tolerance — Use to specify a tolerance value for determining "same" planes. All 
planes, within +/- the tolerance value, along the normal vector will be highlighted using 
the specified color. 
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Sample Graphics display after using the X-Caliper window, Highlight Same Plane 
option: 
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AUTO-DIFF (AUTO-DIFF window) 
 
VERICUT Users: 
VERICUT Location: Analysis menu > AUTO-DIFF 

VERICUT toolbar short cut:   

 
Mold and Die Users: 
Mold and Die Location:   Analysis and Viewing page > Compare to the Design 

Notebook Feature:     

 

Opens a window to compare design model data against the VERICUT simulated cut 
model. Using AUTO-DIFF, a licensed option, clearly identifies discrepancies between 
the cut model the intended design model. Errors are identified before actual machine time 
is wasted machining an incorrect part. You can use AUTO-DIFF interactively, in batch 
mode, or automatically via "VERICUT-COMMAND" records in the tool path file. After 
using AUTO-DIFF to identify gouges and excess material, use other VERICUT functions 
such as X-Caliper and Zoom (ref. View menu > Orient) to measure and help determine 
the source of the errors. 
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Settings tab — Features on this tab control the AUTO-DIFF comparison, and what you 
see as a result. 

Options tab — Features on this tab are used to set processing and reporting options. 

Compare By Region tab — Features on this tab enable you to select a region to perform 
AUTO-DIFF on. 

Constant Gouge Check tab — Features on this tab enable you to specify a tolerance 
value for Constant Gouge Check and turn Constant Gouge Check On/Off. 

 

Apply — Applies the current AUTO-DIFF window settings. 

Compare — Compares the design model(s) specified by the AUTO-DIFF window 
settings. 

Restore — Restores the VERICUT model as it was before performing the AUTO-DIFF 
operation. 
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Report — Opens a window containing an AUTO-DIFF Report file that identifies errors 
detected by AUTO-DIFF. Information includes a listing of tool path record numbers 
responsible for the errors, and amount of deviation from the design model. Selecting an 
error in the list highlights the location of the error on the model. AUTO-DIFF 
automatically builds the report after the comparison has been done. If you are only 

interested in seeing the results (no report), you can abort report building by pressing  , 
Stop after you see the message "Creating AUTO-DIFF report". 

Select any column heading to sort the report by the entries in that column. 

Close — Closes the AUTO-DIFF window without applying window changes. 
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AUTO-DIFF, Settings tab 
Location: Analysis menu > AUTO-DIFF 

VERICUT toolbar short cut:   

 

Features on this tab control the AUTO-DIFF comparison, and what you see as a result. 
You can compare four types of design data with AUTO-DIFF: solid models, surface data, 
inspection points and profiles. The Comparison Method controls which type of design 
data is compared, while Comparison Type determines the error condition checked for. 
Comparison Tolerance features set the inspection tolerances and the display colors used 
for identified gouge/excess errors. The appearance of the Comparison Tolerance portion 
of the Settings tab will vary depending on the Comparison Method Setting. 

 

 
 

Stock Component — When multiple Stock components are defined, this option controls 
which one is used in the comparison. The Design component used in the comparison is 
that which is connected to, or connected to the same component as the chosen Stock 
component. 
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Stock Display — When selected, displays the stock model in the AUTO-DIFF view. 
Options are provided to display these models as Solid, Translucent, or Lines. The 
available options will vary depending on the Comparison Method that is selected. 

Design Display — Similar to Stock Display above, except applies to design model(s). 

Comparison Method — Controls the method of comparing design model data against 
the VERICUT model. The comparison method also re-configures the Settings tab to 
reflect the tolerances and other data required to compare the data as requested. All 
methods generate an AUTO-DIFF model that can be analyzed or saved as an In Process 
file. Regardless of the method chosen, the design model must first be loaded prior to 
comparison (ref. Modeling window: Model tab). Design models can be loaded at any 
time.  

Options: 
Solid — Compare a solid design model by subtracting solid models from each 
other. (See how ) Solid models must be "watertight"-in other words, completely 
enclosed surfaces. 

You can check solid design model integrity by loading it as a stock model, then 
select Analysis menu > X-Caliper window: Volume tab to analyze the volume 
of the stock model. After checking the volume, the following problems indicate 
the design model needs repair, or is suitable only for the Surface comparison 
method: 

• small holes or gaps appear in the model 
• model falls apart-is partially displayed 
• model disappears completely 

 
AUTO-DIFF "Solid" method example 
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Surface — Compare a surface, set of surfaces, or skin of a solid design model or 
VERICUT Solid by overlaying the surface on the cut model. (See how) 
VERICUT only compares where the design surface and cut model overlap. 
Surface comparison provides multiple colors and tolerances that produce a 
"rainbow" affect to show the extent of errors. 

NOTE:  VERICUT Solids can only be used for Standard (not FastMill) cutting 
mode. 

 

AUTO-DIFF "Surface" method example 

 
 

Point — Compare a set of design inspection points by overlaying the points on 
the cut model. (See how ) VERICUT searches from each point for an intersection 
with the model surface. Surface normal vectors control the direction in which to 
search. Only points associated with errors are seen in the results. Points associated 
with gouges have the Error color-typically Red, while points associated with 
excess material have the 5th defined color in the Shade Color list (typically 
Magenta). 

 

AUTO-DIFF "Point" method example 
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Profile— Enables you to compare the turning profile of the cut stock with profile 
of a design model. (See how)  

When Comparison Method is set to Profile, up to four profiles (Gouge, Excess, 
Stock, Design) may be displayed in the "Profile" view. Each can be displayed in 
one of two modes:  Solid or Lines. The display mode for Stock and Design 
profiles is specified using the Design Display / Stock Display features. The 
display mode for Gouge and Excess is specified using the Draw Mode option in 
the View Attributes window for the currently active "Profile" view. 

When display mode is set to "Solid", Stock and Design profiles are displayed the 
"component" color unless the "model" color is different than the "component" 
color. In this case, Stock and Design profiles are displayed the color of the 1st 
model. Gouge and Excess profiles are displayed in the color selected with the 
Comparison Tolerance "color" feature. 

When display mode is set to "Lines", the same color scheme described above is 
used for "uncut" sections of the profile. "Cut" sections of the profile are displayed 
in the "cut" color. 

X-Caliper can be used to analyze any of the profiles (Gouge, Excess, Design, and 
Stock profiles) currently displayed in a "Profile" view.  Saving an In-Process file 
(IP file) stores all four profile types. 

Any valid VERICUT model type can be used as a design model for an AUTO-
DIFF Profile comparison. The design profile which is compared to stock profile is 
a Boolean union of the individual profiles of all Design Component models 
associated with specified Stock. 

If a design model is a Cone, Cylinder, SOR, or IGES Profile, and its Z-axis is 
aligned with the turning axis, its profile is built directly from its definition profile 
and is "exact". In all other cases, the profile is built by spinning the model about 
the turning axis (as is common with other turning applications) and is an 
approximation. The smaller the Cut Tolerance that is used, the better the 
approximation. If the "design component" consists of multiple models, the 
individual model profiles are merged into one design profile. 
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AUTO-DIFF "Profile" method example 

 
 

Comparison Type — Controls the error type(s) checked for by the AUTO-DIFF 
operation.  

Options: 

Gouge 
Excess 
Both 

  

Comparison Tolerance Features 
Comparison Tolerance features are used to specify the tolerances and colors used by 
AUTO-DIFF. The degree to which VERICUT can detect discrepancies is also affected by 
Cutting Tolerance. For best results set cutting tolerance smaller than the smallest 
tolerances used by AUTO-DIFF. 

Comparison Tolerance features displayed will vary depending the on the Comparison 
Method and Comparison Type settings. 
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Solid comparison tolerances 

 
 

Gouge — Tolerance used when checking for gouges during a Solid comparison. Gouges 
detected by AUTO-DIFF are shaded in the associated gouge color. 

Excess — Similar to Gouge above, except applies when checking for excess material. 

NOTE: "Solid" Gouge/Excess tolerance/color values are independent of "Profile" 
Gouge/Excess tolerance/color values and are stored as separate values in .VcProject file. 

 

Surface comparison tolerances 

 
 

Gouge Range/Color list — Range of tolerances used when checking for gouges during a 
Surface comparison. Multiple tolerance values can be listed in addition to the "Gouge 
Check Distance" used to limit checking. If more than six tolerance values are listed, a 
scroll bar will be added to the table. Each pair of tolerance values represents a range of 
gouge depths to which the gouge color (of the lower tolerance value) will be applied. Use 
the Add and Delete buttons to add/remove tolerance values. 
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The AUTO-DIFF model is first shaded using the "Base color" (top color in the list 
associated with the "Gouge Check Distance" - see the illustration below), then gouges 
detected by AUTO-DIFF are shaded in the gouge color(s) associated with the depth of 
the gouge. 

Excess Range/Color list — Similar to Gouge Range/Color list above, except applies 
when checking for excess material. 

 

 
 

Minimum Excess — This feature enables you to specify a value and color to be used to 
represent an offset from the design surface. The Minimum Excess value is applied to the 
design surface in all directions. During the compare, any Excess value less than the 
Minimum Excess value is considered to be a gouge and displayed the Minimum Excess 
color. Excess material is measured from the Minimum Excess to the Range value (see 
below) 
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. 

NOTE:  The amount of gouge and excess reported is with respect to the offset design, 
not the original design. In other words, zero deviation is where the cut stock excess with 
respect to the original design exactly equals to the given "Minimum Excess" value. This 
also is where the Excess color table range starts from. 

While in this mode, AUTO_DIFF > Report shows both gouges and excesses with respect 
to the condition described above. If a cut produces both a gouge and an excess, AUTO-
DIFF reports the gouge (no matter what the value of the excess). This is different from 
the Report behavior when "Comparison Type" = "Both" where the biggest deviation 
would be reported. 

 

Point comparison tolerances 

 
 

Gouge Tolerance — Tolerance used when checking for gouges during a Point 
comparison. Gouges detected by AUTO-DIFF are shaded in the gouge color specified for 
a Solid comparison. 
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Excess Tolerance — Similar to Gouge above, except applies when checking for excess 
material conditions. 

Gouge Check Distance — Maximum distance to check for the cut model surface in the 
gouge direction. Distance is measured from the inspection point along direction of the 
normal vector used with the inspection point. 

Excess Check Distance — Similar to Gouge Check Distance above, except applies 
when checking for excess material. 

Default Normal (IJK) — Default normal vector in which to check during a Point 
comparison when vector data is not present in the Design Points file. Enter three values 
separated by spaces, for example "0 0 1". 

Normal Direction — Indicates if surface normal vectors associated with design points 
are pointing outward (Out) or inward (In) relative to the design model. 

  

Profile comparison tolerances 

 
 

The Profile comparison tolerances are applied "exactly", without tessellating the stock 
and/or design profiles.  An arc offset by the tolerance value, will also be an arc and will 
be recognized by X-Caliper as such. The Profile Gouge/Excess tolerance values are 
independent of the Solid Gouge/Excess tolerance values described above, and are stored 
as separate values in .VcProject file. 

Gouge — Tolerance used when checking for gouges during a Profile comparison. 
Gouges detected by AUTO-DIFF are shaded in the associated gouge color.  

Excess — Similar to Gouge above, except applies when checking for excess material. 

NOTE:  "Profile" Gouge/Excess tolerance/color values are independent of "Solid" 
Gouge/Excess tolerance/color values and are stored as separate values in .VcProject file. 
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AUTO-DIFF window, Options tab 
Location: Analysis menu > AUTO-DIFF 

VERICUT toolbar short cut:   

  

The features on this tab are used to set processing and reporting options. 

 

 
 

Design Consistency Check—When selected during a "Solid" comparison, checks 
consistency of solid design models, including: check for "watertight" solid- repair 
improperly trimmed surfaces (overlaps and gaps), and reconstruct insignificant missing 
surfaces. This option is highly recommended for design models creating from importing 
IGES data, and other model files which produce unsatisfactory results from the 
comparison. 

When selected during a "Profile" comparison, Design Consistency Check is applicable 
when building a profile from an STL, VERICUT Polygon, or VERICUT Solid design 
model. 

While checking design model consistency can take a while, it provides the best insurance 
for reliable AUTO-DIFF results. If you've used the model in VERICUT before and know 
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the quality is good enough, you can save time by clearing this checkbox. AUTO-DIFF 
will take less time, but results may not be reliable if the solid is not water-tight. 

Keep Design Solid — When selected, keeps the solid design model created by AUTO-
DIFF so it can be used in additional comparisons. This action can reduce AUTO-DIFF 
time if multiple comparisons are made, but will require additional computer resources to 
keep the design solid. The design solid is kept until the VERICUT model is reset, a 
design model is removed or deleted, or the checkbox is cleared and Apply is pressed. 
Saving an IP file also contains the kept design solid. Clear this checkbox to have AUTO-
DIFF create a new design solid for each comparison. 

 Disable Report — Enables you to turn off the AUTO-DIFF Report feature to reduce 
AUTO-DIFF processing time. To generate the report, the processor must search through 
all cut records and lists the maximum error for each bad cut record. This can take a 
significant amount of time for large NC program files. When is toggled "on", you will 
still see the AUTO-DIFF results in the graphic area. Disable Report is only active when 
Comparison Method is set to Solid, Surface or Profile.  

Report Uncut Differences — When selected, differences between the design and uncut 
stock are added to the AUTO-DIFF report. 

Show Point Vectors — Displays the measurement vector associated with each point for 
the "Point" Comparison Method. The Vector is drawn whether AUTO-DIFF compare is 
active or not. 

Save AUTO-DIFF Model — Use to save gouge or excess data as a VERICUT solid 
model file (.vct). Selecting Save AUTO-DIFF Model displays a dialog enabling you to 
specify a directory path and filename for the model file. If both gouge and excess models 
are present, two files will be created ( gouge_filename.vct and excess_filename.vct, 
where filename is the filename you entered in the Save AUTO-DIFF Model dialog. 

This option is only available for use if all of the following are true (otherwise it is grayed 
out):  

1. Standard Cut Mode is active (not FastMill). 

2. Constant Gouge Check is turned off. 

3. AUTO_DIFF Comparison Method is set to Solid or Profile. 

4. AUTO-DIFF Compare has been processed. 
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AUTO_DIFF window, Compare By Region tab 
Location: Analysis menu > AUTO-DIFF 

VERICUT toolbar short cut:   

  

The features on this tab enable you to select a region to perform AUTO-DIFF on. 
Compare By Region is created for very large parts that would require too much memory 
for AUTO-DIFF to process the entire part.  Optionally, cut stock can be internally re-cut 
within the region with a better Cut Tolerance before doing AUTO-DIFF. The Compare 
By Region tab is not available when Comparison Method is set to "Profile". 

  

 
  

On — When selected, activates the Compare by Region feature. When toggled "on", 
AUTO-DIFF comparison only processes the cut stock and design volumes within the 
specified "region". 
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Apply Regions Over Entire Stock — The check box, Apply Regions Over Entire 
Stock, does the following: 

• Calculates a region that can achieve the specified Comparison Tolerance within 
the computer’s physical memory. 

• Re-processes that region of the cut stock at a tolerance that ensures the 
Comparison Tolerance can be achieved. 

• Does the specified AUTO-DIFF comparison for the region. 
• Repositions the region and does AUTO-DIFF multiple times over the entire cut 

stock. 

During AUTO-DIFF processing, the Region Box is displayed at each position over the 
cut stock. 

When Compare is pressed and this box is checked, a notice dialogue is displayed with the 
text, “Processing may take several minutes depending on tolerance, size of the cut stock, 
memory and processor speed. Press the stop button in the main window to cancel AUTO-
DIFF.”, OK. 

When the Apply Regions Over Entire Stock feature is active, the Region Size features 
are disabled. 

Improve Cut Stock Tolerance — When selected, the Cut Stock is re-evaluated at a new 
tolerance based on the specified minimum AUTO-DIFF tolerance. Having this box 
checked affects the results from both the Fit to Memory and the Apply Regions Over 
Entire Stock features. Typically the Comparison Tolerance is smaller than the Cut 
Tolerance, so processing will take longer when Improve Cut Stock Tolerance is active. 

  

Region Size features 

Show Region Box — Click on the  icon to show / not show the "region box", 
representing the AUTO-DIFF comparison region, in the Workpiece View. 

 Minimum XYZ — Use to enter the minimum X, Y, and Z values (relative to the 
workpiece coordinate system), separated by spaces. These values represent the X, Y, Z 
coordinates of first corner point of the "region box". 

 Maximum XYZ — Use to enter the maximum X, Y, and Z values (relative to the 
workpiece coordinate system), separated by spaces. These values represent the X, Y, Z 
coordinates of the diagonal corner point of the "region box".  

 Maximize to Stock — Use to size the "region box" to the maximum extent of the union 
of the stock and design volumes. 

 Fit to Box — Use to drag a 2 dimensional rectangle (similar to a "zoom" box) over the 
cut stock. The rectangle is projected into 3 dimensional space to define the "region box". 

Drag Region — Enables you grab a corner of the "region box" and drag it to re-size the 
"region box". The new corner location is automatically projected onto the cut stock in 3 
dimensional space. Grab the mid-point of one of the "region box" edges to re-size the 
"region box" by dragging a face. Click with the mouse pointer in the point representing 
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the center of the "region box" and drag around the Cut Stock to reposition the "region 
box" without resizing it. 

Fit to Memory — Use to automatically size the "region box" based on the available 
memory for AUTO-DIFF. A short delay occurs while memory is analyzed. 

781781



VERICUT HELP – Analysis menu 

AUTO-DIFF window, Constant Gouge Check tab 
Location: Analysis menu > AUTO-DIFF 

VERICUT toolbar short cut:   

 

Enables you to specify a gouge check tolerance, and turn Constant Gouge Check on and 
off. Gouge areas found by Constant Gouge Check during NC Program processing are 
displayed in the assigned Error color. (See how). 

  

 
  

On — Toggles Constant Gouge Check on and off. 

Toggle Constant Gouge Check on/off to activate/deactivate Constant Gouge Check 
during NC program processing. 

  

NOTES:  
1. A design model must be present in the component tree for Constant Gouge Check 

to detect potential gouges. 
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2. Constant Gouge Check is not compatible with FastMill. When cutting in FastMill 
mode, use one of the AUTO-DIFF comparison methods instead. 

3. AUTO-DIFF and Constant Gouge Check are mutually exclusive. To use the 
AUTO-DIFF features Constant Gouge Check must be turned "off". If you are 
using AUTO-DIFF, you must click the Restore button before you will be able to 
turn Constant Gouge Check "on". 

Tolerance — Specify a tolerance value for Constant Gouge Check. Only gouges, 
greater than the specified tolerance, will be displayed. You can turn Constant Gouge 
Check "off", change the tolerance, and reprocess the NC program at any time. 

NOTE:  A VERICUT Solid (.vct) file can be used for a design model when using 
Constant Gouge Check to find gouges during NC program processing. 
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Comparator (Comparator window) 
 

VERICUT Users: 
VERICUT Location: Analysis menu > Comparator 

VERICUT toolbar short cut:   

  

Cutter Grinder Users: 
Cutter Grinder Location:   Analyze, View Files, Print page > Comparator Grid 

Notebook Feature:     

  

Opens the Optical Comparator window enabling you to overlay a polar or rectangular 
grid over a workpiece or machine view to emulate an optical comparator chart. (See how)  

 

 
 

Use this feature to measure distance and angular relationships of features on your part 
like you would with optical comparator. 
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Comparator Grid Example 

 
 

The grid can be displayed in any view but only in one view at a time. The grid is always 
displayed in the "active" view. The grid is always displayed parallel to the screen and its 
center (0,0) position is related to the origin of either the workpiece coordinate system or 
the machine coordinate system depending on the type of view that is active. 

The grid will be displayed as long as the Optical Comparator window is open. Closing 
the Optical Comparator window removes the grid from the display. 

 Full Polar — Displays a full polar grid . 

 Polar Grid With Linear Quadrant — Displays a polar grid with one linear 
grid quadrant. 

 Half Polar / Half Linear — Displays a grid that is half polar and half linear. 

 Linear Grid With Polar Quadrant — Displays a linear grid with one polar 
quadrant. 

 Full Linear — Displays a full linear grid. 

 Color Pallet — Select a color from the pallet for the optical comparator grid. 
The default color is VERICUT's Foreground color. Click on the "X" in the upper right 
corner of the color pallet to close it. 
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Use the following options to specify the size and position of the grid as well as define the 
spacing between major and minor grid lines. Units are the same as the workpiece or 
machine depending on the type of view that is "active". 

Radius — Specify the radius of the grid that you want to display. 

Center X — Specify the horizontal position of the center of the grid. Enter a value in the 
text field. A negative number moves the center of the grid the specified number of units 
to the left of the coordinate system origin. A positive number moves the grid to the right.  

You can also move the horizontal position of the grid center by selecting one of the arrow 
buttons. Selecting either the < or > button moves the center of the grid to the left or right 
of its current position by the value specified for Minor Linear Spacing. Selecting either 
the < <  or  >>  button moves the center of the grid  to the left, or right, of its current 
position by the value specified for Major Linear Spacing. 

Center Y — Specify the vertical position of the center of the grid.  Enter a value in the 
text field. A negative number moves the center of the grid the specified number of units 
down from the coordinate system origin. A positive number moves the grid up.  

You can also move the vertical position of the grid center by selecting one of the arrow 
buttons. Selecting either the < or > button moves the center of the grid down, or up, from 
its current position by the value specified for Minor Linear Spacing. Selecting either the 
< < or >> button moves the center of the grid down, or up, from its current position by 
the value specified for Major Linear Spacing. 

CCW Rotation — Use to rotate the grid about its center point. Enter an angle value in 
the text field. A positive number rotates the grid the specified number of degrees in a 
counterclockwise direction from its default (zero) position. A negative number rotates the 
grid the specified number of degrees in a clockwise direction from its default (zero) 
position. 

You can also rotate the grid about its center by selecting one of the arrow buttons. 
Selecting either the < or > button rotates the grid clockwise or counterclockwise from its 
current position by the value specified for Minor Angular Spacing. Selecting either 
the << or >> button rotates the grid clockwise, or counterclockwise, from its current 
position by the value specified for Major Angular Spacing.  

Major Angular Spacing — Specify the number of degrees between the "major" grid 
lines of a polar grid. 

Minor Angular Spacing — Specify the number of degrees between the "minor" grid 
lines of a polar grid. 

Major Linear Spacing — Specify the distance between "major" grid lines of a linear 
grid. 

Minor Linear Spacing — Specify the distance between "minor." grid lines of a linear 
grid. 

Magnification — Use this option to quickly change the size of the grid by either a factor 
of 2, or a factor of 10. Selecting either the < or > button reduces or enlarges the size of 
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the grid by a factor of 2. Selecting either the < < or >> button reduces or enlarges the size 
of the grid by a factor of 10. 

Snap to — Use this option to center the grid on a specific feature of the workpiece or 
machine. Click on the text field so that it is highlighted. Select a feature in the graphics 
area and the grid center will move to that location. You can also enter the X, Y, and Z 
coordinates of the workpiece/machine coordinate system in the text field. Selecting the 
Snap to button (or <Enter> on the keyboard) moves the grid to the specified location. 

 

OK — Saves the current settings and dismisses the Optical Comparator window.  

Apply — Applies all of the current settings to the displayed grid without dismissing the 
Optical Comparator window. You can also use the <Enter> key after changing an 
individual setting to immediately apply the change to the current grid display. 

Cancel — Dismisses the Optical Comparator window without saving the settings. 
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NC Program Review 
Location:  Analysis > NC Program Review 

VERICUT toolbar short cut:   

 

The NC Program Review feature enables you to quickly and easily view, replay and edit 
a previously processed NC program (toolpath). (See how) NC Program Review can be 
accessed at any point in the verification process. It does not interrupt the current 
verification status, so reset or rewind of the NC program is not necessary. 

NOTE:   The following conditions must be met before a NC program can be viewed 
with NC Program Review. 

1. The NC program must be processed far enough in VERICUT so that a tool has 
been loaded and at least one tool motion has been processed after the tool is 
loaded. 

2. There must be a model attached to the first "Stock" type component in the 
Component Tree. 

3. The first "Stock" type component must be visible in a workpiece view. 

 

 
 

The NC Program Review main window is composed of three distinct areas, each with 
different user interaction. The window header displays the current NC program file. This 
window can be moved and resized like most other windows, via dragging the window 
header, sides or corners. In addition, the size of the NC Program Listing, Error Listing, 
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and Graphics areas can be changed within the main window by dragging the adjoining 
sides of each area.  

NC Program Review enables you to quickly and easily associate the NC program 
record, the motion resulting from it, and any errors that may be associated with it. The 
three areas of the window are linked together so that if you select a NC program record in 
the listing, the tool moves to the corresponding location in the graphics area. If you select 
a location in the graphics area, the corresponding NC program record is highlighted in the 
NC program listing. If you select an error in the error listing, the NC program record that 
caused the error becomes highlighted in the NC program listing and the tool moves to the 
position where the error occurred in the graphics area. 

  

NC Program Listing — This area displays a listing of the NC program (toolpath) 
records. In this area you can manually edit, add, or delete NC program records. Save the 
modified NC program file or open another NC program file associated with the current 
project file. You can also set Start and End markers to define the range of NC program 
records that you want to review. For more information about this portion of the NC 
Program Review window, see the NC Program Listing Area section below. 

Error Listing — This area displays a list of the errors that VERICUT found while 
processing the NC program (toolpath). For more information about this portion of the NC 
Program Review window, see the Error Listing Area section below. 

Graphics Area — This area displays a visual representation of the motion associated 
with the records in the NC Program Listing. Here you can control how the tool is 
displayed, the method and direction of the replayed NC program as well as the speed of 
the replay. For more information about this portion of the NC Program Review window, 
see the Graphics Area section below. 
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NC Program Review window, NC Program Listing 
Area 
 

The NC Program Listing area is located in the upper left portion of the NC Program 
Review window. 

 

 
 

Main Menu 

 
 

The menu located across the top of the NC Program Review window provide easy access 
to major NC Program Review functions. Each menu contains groups of related functions. 
Left-click on any menu name to display the list of functions in that menu. Click on the 
function in the menu you want to use. The name of the current NC program file is also 
displayed in this area. 

 

File 
Save As — Save the current NC program file under a different name. 

Close — Close the NC Program Review window. 
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Edit 
Cut — Cuts the highlighted text in the NC program listing and puts it in the paste 
buffer.  

Copy — Copies the highlighted text in the NC program listing to the paste buffer. 

Paste — Puts the contents of the paste buffer at the location of the cursor in the NC 
program listing. 

 

Settings 
Set Start — Sets the "Start" marker to the position specified by the cursor in the NC 
program listing or picking a location in the Graphics Area. 

Set Current — Sets the "Current" marker to the position specified either by the 
cursor in the NC program listing or picking a location in the Graphics Area. 

Set End — Sets the "End" marker to the position specified by the cursor in the NC 
program listing or picking a location in the Graphics Area. 

Display to Box — Enables you to set "Start", "Current" and "End" markers by 
creating a box around the area of interest in the graphics area. Click on Display to 
Box, then left click in the Graphics Area and drag the cursor to create a box around 
the area of interest. The "Start" marker will be set to the lowest record number 
contained within the boxed area and the "Current" and "End" markers will be set to 
the highest record number contained within the "boxed" area. 

Cut Line — Displays a color pallet enabling you to specify a color for "cutting" 
portions of the toolpath display in the Graphics Area. 

Non-Cut Line — Displays a color pallet enabling you to specify a color for "non-
cutting" portions of the toolpath display in the Graphics Area. 

Current Line — Displays a color pallet enabling you to specify a color for "current" 
motion of the toolpath display in the Graphics Area. 

Goto Start — Moves the cursor in the NC program listing and positions the cutter in 
the Graphics area to the position indicated by the "Start" marker. 

Goto Current — Moves the cursor in the NC program listing and positions the cutter 
in the Graphics area to the position indicated by the "Current" marker. 

Goto End — Moves the cursor in the NC program listing and positions the cutter in 
the Graphics area to the position indicated by the "End" marker. 

 

Shortcut: You can also access the Settings menu by using the right mouse button in 
either the NC Program Listing area or in the Graphics Area. 
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Icon Bar 

 
 

The items in the Icon Bar enable you to search for specific items in the NC program 
listing, print the NC program listing, or exit NC Program Review. Moving the cursor 
over the icon will display name of the option. 

Line Number or Search Text — Use to enter a line number or a string of text to search 
for. 

Goto Line Number — Moves the cursor in the NC program listing to the line number 
specified in the Line Number or Search Text field. 

Search Forward — Searches forward in the NC program listing for the text string 
specified in the Line Number or Search Text field. 

Search Backward — Searches backward in the NC program listing for the text string 
specified in the Line Number or Search Text field. 

Replacement Text — Use to enter a "replacement text" string. 

Replace One — Replace one occurrence of text string in the Line Number or Search 
Text field (or the highlighted text in the NC program listing) with the text string in the 
Replacement Text field. 

Replace All — Replace all occurrences of the text string in the Line Number or Search 
Text field with the text string in the Replacement Text field. 

Print — Prints the NC program listing. 

Close Window — Closes the NC Program Review window. 

  

NC program Listing 
NC program Editing 
The NC program listing area allows you to edit the NC program with a full function text 
editor. 

You can use the keyboard to add, change, or delete portions of the NC program listing. 
You can also use the Cut, Copy and Paste functions found under Edit in the main menu. 

You can easily see the modifications that you have made to the NC program listing. 
Added, changed, and pasted text is displayed in blue and underlined. Cut and deleted text 
is displayed in red with a "strike through" font. Once you save the modified NC program, 
the red and deleted text is removed and the blue added, changed, and pasted text is 
returned to the original font. 
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Start/Current/End Markers 
The Start/Current/End markers can be found along the left side of the NC Program 
Listing area. The Start marker is represented by the green triangle, the Current marker 
is represented by the aquamarine arrow and the End marker is represented by the red 
square. You can easily identify each marker by moving the cursor over it. 

The Start and End markers are used to define the range of NC program records that will 
be replayed when using Play to End. The Current marker moves to the NC program 
record that is currently being replayed. Set these markers by either selecting an NC 
program record in the NC program listing or the location in the graphics area where you 
want the marker placed. Then select the appropriate option (Set Start, Set Current, Set 
End) from the menu displayed when using the right mouse button in either the graphics 
area to the NC program listing. The menu can also be found under Settings in the NC 
Program Review main window. You can also click on the marker in the NC program 
listing and drag it to the desired NC program record.  

The line number of the "current" record is displayed in the lower left corner of the NC 
Program Listing area. 

If the user file contains more than one NC program file, the name of the displayed NC 
program file is displayed in the lower right corner of the NC Program Listing area. 
Clicking on the button to the right of the NC program file name displays a list of the NC 
program files contained in the project file. Click on a file name in the list to change the 
NC program displayed in the NC Program Listing area. 
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NC Program Review window, Error Listing Area 
 

The Error Listing area is located in the lower left portion of the NC Program Review 
window. It contains a list of the errors that were found while processing the NC program 
in VERICUT. 

 

 
 

Selecting an error in the Error Listing causes the line in the NC Program Listing 
associated with the error to become highlighted. At the same, the tool display in the 
Graphics Area moves to the position where the error occurred. This enables you to 
quickly and easily associate the error with the position in the NC program and in the 
toolpath display. 
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NC Program Review window, Graphics Area 
 

The Graphics area is located in the right portion of the NC Program Review window. 

 

 
 

The graphics area displays the active workpiece view from the VERICUT main graphics 
area. Also, the analysis tools found under Analysis >X-Caliper in the VERICUT main 
menu are available for use while you are in the NC Program Review graphics area. 
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View Manipulation Icons 

 
 

The view manipulation icons and the X-Caliper icon perform the same function as those 
found in the VERICUT toolbar. For more information on these features, see View menu 
> Toolbar. 

  

The Toolpath Display 
As the toolpath is replayed, a line representing the motion of the tool control point is 
displayed in the graphics area. Motions that remove material are displayed as solid lines 
with a default color of the foreground color. Motions that do not remove material are 
displayed as dashed lines with a default color of magenta. The line representing the 
motion of the current NC program record is highlighted with a default color of red. The 
tool image is displayed at the location of the current NC program record. 

The color of the lines can be changed using the Cut Line, Non-Cut Line and Current 
Line options found in the menu that is displayed when using the right mouse button in 
the graphics area or the NC Program listing area, or found under Settings in the NC 
Program Review main window. 

 

Graphics Area Controls 
The current tool (tool id or APT description) and the X, Y, Z, I, J, K of the current tool 
tip position are displayed in the upper right corner of this area. 

Tool Display — Use to specify how the tool is displayed during the toolpath replay. 
Choose Off (do not display the tool), Solid (a shaded solid) or Translucent. 

Line Display — Use to specify whether or not to display the lines representing the path 
of the tool end points. Choose On (display the path), or Off (do not display the path). 

Animation Speed Slider — Controls the speed of the toolpath replay. Move to the left to 
slow down the replay of the toolpath. Move to the right to speed it up. 

Simulation (VCR) Controls — The simulation controls, also known as VCR buttons, 
located at the bottom-right corner of the Graphics area control interactive tool path 
replay. Use these controls to start and stop the replay of the toolpath. To see what action 
is associated with a Simulation control icon, simply position the cursor over the icon and 
a tip appears. 
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Icon Name Function 

 
Play to End Replays from the Current position to the End 

position. 

 
Step Forward Replays the next NC program record ("single block"). 

 
Stop Stop the replay during "Play" (after the current record 

displays) 

 
Step Back Replays the previous NC program record ("single 

block"). 

 
Rewind 

Sets the Current marker to the record with the Start 
marker and clears the toolpath display from the 
Graphics area. 

 
Reset 

Sets the Start and Current markers to the first motion 
record in the NC program, sets the End marker to the 
last NC program motion record, and clears the toolpath 
display from the Graphics area. 
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Inspection 

Introduction to VERICUT Inspection 
 

The VERICUT Inspection module, is a licensed option to VERICUT that provides the 
tools enabling you to quickly and easily specify critical inspection data, then use it to 
create a fully customizable inspection report. 

Inspection Sequence is used to define and document inspection operations critical to the 
integrity of the part. Inspection can be used to document critical dimensions to be 
checked while the part is still on the machine, at various times in the machining process, 
to detect and correct errors on the "in process" part so that time is not wasted on 
subsequent machining operations on a part that is already out of tolerance (see example). 
Inspection can also be used to define and document final inspection procedures on the 
finished part.  

As you use Inspection to define inspection operations, an inspection file (.vcinspect) is 
created containing the two elements essential to creating the actual inspection report. The 
first is a picture showing the features that are to be inspected, the second is a table 
containing the inspection data related to each of these features. Samples of these two 
elements are shown below. 

Sample Inspection File Picture  
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Sample Inspection File Table 

 
  

File Organization 
An inspection sequence file retains all the information needed to reproduce the inspection 
data table and the corresponding inspection markers on the workpiece for a single report. 
The inspection sequence file is not the report itself. Once the inspection sequence file has 
been created, the Inspection Report is created using the same report generation 
mechanism used with the rest of VERICUT. 

A report is created on demand and will typically have the extension ".htm" or ".pdf". 
Unless you explicitly specify a file name when you first save an inspection sequence, the 
inspection sequence file name will default to user file name, with its extension changed to 
".vcinspect". If there will be several inspection sequences for a part, it is suggested that 
you adjust the file names to include suffixes "1", "2", ... or "A", "B", ... or perhaps tool 
identifiers.  

When you request that a report be created, the report file name will be the same as the 
inspection sequence file name, with the extension changed to ".htm" or ".pdf". For a PDF 
file, any pictures required in the report will be embedded, which makes it trivial to pass 
the report around electronically. For an HTML file, the pictures are generated as separate 
GIF and JPEG files, making it more difficult to keep all the pieces together, unless you 
place all inspection files and reports for a part in their own folder, perhaps named using 
the part's identifier.  

VERICUT reports are based on report template files, which are fully customizable. You 
can either create the Inspection Report using the sample Inspection Report template 
provided, or use a custom one that you have created. For more information on VERICUT 
report templates and report creation, see the Introduction to VERICUT Reports 
section. 
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Inspection Sequence window 
Location:  Analysis > Inspection 

 VERICUT toolbar short cut:   

 

Opens the Inspection Sequence window enabling you to create/edit an inspection 
sequence (.vcinspect) file and use it create inspection reports based on its content. The 
Inspection Sequence feature enables you to quickly and easily create and document 
critical inspection points associated with the current user file. (See How) 

 

 
  

The Menu Bar 

 
 

The menu located across the top of the Inspection Sequence window provides easy 
access to major Inspection Sequence functions. Each menu contains groups of related 
functions. Left-click on any menu name to display the list of functions in that menu. 
Click on the function in the menu you want to use. 

 

File 
New — Start a new Inspection Sequence file. 

Open — Open an existing Inspection Sequence file. Such files typically have the 
extension ".VcInspect". Note that you can also open one of  the ten most recently 
accessed files more directly by selecting from the Recent Files list. 
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Save — Save the current inspection sequence file. You may be prompted to select a file 
name if the current sequence was not derived from an existing file. 

Save As — Save the current Inspection Sequence file under a different name. 

Create Report — Use to create an inspection sequence report.  

See Create a Report Using a Template in the Using VERICUT section for additional 
information. Using VERICUT can be found in the VERICUT Help Library. 

Choose one of the following formats: 

Text — Create an inspection sequence report in text format. 
HTML — Create an inspection sequence report in HTML format. 
PDF — Create an inspection sequence report in PDF format. 

NOTE:  The picture used in the inspection report is the one from the "active" window. 

Report Template — Displays the Report Template window enabling you to select 
and/or modify an existing report template or create a new one. 

User-Defined Tag Values — Opens the User-Defined Tags window enabling you to 
assign/edit user-defined tag values used by the current inspection sequence report 
template. 

Rotate Picture CCW — When toggled "On", the Inspection Sequence picture is rotated 
90 degrees counterclockwise when it is used in the Inspection Sequence report. 

Recent Files — Provides a list of recently opened files. To open a file in the list, select 
the desired file. 

Exit — Closes the Inspection Sequence window. 

 

Analysis 
Feature Identifier — Displays the Feature Identifier window to assist you in locating 
critical part features that you want included in the inspection table. 

 

Edit 

NOTE:  All of the following inspection features are selected in the active workpiece 
view. 

 Insert Wall Thickness Row — Inserts a wall thickness inspection record to the 
Inspection Sequence table. You will be prompted to pick the wall feature. 

 Insert Floor Thickness Row — Inserts a floor thickness inspection record to the 
Inspection Sequence table. You will be prompted to pick the floor feature. 

 Insert Hole Diameter Row — Inserts a hole diameter inspection record to the 
Inspection Sequence table. You will be prompted to pick the hole feature. 
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 Insert Datum Plane Row — Inserts a datum plane inspection record to the 
Inspection Sequence table. You will be prompted to pick the plane feature to be used as 
the datum. 

 Insert Distance Row — Inserts a distance (from a datum plane) inspection record to 
the Inspection Sequence table. You will be prompted to pick the relevant feature. Use of 
this type of measurement requires a datum plane. 

 Insert Angle Row — Inserts an angle ( between a selected plane and the datum 
plane) inspection record to the Inspection Sequence table. The "angle" feature can be 
used without a datum plane if it is obvious which angle is to be measured. 

 Insert Position Rows — Inserts two or three rows in the table for the coordinates of 
a position. You could use this type of feature to specify the location of the center of a 
hole, relative to the currently active coordinate system. You will be prompted to pick the 
hole in the active workpiece view. 

 Insert Hole Depth Row — Inserts a hole depth inspection record to the Inspection 
Sequence table. You will be prompted to pick the hole feature. 

 Insert Radius Row — Inserts a radius inspection record to the Inspection Sequence 
table. You will be prompted to pick the hole or cylinder feature. 

 Insert Surface Finish Row — Inserts a surface finish inspection record to the 
Inspection Sequence table. You will be prompted to pick the surface feature. 

 Insert Note Row — Inserts a row in the table for a tabulated note. You will be 
prompted to pick a reference location for the note. 

 Modify Marker Location — Reposition the highlighted feature's inspection point 
marker in the active workpiece view. 

Restore Default Tolerance — Restores the highlighted tolerance to its default value. 

Edit Geometric Tolerance — Opens the Geometric Tolerance window enabling you to 
add geometric tolerance specifications to the Inspection Sequence Table. 

 Delete Row — Deletes the highlighted inspection record from the Inspection 
Sequence table. 

 Refresh —   

Shortcut: You can also access the Edit menu options by selecting the appropriate icon 
from the Icon Bar, or by using the right mouse button in the Inspection Sequence table 
and selecting from the menu that displays. 
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Program 

 Use probe for selected feature — Changes the measuring instrument in the 
currently selected (highlighted) row to "Probe". 

 Use probe for all features — Changes the measuring instrument in all rows to 
"Probe". Typically this would be used just before the next icon. 

 Program probe cycles — Causes the Inspection Programming window to be 
displayed, and transfers any features that have "Probe" as their measuring instrument, to 
the Inspection Programming window. 

  

Shortcut: You can also access the Program menu options by selecting the appropriate 
icon from the Icon Bar or by using the right mouse button in the Inspection Sequence 
table and selecting from the menu that displays. 

  

Icon Bar 
The items in the Icon Bar provide quick access to the most frequently used features 
described above. 

   

New 
File 

Open 
File 

Save 
File 

From File menu 

  

 

Feature Identifier 

From Analysis 
menu 
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Insert Wall 
Thickness 
Row 

Insert Floor 
Thickness 
Row 

Insert 
Hole 
Diameter 
Row 

Insert 
Datum 
Plane 
Row 

Insert 
Distance 
Row 

Insert 
Angle 
Row 

Insert 
Position 
Rows 

From Edit menu 

  

     

Insert 
Hole 
Depth 
Row 

Insert 
Radius 
Row 

Insert 
Surface 
Finish 
Row 

Insert 
Note 
Row 

Modify 
Marker 
Location 

From Edit menu 

  

    

Use 
probe 
for 
selected 
feature 

Use 
probe for 
all 
features 

Program 
probe 
cycles 

Delete Row 

From Program menu From Edit 
menu 

  

   

Export HTML 
(Create 
Report>HTML) 

Export PDF 
(Create 
Report>PDF) 

Close 
Window 
(Exit) 

From File menu 
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Inspection Sequence Table 

 
  

Each record in the table consists of eight columns of information. The first five columns 
are automatically entered by VERICUT when the record is created. Click on any column 
in a row to highlight a record for editing. The order of the records in the table can be 
changed by clicking on the square button at the beginning of the record and dragging the 
record to the desired position. Each record in the table consists of the following 
information: 

Symbol — Represents the inspection record type. This column is automatically updated 
when Feature, below, is edited. 

Feature — Indicates the record type. With the record highlighted, click on the record 
"feature" field and select the feature type from the pull-down list (Wall Thickness, Floor 
Thickness, Hole Diameter, Distance, Angle, Position, Hole Depth, Radius, Surface 
Finish).  

You can also enter the name of a different feature type that has not already been included. 
If you do so, there will be no corresponding symbol in the first column.  

Identifier — Indicates the inspection record's unique identifier. VERICUT will 
automatically generate a feature identifier.  

 If the first feature inserted in a table does not require a datum plane, its identifier will be 
"A1". The next will be "A2", then "A3", etc. If you were to edit the last one in this 
sequence, making it "B1", then subsequently appended rows would continue the new 
sequence, with "B2", "B3", etc. If you then inserted a row after the last "A" feature, its 
identifier would continue the "A" sequence.  

With the record highlighted, double click on the identifier field of a record to edit the 
identifier text. 

Instrument — Indicates the inspection instrument to be used to measure the inspection 
feature. VERICUT will initially show a suitable instrument type, such as "Ultrasonic" for 
a floor thickness or "Snap Caliper" for a wall thickness, but can be changed as follows. 
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With the record highlighted, click on the record "instrument" field and select the 
instrument type from the pull-down list (Snap Caliper, Ultrasonic, Plug Gage, Depth 
Gage, Comparator, Micrometer, Caliper, Height Gage, Bore Gage, Hole Gage, Surface 
Tester). You can also add additional instrument types by highlighting the text in the 
"instrument" field and type in a new instrument type. When you press "Enter", the new 
instrument type is added to the pull-down list. 

Dimension — Indicates the expected dimension of the inspection feature. For many 
feature types, but not all, this column will be populated by the system. For floor thickness 
for example, VERICUT uses X-Caliper's capabilities to determine the distance through 
the stock from the position you picked to the next "air" condition. The same calculation is 
performed for wall thickness. And if you pick a cylinder when locating a diameter or 
radius feature, VERICUT can also fill in the column easily. Things become a little more 
complicated when a datum plane is involved.  

For additional information on using datum planes with Inspection Sequence, see 
Inspection, using datum planes in the Using VERICUT section. Using VERICUT can be 
found in the VERICUT Help Library. 

Whether the column is populated automatically or not, you can always adjust the value.  

Tolerance — Indicates the tolerance of the inspection feature. If the dimension value is 
automatically generated by VERICUT when you insert the row, the Tolerance column 
value is automatically filled in also. There are hard-coded default tolerance values built 
into VERICUT.  

If the tolerances generated do not reflect the values you want, at least they give you initial 
entries to edit, with the advantage that you don't need to know how to keyboard enter a 
plus/minus symbol. If you need non-symmetric tolerances you could enter "+0.010/-
0.008" for example, or you could employ ISO standards by typing an "H" number. 
Incidentally, if you do want to type a plus/minus symbol, on a Windows system try 
holding down the Alt key while you hit the numeric pad keys 0, 1, 7 and 7, then release 
the Alt key. Cut and Paste is easier to remember. 

You can also create, and have VERICUT use, a custom inspection tolerance file. 

For additional information on creating and using a custom inspection tolerance file with 
Inspection Sequence, see Inspection, creating a custom inspection tolerance file in the 
Using VERICUT section. Using VERICUT can be found in the VERICUT Help Library. 

Geo. Tolerance — Indicates the geometric tolerance (GD&T) characteristics associated 
with the inspection feature. If you do not use the widely misinterpreted GD&T standard, 
you can shrink this column's width to zero in the table, and omit it completely from your 
report template. But if your company uses geometric tolerancing, select a row that 
requires it and select Edit Geometric Tolerance from the Inspection Sequence, Edit menu 
(or right-click on the inspection table and pick Edit Geometric Tolerance from the pop-up 
menu) to display the Geometric Tolerance window. 

Measurement — Use this field to record the "actual" measurement of the inspection 
feature. This will most likely occur on paper copies of the reports generated by this 
module. If your company is using digital record keeping, and VERICUT is available to 
your inspectors, they can enter the values directly into the table. 
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Geometric Tolerance window 
 

The Geometric Tolerance window, accessed using Edit > Edit Geometric Tolerance in 
the Inspection Sequence window, enables you to assemble the elements of a geometric 
tolerance (GD&T) specification for inclusion in the Inspection Sequence table. (See 
How) 

NOTE:  The features in the Geometric Tolerance window provides the tools to 
assemble a geometric tolerance specification but does not attempt to check the validity of 
the specification created, or enforce compliance to any "standard". 

  

 
  

In the sample window shown above, notice that one of the element boxes is highlighted 
indicating that it is the "active" element. Click on an element box to make it "active" or 
use the "Enter" or "Tab" keys to step to the next element box and make it "active". Use 
the  icon below each element to shift the elements to the right and make space for an 
additional one. Use the  icon below each element to delete an element and shift the 
remaining elements to the left. To add text to an empty box, simply type in an "active" 
element box. 

  

Text — Click on the text button, , to change a Characteristic, Separator, or 
Modifier symbol in the active element box to text. 

Characteristic — Click on the appropriate characteristic symbol to add it to the "active 
element box. 

Tip: Hold the cursor over a characteristic symbol for a text reminder of what the symbol 
represents. 

Separator — Click on the separator button,  , to add a separator to the "active" 
element box. 
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Modifier — Click on the appropriate modifier symbol to add it to the "active element 
box. 

Tip: Hold the cursor over a modifier symbol for a text reminder of what the symbol 
represents. 

Clear — Use this feature to clear all element boxes. 

OK — Adds the geometric tolerance specification to the Inspection Sequence table and 
closes the Geometric Tolerance window. 

Cancel — Closes the Geometric Tolerance window without adding the geometric 
tolerance specification to the Inspection Sequence table. 
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Feature Identifier window 
 

The Feature Identifier window, accessed using Analysis > Feature Identifier in the 
Inspection Sequence window, assists you in locating critical part features for inclusion 
in the Inspection Sequence table. (See How) 

  

 
  

First Feature — Use   (Step backward / Step forward) to step through each 
feature created with the highlighted cutter, starting with the first feature and moving 
toward the last feature. The current "first" feature is displayed with the "1" marker as 
shown in the illustration below. 

Last Feature — Use   (Step backward / Step forward) to step through each 
feature created with the highlighted cutter, starting with the last feature and moving 
toward the first feature. The current "last" feature is displayed with the "2" marker as 
shown in the illustration below. 

Color Bar — Use the pull-down list of colors to specify the feature display color. 

 Close Window — Closes the Inspection Feature Identifier window. 

Cutter Table — Contains a list of cutters used to cut the part. Each record contains the 
following information: 

File # — The toolpath file number. 

Record Number — The line number of the tool change record. 

Tool ID — The tool ID of the cutter. 

Description — A description of the cutter. 
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Inspection Programming window 
Location:  Analysis > Inspection window:  Program > Program probe cycles 

VERICUT toolbar short cut:    

 

Opens the Inspection Programming window enabling you to create G-Code programs 
to drive an NC machine through the steps required to inspect a workpiece using one or 
more probes. 

 

 
 

The Inspection Programming feature enables you to quickly and easily create a G-Code 
program to drive an NC machine with a probe loaded to the critical inspection points 
associated with the current project file. (See How) 

  

The Menu Bar 

 
 

The menu located across the top of the Inspection Programming window provides easy 
access to major Inspection Programming functions. Click on the function in the menu you 
want to use. 

811811



VERICUT HELP – Analysis menu 

Post-processor — Enter the /path/filename of the post-processor file to use, or use the 

  (Browse for Post-processor) icon and use the Post-processor file selection box to 
select the Post-processor file. 

 Edit post-processor — Displays the Post-processor in a text edit window enabling 
you to view/edit the post-processor file. 

N= — Use the N= text field to enter the increment to be used for sequence numbers in 
the G-Code program (i.e., N=10 results in sequence numbers N10, N20, N30, ...) 

 Run post to generate program — Runs the specified post processor program to 
generate the probe G-Code program. 

Probe program — Enter the /path/filename of the probe G-Code program to generate, or 

use the  (Browse for probe program) icon and use the Probe program file selection 
box to select the probe G-Code program file. 

 Edit probe program — Displays the probe G-Code program in a text edit window 
enabling you to view/edit the probe program that was created. 

 Simulate probe program — Displays the NC Program window enabling you to 
specify the probe G-Code program and simulate the probe path in VERICUT. 

 Close Window — Closes the Inspection Programming window. 

  

812812



VERICUT HELP – Analysis menu 

Die Sinking Simulation (Die Sinking Simulation 
window) 
Location:  Analysis menu > Die Sinking Simulation 

  

Opens the Die Sinking Simulation window enabling you to select electrodes and 
simulate the die sinking process. (See How) 

  

 
  

Simulation Display Features 
Stock — Enables you to select the Stock component that is to be used for the simulation. 
Select the name of the Stock component from the pull-down list. 

Display Stock — use to specify whether or not to display the Stock model during the 
simulation. The stock model can be displayed as Solid or Translucent. The stock model 
remains displayed during the Burn process unless Display Burned Material is toggled 
on. In this case the Stock model will be turned off when you select Burn and only the 
material removed by the simulated EDM burn will be displayed at the end of the burn 
process. 
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Display Electrodes — use to specify whether or not to display the Electrode model(s). 
Electrode models can be displayed as Solid or Translucent. Electrode models are always 
toggled off after Burn is selected. 

Display Burned Material — use to specify whether or not to display the material that is 
removed by each electrode during the simulation. The "burned material" can be displayed 
as Solid or Translucent. 

Animate — use to specify whether or not to display electrode animation during the 
"burn" process. Use the slider bar to control the speed of the animation. If toggled off, 
displays only the result of the burn process.  

  

Electrode Table 
Table of electrodes selected for use during Die Sinking Simulation.  

On — Toggles on and off to activate/deactivate individual electrodes in the table. Only 
the active electrodes will be used during the "burn" process. 

Electrode — The name of the electrode component.  

Overburn — this column enables you to specify an "overburn" value for each electrode. 
The "overburn" value is applied as an offset to each electrode during "burn" processing. 

Volume Removed — this column displays the volume of material that was removed by 
each active electrode during the burn process. The "volume removed" value is updated in 
the table as each electrode completes the burn process. 

Click and drag the button in the first column of each row to change position of an 
electrode in the table. "Active" electrodes will be processed sequentially starting at the 
top of the table. 

Add — use to add additional electrodes to the table. Select the electrode to be added 
from the pull-down list then select Add. The pull-down list will contain all electrode 
components found in the Component Tree that are not currently in the table. 

Delete — use to remove the highlighted electrode from the table. 

The Add / Delete can be accomplished by either selecting the associated button in the 
Die Sinking Simulation window or selecting it from the pull-down that results from 
using the right mouse button while the cursor is in the Electrode table. 

Set All — use to activate "all" electrodes in the table.  

Clear All — use to deactivate "all" electrodes in the table. 

  

Die Sinking Simulation features 

Compare With Design — displays the AUTO-DIFF window enabling you to compare 
the stock model at the end of the burn process with the design model. 

Save Model — enables you to save the stock model that resulted from the burn process 
as a VERICUT solid (.vct) file. 
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Apply — Use to save the current Die Sinking Simulation settings. 

Burn — Use to start the "burn" process. 

Restore — Restores the stock model to the state it was in prior to the "burn" process. 

Report — Use to create a Die Sinking Simulation Report. 

Close — Closes the Die Sinking Simulation window. 
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OptiPath Menu 
Control (OptiPath Control window) 
 

VERICUT Users: 
VERICUT Location:  OptiPath menu > Control 

                                  Project menu > Output: Logs tab, Settings button 

VERICUT toolbar short cut:      

  

Mold and Die Users: 
Mold and Die Location:    Preview and Optimize page > Optimize Tool Path 

Notebook Feature:        

  

Opens a window to control when tool paths are optimized by OptiPath, specify the file to 
receive the optimized data, choose the type of stock material and NC machine involved in 
the cutting the workpiece. Feed rates and spindle speeds can be monitored via the Status 
window. A summary of the cutting conditions encountered during optimization and 
min/max optimized feed rates is written to the Log and available for use when creating a 
report file showing an overview of the results of the current VERICUT session. 
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Settings tab — Features on this tab enable you to control when and how tool paths are 
optimized. 

G-Code Output Options tab — Features on this tab enable you to configure how the 
machine control will process machine code data, and configure settings referenced when 
G-code tool path files are optimized. 

Learn Mode Options tab — Features on this tab enable you to control how and when 
OptiPath records are written to the OptiPath Library file during Learn From Toolpath 
processing.  

APT Output Options tab — Features on this tab enable you to configure settings 
referenced when APT NC programs are optimized. 

  

OK — Applies the changes and closes the OptiPath Control window. 

Apply — Applies the changes and leaves the OptiPath Control window open. 

Cancel — Closes the OptiPath Control window without applying changes. 
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OptiPath Control window, Settings tab 
VERICUT Location:  OptiPath menu > Control 

                                  Project menu > Output: Logs tab, Settings button 

 VERICUT toolbar short cut:      

  

Features on this tab enable you to control when and how tool paths are optimized. 

  

 
  

OptiPath Mode — Controls when and how tool paths are optimized. All OptiPath modes 
can be used with both Standard and FastMill cut modes. 

Options: 

Off — Turns optimization off. Optimization is automatically turned off when the end 
of the tool path file has been reached, or when the tool path has been reset or 
rewound. 

On — Turns tool path optimization on and writes optimized tool path data to the 
Optimized File. For optimization to occur, OptiPath records must be associated with 
cutting tools in the tool path file. There are two methods of doing this: 

Tool Library association method - associate the OptiPath tool description and 
number of teeth with a tool in a Tool Library file, then choose the stock material 
and machine in the OptiPath Control window. 
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Tool List association method - choose the stock material and machine in the 
OptiPath Control window, then build a tool list that associates OptiPath records 
with cutting tools to be optimized in the tool path file. 

With either method, tools without cutting tool-to-OptiPath record associations are not 
optimized. If both methods are used, associations in the tool list override those stored 
with tools in the Tool Library. 

Prompt While Cutting — Turns tool path optimization on and interactively prompts 
for optimization data at each tool change. As you enter data for optimizing the cuts 
performed by each tool, VERICUT automatically stores this information in an 
OptiPath Library file and sets tool properties to point to the new OptiPath records. 

Learn From Toolpath —    Automatically creates a new OptiPath Library file for 
the current user file in the /path/filename specified by OptiPath Library. (See how) 
The OptiPath library file that is created can then be manually fine-tuned using 
OptiPath Manager and used to optimize the tool path.  

Learn From Toolpath can be turned On / Off at any time during cut processing. 
Each time Learn From Toolpath is turned on, it creates an OptiPath library file. The 
file contains OptiPath settings for every tool loaded since cutting was started with 
Learn From Toolpath turned "On", including the tool that was cutting at time that 
Learn From Toolpath was turned "Off". These settings are based only on cutting 
conditions that occurred between the time cutting was started with Learn From 
Toolpath was turned on and the time when cutting stops and Learn From Toolpath 
turned "Off". To get complete and accurate information for each tool, process the 
whole job through Learn From Toolpath. Turning Learn From Toolpath On / Off 
during cutting can be used to analyze cutting conditions for a specific group of cuts. 

When Learn From Toolpath mode is turned on and an existing .olb is present, any 
tools with matching OP records are skipped, not "learned". Any tools without OP 
records are "learned" and a new OP record is created. The old and new records are 
combined in a new OP library file. 

For each tool, OptiPath finds the maximum volume removal rate and chip thickness 
that occurred during cutting and uses them for corresponding OptiPath settings for the 
tool. The optimization mode is set to a combination of "Chip Thickness" and 
"Volume Removal" for each tool. Axial Depth and Radial Width values are 
determined by the cut that produces the highest volume removal rate. Default values 
are used for other settings unless they have specifically been changed using Learn 
Mode Options tab. 

Learn From Toolpath only automatically creates the OptiPath Library file (.olb) and 
an updated Tool Library file (.tls) containing the "OP Description" and "# Teeth" 
values associated with the newly created OptiPath Library file. It does not 
automatically optimize the tool path or produce the Optimized File. Once Learn 
From Toolpath creates the Optipath Library file, you are prompted whether or not 
you want to optimize the NC program using the newly created OptiPath Library file 
and Tool Library files. 

819819



VERICUT HELP – OptiPath menu 

OptiPath Library — If OptiPath Mode is set to Off, On, or Prompt While Cutting, 
OptiPath Library represents the /path/filename of the OptiPath Library file containing the 
desired OptiPath records. If OptiPath Mode is set to Learn From Toolpath, OptiPath 
Library represents the /path/filename of the OptiPath Library file that will be created. 

Optimized File — Specifies the name of the modified (optimized) tool path file to 
receive optimized tool path data. The format of this file, APT vs. G-code, is the same as 
the tool path file being optimized. When an APT tool path type is optimized the 
programmed "FEDRAT" records are commented out using "$$" and written to the 
modified path for reference. The Optimized File name must be different from that of the 
original tool path file. OptiPath will not permit the original tool path file to be 
overwritten. 

When optimizing multiple tool path files an optimized tool path file is output for each 
tool path file simulated. Each output file has an ascending sequence number appended to 
the end of the base file name. For example: assume Optimized File="part.mco" is 
entered (without the quotes). Optimizing 2 tool paths outputs the following files: 

part001.mco => optimized tool path from tool path 1 

part002.mco => optimized tool path from tool path 2 

If a dot "." is the last character of the optimized tool path file name, then three digits are 
appended to the file name as the extension. Continuing with the above example: assume 
Optimized File="part." is entered. Optimizing the same 2 tool paths outputs the 
following files: 

part.001 => optimized tool path from tool path 1 

part.002 => optimized tool path from tool path 2 

If an asterisk “*” is used in the optimized tool path file name, the original tool path file 
name is used as the output file name in place of the asterisk. If characters follow the 
asterisk, the input tool path file name extension is replaced with the characters following 
the asterisk. Examples follow. 

 

Original tool path file Optimized File name Output file name 

dir1/filename.tp dir2/* dir2/filename.tp 

dir1/filename.tp dir2/*.op dir2/filename.op 

dir1/filename.tp dir2/*op dir2/filenameop 

dir1/filename.tp dir2/*op.tp dir2/filenameop.tp 

 filename.tp *.op filename.op 
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Only a single asterisk is acted on in the optimized tool path file name, with one 
exception: asterisk dot asterisk (“*.*”). This case behaves exactly like the single asterisk 
file name described above. This is NOT a regular expression replacement, therefore any 
characters before the asterisk are ignored and lost. When there is more than one asterisk, 
only the first one is replaced. Examples follow. 

 

Original tool path file Optimized File name Output file name 

dir1/filename.tp dir2/*.* dir2/filename.tp 

dir1/filename.tp dir2/op* dir2/filename.tp 

dir1/filename.tp dir2/op*.ext dir2/filename.ext 

dir1/filename.tp dir2/*op.* dir2/filenameop.* 

 
Material — Identifies the stock material being cut. The material name is changed via 
clicking the arrow and selecting from a list of available materials, or clicking in the data 
field and typing a new material name. 

Machine — Identifies the NC machine being used to cut the workpiece. This feature 
functions similar to Material described above. 

NOTE:  For optimization to occur the Material and Machine names must match those 
of the desired records in the OptiPath Library. 

Override All Feedrates — Overrides optimized feed rates calculated for all tools 
optimized. 100% uses optimized feed rates as is, 50% cuts feed rates in half, 200% 
doubles the feed rates, and so on. 
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OptiPath Control window, G-Code Output Options tab 
VERICUT Location:  OptiPath menu > Control 

                                  Project menu > Output: Logs tab, Settings button 

 VERICUT toolbar short cut:      

  

Enables you to configure how the machine control will processes machine code data and 
configure settings referenced when G-code tool path files are optimized by OptiPath. The 
G-Code Output Options tab is only available when NC Program Type is set to G-Code 
Data. 

  

 
  

OptiPath & Curve Fit tab — Features on this tab enable you to configure settings 
referenced when G-code tool path files are optimized by OptiPath.  

General tab — Features on this tab enable you to configure general guidelines for how 
the control processes machine code data and number equations. 
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OptiPath Control window, G-Code Output Options tab, 
OptiPath & Curve Fit tab 
VERICUT Location:  OptiPath menu > Control > G-Code Output Options tab 

 

Features on this tab enable you to configure settings referenced when G-code tool path 
files are optimized by OptiPath. (See how)  

  

 
  

The settings are used to control block sequencing and word/value spacing in the 
optimized output tool path file. Note that by default, optimized blocks receive the same 
sequence number, if any, that appears on the original block processed. This typically 
results in multiple blocks having the same sequence number. The features on this tab are 
the same as those found on the Control Settings window: OptiPath & Curve Fit tab. 

Auto Sequence Numbering — When active, re-sequences optimized tool path records in 
ascending order. The Sequence Increment Value (see below) is used for the beginning 
sequence number, and as the increment value for subsequent sequence numbers. Both 
optimized and non-optimized blocks with sequence numbers are re-sequenced. Sequence 
numbers are not added to un-optimized blocks without a sequence number. 

NOTE:  If the general control setting Default Word="N", then "N" does not appear in 
the sequence number. The result is a sequence number without a word, for example: 
"50G01X5", such as required by Heidenhain controls. 

Add Sequence Number to Added Blocks — When active, adds sequence numbers to 
blocks added during optimization via the Add More Cuts OptiPath setting. 
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Sequence Increment Value — Initial value and increment value for re-sequencing 
optimized G-code tool path records. 

 
 

Word Value Spacing — When active, includes a space between word/value pairs in the 
optimized tool path file. Un-optimized records do not receive spacing. When this feature 
is not used, optimized tool path records are not spaced. 
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OptiPath Control window, G-Code Output Options tab, 
General tab 
 
Features on this tab enable you to configure general guidelines for how the control 
processes machine code data and number equations. (See how)  
The features on this tab are the same as those found on the Control Settings window: 
General tab. 
 

 
  
 
Control Type — Sets the type of NC control being used. Choosing the proper option 
establishes a mode of operation consistent with how the control processes NC data. 
Options are: 

Generic — Fanuc and most other controls using standard controller functions. 

NUM — French-made control. This option affects how G-code data is interpreted, for 
example: how variables are initialized and processed, and how to interpret parameters 
to macros that shift the location of the tool path. 

Heidenhain Conversational — Heidenhain Conversational control. This option 
causes VERICUT to recognize the "L" word as an optimizable word. Also, the "L" 
word is included with any cuts added during optimization. 

Calculation Tolerance — Tolerance for rounding mathematical evaluations, such as 
determining if two calculated values are equal to, greater than, or lesser than each other.  

NOTE:  The Calculation Tolerance should be adjusted to eliminate "invalid circle" 
errors caused by circle calculations that produce differences larger than the tolerance 
value when processing G-Code data. 
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Order of Math Operations — Order in which math operations are performed. Options 
are: 

Rules of Precedence — Follow the basic rules of math precedence: 

1. Perform exponential (power). 

2. Perform multiplication and division operations. 

3. Perform addition and subtraction operations, example: 5 + 5.3 * 3 * sin(30)= 
12.95 

Enclosing math operations in parenthesis causes them to be performed before 
those not enclosed in parenthesis. The same rules of precedence are applied to 
math operations enclosed in parenthesis. 

Left to Right — Use left to right sequence, example: 5 + 5.3 * 3 * sin(30)= 15.45 

Default Word — Word assumed by VERICUT for NC data blocks beginning with 
numbers, such as NC data for some Heidenhain controls. For example, for VERICUT to 
interpret blocks like "50G01X5", set Default Word to "N". VERICUT then interprets the 
block without error as "N50G01X5". 
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OptiPath Control window, Learn Mode Options tab 
VERICUT Location:  OptiPath menu > Control 

                                  Project menu > Output: Logs tab, Settings button 

 VERICUT toolbar short cut:      

  

Features on this tab enable you to control how and when OptiPath records are written to 
the OptiPath Library file during Learn From Toolpath processing.  

  

 
  

Enables you to override the default values for Minimum Feedrate Change, Clean-up 
Feedrate, Minimum Cut Feedrate and Maximum Cut Feedrate without going to the 
OptiPath Control window: Settings tab. 

The Learn Mode Options tab is only active when OptiPath Mode, on the OptiPath 
Control window: Settings tab, is set to Learn From Toolpath. 

Append to Existing OptiPath Library — If toggled "On", Learn From Toolpath 
appends OptiPath records to the existing OptiPath Library file for the current project file. 
Otherwise the "OptiPath Library to be created" window will display enabling you to 
specify the /path/filename for the new OptiPath library file to be created. 

Update Optimization Settings for Existing Records — If toggled "On", existing 
OptiPath records are updated with new volume, chip thickness, and spindle speed values. 
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NOTE:  If Update Optimization Settings for Existing Records is toggled "On", and 
the same tool is loaded multiple times in the toolpath, the OptiPath Library file (.olb), 
produced by Learn From Toolpath, will have only one record for the tool. The settings 
for the tool are based on the "worst case" cut condition of all cuts made with the tool 
during the current toolpath. If toggled "Off", a record will be added to the OptiPath 
Library file each time the tool is loaded. The settings will be based on the "worst case" 
cut for the current "load tool" cut sequence.  

  

Reset and Optimize after Learning — If toggled "On", VERICUT automatically resets 
and optimizes the toolpath after the OptiPath Library file is created. Otherwise, you will 
be prompted whether or not you want to optimize the toolpath using the newly created 
OptiPath Library file and Tool Library files. 

Minimum Feedrate Change — Specifies the minimum change from the current 
optimized feed rate that will cause a new optimized feed rate to be output. This feature 
controls the quantity of feed rates output to the optimized tool path file. A small value 
causes more optimized feed rates to be output than when a larger value is entered. 

Default — When selected, sets the default Minimum Feedrate Change = 1 IPM or 25 
MMPM, whichever applies. 

Clean-up Feedrate — Feed rate used when the tool is adjacent to, but not removing 
material. This condition is commonly referred to as a “spring pass”. 

Default — When selected, sets the default clean-up feed rate as follows: 

G-code tool path = 50% of the Max Feed Velocity of the machine's X-axis. 

APT tool path = 50% of the Fast Feed value. 

 

Tip: Set the Clean-up Feedrate to be less than the Air Cut Feedrate, since actual 
cutting leaves small amounts of material from tool deflection. 

 

Minimum Cut Feedrate — Specifies the minimum optimized feed rates that can be 
output when removing material. 

Default option — When selected, sets the default minimum feed rate = 1 IPM or 25 
MMPM, whichever applies. 

Maximum Cut Feedrate — Specifies the maximum optimized feed rates that can be 
output when removing material. 

Default — When selected, sets the default maximum feed rate as follows: 

G-code tool path = 45% of the Max Feed Velocity of the machine's X-axis. 

APT tool path = 45% of the Fast Feed value. 
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Air Cut Feed Rate — This option is useful for reducing time of proven tool paths, 
without affecting cutting feed rates and resulting surface finishes. When the checkbox is 
cleared, this feature controls the feed rate used by all other optimization methods to 
optimize air cuts. 

Default — when selected, the air cut feed rate is determined as follows: 

G-code tool path = Max Feed Velocity of the machine's X-axis. 

APT tool path = Fast Feed value. 

To specify an air cut feed rate value, clear the Default checkbox and enter a value in the 
data field. The feed rate entered should reflect the maximum speed at which machine 
axes can move simultaneously in feed mode (e.g. G01). 
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OptiPath Control window, APT Output Options tab 
VERICUT Location:  OptiPath menu > Control 

                                  Project menu > Output: Logs tab, Settings button 

 VERICUT toolbar short cut:      

  

Features on this tab enable you to configure settings referenced when APT NC programs 
are optimized. 

  

 
  

Output Number of Decimal Places — Use the text field to specify the number of 
decimal places that are to be output when OptiPath adds records. The default value is 10. 
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Compare Files (Compare NC Program Files window) 
VERICUT Location:  OptiPath menu > Compare Files 

  

Opens a window to enabling you to select and compare the original NC program file and 
the optimized NC program file. 

  

 
  

Toolpath Type — Select APT or G-Code Data. 

Original Toolpath — Enter the \path\file name in the text field of the file to receive 
exported model data or click on Browse and use the Original NC program file selection 
window to specify the file. 

Optimized Toolpath — Enter the \path\file name in the text field of the file to receive 
exported model data or click on Browse and use the Optimized NC program file selection 
window to specify the file. 

Previous Difference — Use the  icon to step back through the file to the previous 
difference. 

Next Difference — Use the  icon to step forward through the file to the next 
difference. 
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Line Number or Search Text — Use to enter a line number or a string of text to search 
for. 

Goto Line Number — Use the  icon to move the cursor in the file listing to the line 
number specified in the Line Number or Search Text field. 

Search Forward — Use the  icon to search forward in the file listing for the text 
string specified in the Line Number or Search Text field. 

Search Backward — Use the    icon to search backward in the file listing for the text 
string specified in the Line Number or Search Text field. 

Compare — Starts the compare of the two specified NC program files. 

Close — Closes the Compare NC Programs window. 

Stop — Use the  icon to stop the compare. 
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